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This document describes how to create, deploy, and debug Oracle CEP applications.

Oracle CEP (formally known as the WebLogic Event Server) is a Java server for the
development of high-performance event driven applications. It is a lightweight Java
application container based on Equinox OSGi, with shared services, including the
Oracle CEP Service Engine, which provides a rich, declarative environment based on
Oracle Continuous Query Language (Oracle CQL) - a query language based on SQL
with added constructs that support streaming data - to improve the efficiency and
effectiveness of managing business operations. Oracle CEP supports ultra-high
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time end-to-end Java Event-Driven Architecture (EDA) development platform.

This document is intended for programmers creating Oracle CEP applications.

Documentation Accessibility
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facilitate access by the disabled community. Accessibility standards will continue to
evolve over time, and Oracle is actively engaged with other market-leading
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Accessibility of Links to External Web Sites in Documentation
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any representations regarding the accessibility of these Web sites.
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Overview of Creating Oracle CEP
Applications

This section contains information on the following subjects:

= Section 1.1, "Overview of the Oracle CEP Programming Model"
= Section 1.2, "Oracle CEP IDE for Eclipse"

= Section 1.3, "Creating an Oracle CEP Application”

= Section 1.4, "Configuring Oracle CEP Resource Access"

= Section 1.5, "Next Steps"

1.1 Overview of the Oracle CEP Programming Model

Because Oracle CEP applications are low latency high-performance event-driven
applications, they run on a lightweight container and are developed using a
POJO-based programming model. In POJO (Plain Old Java Object) programming,
business logic is implemented in the form of POJOs, and then injected with the
services they need. This is popularly called dependency injection. The injected services
can range from those provided by Oracle CEP services, such as configuration
management, to those provided by another Oracle product such as Oracle Kodo, to
those provided by a third party.

Oracle CEP defines a set of core services or components used together to assemble
event-driven applications; the typical services are adapters, streams, and processors.
You can also create your own business logic POJOs and Spring beans that are part of
the application, as well as specialized event beans that are just like Spring beans but
with full access to the Oracle CEP framework, such as monitoring and

record /playback of events. In addition to these, Oracle CEP includes other
infrastructure services, such as caching, clustering, configuration, monitoring, logging,
and so on.

All services are deployed on the underlying Oracle microServices Architecture (mSA)
technology. Oracle mSA is based upon the OSGi Service Platform defined by the OSGi
Alliance (see http://www.osgi.org/ for more information.)

The following sections provide additional information about the Oracle CEP
programming model and creating applications:

= Section 1.1.1, "Components of the Oracle CEP Event Processing Network"
= Section 1.1.2, "Oracle CEP Event Types"

= Section 1.1.3, "Transmitting Events in the EPN: Stream and Relation Sources and
Sinks"
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= Section 1.1.4, "EPN Assembly File"
s Section 1.1.5, "Component Configuration Files"

»  Section 1.1.5.1, "Accessing Component and Server Configuration Using the
ConfigurationPropertyPlaceholderConfigurer Class"

= Section 1.1.8, "High Availability and Scalability"
s Section 1.1.7, "Extending the EPN"

= Section 1.1.6, "How Components Fit Together"

= Section 1.1.9, "Oracle CEP Application Lifecycle"
s Section 1.1.10, "Oracle CEP APIs"

1.1.1 Components of the Oracle CEP Event Processing Network

The Oracle CEP Event Processing Network (EPN) represents the interconnections
between the various Oracle CEP components of an Oracle CEP application.

Oracle CEP applications and their EPNs are made up of the following basic
components:

= Section 1.1.1.1, "Adapter"

s Section 1.1.1.2, "Channel"

s Section 1.1.1.3, "Processor"

s Section 1.1.1.4, "Event Bean"
= Section 1.1.1.5, "Spring Bean"
s Section 1.1.1.6, "Cache"

s Section 1.1.1.7, "Table"

Each component on the EPN is known as a stage. Within the Oracle CEP IDE for
Eclipse, each component on the EPN is also known as a node.

For more information, see:

»  Section 1.1.1.8, "Nested Stages"
= Section 1.1.1.9, "Foreign Stages"
»  Section 6.4.1, "Creating Nodes"

1.1.1.1 Adapter

An adapter is a component that provides an interface to incoming data feeds and
converts the data into event types that the Oracle CEP application understands.

Adapters can be both incoming (receive data) and outgoing (send data). Oracle CEP
includes some built-in adapters, such as JMS and HTTP publish-subscribe adapters
and adapters for configuring high availability.

For more information, see:

s Chapter 7, "Configuring JMS Adapters"

s Chapter 8, "Configuring HTTP Publish-Subscribe Server Adapters"
s Chapter 14, "Configuring Custom Adapters"

= Section 21.2, "Configuring High Availability Adapters"
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1.1.1.2 Channel

A channel is a component that represents the physical conduit through which events
flow.

Channels connect components that send events with components that receive events.
For more information, see Chapter 9, "Configuring Channels".

1.1.1.3 Processor

A processor is a component that executes user-defined event processing rules against
the events offered by channels.

The user-defined rules are written using either of the following;:
s Oracle Continuous Query Language (Oracle CQL)

For more information, see:

- Chapter 10, "Configuring Oracle CQL Processors"

- Oracle Complex Event Processing CQL Language Reference
s Event Processing Language (EPL)

For more information, see:

- Chapter 11, "Configuring EPL Processors"

- Oracle Complex Event Processing EPL Language Reference

Note: Oracle CQL replaces Event Processing Language (EPL) in
Oracle CEP 11g Release 1 (11.1.1). Oracle CEP supports EPL for
backwards compatibility.

1.1.1.4 Event Bean
An event bean is a user-coded Plain Old Java Object (POJO) bean managed by Oracle
CEP.

Event beans are analogous to Spring beans, which are managed by the Spring
framework, however they support event-based features, such as the specification of a
suspend and resume methods. For more information, see Chapter 15, "Configuring
Custom Event Beans".

1.1.1.5 Spring Bean
A spring bean is a user-coded Plain Old Java Object (POJO) managed by the Spring
framework.

These components are not managed by Oracle CEP; for example, you cannot monitor
these components, record and playback of events, and so on. If you require this
additional functionality for your POJO, consider creating an Oracle CEP event bean
instead. For more information, see Section 16, "Configuring Custom Spring Beans".

1.1.1.6 Cache

A cache is a temporary storage area for events, created exclusively to improve the
overall performance of your application and to handle large amounts of historical
data.

For more information, see:

= Section 10.4, "Configuring an Oracle CQL Processor Cache Source"
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= Section 11.3, "Configuring an EPL Processor Cache Source"

s Chapter 12, "Configuring Caching".

1.1.1.7 Table

A table is a component that connects a relational database table to the EPN as an event
data source.

You can access a relational database table from an Oracle CQL query using:

= table source: using a table source, you may join a stream only with a NOW window
and only to a single database table.

Note: Because changes in the table source are not coordinated in
time with stream data, you may only join the table source to an event
stream using a Now window and you may only join to a single
database table. For more information, see "S[now]" in the Oracle
Complex Event Processing CQL Language Reference.

To integrate arbitrarily complex SQL queries and multiple tables with
your Oracle CQL queries, consider using the Oracle JDBC data
cartridge instead.

For more information, Section 10.3, "Configuring an Oracle CQL Processor Table
Source".

s Oracle JDBC data cartridge: using the Oracle JDBC data cartridge, you may
integrate arbitrarily complex SQL queries and multiple tables and datasources
with your Oracle CQL queries.

Note: Oracle recommends that you use the Oracle JDBC data
cartridge to access relational database tables from an Oracle CQL
statement.

For more information, see "Understanding the Oracle JDBC Data Cartridge" in the
Oracle Complex Event Processing CQL Language Reference.

In all cases, you must define datasources in the Oracle CEP server config.xml file.
For more information, see "Configuring Access to a Relational Database" in the Oracle
Complex Event Processing Administrator’s Guide.

Oracle CEP relational database table event sources are pull data sources: that is, Oracle
CEP will periodically poll the event source.

1.1.1.8 Nested Stages
When you define a child stage within a parent stage in an EPN, the child stage is said
to be nested. Only the parent stage can specify the child stage as a listener.

Example 1-1 shows the EPN assembly source in which HelloWorldBean is nested
within the helloworldOutputChannel. Only the parent
helloworldOutputChannel may specify the nested bean as a listener.

Example 1-1 EPN Assembly File With Nested Bean

<wlevs:adapter id="helloworldAdapter"
class="com.bea.wlevs.adapter.example.helloworld.HelloWorldAdapter" >
<wlevs:instance-property name="message" value="HelloWorld - the current time is:"/>
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</wlevs:adapter>

<wlevs:channel id="helloworldInputChannel" event-type="HelloWorldEvent" >
<wlevs:listener ref="helloworldProcessor"/>
<wlevs:source ref="helloworldAdapter"/>

</wlevs:channel>

<wlevs:processor id="helloworldProcessor" />

<wlevs:channel id="helloworldOutput" event-type="HelloWorldEvent" advertise="true">
<wlevs:listener>
<bean class="com.bea.wlevs.example.helloworld.HelloWorldBean" />
</wlevs:listener>
<wlevs:source ref="helloworldProcessor"/>
</wlevs:channel>

Alternatively, you can define this EPN so that all nodes are nested as Example 1-2
shows. The helloworldAdapter, the outermost parent stage, is the only stage
accessible to other stages in the EPN.

Example 1-2 EPN Assembly File With all Nodes Nested

<wlevs:adapter id="helloworldAdapter" class="com.bea.wlevs.adapter.example.helloworld.HelloWorldAdapter" >
<wlevs:instance-property name="message" value="HelloWorld - the current time is:"/>
<wlevs:listener>
<wlevs: id="helloworldInput" event-type="HelloWorldEvent" >
<wlevs:listener>
<wlevs:processor id="helloworldProcessor">
<wlevs:listener>
<wlevs: id="helloworldOutput" event-type="HelloWorldEvent">
<wlevs:listener>
<bean class="com.bea.wlevs.example.helloworld.HelloWorldBean"/>
</wlevs:listener>
</wlevs:>
</wlevs:listener>
</wlevs:processor>
</wlevs:listener>
</wlevs:>
</wlevs:listener>
</wlevs:adapter>

For more information, see Section 6.2.9, "Nested Stages".

1.1.1.9 Foreign Stages

You can refer to a stage simply by its id attribute when you define both the source and
target stage in the same application.

To refer to a stage you define in a different application, you use the following syntax:
FOREIGN-APPLICATION-NAME: FOREIGN-STAGE-ID
Where FOREIGN-APPLICATION-NANME is the name of the application in which you

defined the foreign stage and FOREIGN-STAGE-IDis the id attribute of the foreign
stage.

Example 1-3 shows how the reference in applicationl to the foreign stage
HelloWorldBeanSource that you define in application application?2.

Example 1-3 Application 1 Referencing Foreign Stage in Application 2

<wlevs:stream id="helloworldInstream" >
<wlevs:listener ref="helloworldProcessor"/>
<wlevs:source ref="application2:HelloWorldBeanSource"/>
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</wlevs:stream>

Example 1-4 Foreign Stage in Application 2

<wlevs:event-bean id="HelloWorldBeanSource"
class="com.bea.wlevs.example.helloworld.HelloWorldBeanSource"
advertise="true"/>

The following stages cannot be foregin stages:
s Cache

When creating Oracle CEP applications with foreign stages, you must consider foreign
stage dependencies when assembling, deploying, and redeploying your application.
For more information, see Section 24.2.3, "Assembling Applications With Foreign
Stages".

1.1.2 Oracle CEP Event Types

Event types define the properties of the events that are handled by Oracle CEP
applications. Adapters receive incoming events from different event sources, such as
the Java Messaging System (JMS), or financial market data feeds. You must define an
Oracle CEP event type for these events before a processor is able to handle them. You
then use these event types in adapter and POJO Java code, and in the Oracle CQL and
EPL rules you associate with the processors.

Events are JavaBean or Java class instances in which each property represents a data
item from the event source. Oracle CEP supports a variety of event type
implementations.

For more information, see Chapter 2, "Overview of Oracle CEP Events".

1.1.3 Transmitting Events in the EPN: Stream and Relation Sources and Sinks

All components in an EPN either produce events or consume events. Some
components can do both, such as an event bean in the middle of an EPN that receives
events from an upstream component, such as an adapter, and then sends events to a
downstream component, such as a processor.

Components can act on the events they receive from an upstream component, pass
events on to a downstream component, and create new events and insert them into an
upstream or downstream channel.

In general, predefined components (such as JMS and HTTP publish-subscribe
adapters, channels, and processors) all implement the required interfaces to operate as
stream and relation sources and sinks. You can use them as is or configure their
behavior using the EPN assembly file.

For custom adapters, event beans, and Spring beans, you must implement the
appropriate interfaces to use these components as stream and relation sources and
sinks.

This section describes:

s Section 1.1.3.1, "Streams and Relations"

s Section 1.1.3.2, "Stream and Relation Sources"
s Section 1.1.3.3, "Stream and Relation Sinks"

= Section 1.1.3.4, "Transmitting Events in the EPN: Examples"
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For more information, see Section 1.1.9.6, "User Action: Calling Methods of Stream and
Relation Sources and Sinks".

1.1.3.1 Streams and Relations
Oracle CEP models event flow as either streams or relations:

= A stream S is a bag multi-set of elements (s, T) where s is in the schema of S and
T is in the time domain. Stream elements are tuple-timestamp pairs, which can be
represented as a sequence of timestamped tuple insertions. In other words, a
stream is a sequence of timestamped tuples. There could be more than one tuple
with the same timestamp. The tuples of an input stream are required to arrive at
the system in the order of increasing timestamps.

You specify a channel as a stream by setting EPN assembly element wlevs:
attribute is-relation to false (the default).

= Arelation is an unordered, time-varying bag of tuples: in other words, an
instantaneous relation. At every instant of time, a relation is a bounded set. It can
also be represented as a sequence of timestamped tuples that includes insertions,
deletions, and updates to capture the changing state of the relation.

You specify a channel as a relation by setting EPN assembly element
wlevs:channel attribute is-relation to true.

For more information, see:
= Section 9.1.2, "Channels Representing Streams and Relations"

= "Streams and Relations" in the Oracle Complex Event Processing CQL Language
Reference

1.1.3.2 Stream and Relation Sources
All components that produce events must implement one of the following interfaces:

m com.bea.wlevs.ede.api.StreamSource

m com.bea.wlevs.ede.api.RelationSource

com.bea.wlevs.ede.api.StreamSource

The StreamSource interface has one method, setEventSender; at runtime the
event source component is injected with a
com.bea.wlevs.ede.api.StreamSender instance.

The StreamSender instance, in turn, has a sendInsertEvent method that the
component invokes to actually send events to the next component in the EPN.

The StreamSender instance also provides a sendHeartbeat method. The
sendHeartBeat method applies only to application-timestamped channels.

If you enable batching on a channel, then components that send events to that channel
must implement the com.bea.wlevs.ede.api.BatchStreamSender interface.
The BatchStreamSender interface has a sendInsertEvents method that the
component invokes to send a batch of events of type insert downstream to a
BatchStreamSink. For more information, see Section 9.1.6, "Batch Processing
Channels".
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com.bea.wlevs.ede.api.RelationSource

The RelationSource interface has one method, setEventSender; at runtime the
event source component is injected with a
com.bea.wlevs.ede.api.RelationSender instance.

The RelationSender instance, in turn, has sendUpdateEvent and
sendDeleteEvent methods that the component invokes to actually send events to
the next component in the EPN.

When you configure a channel as a relation, the channel attribute primary-key
determines event identity. For more information, see Section 9.1.2.2, "Channels as
Relations".

For sendDeleteEvent, you must send an instance of the same event type as that
configured for the channel.

For sendInsertEvent, a unique constraint violation exception will be raised and the
input event discarded if an event with the same primary key is already in the relation.

For sendUpdateEvent, an invalid update tuple exception will be raised and the
input event discarded if an event with the given primary key is not in the relation.

If you enable batching on a channel you configure as a relation, then components that
send events to that channel must implement the
com.bea.wlevs.ede.api.BatchRelationSender interface. The
BatchRelationSender interface has a sendEvents method that the component
invokes to send a batch of events of type insert, update, and delete downstream
to a BatchRelationSink. For more information, see Section 9.1.6, "Batch Processing
Channels".

1.1.3.3 Stream and Relation Sinks

All components that consume events must implement one of the following interfaces:
m com.bea.wlevs.ede.api.StreamSink

m com.bea.wlevs.ede.api.RelationSink

com.bea.wlevs.ede.api.StreamSink

The StreamSink interface has a single callback method, onInsertEvent, that
components implement to receive a list of events from the previous component in the
EPN.

If you enable batching on a channel, then components that receive events from that
channel must implement the com.bea.wlevs.ede.api.BatchStreamSink
interface. The BatchStreamSink interface has an onInsertEvents call-back
method for receiving a batch of events of type insert. Events of type insert are
used to model streams, as streams are append-only. In the case of single event,
call-back method of StreamSink will be invoked. For more information, see
Section 9.1.6, "Batch Processing Channels".

com.bea.wlevs.ede.api.RelationSink

The RelationSink interface extends StreamSink to model an Oracle CQL relation
sink. The RelationSink interface also provides an onDeleteEvent and
onUpdateEvent methods.

If you enable batching on a channel you configure as a relation, then components that
receive events from that channel must implement the
com.bea.wlevs.ede.api.BatchRelationSink interface. The
BatchRelationSink interface has an onEvents call-back method for receiving a
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batch of events for each event type of insert, update, and delete. If there is no
event of a particular kind, then the corresponding Collection will be an empty
Collection. For more information, see Section 9.1.6, "Batch Processing Channels".

1.1.3.4 Transmitting Events in the EPN: Examples

The following example is based on the HelloWorld example that Figure 1-1 shows. It
is modified here to illustrate:

s Creating the HelloWorldEvent as a Tuple Event
= Sending Events from the HelloWorld Adapter as a StreamSource
= Receiving Events in the HelloWorldBean as a StreamSink

= Sending Events from the HelloWorldBean as a StreamSource

Figure 1-1 The HelloWorld Example Event Processing Network
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For more information, see:

s Chapter 14, "Configuring Custom Adapters"

s Chapter 15, "Configuring Custom Event Beans"

s Chapter 16, "Configuring Custom Spring Beans"

= "HelloWorld Example" in the Oracle Complex Event Processing Getting Started

Creating the HelloWorldEvent as a Tuple Event
First, create the tuple event in the EPN assembly file:

<wlevs:event-type-repository>
<wlevs:event-type type-name="HelloWorldEvent">
<wlevs:properties>
<wlevs:property name="message" type="char" length="1000"/>
</wlevs:properties>
</wlevs:event-type>
</wlevs:event-type-repository>

Sending Events from the HelloWorldAdapter as a StreamSource

Modify the HelloWorldAdapter to inject an EventTypeRepository instance at
runtime by adding a setEventTypeRepository method using the @Service
annotation:

@Service
public void setEventTypeRepository (EventTypeRepository etr) {
etr_ = etr;

}
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Modify the HelloWorldAdapter’s generateHelloMessage method to use the
EventTypeRepository instance to instantiate a HelloWorldEvent, then configure
the event’s properties, and send the event to the helloWorldInputChannel using
the StreamSender instance that Oracle CEP server injected at runtime:

private void generateHelloMessage() {
String message = this.message + dateFormat.format (new Date());

EventType type = etr_.getEventType ("HelloWorldEvent");
EventProperty messageProp = type.getProperty("message");
Object event = type.createEvent();

messageProp.setValue (event, message);

eventSender.sendInsertEvent (event) ;

Receiving Events in the HelloWorldBean as a StreamSink

Modify the HelloWorldBean to inject an EventTypeRepository instance at
runtime using the @Service annotation:

@Service
public void setEventTypeRepository (EventTypeRepository etr) {
etr_ = etr;

Modify the HelloWorldBean’s onInsertEvent method use the
EventTypeRepository instance to get the type of the received insert event and get
the event’s property.

public void onInsertEvent (Object event) {
EventType eventType = etr_.getEventType (event) ;
String prop = (String)eventType.getPropertyValue (event, "message");

System.out.println("Tuple Message: " + prop);

Sending Events from the HelloWorldBean as a StreamSource

Imagine that the HelloWorldBean is connected to another component and you want
to send events from the HelloWorldBean to this downstream component.

First, modify the HelloWorldBean class to implement the StreamSource interface
and add the required setEventSender method:

public class HelloWorldBean implements StreamSource, StreamSink {
private StreamSender streamSender_;

public void setEventSender (StreamSender sender) {
streamSender_ = sender;

Modify the HelloWorldBean to inject an EventTypeRepository instance at
runtime by adding a setEventTypeRepository method using the @Service
annotation:

@Service
public void setEventTypeRepository (EventTypeRepository etr) {
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etr_ = etr;

Modify the HelloWorldBean to use the EventTypeRepository instance to
instantiate a HelloWorldEvent, then configure the event’s properties, and send the
event to the downstream component using the StreamSender instance that Oracle
CEP server injected at runtime:

private void generateHelloMessage() {
String message = this.message + dateFormat.format (new Date());

EventType type = etr_.getEventType("HelloWorldEvent");
EventProperty messageProp = type.getProperty("message");
Object event = type.createEvent();

messageProp.setValue (event, message);

eventSender.sendInsertEvent (event) ;

1.1.4 EPN Assembly File

You assemble an Oracle CEP application and an Event Processing Network (EPN)
assembly file before deploying it to the server; this EPN assembly file is an extension
of the Spring framework XML configuration file.

The spring-wlevs-v11_1_1_3.xsd schema file describes the structure of EPN
assembly files.

The structure of EPN assembly files is as follows. There is a top-level root element
named beans that contains a sequence of sub-elements. Each individual sub-element
contains the configuration data for an Oracle CEP component. For example:

<?xml version="1.0" encoding="UTF-8"?>
<beans xmlns="http://www.springframework.org/schema/beans"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmlns:osgi="http://www.springframework.org/schema/osgi"
xmlns:wlevs="http://www.bea.com/ns/wlevs/spring"
xsi:schemalocation="
http://www.springframework.org/schema/beans
http://www.springframework.org/schema/beans/spring-beans.xsd
http://www.springframework.org/schema/osgi
http://www.springframework.org/schema/osgi/spring-osgi.xsd
http://www.bea.com/ns/wlevs/spring
http://www.bea.com/ns/wlevs/spring/spring-wlevs-v11_1_1_3.xsd">

<wlevs:event-type-repository>
<wlevs:event-type type-name="HelloWorldEvent">
<wlevs:class>com.bea.wlevs.event.example.helloworld.HelloWorldEvent</wlevs:class>
</wlevs:event-type>
</wlevs:event-type-repository>

<wlevs:adapter id="helloworldAdapter"
class="com.bea.wlevs.adapter.example.helloworld.HelloWorldAdapter" >
<wlevs:instance-property name="message" value="HelloWorld - the current time is:"/>
</wlevs:adapter>

<wlevs:channel id="helloworldInputChannel" event-type="HelloWorldEvent" >
<wlevs:listener ref="helloworldProcessor"/>
<wlevs:source ref="helloworldAdapter"/>

</wlevs:channel>

<wlevs:processor id="helloworldProcessor" />

Overview of Creating Oracle CEP Applications 1-11



Overview of the Oracle CEP Programming Model

<wlevs:channel id="helloworldOutputChannel"
event-type="HelloWorldEvent" advertise="true">
<wlevs:listener>
<bean class="com.bea.wlevs.example.helloworld.HelloWorldBean"/>
</wlevs:listener>
<wlevs:source ref="helloworldProcessor"/>
</wlevs:channel>

</beans>

For some Oracle CEP features, you specify some configuration in the EPN assembly
file and some in the component configuration file.

For more information, see:

= Section 4.3, "Creating EPN Assembly Files"

= Section 1.1.5, "Component Configuration Files"

s Section 1.1.6, "How Components Fit Together"

= Appendix B.1, "EPN Assembly Schema spring-wlevs-v11_1_1_3.xsd"

1.1.5 Component Configuration Files

Each component in your event processing network (adapter, processor, channel, or
event bean) can have an associated configuration file, although only processors are
required to have a configuration file. The caching system also uses a configuration file,
regardless of whether it is a stage in the event processing network. Component
configuration files in Oracle CEP are XML documents whose structure is defined using
standard XML Schema. You create a single file that contains configuration for all
components in your application, or you can create separate files for each component;
the choice depends on which is easier for you to manage.

The wlevs_application_config.xsd schema file describes the structure of
component configuration files. This XSD schema imports the following schemas:

s wlevs_base_config.xsd: Defines common elements that are shared between
application configuration files and the server configuration file

s wlevs_eventstore_config.xsd: Defines event store-specific elements.
» wlevs_diagnostic_config.xsd: Defines diagnostic elements.

The structure of application configuration files is as follows. There is a top-level root
element named config that contains a sequence of sub-elements. Each individual
sub-element contains the configuration data for an Oracle CEP component (processor,
channel, or adapter). For example:

<?xml version="1.0" encoding="UTF-8"?>
<nl:config xmlns:nl="http://www.bea.com/ns/wlevs/config/application"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<processor>
<name>helloworldProcessor</name>
<rules>
<query id="helloworldRule">
<! [CDATA[ select * from helloworldInputChannel [Now] ]]>
</query>
</rules>
</processor>
<channel>
<name>helloworldInputChannel</name>
<max-size>10000</max-size>
<max-threads>2</max-threads>
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</channel>
<channel>
<name>helloworldOutputChannel</name>
<max-size>10000</max-size>
<max-threads>2</max-threads>
</channel>
</nl:config>

For more information, see:

= Section 1.1.5.1, "Accessing Component and Server Configuration Using the
ConfigurationPropertyPlaceholderConfigurer Class"

»s  Section 1.1.6, "How Components Fit Together"
= Section 4.4, "Creating Component Configuration Files"

= Appendix B.2, "Component Configuration Schema wlevs_application_config.xsd"

1.1.5.1 Accessing Component and Server Configuration Using the
ConfigurationPropertyPlaceholderConfigurer Class

Using the ConfigurationPropertyPlaceholderConfigurer class, you can
reference existing configuration file properties, in both component configuration and
server configuration files, using a symbolic placeholder. This allows you to define a
value in one place and refer to that one definition rather than hard-coding the same
value in many places.

For example, given the element that Example 1-5 shows, you can refer to the netio
element port value as Example 1-6 shows.

Example 1-5 netio Element

<netio>
<name>MyNetIO</name>
<port>9003</port>
</netio>

Example 1-6 Accessing the netio Element port Value

<property name="myprop" value="${MyNetIO.port}"/>

To use this feature, insert a ConfigurationPropertyPlaceholderConfigurer
bean in the application context configuration file of your application bundle as
Example 1-7 shows.

Example 1-7 Adding a ConfigurationPropertyPlaceholderConfigurer

<bean class="com.bea.wlevs.spring.support.ConfigurationPropertyPlaceholderConfigurer"/>

For complete details, see the
com.bea.wlevs.spring.support.ConfigurationPropertyPlaceholderCon
figurer class in the Oracle Fusion Middleware Java API Reference for Oracle Complex
Event Processing.

For more information on accessing property files, see Section 4.7.3, "How to Add a
Property File to an Oracle CEP Project".
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1.1.6 How Components Fit Together

Oracle CEP applications are made of services that are assembled together to form an
Event Processing Network (EPN).

The server uses the Spring framework as its assembly mechanism due to Spring's
popularity and simplicity. Oracle CEP has extended the Spring framework to further
simplify the process of assembling applications. This approach allows Oracle CEP
applications to be easily integrated with existing Spring-beans, and other light-weight
programming frameworks that are based upon a dependency injection mechanism.

A common approach for dependency injection is the usage of XML configuration files
to declaratively specify the dependencies and assembly of an application. You
assemble an Oracle CEP application an EPN assembly file before deploying it to the
server; this EPN assembly file is an extension of the Spring framework XML
configuration file.

After an application is assembled, it must be package so that it can be deployed into
Oracle CEP. This is a simple process. The deployment unit of an application is a plain
JAR file, which must contain, at a minimum, the following artifacts:

s The compiled application Java code of the business logic POJO.

s Component configuration files. Each processor is required to have a configuration
file, although adapters and streams do not need to have a configuration file if the
default configuration is adequate and you do not plan to monitor these
components.

= The EPN assembly file.
s A MANIFEST.MF file with some additional OSGi entries.

After you assemble the artifacts into a JAR file, you deploy this bundle to Oracle CEP
so it can immediately start receiving incoming data.

For more information, see Chapter 24, "Assembling and Deploying Oracle CEP
Applications".

1.1.7 Extending the EPN

In addition to the components that Oracle CEP provides, you can extend the EPN by
creating custom adapters, event beans, and Spring beans.

You can also extend the EPN using the Oracle Java data cartridge and Oracle Spatial to
incorporate Java and Oracle Spatial operations in your Oracle CQL queries.

You can also expose Oracle CEP applications as Web services and consume Web
services in your Oracle CEP application.

For more information, see Part IV, "Extending the Oracle CEP Event Processing
Network"

1.1.8 High Availability and Scalability

When designing an Oracle CEP application, it is a best practice to consider high
availability and scalability early in the design process.

Oracle CEP provides a range of high availability options that allow you to
declaratively configure the quality of service your application requires for recovering
from server failures.

Oracle CEP also provides a variety of features that allow you to scale your application
to accommodate increasing event rates.
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For more information, see:
s PartV, "Developing Applications for High Availability"
s Part VI, "Developing Applications for Scalability"

1.1.9 Oracle CEP Application Lifecycle

Figure 1-2 shows a state diagram for the Oracle CEP application lifecycle. In this
diagram, the state names (STARTING, INITIALIZING, RUNNING, SUSPENDING,
SUSPENDED, and FAILED) correspond to the ApplicationRuntimeMBean method
getState return values. These states are specific to Oracle CEP; they are not OSGi
bundle states.

Figure 1-2 Oracle CEP Application Lifecycle State Diagram
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Note: For information on Oracle CEP server lifecycle, see "Oracle
CEP Server Lifecycle" in the Oracle Complex Event Processing
Administrator’s Guide.

This section describes the lifecycle of an application deployed to the Oracle CEP server
and the sequence of com.bea.wlevs.ede.api API callbacks. The lifecycle
description is broken down into actions that a user performs, including:

»  Section 1.1.9.1, "User Action: Installing an Application or Start the Server With
Application Already Deployed"

= Section 1.1.9.2, "User Action: Suspend Application"
= Section 1.1.9.3, "User Action: Resume Application”
= Section 1.1.9.4, "User Action: Uninstall Application"
= Section 1.1.9.5, "User Action: Update Application"

= Section 1.1.9.6, "User Action: Calling Methods of Stream and Relation Sources and
Sinks"

Overview of Creating Oracle CEP Applications 1-15



Overview of the Oracle CEP Programming Model

This information explains how Oracle CEP manages an application's lifecycle so that
you can better use the lifecycle APIs in your application.

For a description of these lifecycle APIs (such as RunnableBean and
SuspendableBean), see:

s Section 1.1.10, "Oracle CEP APIs"
s Appendix I, "Oracle CEP Metadata Annotation Reference"

»  Oracle Fusion Middleware Java API Reference for Oracle Complex Event Processing

1.1.9.1 User Action: Installing an Application or Start the Server With Application
Already Deployed

Oracle CEP performs the following actions:

1. Oracle CEP installs the application as an OSGI bundle. OSGI resolves the imports
and exports, and publishes the service.

2. Oracle CEP creates beans (for both standard Spring beans and those that
correspond to the Oracle CEP tags in the EPN assembly file). For each bean, Oracle
CEP:

»  Sets the properties on the Spring beans. The <wlevs: instance-property>
values are set on adapters and event-beans.

= Injects appropriate dependencies into services specified by @Service or
@ServiceReference annotations.

= Injects appropriate dependencies into static configuration properties.
s Callsthe InitializingBean.afterPropertiesSet method.

=  Calls configuration callbacks (ePrepare,@Activate) on Spring beans as well
as factory-created stages.

For more information, see Section 1.4, "Configuring Oracle CEP Resource
Access".

3. Application state is now INITIALIZING.
4. Oracle CEP registers the MBeans.

5. Oracle CEP calls the ActivatableBean.afterConfigurationActive
method on all ActivatableBeans.

6. Oracle CEP calls the ResumableBean .beforeResume method on all
ResumableBeans.

7. For each bean that implements RunnableBean, Oracle CEP starts it running in a
thread.

8. Application state is now RUNNING.

1.1.9.2 User Action: Suspend Application

Oracle CEP performs the following actions:

1. Oracle CEP calls the SuspendableBean . suspend method on all
SuspendableBeans.

2. Application state is now SUSPENDED.
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1.1.9.3 User Action: Resume Application
Oracle CEP performs the following actions:

1. Oracle CEP calls the ResumableBean .beforeResume method on all
ResumableBeans

2. For each bean that implements RunnableBean, Oracle CEP starts it running in a
thread.

3. Application state is now RUNNING.

1.1.9.4 User Action: Uninstall Application

Oracle CEP performs the following actions:

1. Oracle CEP calls the SuspendableBean. suspend method on all
SuspendableBeans.

2. Oracle CEP unregisters MBeans.

3. Oracle CEP calls the DisposableBean.dispose method on all
DisposableBeans.

4. Oracle CEP uninstalls application bundle from OSGI.

1.1.9.5 User Action: Update Application

This is equivalent to first unistalling an application and then installing it again.
See:
= Section 1.1.9.4, "User Action: Uninstall Application"

= Section 1.1.9.1, "User Action: Installing an Application or Start the Server With
Application Already Deployed"

1.1.9.6 User Action: Calling Methods of Stream and Relation Sources and Sinks

You may not call a method on a stream or relation source or sink from a lifecycle
callback because components may not be ready to receive events until after these
phases of the application lifecycle complete.

For example, you may not call StreamSender method sendInsertEvent from a
lifecycle callback such as such as afterConfigurationActive or beforeResume.

You can call a method on a stream or relation source or sink from the run method of
beans that implement RunnableBean.

For more information, see:

»  Section 1.1.9.1, "User Action: Installing an Application or Start the Server With
Application Already Deployed"

= Section 1.1.3, "Transmitting Events in the EPN: Stream and Relation Sources and
Sinks"

1.1.10 Oracle CEP APIs

Oracle CEP provides a variety of Java APIs that you use in your adapter or event bean
implementation.

This section describes the APIs in the com.bea.wlevs.ede.api package that you
will most typically use in your adapters and event beans.

» Adapter—Adapters must implement this interface.
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» AdapterFactory—Adapter factories must implement this interface.

= Component life cycle interfaces—If you want some control over the life cycle of
the component you are programming, then your component should implement
one or more of the following interfaces:

- ActivatableBean—Use if you want to run some code after all dynamic
configuration has been set and the event processing network has been
activated. Implement the afterConfigurationActive method.

- DisposableBean—Use if you want to release resources when the application
is undeployed. Implement the destroy method in your component code.

- InitializingBean—Use if you require custom initialization after Oracle
CEP has set all the properties of the component. Implement the
afterPropertiesSet method.

- ResumableBean—Use if you want to perform some task, such as acquire or
configure resources, before the component resumes work.

- RunnableBean—Use if you want the component to be run in a thread.

The Spring framework implements similar bean life cycle interfaces; however,
the equivalent Spring interfaces do not allow you to manipulate beans that
were created by factories, while the Oracle CEP interfaces do.

- SuspendableBean—Use if you want to suspend resources or stop processing
events when the event processing network is suspended. Implement the
suspend method.

See also Appendix I, "Oracle CEP Metadata Annotation Reference" for additional
lifecycle annotations.

s EventBuilder—Use to create events whose Java representation does not expose
the necessary setter and getter methods for its properties. If your event type is
represented with a JavaBean with all required getter and setter methods, then you
do not need to create an EventBuilder.

s EventBuilder.Factory—Factory for creating EventBuilders.

s StreamSink—Components that want to receive events as an Oracle CEP stream
must implement this interface. An Oracle CEP stream has the following
characteristics:

= Append-only, that is, events are always appended to the end of the stream.

= Unbounded and generally need a window to be defined before it can be
processed.

= Events have non-decreasing time-stamps.

The interface has a callback method, onInsertEvent, in which programmers put
the code that handles the received events.

s StreamSource—Components that send events modeling an Oracle CEP stream,
such as adapters, must implement this interface. The interface has a
setEventSender method for setting the StreamSender, which actually sends
the event to the next component in the network.

s RelationSink—Components that want to receive events modeling an Oracle
CEP relation must implement this interface. An Oracle CEP relation has the
following characteristics:

= Supports events that insert, delete, and update its content.
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For

= Isalways known at an instant time.
= Events have non-decreasing time-stamps.

The interface has callback methods onDeleteEvent and onInsertEvent in
which programmers put the code that handles event deletion and event insertion.

RelationSource—Components that send events modeling an Oracle CEP
relation, such as adapters, must implement this interface. The interface has a
setEventSender method for setting the RelationSender, which actually
sends the event to the next component in the network.

more information, see:

For the full reference documentation for all classes and interfaces, see Oracle Fusion
Middleware Java API Reference for Oracle Complex Event Processing.

For sample Java code that uses these APISs, see:

— Chapter 14, "Configuring Custom Adapters"

— Chapter 15, "Configuring Custom Event Beans"

— Chapter 16, "Configuring Custom Spring Beans"

- "Oracle CEP Samples" in the Oracle Complex Event Processing Getting Started.

Section 1.4, "Configuring Oracle CEP Resource Access" for information on using
Oracle CEP annotations and deployment XML to configure resource injection.

1.2 Oracle CEP IDE for Eclipse

Oracle provides an IDE targeted specifically to programmers that want to develop
Oracle CEP applications. Oracle CEP IDE for Eclipse is a set of plugins for the Eclipse
IDE designed to help develop, deploy, and debug applications for Oracle CEP.

The key features of the Oracle CEP IDE for Eclipse are as follows:

Project creation wizards and templates to quickly get started building event driven
applications.

Advanced editors for source files including Java and XML files common to Oracle
CEP applications.

Integrated server management to seamlessly start, stop, and deploy to Oracle CEP
server instances all from within the IDE.

Integrated debugging.

Event Processing Network (EPN) visual design views for orienting and navigating
in event processing applications.

Integrated support for the Oracle CEP Visualizer so you can use the Oracle CEP
Visualizer from within the IDE.

Although it is not required or assumed that you are using the Oracle CEP IDE, Oracle
recommends that you give it a try.

For

detailed instructions on installing and using the IDE, see Chapter 3, "Overview of

the Oracle CEP IDE for Eclipse".

1.3 Creating an Oracle CEP Application

The following procedure shows the suggested start-to-finish steps to create an Oracle
CEP application. Although it is not required to program and configure the various
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components in the order shown, the procedure shows a typical and logical flow
recommended by Oracle.

It is assumed in the procedure that you are using an IDE, although it is not required
and the one you use is your choice. For one targeted to Oracle CEP developers, see
Section 1.2, "Oracle CEP IDE for Eclipse."

To create an Oracle CEP application:

1. Set up your environment as described in "Setting Your Development
Environment" in the Oracle Complex Event Processing Getting Started.

2. Create an Oracle CEP project using the Oracle CEP IDE for Eclipse.
For more information, see Chapter 4, "Oracle CEP IDE for Eclipse Projects".
3. Design your event processing network (EPN).

Using the Oracle CEP IDE for Eclipse and the EPN editor, add the full list of
components that make up the application and how they are connected to each
other, as well as registering the event types used in your application.

This step combines both designing of your application, in particular determining
the components that you need to configure and code, as well as creating the actual
XML file that specifies all the components (the EPN assembly file) and the XML
file that specifies component configuration (the component configuration file). You
will likely be constantly updating these XML files as you implement your
application, but Oracle recommends you start with this step so you have a
high-level view of your application.

For more information, see:

»  Chapter 6, "Oracle CEP IDE for Eclipse and the Event Processing Network"
= Section 4.3, "Creating EPN Assembly Files."

= Section 4.4, "Creating Component Configuration Files."

4. Determine the event types that your application is going to use, and, if creating
your own JavaBean, program the Java file.

See Chapter 2.1.4, "Creating Oracle CEP Event Types"

5. Program, and optionally configure, the adapters or event beans that act as
inbound, intermediate, or outbound components of your event processing
network. You can create your own adapters or event beans, or use the adapters
provided by Oracle CEP. For details, see:

s Section 1.1.10, "Oracle CEP APIs"

= Section 1.4, "Configuring Oracle CEP Resource Access"

»  Chapter 7, "Configuring J]MS Adapters"

»  Chapter 8, "Configuring HTTP Publish-Subscribe Server Adapters"
»  Chapter 14, "Configuring Custom Adapters"

»  Chapter 15, "Configuring Custom Event Beans"

6. Configure the processors by creating their component configuration XML files; the
most important part of this step is designing and declaring the initial rules that are
associated with each processor.

See:

»  Chapter 10, "Configuring Oracle CQL Processors"
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s Chapter 11, "Configuring EPL Processors"

7. Design the rules that the processors are going to use to select events from their
upstream channels and output events to their downstream channels.

See:
»  Oracle Complex Event Processing CQL Language Reference
»  Oracle Complex Event Processing EPL Language Reference

Note: Oracle CQL replaces Event Processing Language (EPL) in
Oracle CEP 11g Release 1 (11.1.1). Oracle CEP supports EPL for
backwards compatibility.

8. Optionally configure the channels that stream data between adapters, processors,
and the business logic POJO by creating their configuration XML files.

See Chapter 9, "Configuring Channels."

9. Optionally configure the caching system to publish or consume events to and from
a cache to increase the availability of the events and increase the performance of
your applications.

See Chapter 12, "Configuring Caching."

10. Optionally, use the Oracle CEP server log subsystem to write log messages from
your application to the Oracle CEP server log:

import org.apache.commons.logging.Log;
import org.apache.commons.logging.LogFactory;

Log LOG=LogFactory.getLog ("LogName") ;

LOG.debug ("Some debug information");

Using the Oracle CEP Visualizer, you can deploy your application, configure the
log level for your application, and view the Oracle CEP server console.

For more information, see:

= "Configuring Logging and Debugging for Oracle CEP" in the Oracle Complex
Event Processing Administrator’s Guide

= Section 24.4, "Managing Log Message Catalogs"

= "How to Configure Component Logging" in the Oracle Complex Event
Processing Visualizer User’s Guide

= "How to View Console Output" in the Oracle Complex Event Processing
Visualizer User’s Guide

See Section 1.5, "Next Steps" for the list of steps you should follow after you have
completed programming your application, such as packaging and deploying.

1.4 Configuring Oracle CEP Resource Access

By using Oracle CEP and standard Java annotations and deployment XML, you can
configure the Oracle CEP Spring container to inject resources (such as data sources or
persistence managers, and so on) into your Oracle CEP application components.
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The Spring container typically injects resources during component initialization.
However, it can also inject and re-inject resources at runtime and supports the use of
JNDI lookups at runtime.

Oracle CEP supports the following types of resource access:
m  Section 1.4.1, "Static Resource Injection”

= Section 1.4.2, "Dynamic Resource Injection”

= Section 1.4.3, "Dynamic Resource Lookup Using JNDI"

See Section 1.4.4, "Understanding Resource Name Resolution" for information on
resource name resolution.

See Appendix I, "Oracle CEP Metadata Annotation Reference" for complete details of
all Oracle CEP annotations.

In the following sections, consider the example resource that Example 1-8 shows. This
is a data source resource named StockDS that you specifiy in the Oracle CEP server
config.xml file.

Example 1-8 Sample Resource: Data Source StockDS

<config ...>
<data-source>
<name>StockDs</name>

<driver-params>
<url>jdbc:derby:</url>

<driver-params>
</data-source>

</config>

1.4.1 Static Resource Injection

Static resource injection refers to the injection of resources during the initialization
phase of the component lifecycle. Once injected, resources are fixed, or static, while the
component is active or running.

You can configure static resource injection using;:
s Section 1.4.1.1, "Static Resource Names"

s Section 1.4.1.2, "Dynamic Resource Names"

1.4.1.1 Static Resource Names

When you configure static resource injection using static resource names, the resource
name you use in the @Resource annotation or Oracle CEP assembly XML file must
exactly match the name of the resource as you defined it. The resource name is static in
the sense that you cannot change it without recompiling.

To configure static resource injection using static resource names at design time, you
use the standard javax.annotation.Resource annotation as Example 1-9 shows.

To override design time configuration at deploy time, you use Oracle CEP assembly
file XML as Example 1-10 shows.

In Example 1-9 and Example 1-10, the resource name StockDs exactly matches the
name of the data source in the Oracle CEP server config.xml file as Example 1-8
shows.
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Example 1-9 Static Resource Injection Using Static Resource Names: Annotations

import javax.annotation.Resource;
public class SimpleBean implements EventBean {

@Resource (name="StockDs")
public void setDataSource (DataSource dataSource) {
this.dataSource = dataSource;

Example 1-10 Static Resource Injection Using Static Resource Names: XML

< wlevs:event-bean id="simpleBean" class="...SimpleBean"/>
<wlevs:resource property="dataSource" name="StockDs"/>
</wlevs:event-bean>

If the name of the EventBean set method matches the name of the resource, then the
@Resource annotation name attribute is not needed as Example 1-11 shows.
Similarly, in this case, the wlevs: resource element name attribute is not needed as
Example 1-12.

Example 1-11 Static Resource Injection Using Static Resource Names: Annotations

import javax.annotation.Resource;
public class SimpleBean implements EventBean {

@Resource ()
public void setStockDs (DataSource dataSource) {
this.dataSource = dataSource;

Example 1-12 Static Resource Injection Using Static Resource Names: XML

< wlevs:event-bean id="simpleBean" class="...SimpleBean"/>
<wlevs:resource property="dataSource"/>
</wlevs:event-bean>

1.4.1.2 Dynamic Resource Names

A dynamic resource name is one that is specified as part of the dynamic or external
configuration of an application. Using a dynamic resource name, the deployer or
administrator can change the resource name without requiring that the application
developer modify the application code or the Spring application context.

To add a dynamic resource name to a component, such as an adapter or POJO, you
must first specify custom configuration for your component that contains the resource
name as Example 1-13 shows.

Example 1-13 Custom Component Configuration

<simple-bean>
<name>SimpleBean</name>
<trade-datasource>StockDs</trade-datasource>
</simple-bean>

To configure static resource injection using dynamic resource names at design time,
you use the standard javax.annotation.Resource annotation as Example 1-14
shows.
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To override design time configuration at deploy time, you use Oracle CEP assembly
file XML as Example 1-15 shows.

Example 1-14 Static Resource Injection Using Dynamic Resource Names: Annotations

import javax.annotation.Resource;
public class SimpleBean implements EventBean {

@Resource (name="trade-datasource")
public void setDataSource (DataSource dataSource) {
this.dataSource = dataSource;

}

Example 1-15 Static Resource Injection Using Dynamic Resource Names: XML

< wlevs:event-bean id="simpleBean" class="...SimpleBean"/>
<wlevs:resource property="dataSource" name="trade-datasource"/>
</wlevs:event-bean>

1.4.2 Dynamic Resource Injection

Dynamic resource injection refers to the injection of resources dynamically while the
component is active in response to a dynamic configuration change using Spring
container method injection.

To configure dynamic resource injection at design time, you use the standard
javax.annotation.Resource annotation as Example 1-16 shows.

Example 1-16 Dynamic Resource Injection: Annotations

import javax.annotations.Resource;
public class SimpleBean implements EventBean {

@Resource ("trade-datasource")
public abstract DataSource getDataSource ();

}

The component calls the getDataSource method at run time whenever it needs to
retrieve a new instance of the resource that the resource name trade-datasource
refers to.

Typically, the component calls the getDataSource method during the @Prepare or
@Activate methods when dynamic configuration changes are handled. For more
information see:

= Section 1.2, "com.bea.wlevs.configuration.Activate"
»  Section 1.3, "com.bea.wlevs.configuration.Prepare"

Another strategy is to always call the getDataSource prior to using the data source.
That is, the application code does not store a reference to the data source as a field in
the component.

1.4.3 Dynamic Resource Lookup Using JNDI

Oracle CEP supports the use of JNDI to look up resources dynamically as
Example 1-17.
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Example 1-17 Dynamic Resource Lookup Using JNDI

import javax.naming.InitialContext;
public class SimpleBean implements EventBean {

public abstract void getDataSource () throws Exception {
InitialContext initialContext= new InitialContext ();
return initialContext.lookup ("StockDs”);
}
}
In Example 1-17, the JNDI name StockDs must exactly match the name of the data

source in the Oracle CEP server config.xml file as Example 1-8 shows.

Note: You must disable security when starting the Oracle CEP server
in order to use JNDI. Oracle does not recommend the use of JNDI for
this reason.

For more information, see "Configuring Security for Oracle CEP" in
the Oracle Complex Event Processing Administrator’s Guide.

1.4.4 Understanding Resource Name Resolution

Oracle CEP server resolves resource names by examining the naming scopes that
Table 1-1 lists.

Table 1-1 Resource Name Resolution

Naming Scope | Contents Resolution Behavior
Component The property names of the component’s custom configuration | Mapping
Application The names of the configuration elements in the application Matching

configuration files

Server The names of the configuration elements in the server Matching
configuration file

JNDI The names registered in the server's JNDI registry Matching

Each naming scope contains a set of unique names. The name resolution behavior is
specific to a naming scope. Some naming scopes resolve names by simple matching.
Other scopes resolve names by mapping the name used to do the lookup into a new
name. Once a name is mapped, lookup proceeds recursively beginning with the
current scope.

1.5 Next Steps

After you have programmed all components of your application and created their
configuration XML files:

= Assemble all the components into a deployable OSGi bundle. This step also
includes creating the MANIFEST . MF file that describes the bundle.

See Section 24.2, "Assembling an Oracle CEP Application."
= Start Oracle CEP.

See:

- Section 5.3.1, "How to Start a Local Oracle CEP Server"

- Section 5.3.2, "How to Stop a Local Oracle CEP Server"
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= Optionally configure the server in your domain to enable logging, debugging, and
other services.

See:

- Section 5.2, "Creating Oracle CEP Servers"

- Section 5.3, "Managing Oracle CEP Servers"

—  Section 24.4, "Managing Log Message Catalogs"

— "Understanding Oracle CEP Configuration" in the Oracle Complex Event
Processing Administrator’s Guide

= Deploy the application to Oracle CEP.
See Section 24.5, "Deploying Oracle CEP Applications."

= Optionally, use the Oracle CEP load generator and Oracle CEP Visualizer to test
and tune your Oracle CEP application.

The Oracle CEP load generator is a testing tool that you can use to test your
application, in particular its rules. This testing tool can temporarily replace the
adapter component in your application, for testing purposes. For details, see
Chapter 25, "Testing Applications With the Load Generator and csvgen Adapter."

The Oracle CEP Visualizer is a runtime administration console with advanced
diagnostic and maintenance features that you can use to manage and tune your
Oracle CEP application. For details, see Oracle Complex Event Processing Visualizer
User’s Guide.d

See also Section 5.4, "Debugging an Oracle CEP Application Running on an Oracle
CEP Server".
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Overview of Oracle CEP Events

This section describes Oracle CEP events, including:

Section 2.1, "Oracle CEP Event Types"

Section 2.2, "Creating an Oracle CEP Event Type as a JavaBean"
Section 2.3, "Creating an Oracle CEP Event Type as a Tuple"
Section 2.4, "Creating an Oracle CEP Event Type as a Java Class"
Section 2.5, "Creating an Oracle CEP Event Type as a java.util. Map"
Section 2.6, "Using an Event Type Builder Factory"

Section 2.7, "Accessing the Event Type Repository"

Section 2.8, "Sharing Event Types Between Application Bundles"

2.1 Oracle CEP Event Types

Event types define the properties of the events that are handled by Oracle CEP
applications. Adapters receive incoming events from different event sources, such as
the Java Messaging System (JMS), or financial market data feeds. You must define an
Oracle CEP event type for these events before a processor is able to handle them. You
then use these event types in adapter and POJO Java code, and in the Oracle CQL and
EPL rules you associate with the processors.

Events are JavaBean or Java class instances in which each property represents a data
item from the event source. Oracle CEP supports the following event type
implementations:

JavaBean: an event type based on a Java Bean class.

For more information, see Section 2.2, "Creating an Oracle CEP Event Type as a
JavaBean".

Tuple: an event type you create and register declaratively in the EPN assembly
file.

For more information, see Section 2.3, "Creating an Oracle CEP Event Type as a
Tuple".

Java Class: an event type based on a Java class.

For more information, see:

= Section 2.4, "Creating an Oracle CEP Event Type as a Java Class"
= Section 2.6, "Using an Event Type Builder Factory"
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= Jjava.util.Map: an event type based on an instance of java.util.Map.

For more information, see see Section 2.5, "Creating an Oracle CEP Event Type as a
java.util. Map".

Oracle recommends that you define your events using the JavaBean (or Java class and
factory) approach. Doing so allows you greater flexibility to deal with event types as
part of your application logic and can simplify integration with existing systems.

Alternatively, you can specify the properties of the event type declaratively in the EPN
assembly file using wlevs : property tags, in which case Oracle CEP will use a
java.util.Map or tuple. Tuple is the default and is similar to the Oracle CQL tuple.
It essentially provides the user with an optimized implementation, however, the user
must always set and get its value using the EventTypeRepository APIs. This
approach is best used for quick prototyping or when the application developer does
not need to deal with JavaBean events as part of the application logic or due to
integration to some legacy system.

For more information, see:

= Section 2.1.1, "Event Type Instantiation and Immutability"
= Section 2.1.2, "Event Type and Serialization"

= Section 2.1.3, "Event Type Data Types"

= Section 2.1.4, "Creating Oracle CEP Event Types"

= Section 2.7, "Accessing the Event Type Repository"

2.1.1 Event Type Instantiation and Immutability

In Oracle CEP, events are conceptually immutable. Once an event is instantiated
(created and initialized), the Oracle CEP server will not change it and application
developers should not change it, either.

In Oracle CEP, an event can be instantiated either by the application developer or by
the Oracle CEP server. For example:

= An application developer can instantiate an event in an inbound Spring-bean,
event-bean, or adapter.

= Oracle CEP server can instantiate an event when a CQL processor outputs an
event to a downstream component.

The Oracle CEP server uses the following procedure to instantiate an event for a
JavaBean event type:

= Itinvokes an empty-argument public constructor for the Java class.

= Itinvokes a public setter method following JavaBean conventions for each event
property.
Note that even though the event is conceptually immutable, setter methods must be

available in this case. The Oracle CEP server will invoke these setter methods only
once during event initialization.

If a JavaBean event is only being created by the application developer, then making the
Java class immutable can help improve performance. A truly immutable bean is read
only (provides only getters) and has public constructors with arguments that satisfy
immutability. Note that immutability is not possible if the event is being output from a
CQL processor, but it is possible if the event is used only as input.
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The Oracle CEP server uses the following procedure to instantiate an event for a Java
class event type:

s It acquires an instance of the
com.bea.wlevs.ede.api.EventBuilder.Factory you associate with the
event type by calling the factory's createBuilder method.

= Itinstantiates an event by calling the createEvent method.

Note that again, even though the event is conceptually immutable, setter methods
must be available in this case. And, again, the Oracle CEP server will invoke these
setter methods only once, indirectly, when the factory initializes the event.

2.1.2 Event Type and Serialization

In general, Oracle CEP events need not be serializable.

However, if you are caching events in Oracle Coherence, then events must be
serializable.

2.1.3 Event Type Data Types
When creating event types, observe the following data type restrictions:
= Section 2.1.3.1, "Event Types Specified as JavaBean or Java Class"
= Section 2.1.3.2, "Event Types Specified as java.util. Map"
= Section 2.1.3.3, "Event Types Specified as a Tuple"
= Section 2.1.3.4, "Event Types for use With a Database Table Source"
= Section 2.1.3.5, "Event Types for use With the csvgen Adapter"
For more information, see:
= "Datatypes" in the Oracle Complex Event Processing CQL Language Reference

= "Overview of the EPL Language" in the Oracle Complex Event Processing EPL
Language Reference

2.1.3.1 Event Types Specified as JavaBean or Java Class

When you define an event type as a JavaBean or Java class, you may use any Java type
for its properties.

Using the Oracle Java data cartridge, you may also combine JavaBean or Java class
event types with other events types. Example 2-1 shows a tuple event type Student
that defines its address property as Java class event type Address.

Example 2-1 Event Type Repository

<event-type-repository>
<event-type name="Student">
<property name="name" type="char"/>
<property name="address" type="Address"/>
</event-type>

<event-type name="Address">
<class-name>test.Address</class-name>
</event-type>

<event-type-repository>

For more information, see
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= Section 2.2, "Creating an Oracle CEP Event Type as a JavaBean"
»  Section 2.4.1, "How to Create an Oracle CEP Event Type as a Java Class Manually"
= Section 2.8, "Sharing Event Types Between Application Bundles"

= "Oracle Java Data Cartridge" in the Oracle Complex Event Processing CQL Language
Reference

2.1.3.2 Event Types Specified as java.util.Map

When you specify the properties of the event type declaratively in the EPN assembly
file asa java.util.Map, you may use any Java type for its properties. However, you
specify the event type as either:

s The fully qualified name of a Java class that must conform to the same rules as
Class.forName () and must be available in the application's class-loader.

= AJava primitive (for example, int or float).
You may specify an array by appending the characters [] to the event type name.

Example 2-2 shows how to use these types:

Example 2-2 Specifying Java Data Types for java.util. Map Event Type Properties

<wlevs:event-type-repository>
<wlevs:event-type type-name="AnotherEvent">
<wlevs:property>
<entry key="name" value="java.lang.String"/>
<entry key="employeeId" value="java.lang.Integer[]"/>
<entry key="salary" value="float"/>
<entry key="projectIds" value="short[]"/>
</wlevs:property>
</wlevs:event-type>
</wlevs:event-type-repository>

For more information, see Section 2.5.1, "How to Create an Oracle CEP Event Type as a
java.util.Map".

2.1.3.3 Event Types Specified as a Tuple

When you specify the properties of the event type declaratively in the EPN assembly
file as a tuple, you may use any CQL primitive types or Java types.

Example 2-3 shows the use of different types:

Example 2-3 Specifying com.bea.welvs.ede.api.Type Data Types for Tuple Event Type
Properties

<wlevs:event-type-repository>
<wlevs:event-type type-name="SimpleEvent">
<wlevs:properties>
<wlevs:property name="id" type="char" length="1000" />
<wlevs:property name="msg" type="char" />
<wlevs:property name="count" type="double" />
<wlevs:property name="time_stamp" type="timestamp" />
</wlevs:properties>
</wlevs:event-type>

</wlevs:event-type-repository>

For more information, see Section 2.3, "Creating an Oracle CEP Event Type as a Tuple".
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2.1.3.4 Event Types for use With a Database Table Source

When you specify the properties of an event type (as any of a JavaBean, Java class,
java.util.Map, or tuple) for use with a relational database table, you must observe
the following additional JDBC type restrictions:

»  Table 10-2, " EPN Assembly File event-type Element Property Attributes"
s Table 10-3, " SQL Column Types and Oracle CEP Type Equivalents"

For more information, see:

= Section 10.3, "Configuring an Oracle CQL Processor Table Source"

= Section 2.1.3, "Event Type Data Types"

2.1.3.5 Event Types for use With the csvgen Adapter

When you specify the properties of an event type (as any of a JavaBean, Java class,
java.util.Map, or tuple) for use with the csvgen adapter, you may only use the
data types that Table 2-1 describes.

Table 2-1 csvgen Adapter Types

Type Usage

char Single or multiple character values. Use for both char and java.lang.String
values.

Optionally, you may used the 1ength attribute to specify the maximum length of
the char value as Example 2-3 shows for the property with name id. The default
length is 256 characters. If you need more than 256 characters you should specify an

adequate length.
int Numeric values in the range that java.lang. Integer specifies.
long Numeric values in the range that java. lang.Long specifies.

double Numeric values in the range that java.lang.Double specifies.

For more information, see:
= Section 25.4, "Creating a Data Feed File"
= Section 2.1.3.1, "Event Types Specified as JavaBean or Java Class"

»  Section 2.1.3.3, "Event Types Specified as a Tuple"

2.1.4 Creating Oracle CEP Event Types

Event types define the properties of the events that are handled by Oracle CEP
applications. Adapters receive incoming events from different event sources, such as
JMS, or financial market data feeds. You must define these events by an event type
before a processor is able to handle them. You then use these event types in the
adapter and POJO Java code, as well as in the Oracle CQL and EPL rules you associate
with the processors.

This section describes:

= Section 2.2, "Creating an Oracle CEP Event Type as a JavaBean"

= Section 2.3, "Creating an Oracle CEP Event Type as a Tuple"

= Section 2.4, "Creating an Oracle CEP Event Type as a Java Class"

»  Section 2.5, "Creating an Oracle CEP Event Type as a java.util. Map"
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= Section 2.6, "Using an Event Type Builder Factory"
»  Section 2.7, "Accessing the Event Type Repository"
= Section 2.8, "Sharing Event Types Between Application Bundles"

For more information, see Section 2.1, "Oracle CEP Event Types".

2.2 Creating an Oracle CEP Event Type as a JavaBean

You can create and register an Oracle CEP event type as a JavaBean. This is the
preferred approach.

Follow standard JavaBeans programming guidelines. See the JavaBeans Tutorial at
http://java.sun.com/docs/books/tutorial/javabeans/ for additional
details.

Oracle recommends that, if possible, you make your event type JavaBeans immutable
to improve performance. For more information, see Section 2.1.1, "Event Type
Instantiation and Immutability".

When you design your event, you must restrict your design to the even data types that
Section 2.1.3.1, "Event Types Specified as JavaBean or Java Class" describes.

This topic describes:

»  Section 2.2.1, "How to Create an Oracle CEP Event Type as a JavaBean Using the
Event Type Repository Editor"

= Section 2.2.2, "How to Create an Oracle CEP Event Type as a JavaBean Manually"

2.2.1 How to Create an Oracle CEP Event Type as a JavaBean Using the Event Type
Repository Editor

This procedure describes how to create and register an Oracle CEP event type as a
JavaBean using the Oracle CEP IDE for Eclipse event type repository editor. For more
information about the Oracle CEP IDE for Eclipse, see Example 3, "Overview of the
Oracle CEP IDE for Eclipse".

Alternatively, you can create and register your event type as a JavaBean manually (see
Section 2.2.2, "How to Create an Oracle CEP Event Type as a JavaBean Manually").

To create an Oracle CEP event type as a Java bean using the event type
repository editor:

1. Create a JavaBean class to represent your event type.
Follow standard JavaBeans programming guidelines. See the JavaBeans Tutorial at

http://java.sun.com/docs/books/tutorial/javabeans/ for additional
details.

Oracle recommends that, if possible, you make your event type JavaBeans
immutable to improve performance. For more information, see Section 2.1.1,
"Event Type Instantiation and Immutability".

When you design your event, you must restrict your design to the even data types
that Section 2.1.3.1, "Event Types Specified as JavaBean or Java Class" describes.

Example 2-5 shows the MarketEvent which is implemented by the
com.bea.wlevs.example.algotrading.event.MarketEvent class.
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Example 2-4 MarketEvent Class

package com.bea.wlevs.example.algotrading.event;
import java.util.Date;

public final class MarketEvent {
private final Long timestamp;

private final String symbol;
private final Double price;
private final Long volume;
private final Long latencyTimestamp;
public MarketEvent (final Long timestamp, final String symbol,
final Double price, final Long volume, final Long latencyTimestamp) {
this.timestamp = timestamp;
this.symbol = symbol;
this.price = price;

this.volume = volume;
this.latencyTimestamp = latencyTimestamp;

public Double getPrice() {
return price;

public String getSymbol() {
return symbol;

public Long getTimestamp() {
return timestamp;

public Long getLatencyTimestamp () {
return latencyTimestamp;

public Long getVolume() {

return volume;

2. Compile the JavaBean that represents your event type.
3. Open the EPN in the Oracle CEP IDE for Eclipse.
The EPN editor opens as Figure 2-1 shows.
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Figure 2-1 EPN Editor
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For more information, see Section 6.1, "Opening the EPN Editor".
4. Click the Event Types tab.
The Event Type tab appears as Figure 2-2 shows.

Figure 2-2 Event Type Repository Editor

E HEPN: CEPFx 3 || spreader, xml || *com.oracle.cep.sample.fx.context. xml D MarketEvent, java e

Event Type Definitions &= % Event Type Details

Type name: | StockTick |
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(%) Properties defined declarativek
() Properties defined in Java bean

Mame Type ‘char' Length
lastPrice double
syrbal char

Crverview | Event Types

5. Click Add Event Type (green plus sign).

A new event is added to the Event Type Definitions list with default name
newEvent as Figure 2-3 shows.
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Figure 2-3 Event Type Repository Editor - JavaBean Event
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6. In the Event Type Definitions list, select newEvent.

The properties of this event appear in the Event Type Details area as Figure 2-3
shows.

7. Enter a name for this event in the Type name field.
8. Click Properties defined in Java bean.
9. Enter the fully qualified class name of your JavaBean class in the Class field.
For example com.bea.wlevs.example.algotrading.event.MarketEvent.
10. Click the Save button in the Eclipse tool bar (or type CTRL-S).
The event is now in the event type repository.
You can use the event type repository editor:

a. To view the corresponding event type definition in the EPN assembly file,
double-click the event type in the Event Type Definitions area.

b. To delete this event, select the event type in the Event Type Definitions area
and click Delete Event Type (red x).

11. Use the event type:

= Reference the event types as standard JavaBeans in the Java code of the
adapters and business logic POJO in your application.

public void onEvent (List newEvents)
throws RejectEventException {
for (Object event : newEvents) {
MarketEvent marketEvent = (MarketEvent) event;
System.out.println("Price: " + marketEvent.getPrice());

}

m  Access the event types from Oracle CQL and EPL rules:

The following Oracle CQL rule shows how you can reference the
MarketEvent in a SELECT statement:
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<query id="helloworldRule">
<! [CDATA[ select MarketEvent.price from marketEventChannel [Now] ]]>
</query>

2.2.2 How to Create an Oracle CEP Event Type as a JavaBean Manually

This procedure describes how to create and register an Oracle CEP event type as a
JavaBean manually.

Alternatively, you can create and register your event type as a JavaBean using the
Oracle CEP IDE for Eclipse event type repository editor (see Section 2.2.1, "How to
Create an Oracle CEP Event Type as a JavaBean Using the Event Type Repository
Editor").

To create an Oracle CEP event type as a Java bean manually:
1. Create a JavaBean class to represent your event type.
Follow standard JavaBeans programming guidelines. See the JavaBeans Tutorial at

http://java.sun.com/docs/books/tutorial/javabeans/ for additional
details.

Oracle recommends that, if possible, you make your event type JavaBeans
immutable to improve performance. For more information, see Section 2.1.1,
"Event Type Instantiation and Immutability".

When you design your event, you must restrict your design to the even data types
that Section 2.1.3.1, "Event Types Specified as JavaBean or Java Class" describes.

Example 2-5 shows the MarketEvent which is implemented by the
com.bea.wlevs.example.algotrading.event.MarketEvent class.

Example 2-5 MarketEvent Class

package com.bea.wlevs.example.algotrading.event;
import java.util.Date;

public final class MarketEvent {
private final Long timestamp;

private final String symbol;

private final Double price;

private final Long volume;

private final Long latencyTimestamp;

public MarketEvent (final Long timestamp, final String symbol,
final Double price, final Long volume, final Long latencyTimestamp) {
this.timestamp = timestamp;
this.symbol = symbol;
this.price = price;
this.volume = volume;
this.latencyTimestamp = latencyTimestamp;

}
public Double getPrice() {
return price;

}

public String getSymbol () {
return symbol;
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}

public Long getTimestamp() {
return timestamp;

}

public Long getLatencyTimestamp () {
return latencyTimestamp;

}

public Long getVolume () {
return volume;

}

2. Compile the JavaBean that represents your event type.
3. Register your JavaBean event type in the Oracle CEP event type repository:

a. To register declaratively, edit the EPN assembly file using the
wlevs:event-type-repository element wlevs:event-type child
element as Example 2-6 shows.

Example 2-6 EPN Assembly File event-type-repository

<wlevs:event-type-repository>
<wlevs:event-type type-name="MarketEvent">
<wlevs:class>
com.bea.wlevs.example.algotrading.event.MarketEvent
</wlevs:class>
</wlevs:event-type>
</wlevs:event-type-repository>

b. To register programatically, use the EventTypeRepository class as
Example 2-7 shows.

Example 2-7 Programmatically Registering an Event

EventTypeRepository rep = getEventTypeRepository();
rep.registerEventType (

"MarketEvent",

com.bea.wlevs.example.algotrading.event .MarketEvent.getClass ()

For more information, see Section 2.7, "Accessing the Event Type Repository".
4. Use the event type:

= Reference the event types as standard JavaBeans in the Java code of the
adapters and business logic POJO in your application.

public void onEvent (List newEvents)
throws RejectEventException {
for (Object event : newEvents) {
MarketEvent marketEvent = (MarketEvent) event;
System.out.println("Price: " + marketEvent.getPrice());

= Access the event types from Oracle CQL and EPL rules:

The following Oracle CQL rule shows how you can reference the
MarketEvent in a SELECT statement:

Overview of Oracle CEP Events 2-11



Creating an Oracle CEP Event Type as a Tuple

<query id="helloworldRule">
<! [CDATA[ select MarketEvent.price from marketEventChannel [Now] ]]>
</query>

2.3 Creating an Oracle CEP Event Type as a Tuple
You can create and register an Oracle CEP event type as a tuple.

When you design your event, you must restrict your design to the even data types that
Section 2.1.3.3, "Event Types Specified as a Tuple" describes.

This topic describes:

= Section 2.3.1, "How to Create an Oracle CEP Event Type as a Tuple Using the
Event Type Repository Editor"

= Section 2.3.2, "How to Create an Oracle CEP Event Type as a Tuple Manually"

2.3.1 How to Create an Oracle CEP Event Type as a Tuple Using the Event Type
Repository Editor

This procedure describes how to create and register an Oracle CEP event type as a
tuple using the Oracle CEP IDE for Eclipse event type repository editor. For more
information about the Oracle CEP IDE for Eclipse, see Example 3, "Overview of the
Oracle CEP IDE for Eclipse".

Alternatively, you can create and register your event type as a tuple manually (see
Section 2.3.2, "How to Create an Oracle CEP Event Type as a Tuple Manually").

To create an Oracle CEP event type as a tuple using the event type repository
editor:

1. Decide on the properties your event type requires.

When you design your event, you must restrict your design to the even data types
that Section 2.1.3.3, "Event Types Specified as a Tuple" describes.

2. Open the EPN in the Oracle CEP IDE for Eclipse.
The EPN editor opens as Figure 2—4 shows.
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Figure 2-4 EPN Editor
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For more information, see Section 6.1, "Opening the EPN Editor".

3. Click the Event Type tab.

The Event Type tab appears as Figure 2-5 shows.

Figure 2-5 Event Type Repository Editor
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4. Click Add Event Type (green plus sign).

A new event is added to the Event Type Definitions list with default name
newEvent as Figure 2-6 shows.
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Figure 2-6 Event Type Repository Editor - Tuple Event
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5. In the Event Type Definitions list, select newEvent.

The properties of this event appear in the Event Type Details area as Figure 2—-6
shows.

6. Enter a name for this event in the Type name field.
7. Click Properties defined declaratively.
8. Add one or more event properties:
»  Click Add Event Property (green plus sign).
A new row is added to the Event Type Details table.
s Click in the Name column of this row and enter a property name.

»  Click in the Type column of this row and select a data type from the pull
down menu.

When you design your event, you must restrict your design to the even data
types that Section 2.1.3.3, "Event Types Specified as a Tuple" describes.

»  For char data type properties only, click in the “char” Length column of this
row and enter a value for the maximum length of this char property.

Optionally, you may used the 1ength attribute to specify the maximum
length of the char value. The default length is 256 characters. The maximum
length is java.lang.Integer .MAX_VALUE. If you need more than 256
characters you should specify an adequate length.

9. Click the Save button in the Eclipse tool bar (or type CTRL-S).
The event is now in the event type repository.
You can use the event type repository editor:

a. To view the corresponding event type definition in the EPN assembly file,
double-click the event type in the Event Type Definitions area.

b. To delete this event, select the event type in the Event Type Definitions area
and click Delete Event Type (red x).

10. Use the event type:
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= Reference the event types using the EventTypeRepository introspection
interface EventType in the Java code of the adapters and business logic POJO
in your application:

@Service
public void setEventTypeRepository (EventTypeRepository etr) {
etr_ = etr;

}

// handle events

public void onInsertEvent (Object event) throws EventRejectedException {
// get the event type for the current event instance
EventType eventType = etr_.getEventType (event) ;

// get the event type name
String eventTypeName = eventType.getTypeName () ;

// get the event property names
String[] propNames = eventType.getPropertyNames () ;

// test if property is present
if (eventType.isProperty ("fromRate")) {
// get property value
Object propValue =
eventType.getProperty ("fromRate") .getValue (event) ;
}

}

For more information, see Section 2.7, "Accessing the Event Type Repository".
m  Access the event types from Oracle CQL and EPL rules:

The following Oracle CQL rule shows how you can reference the
CrossRateEvent in a SELECT statement:

<query id="FindCrossRatesRule"><![CDATA[
select ((a.price * b.price) + 0.05) as internalPrice,
a.fromRate as crossRatel,
b.toRate as crossRate2
from FxQuoteStream [range 1] as a, FxQuoteStream [range 1] as b
where
NOT (a.price IS NULL)
and
NOT (b.price IS NULL)
and
a.toRate = b.fromRate
11></query>

2.3.2 How to Create an Oracle CEP Event Type as a Tuple Manually

This procedure describes how to create and register an Oracle CEP event type
declaratively in the EPN assembly file as a tuple. Oracle recommends that you create
an Oracle CEP event type as a JavaBean (see Section 2.2.2, "How to Create an Oracle
CEP Event Type as a JavaBean Manually").

For more information on valid event type data types, see Section 2.1.3.3, "Event Types
Specified as a Tuple".
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To create an Oracle CEP event type as a tuple:
1. Decide on the properties your event type requires.

When you design your event, you must restrict your design to the even data types
that Section 2.1.3.3, "Event Types Specified as a Tuple" describes.

2. Register your event type declaratively in the Oracle CEP event type repository:

To register declaratively, edit the EPN assembly file using the
wlevs:event-type-repository element wlevs:event-type child element
as Example 2-8 shows.

Example 2-8 EPN Assembly File event-type-repository

<wlevs:event-type-repository>
<wlevs:event-type type-name="CrossRateEvent">
<wlevs:properties>
<wlevs:property name="price" type="double"/>
<wlevs:property name="fromRate" type="char"/>
<wlevs:property name="toRate" type="char"/>
</wlevs:properties>
</wlevs:event-type>
</wlevs:event-type-repository>

At runtime, Oracle CEP generates a bean instance of CrossRateEvent for you.
The CrossRateEvent has three properties: price, fromRate, and toRate.

For more information on the valid values of the type attribute, see Section 2.1.3.3,
"Event Types Specified as a Tuple".

3. Use the event type:

= Reference the event types using the EventTypeRepository introspection
interface EventType in the Java code of the adapters and business logic POJO
in your application:

@Service
public void setEventTypeRepository (EventTypeRepository etr) {
etr_ = etr;

}

// handle events

public void onInsertEvent (Object event) throws EventRejectedException {
// get the event type for the current event instance
EventType eventType = etr_.getEventType (event) ;

// get the event type name
String eventTypeName = eventType.getTypeName () ;

// get the event property names
String[] propNames = eventType.getPropertyNames () ;

// test if property is present
if (eventType.isProperty ("fromRate")) {
// get property value
Object propValue =
eventType.getProperty ("fromRate") .getValue (event) ;
}

For more information, see Section 2.7, "Accessing the Event Type Repository".
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m  Access the event types from Oracle CQL and EPL rules:

The following Oracle CQL rule shows how you can reference the
CrossRateEvent in a SELECT statement:

<query id="FindCrossRatesRule"><![CDATA[
select ((a.price * b.price) + 0.05) as internalPrice,
a.fromRate as crossRatel,
b.toRate as crossRate2
from FxQuoteStream [range 1] as a, FxQuoteStream [range 1] as b
where
NOT (a.price IS NULL)
and
NOT (b.price IS NULL)
and
a.toRate = b.fromRate
11></query>

2.4 Creating an Oracle CEP Event Type as a Java Class
You can create and register an Oracle CEP event type as a Java class.
This topic describes:
= Section 2.4.1, "How to Create an Oracle CEP Event Type as a Java Class Manually"

2.4.1 How to Create an Oracle CEP Event Type as a Java Class Manually

This procedure describes how to create and register an Oracle CEP event type as a Java
class that does not conform to the JavaBeans programming guidelines.

For more information on valid event type data types, see Section 2.1.3.1, "Event Types
Specified as JavaBean or Java Class".

To create an Oracle CEP event type as a Java class manually:
1. Create a Java class to represent your event type.

Oracle recommends that, if possible, you make your event type Java class
immutable to improve performance. For more information, see Section 2.1.1,
"Event Type Instantiation and Immutability".

Example 2-5 shows the ForeignExchangeEvent which is implemented by the
ForeignExchangeEvent inner class of
com.bea.wlevs.example. fx.OutputBean.

Example 2-9 ForeignExchangeEvent Class: Does not Conform to JavaBean Standards

package com.bea.wlevs.example.fx.OutputBean.ForeignExchangeEvent;

static public class ForeignExchangeEvent {
private String symbol;
private Double price;
private String fromRate;
private String toRate;
private Long clientTimestamp;
private Long adapterTimestamp;

public ForeignExchangeEvent () {

}
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public ForeignExchangeEvent (String symbol, Double price, String fromRate, String toRate)

this.symbol = symbol;
this.price = price;
this.fromRate = fromRate;
this.toRate = toRate;

if (clientTimestamp == null)
this.clientTimestamp = new Long(0);

if (adapterTimestamp == null)

this.adapterTimestamp = new Long(0);

public String getSymbol() {
return symbol;

public Double getPrice() {
return price;

public String getFromRate() {
return fromRate;

public String getToRate() {
return toRate;

public Long getClientTimestamp() {
return clientTimestamp;

public Long getAdapterTimestamp() {
return adapterTimestamp;

2. Create a Java class to represent your event type builder as Example 2-10 shows.

Example 2-10 ForeignExchangeBuilderFactory
package com.bea.wlevs.example.fx;

import java.util.HashMap;
import java.util.Map;

import com.bea.wlevs.ede.api.EventBuilder;
import com.bea.wlevs.example.fx.OutputBean.ForeignExchangeEvent;

public class ForeignExchangeBuilderFactory implements EventBuilder.Factory {

public EventBuilder createBuilder() {
return new ForeignExchangeBuilder () ;

static class ForeignExchangeBuilder implements EventBuilder {
private Map<String,Object> values = new HashMap<String,Object>(10);

public Object createEvent() {
return new ForeignExchangeEvent (
(String) values.get("symbol"),
(Double) values.get("price"),
(String) values.get("fromRate"),
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(String) values.get("toRate"));

public void put(String property, Object value) throws IllegalStateException {
values.put (property, value);

Oracle CEP uses the event builder factory to create event instances that do not
follow the JavaBean specification. See Section 2.6, "Using an Event Type Builder
Factory" for additional information about using an event type builder factory.

3. Compile the Java classes that represent your event type and event builder factory.

4. Register your event type and event builder factory in the Oracle CEP event type
repository:

a. To register declaratively, edit the EPN assembly file using the
wlevs:event-type-repository element wlevs:event-type child
element as Example 2-6 shows.

Use the wlevs:class element to point to your JavaBean class, and then use
the <wlevs:property name="builderFactory"> element to specify a
custom event builder factory for the event type.

Example 2-11 EPN Assembly File event-type-repository

<wlevs:event-type-repository>
<wlevs:event-type type-name="ForeignExchangeEvent">
<wlevs:class>
com.bea.wlevs.example. fx.OutputBean.ForeignExchangeEvent
</wlevs:class>
<wlevs:property name="builderFactory">
<bean id="builderFactory"
class="com.bea.wlevs.example. fx.ForeignExchangeBuilderFactory" />
</wlevs:property>
</wlevs:event-type>
</wlevs:event-type-repository>

b. To register programatically, use the EventTypeRepository class as
Example 2-7 shows.

Example 2-12 Programmatically Registering an Event

EventTypeRepository rep = getEventTypeRepository();
ForeignExchangeBuilderFactory factory = new ForeignExchangeBuilderFactory();
rep.registerEventType (

"ForeignExchangeEvent",

com.bea.wlevs.example. fx.OutputBean.ForeignExchangeEvent .getClass (),

factory.createBuilder ()

For more information, see Section 2.7, "Accessing the Event Type Repository".
5. Use the event type:

= Reference the event types as standard JavaBeans in the Java code of the
adapters and business logic POJO in your application.

public void onEvent (List newEvents)
throws RejectEventException {
for (Object event : newEvents) {
ForeignExchangeEvent fxEvent = (ForeignExchangeEvent) event;
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System.out.println("Price: " + fxEvent.getPrice());

}

m  Access the event types from Oracle CQL and EPL rules:

The following Oracle CQL rule shows how you can reference the
MarketEvent in a SELECT statement:

<query id="helloworldRule">

<! [CDATA[ select ForeignExchangeEvent.price from marketEventChannel
[Now] 11>
</query>

2.5 Creating an Oracle CEP Event Type as a java.util.Map
You can create and register an Oracle CEP event type as a java.util.Map.
This topic describes:
= Section 2.5.1, "How to Create an Oracle CEP Event Type as a java.utilL. Map"

2.5.1 How to Create an Oracle CEP Event Type as a java.util.Map

This procedure describes how to create and register an Oracle CEP event type as a
java.util.Map. Oracle recommends that you create an Oracle CEP event type as a
JavaBean (see Section 2.2.2, "How to Create an Oracle CEP Event Type as a JavaBean
Manually").

For more information on valid event type data types, see Section 2.1.3.2, "Event Types
Specified as java.util. Map".

To create an Oracle CEP event type as a java.util.Map:
1. Decide on the properties your event type requires.

2. Register your event type in the Oracle CEP event type repository:

a. To register declaratively, edit the EPN assembly file using the
wlevs:event-type-repository elementwlevs:event-type child
element as Example 2-13 shows.

Example 2-13 EPN Assembly File event-type-repository

<wlevs:event-type-repository>
<wlevs:event-type type-name="AnotherEvent">
<wlevs:properties type="map">
<wlevs:property name="name" value="java.lang.String"/>
<wlevs:property name="age" value="java.lang.Integer"/>
<wlevs:property name="address" value="java.lang.String"/>
</wlevs:properties >
</wlevs:event-type>
</wlevs:event-type-repository>

At runtime, Oracle CEP generates a bean instance of AnotherEvent for you.
The AnotherEvent has three properties: name, age, and address.

b. To register programatically, use the EventTypeRepository class as
Example 2-14 shows.

Example 2-14 Programmatically Registering an Event

EventTypeRepository rep = getEventTypeRepository();
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java.util.Map map = new Map ({name, java.lang.String},
{age, java.lang.Integer}, {address, java.lang.String});
rep.registerEventType ("AnotherEvent", map);

For more information, see Section 2.7, "Accessing the Event Type Repository".
3. Use the event type:

= Reference the event types as standard JavaBeans in the Java code of the
adapters and business logic POJO in your application.

public void onEvent (List newEvents)
throws RejectEventException {
for (Object event : newEvents) {
java.util.Map anEvent = (java.util.Map) event;
System.out.println("Age: " + anEvent.getAge());

}

= Access the event types from Oracle CQL and EPL rules:

The following Oracle CQL rule shows how you can reference the
MarketEvent in a SELECT statement:

<query id="helloworldRule">
<! [CDATA[ select AnotherEvent.age from eventChannel [Now] ]]>
</query>

2.6 Using an Event Type Builder Factory

When you register an event type in the repository using the wlevs:event-type
element, Oracle CEP creates instances of the event using the information in the event
type class.

Sometimes, however, you might want or need to have more control over how the
event type instances are created. This is required if the POJO that represents the event
does not expose the necessary getter and setter methods for the event properties. For
example, assume the event type has a £irstname property, but the EPL rule that
executes on the event type assumes the property is called fname. Further assume that
you cannot change either the event type class (because you are using a shared event
class from another bundle, for example) or the EPL rule to make them compatible with
each other. In this case you can use an event type builder factory to change the way the
event type instance is created so that the property is named fname rather than
firstname.

When you program the event type builder factory, you must implement the
EventBuilder.Factory inner interface of the
com.bea.wlevs.ede.api.EventBuilder interface; see the Oracle Fusion
Middleware Java API Reference for Oracle Complex Event Processing for details about the
methods you must implement, such as createBuilder and createEvent.

The following example of an event type builder factory class is taken from the FX
sample:

package com.bea.wlevs.example.fx;
import java.util.HashMap;
import java.util.Map;
import com.bea.wlevs.ede.api.EventBuilder;
import com.bea.wlevs.example.fx.OutputBean.ForeignExchangeEvent;
public class ForeignExchangeBuilderFactory implements EventBuilder.Factory {
public EventBuilder createBuilder() {
return new ForeignExchangeBuilder () ;
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}
static class ForeignExchangeBuilder implements EventBuilder ({
private Map<String,Object> values = new HashMap<String,Object>(10);
public Object createEvent() {
return new ForeignExchangeEvent (
(String) values.get("symbol"),
(Double) values.get("price"),
(String) values.get("fromRate"),
(String) values.get("toRate"));
}
public void put (String property, Object value) throws IllegalStateException {
values.put (property, value);

}
}

When you register the event type in the EPN assembly file, use the
<wlevs:property name="builderFactory"> child element of the
wlevs:event-type element to specify the name of the factory class. The hard-coded
builderFactory value of the name attribute alerts Oracle CEP that it should use the
specified factory class, rather than its own default factory, when creating instances of
this event. For example, in the FX example, the builder factory is registered as shown
in bold:

<wlevs:event-type-repository>
<wlevs:event-type type-name="ForeignExchangeEvent">
<wlevs:class>com.bea.wlevs.example. fx.OutputBean$SForeignExchangeEvent</wlevs:class>
<wlevs:property name="builderFactory">
<bean id="builderFactory"
class="com.bea.wlevs.example.fx.ForeignExchangeBuilderFactory"/>
</wlevs:property>
</wlevs:event-type>
</wlevs:event-type-repository>

2.7 Accessing the Event Type Repository

The EventTypeRepository is a singleton OSGi service. Because it is a singleton,
you only need to specify its interface name to identify it. You can get a service from
OSGi in any of the following ways:

»  Section 2.7.1, "Using the EPN Assembly File"
= Section 2.7.2, "Using the Spring-DM @ServiceReference Annotation”
= Section 2.7.3, "Using the Oracle CEP @Service Annotation"

For more information, see Oracle Fusion Middleware Java API Reference for Oracle
Complex Event Processing.

2.7.1 Using the EPN Assembly File

You can access the EventTypeRepository by specifying an osgi:referencein
the EPN assembly file as Example 2-15 shows.

Example 2-15 EPN Assembly File With OSGi Reference to EventTypeRepository

<osgi:reference id="etr" interface="com.bea.wlevs.ede.api.EventTypeRepository" />
<bean id="outputBean" class="com.acme.MyBean" >

<property name="eventTypeRepository" ref="etr" />
</bean>
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Then, in the MyBean class, you can access the EventTypeRepository using the
eventTypeRepository property initialized by Spring as Example 2-16 shows.

Example 2-16 Accessing the EventTypeRepository in the MyBean Implementation

package com.acme;

import com.bea.wlevs.ede.api.EventTypeRepository;
import com.bea.wlevs.ede.api.EventType;

public class MyBean {
private EventTypeRepository eventTypeRepository;

public void setEventTypeRepository (EventTypeRepository eventTypeRepository) {
this.eventTypeRepository = eventTypeRepository;
}

public void onInsertEvent (Object event) throws EventRejectedException {
// get the event type for the current event instance
EventType eventType = eventTypeRepository.getEventType (event) ;

2.7.2 Using the Spring-DM @ServiceReference Annotation

You can access the EventTypeRepository by using the Spring-DM
@ServiceReference annotatoin to initialize a property in your Java source as
Example 2-17 shows.

Example 2-17 Java Source File Using the @ServiceReference Annotation

import org.springframework.osgi.extensions.annotation.ServiceReference;
import com.bea.wlevs.ede.api.EventTypeRepository;

@ServiceReference
setEventTypeRepository (EventTypeRepository etr) {

}

2.7.3 Using the Oracle CEP @Service Annotation

You can access the EventTypeRepository by using the Oracle CEP @Service
annotation to initialize a property in your Java source as Example 2-17 shows.

Example 2-18 Java Source File Using the @Service Annotation

import com.bea.wlevs.util.Service;
import com.bea.wlevs.ede.api.EventTypeRepository;

@Service
setEventTypeRepository (EventTypeRepository etr) {

}

For more information, see:Section 1.5, "com.bea.wlevs.util.Service".

2.8 Sharing Event Types Between Application Bundles

Each Oracle CEP application gets its own Java classloader and loads application
classes using that classloader. This means that, by default, one application cannot
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access the classes in another application. However, because the event type repository is
a singleton service, you can configure the repository in one bundle and then explicitly

export the event type classes so that applications in separate bundles (deployed to the

same Oracle CEP server) can use these shared event types.

The event type names in this case are scoped to the entire Oracle CEP server instance.
This means that you will get an exception if you try to create an event type that has the
same name as an event type that has been shared from another bundle, but the event
type classes are different.

To share event type classes, add their package name to the Export-Package header
of the MANIFEST . MF file of the bundle that contains the event type repository you
want to share.

Be sure you deploy the bundle that contains the event type repository before all
bundles that contain applications that use the shared event types, or you will get a
deployment exception.

For more information, see:
»  Section 2.1.3.1, "Event Types Specified as JavaBean or Java Class"
»  Section 24.2.3, "Assembling Applications With Foreign Stages"

= "Oracle Java Data Cartridge" in the Oracle Complex Event Processing CQL Language
Reference
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Part II contains the following chapters:

Chapter 3, "Overview of the Oracle CEP IDE for Eclipse"

Chapter 4, "Oracle CEP IDE for Eclipse Projects"

Chapter 5, "Oracle CEP IDE for Eclipse and Oracle CEP Servers"

Chapter 6, "Oracle CEP IDE for Eclipse and the Event Processing Network"






3

Overview of the Oracle CEP IDE for Eclipse

Oracle CEP IDE for Eclipse is an IDE targeted specifically to programmers that want to
develop Oracle CEP applications.

This chapter describes:
= Section 3.1, "Overview of Oracle CEP IDE for Eclipse"
= Section 3.2, "Installing the Latest Oracle CEP IDE for Eclipse"

= Section 3.3, "Installing the Oracle CEP IDE for Eclipse Distributed With Oracle
CEP"

= Section 3.4, "Configuring Eclipse"

3.1 Overview of Oracle CEP IDE for Eclipse

Oracle CEP IDE for Eclipse is a set of plugins for the Eclipse IDE designed to help
develop, deploy, and debug applications for Oracle CEP.

This section describes:

s Section 3.1.1, "Features"

= Section 3.1.2, "JDK Requirements"

= Section 3.1.3, "Default Oracle CEP Domain ocep_domain and Development"

For more information about Oracle CEP IDE for Eclipse, see
http://www.oracle.com/technology/products/event-driven-architect
ure/cep-ide/11/.

3.1.1 Features
The key features of the Oracle CEP IDE for Eclipse are as follows:

= Project creation wizards and templates to quickly get started building event driven
applications.

= Advanced editors for source files including Java and XML files common to Oracle
CEP applications.

» Integrated server management to seamlessly start, stop, and deploy to Oracle CEP
server instances all from within the IDE.

» Integrated debugging.

= Event Processing Network (EPN) visual design views for orienting and navigating
in event processing applications and visually creating and editing EPN
components.
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s Oracle CEP application source file validation including Oracle Continuous Query
Language (Oracle CQL) syntax highlighting and component configuration and
assembly files.

= Ability to build and export deployable Oracle CEP applications.

s Integrated support for the Oracle CEP Visualizer so you can use the Oracle CEP
Visualizer from within the IDE.

3.1.2 JDK Requirements

In 11g Release 1 (11.1.1), Oracle CEP IDE for Eclipse requires JDK 6.0. For more
information, see:

= "Setting Your Development Environment" in the Oracle Complex Event Processing
Getting Started

= Section 3.4, "Configuring Eclipse"

3.1.3 Default Oracle CEP Domain ocep_domain and Development

When you choose a Typical Oracle CEP server install, the installation does not include
the default ocep_domain domain (with default passwords) and the product samples.

If you want to install the default ocep_domain and samples (recommended), choose
the Custom Oracle CEP server install option.

The Typical install is appropriate for a production environment while the Custom
install is appropriate for a development environment.

Oracle recommends that you install the default ocep_domain and samples for use
with the Oracle CEP IDE for Eclipse during development.

If you choose a Typical Oracle CEP server install, you can use the Configuration
Wizard to create an Oracle CEP server domain.

For more information, see:
» 'Installation Overview" in the Oracle Complex Event Processing Getting Started

s 'Creating an Oracle CEP Standalone-Server Domain" in the Oracle Complex Event
Processing Administrator’s Guide

s "Creating an Oracle CEP Multi-Server Domain Using Oracle CEP Native
Clustering" in the Oracle Complex Event Processing Administrator’s Guide

3.2 Installing the Latest Oracle CEP IDE for Eclipse

New versions of the IDE will be made available via the Oracle Technology Network
Web site. Oracle recommends that you install the IDE from this Eclipse update site.

To install the latest Oracle CEP IDE for Eclipse:

1. Obtain the required versions of Eclipse (3.5.1) and WTP (2.0). We recommend you
take the entire Galileo installation available at the following Web sites:

Windows:
http://www.eclipse.org/downloads/download.php?file=/technolog
y/epp/downloads/release/galileo/SR1/eclipse-jee-galileo-SR1-w
in32.zip

Linux:
http://www.eclipse.org/downloads/download.php?file=/technolog
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v/epp/downloads/release/galileo/SR1/eclipse-jee-galileo-SR1-1
inux-gtk.tar.gz

Note: Check the Oracle CEP Web site
(http://www.oracle.com/technologies/soa/complex-even
t-processing.html) for the latest requirements on the Eclipse
tools.

2. Open your Eclipse IDE and select the menu item Help > Install New Software.
The Install dialog appears as Figure 3—-1 shows.

Figure 3—1 Install Dialog

% Install |Z|®

Available Software
Select a site or enter the location of a site. \) —
ey -
Wark with: | T v| [ Add... ]

Find more software by working with the 'Available Software Sites' preferences.,

Mame ‘ersion
[1@ There is no site selected.

Details
Show only the latest versions of available software [JHide items that are already installed
Group items by category ‘Wwhat is already installed?

[ Contact all update sites during install to find required software

@

3. Click Add.
The Add Site dialog appears as Figure 3-2 shows.

Figure 3-2 Add Site Dialog

£} Add Site 3
Mame: | | [ Local... ]
Location: | http: ! | [ Archive.., ]

@

4. Configure this dialog as Table 3-1 describes.
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Table 3-1 New Update Site Dialog Attributes

Attribute | Description

Name The name for this remote update site. For example: Oracle CEP Tools
Update.
URL The URL to the remote update site. Valid value:

http://download.oracle.com/technology/software/cep-ide/11/

5. Click OK.

6. In the Install dialog, from the Work with pull down menu, select the Oracle CEP
Tools Update site you just created.

It make take a few moments for Eclipse to contact the remote update site. During
this time, the "There is no site selected" entry reads "Pending".

When Eclipse has made contact with the remote update site, the Oracle CEP Tools
entry appears in the list of update sites as Figure 3-3 shows.

7. Check the check box next to the Oracle CEP Tools entry as Figure 3-3 shows.

Figure 3-3 Install Dialog - Site Selected

¥ Install |:|@®
Awvailable Software

Check the items that you wish ta install, \_) —
vy

Work with: | Oracle CEP Tools Update - http://download.oracle. comftechnology/softwarefcep-idef11} w | [ Add... ]

Find more software by working with the 'Available Software Sites' preferences.,

Mame ‘ersion
000 cracle CEP Tools

Details

Show only the latest versions of available software [Hide items that are already installed
Group items by category ‘What is already installed?

[ Contact all update sites during install to find required software

®

8. Click Next.
The Install Details dialog appears as Figure 3—4 shows.
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Figure 3—4 Install Dialog - Install Details

%} Install |Z!@

Install Details
Review the items ta be installed.
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-{p Oracle CEP Tools 11.2.0,20091019-0306  com.bea,wlevs.eclipse.tools, feature. feature, group

Size: Lnknown

Dietails

9. Click Next.
The Review Licenses dialog appears.

10. Click Finish.

11. When prompted restart, Eclipse. If you skip this, unreliable behavior can occur.

12. To confirm the installation, select Help > About Eclipse.

The About Eclipse dialog appears as Figure 3-5 shows.

Figure 3-5 About Eclipse

3 About Eclipse

Eclipse Java EE IDE for Web Developers,
Build id: 20090920-1017

(c) Copyright Eclipse contributors and others 2005, 2009, Al rights reserved.
Wisit BEkpe ) fuaan, eclipse, orgfiwebtools

(O

ZlEs e eE

® Installation Details

13. Click Oracle.
The About Eclipse Features dialog appears as Figure 3-6 shows.
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Figure 3—-6 About Eclipse Features Dialog

- BX

2 About Eclipse Features

about Eclipse Features |

Provider Feature Name Yersion Feature Id
Oracle Oracle CEP Tools Core 11,2,0,20091019-0806  com.bea.wlevs.eclipse.kools.feature

=== Tools for creating, debugging, and deploving Cracle CEP applications.

— Wersion: 11.2.0,20091019-0506
Copyright {c) 2009 Cracle Al rights reserved.

Oracle CEP Documentation
Wisit http:fidownload, oracle, com/docs/cdfE1 2839 _01 finde:x. htm

Based on technology From the Eclipse Project
Wisit hEkpsf fvaw, eclipse, orgfwebtools

Close

[ License ][Elug-in Details][ Colurns. .. ] [

14. Click Plug-In Details.

The Feature Plug-ins dialog appears as Figure 37 shows.

Figure 3-7 Feature Plug-ins Dialog

L Feature Plug-ins

Feature Plug-ins |
Plug-ins contributed by Feature: com.bea.wlevs. eclipse. tools feature
Signed | Provider Plug-in Mame Wersion Plug-in Id
Oratle Oracle CEP Tools Core 11.2.0.20091019-0806  com.bea,wlevs.edipse.tools. core
Oracle Oracle CEP Tools Documentation  11.2.0,20091019-0806  com.bea. wlevs.edipse.tools.doc
Oracle Oracle CEP Tools LI 11,2,0,20091019-0806  com.bea, wievs.eclipse.tools, i
< | @
[ Columns... ] [ Close l

15. Confirm that the plug-ins that Table 3-2 lists are shown.
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Table 3-2 Oracle CEP IDE for Eclipse Plug-Ins

Provider | Plug-in Name Plug-in Id

Oracle Oracle CEP Tools Core com.bea.wlevs.eclipse.tools.core
Oracle Oracle CEP Tools Documentation | com.bea.wlevs.eclipse.tools.doc
Oracle Oracle CEP Tools Ul com.bea.wlevs.eclipse.tools.ui

16. After installing Oracle CEP IDE for Eclipse, consider the following topics:

»  Section 3.1.3, "Default Oracle CEP Domain ocep_domain and Development"
= Section 3.4, "Configuring Eclipse"
s  Appendix J, "Oracle CEP IDE for Eclipse Tutorial"

3.3 Installing the Oracle CEP IDE for Eclipse Distributed With Oracle CEP

A version of the Oracle CEP IDE for Eclipse is shipped with the Oracle CEP product,
although this version might be older than the one on the Oracle Technology Network

site.

To install the Oracle CEP IDE for Eclipse distributed with Oracle CEP:

1.

Obtain the required versions of Eclipse (3.5.1) and WTP (2.0). We recommend you
take the entire Galileo installation available at the following Web sites:

Windows:
http://www.eclipse.org/downloads/download.php?file=/technolog
y/epp/downloads/release/galileo/SR1/eclipse-jee-galileo-SR1-w
in32.zip

Linux:
http://www.eclipse.org/downloads/download.php?file=/technolog
y/epp/downloads/release/galileo/SR1/eclipse-jee-galileo-SR1-1
inux-gtk.tar.gz

Note: Check the Oracle CEP Web site
(http://www.oracle.com/technologies/soa/complex-even
t-processing.html) for the latest requirements on the Eclipse
tools.

Open your Eclipse IDE and select the menu item Help > Install New Software.

The Install dialog appears as Figure 3-1 shows.
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Figure 3-8 Install Dialog

Available Software
Select a site or enter the location of a site. \) —
ey -
Work with:6 v| [ Add... ]

Find more software by working with the 'Available Software Sites' preferences.,

Mame ‘ersion
[1@ There is no site selected.

Details
Show only the latest versions of available software [JHide items that are already installed
Group items by category ‘Wwhat is already installed?

[ Contact all update sites during install to find required software

@

3. Click Add.
The Add Site dialog appears as Figure 3-2 shows.

Figure 3-9 Add Site Dialog

L3 Add Site
Mame: | | [ Local... ]
Location: |http:,l’,l’ | [ Archive.., ]

@

4. Click Archive.
The Select Local Site Archive dialog appears as Figure 3-10 shows.
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Figure 3-10 Select Local Site Archive Dialog

Repository archive

My Recent
Documents

File name: |ceprtacks-11.1.0.20030622-1517 2ip 9 [ geen |

by Metwork. Files of twpe: ?"_iar;".zip v [ Cancel ]

5. Navigate to the ORACLE_CEP_HOME/ocep_11.1/eclipse-update-site
directory and select the cep-tools-11.1.0.DATE-BUILD. zip file.

Where ORACLE_CEP_HOME refers to the main directory into which you installed
Oracle CEP, such as /oracle_cep, and DATE is the build date and BUILDis the
build number.

Click Open.
Complete the Update Manager, selecting to install the Oracle CEP tools.

When prompted restart, Eclipse. If you skip this, unreliable behavior can occur.

© ®» N O

To confirm the installation, select Help > About Eclipse.

The About Eclipse dialog appears as Figure 3-5 shows.

Figure 3—-11 About Eclipse

L} About Eclipse
Eclipse Java EE IDE for Web Developers.

Build id: 20090920-1017

{c) Copyright Eclipse contributors and others 2005, 2009, Al rights reserved.,
Wisit BEkpef frow, eclipse, orgfwebtools

E

FlEe s s eE

® Installation Details

10. Click Oracle.
The About Eclipse Features dialog appears as Figure 3-6 shows.
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Figure 3—12 About Eclipse Features Dialog

2 About Eclipse Features

about Eclipse Features |

- BX

Provider Feature Name
Oracle Oracle CEP Tools Core

Yersion Feature Id

11,2,0,20091019-0806  com.bea.wlevs.eclipse.kools.feature

=57 Tools for creating, debugaing, and deploving Oracle CEP applications.
— Wersion: 11.2.0,20091019-0506
Copyright {c) 2009 Cracle Al rights reserved.

Oracle CEP Documentation
Wisit http:fidownload, oracle, com/docs/cdfE1 2839 _01 finde:x. htm

Based on technology From the Eclipse Project
Wisit hEkpsf fvaw, eclipse, orgfwebtools

[ License ][Elug-in Details][ Colurns. ..

] [ Close

11. Click Plug-In Details.

The Feature Plug-ins dialog appears as Figure 37 shows.

Figure 3—-13 Feature Plug-ins Dialog

L Feature Plug-ins

- B

Feature Plug-ins |
Plug-ins contributed by Feature: com.bea.wlevs. eclipse. tools feature
Signed | Provider Plug-in Mame Wersion Plug-in Id
Oratle Oracle CEP Tools Core 11.2.0.20091019-0806  com.bea,wlevs.edipse.tools. core
Oracle Oracle CEP Tools Documentation  11.2.0,20091019-0806  com.bea. wlevs.edipse.tools.doc
Oracle Oracle CEP Tools LI 11,2,0,20091019-0806  com.bea, wievs.eclipse.tools, i
< | @
[ Columns... ] [ Close l

12. Confirm that the plug-ins that Table 3-2 lists are shown.
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Table 3-3 Oracle CEP IDE for Eclipse Plug-Ins

Provider | Plug-in Name Plug-in Id

Oracle Oracle CEP Tools Core com.bea.wlevs.eclipse.tools.core
Oracle Oracle CEP Tools Documentation | com.bea.wlevs.eclipse.tools.doc
Oracle Oracle CEP Tools Ul com.bea.wlevs.eclipse.tools.ui

13. After installing Oracle CEP IDE for Eclipse, consider the following topics:
»  Section 3.1.3, "Default Oracle CEP Domain ocep_domain and Development"
= Section 3.4, "Configuring Eclipse"
s  Appendix J, "Oracle CEP IDE for Eclipse Tutorial"

3.4 Configuring Eclipse

This section describes how to configure Eclipse to work with the Oracle CEP.

To configure Eclipse:
1. Exit out of Eclipse if it is running.

2. Install a Java 6 JRE on your computer.

By default, the JRockit Java 6.0 JRE is installed with Oracle CEP in your Oracle
CEP home directory. For example:

C:\OracleCEP\jrockit_160_20\jre

3. Using the editor of your choice, open your eclipse. ini file located in your
Eclipse install directory, for example, C:\eclipse\ as Example 3-1 shows.

Example 3—1 Default eclipse.ini File

-showsplash
org.eclipse.platform
--launcher.XXMaxPermSize
256M

Note: When making changes to the eclipse.ini file, add
arguments one argument per line, as
http://wiki.eclipse.org/Eclipse.ini describes.

For more information about configuring Eclipse, see
http://wiki.eclipse.org/FAQ_How_do_I_run_Eclipse.

4. Add the following lines to the eclipse. ini file as Example 3-2 shows.

Example 3-2 Memory Resources

-showsplash
org.eclipse.platform
--launcher.XXMaxPermSize
256M

-vmargs

-Xmx512m
-XX:MaxPermSize=256M
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5. Add the following to the eclipse. ini file as Example 3-3 shows.

Example 3-3 Virtual Machine Path
-vm

PATH-TO-JRE-6.0-JAVAW

Where PATH-TO-JRE-6. 0-JAVAWis the fully qualified path to your Java 6.0 JRE
javaw executable. For example:

-vm
C:\OracleCEP\jrockit_160_20\jre\bin\javaw.exe

Note: Do not put both the -vm and the path on the same line. Each
must be on a separate line as Example 3-3 shows.

Save and close the eclipse.ini file.
Start Eclipse.
Select Help > About Eclipse and click Installation Details.

© ®» N O

Click the Configuration tab.

The Configuration Details tab appears as shown in Figure 3-14.

Figure 3—14 Configuration Details for Java 6

¥ Ec lipse Installation Details

Installed Saftware | Installation History | Features || Plug-i

| Configuration |

Eclipse
| |-—launcher. library
| |[C:veclipse-3.5.0-galileoyplugins/ory.eclipse. equinox. launcher. win3:

| |-startup

| |[C:iveclipse-3.5.0-galileo\plugins/ory.eclipse.equinox. launcher 1.0.:
| |-product

| org.eclipse.epp.package. jee . product

| =

| [C:/3dk/idkl.6.0_153/bin/ . ./ jre/bintelient) jvm.dll

| |lezlipse.home. location=file:/C:/eclipse-3.5.0-galilea/
exlipse. launcher=Cc:yeclipse-3.5.0-galileo\eclipse. exe
| leclipse.pZ.data.area=fconfig. dir/ ../ p2/

| |lezlipse.pZ.profile=epp.package.jee

eclipse. product=org.eclipse.epp. package. jee. product
eclipse. i

5 sclipse.
| |-zmzdom

| |-Zmx512m

| |-XZ:MaxPermSize=25em

| |-Djava.elass.path=C:ieclipse-3.5.0-galileoyplugins/org.eclipse. equ
| |[file.encoding=cpizsz

f file.encoding. pkg=sun.io

| |file.separator="

Java.awt.graphicsenv=sun.avt. Tin3Z2GraphicsEnvironment

| [Java.awt.printerjob=sun.awt.windowvs.WPrinterJdoh

| |Java.class.path=Ciheclipse-3.5.0-galileoh pluyins/org. eclipse. equine
| |dava.class.version=50.0

| |Java. endorsed. dirs=CiY jdk jakl. 6.0_13% jre’ libhendorsed

| java.ext,.dirs=C:\jdk\jdkl.6.0_13\jre\lib\ext,:C:\IJINDOIuJS\Sun\Java\l:v

£ ¥

Wiew Error Log ] [Copy to Clipboard ] [ Close
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10. Confirm that the eclipse.vm property points to the Java 6.0 JRE you configured
in the eclipse. ini file.
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Oracle CEP IDE for Eclipse Projects

An Oracle CEP project is an Eclipse project that brings together all Oracle CEP
artifacts.

This chapter describes:

»  Section 4.1, "Oracle CEP Project Overview"

»  Section 4.2, "Creating Oracle CEP Projects"

»  Section 4.3, "Creating EPN Assembly Files"

= Section 4.4, "Creating Component Configuration Files"
= Section 4.5, "Exporting Oracle CEP Projects"

= Section 4.6, "Upgrading Projects"

»  Section 4.7, "Managing Libraries and Other Non-Class Files in Oracle CEP
Projects"

= Section 4.8, "Configuring Oracle CEP IDE for Eclipse Preferences"

4.1 Oracle CEP Project Overview
An Oracle CEP application includes the following artifacts:
= Java source files
= XML configuration files
= OSGi bundle Manifest file

Figure 4-1 shows the Explorer after creating a project.
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Figure 4-1 Oracle CEP Project Structure

=
==
ER=d Hello
B src

4 com.bea.wlevs.adapter.example.helloworld

4 com.bea.wlevs. example. helloworld
B JRE System Library [jrel.6.0_02]

B, Flug-in Dependencies

(&= build

& META-INF

- spring

|¥] Hello.context. xml ‘_/
B wilevs
1% config.xml

- BB

4 com.bea.wlevs.event.example helloworld 1_- Java Files

__— XML Configuration

— Files

MANIFEST.MF (-
@a build.properties

&1 build il

Bundle Manifest

Table 4-1 summarizes the important files in an Oracle CEP project including their use

and location.

Table 4-1

Oracle CEP Project Artifacts

File Type Location

Description

Java source files Any Java source folder.

Default: src.

Events, adapters, and listeners are implemented in an
Oracle CEP application with Java files. All Java files must
be in a source folder in order to be compiled.

For more information, see Chapter 1, "Overview of
Creating Oracle CEP Applications".

EPN assembly file | META-INF/spring

These are the main files used to wire-up an EPN and to
define event types. This is a Spring context file, and is
where adapters, channels, processors, and listeners are
connected.

For more information, see Chapter 1.1.4, "EPN Assembly
File".

Processor META-INF/wlevs

configuration file

The processor configuration file is where the Complex
Event Processor (CEP) is defined. In this file you'll find
processor rules (defined in the Continuous Query
Language - CQL or the Event Processing Language--EPL)
and other component configuration settings.

For more information, see:

. Chapter 10, "Configuring Oracle CQL Processors"

= Chapter 11, "Configuring EPL Processors"

MANIFEST.MF file | META-INF

The manifest file contains metadata about your application
including its name, version, and dependencies, among
others.

For more information, see Chapter 24, "Assembling and
Deploying Oracle CEP Applications".

4.2 Creating Oracle CEP Projects

Development of an Oracle CEP application begins by creating a project to hold all

source code and related files.
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Projects correspond 1-to-1 with Oracle CEP applications and are the unit of work that
is associated with and deployed to a server instance. In concrete terms, the output of a
built project is a single OSGi bundle (JAR) containing the Oracle CEP application.

4.2.1 How to Create an Oracle CEP Project

By default new projects are set to use Java 6.0. This section describes how to create an
Oracle CEP project using Java 6. For information on configuring an Oracle CEP project
to use Java 6, see Section 3.4, "Configuring Eclipse".

To create an Oracle CEP project:
1. Open the EPN Editor (see Section 6.1, "Opening the EPN Editor")

2. Select File > New Project.
The New Project - Select a Wizard dialog appears as shown in Figure 4-2.

Figure 4-2 New Project - Select a Wizard Dialog

& New Project |Z|@@

Select a wizard

=

Wizards:

|type filker bext

(= General

= s

(= Edlipse Modeling Frarmework
= E®

(= J2EE

= Java

= 1A

= web
(= Examplas

3. Expand Oracle CEP and select Oracle CEP Application Project.
4. Click Next.

The New Oracle CEP Application Project wizard appears as shown in Figure 4-3.
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Figure 4-3 New Oracle CEP Application Project Wizard: Create an Oracle CEP
Application

& New Oracle CEP Application Project EIEIW__Q

Create an Oracle CEP Application.

Create an Oracle CEP Application Project,

Project name: | MyCEPProj|

[#] Use default lacation

Location:

Target Runtime

|oracle cEP v11.L v | [mew... |

@ [ < Back “ Mext > ]

5. Configure the Create an Oracle CEP Application dialog as shown in Table 4-2.

Table 4-2 Create an Oracle CEP Application Dialog

Attribute Description

Project name The name of your Oracle CEP project. This name will be used as
the default name of your application when it is deployed to the
Oracle CEP server.

Location The directory in which your project is stored.

By default your project is located inside the Eclipse workspace
directory.

To keep your workspace and source code control directories
separate, uncheck Use default location and click Browse to
place the project in a directory outside of your workspace.

Target Runtime The Oracle CEP server you will deploy your project to.

6. Click Next.
The Oracle CEP Application Content dialog appears as shown in Figure 4-4.
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Figure 4-4 New Oracle CEP Application Project Wizard: Oracle CEP Application Content

& New Oracle CEP Application Project

Oracle CEP Application Content
Enter the data required to create application. \% |

Bundle Properties
Bundle ID: My CEPProj

Bundle ¥ersion: | 1.0.0
Bundle Mame: My CEPProj

Bundle Provider:

@ [ <Back || Mext |[ Finish H Cancel ]

7. Optionally, configure the Oracle CEP Application Content dialog as shown in
Table 4-3.

Table 4-3 Oracle CEP Application Content Dialog

Attribute Description

Bundle ID The unique ID that distinguishes this application’s OSGi bundle from those
deployed to the target runtime.

Bundle Version  The version of this instance of this OSGi bundle.
Bundle Name The name of this application’s OSGi bundle.
Bundle Provider The name of the provider for this application’s OSGi bundle (optional).

8. Click Next.
The Template dialog appears as shown in Figure 4-5.
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Figure 4-5 New Oracle CEP Application Project Wizard: Template Dialog

& New Oracle CEP Application Project

New Oracle CEP Application Project
Select one of the available ternplates to generate a Fully Functioning Oracle \9 E
CEP Application
Create an Cracle CEP Application using an application template
Termplates:
@Fx . ) A Hello World application For the. Oracle CEP server, A
@Hello warld It includes a simple adapter that repeatadly sends a |
- . | Hello Warld message. The message is printed out ko |
@Slgnal Generation e e o
-
@ [ Finish ] [ Cancel ]
9. Optionally, select an Oracle CEP application template to pre-populate your project

10.

11.

with the content that the template specifies.
Click Finish.
The Oracle CEP IDE for Eclipse creates the Oracle CEP project.

Optionally, create additional EPN assembly files and component configuration
files.

By default, Oracle CEP IDE for Eclipse creates one EPN assembly file and one
component configuration file for your project. Optionally, you may choose to
define and configure Oracle CEP objects in multiple EPN assembly and
component configuration files to improve management, concurrent development,
and re-use.

For more information, see:
= Section 4.3, "Creating EPN Assembly Files"

= Section 4.4, "Creating Component Configuration Files"

4.3 Creating EPN Assembly Files

You use the Event Processing Network (EPN) assembly file to declare the components
that make up your Oracle CEP application and how they are connected to each other.
You also use the file to register event types of your application, as well as the Java
classes that implement the adapter and POJO components of your application.

For

an example of an EPN assembly file, see the "Foreign Exchange (FX) Example" in

the Oracle Complex Event Processing Getting Started. For additional information about
Spring and OSGi, see Appendix A, "Additional Information about Spring and OSGi."

4-6 Oracle Complex Event Processing Developer's Guide



Creating EPN Assembly Files

4.3.1 How to Create a New EPN Assembly File Using Oracle CEP IDE for Eclipse

The most efficient and least error-prone way to create and edit the EPN file is using the
New File Wizard in the Oracle CEP IDE for Eclipse.

For more information, see:
s Section 6.2, "EPN Editor Overview"

= Section 4.7, "Managing Libraries and Other Non-Class Files in Oracle CEP
Projects"

To create a new EPN assembly file using Oracle CEP IDE for Eclipse:
1. Create an Oracle CEP project.

See Section 4.2, "Creating Oracle CEP Projects".

By default, Oracle CEP IDE for Eclipse creates one EPN assembly file for your
project. Optionally, you may choose to define Oracle CEP objects in multiple EPN
assembly files to improve management, concurrent development, and re-use.

2. To optionally create additional EPN assembly files:
a. Select File > New > Other.

The New dialog appears as Figure 4-6 shows.

Figure 4-6 New Dialog

- EX

<>

Select a wizard

Wizards:

[z Java Emitter Templates ~
(= Jawascript
(= 2pa
= [ Oracle CEP
j’ Oracle CEP Application Configuration File
% Oracle CEP Application Project
gj’ Oracle CEP Assembly File
& Oracle CEP Probe Kit
(= Plug-in Development
(= Remote System Explorer
[ Server
(2 5QL Developrient
(= Tasks
[ User Assistance w

b. Expand Oracle CEP and select Oracle CEP Assembly File.
c. Click Next.
The New CEP Assembly File dialog appears as Figure 4-7 shows.
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Figure 4-7 New CEP Assembly File Dialog

L3} New CEP Assembly File

New CEP Assembly File

Create a new CEP assembly file,

| o

Enter or select the parent folder:

JCEPFx/META-INF/spring

= 1= CEPFx
= .settings
+(= build
== META-INF
(= spring
= wlevs
[ sre

File name: | com.oracle.cep,sample.Fx,contesxt2, xmi

@) [ Finish H Cancel ]

d. Configure the New CEP Assembly File dialog as shown in Table 4—4.

Table 4-4 New CEP Assembly File Dialog

Attribute Description

Enter or select the parent Enter the fully qualified path to the folder in which Oracle CEP
folder IDE for Eclipse will create the EPN assembly file or use the file
system navigation controls to select the folder.

File name Enter the name of the new EPN assembly file.

e. C(lick Finish.
3. Open the EPN editor.
See Section 6.1, "Opening the EPN Editor".

4. If you created multiple EPN assembly files, you can select the EPN assembly file
you want to work on using the EPN Editor Filter pull-down menu.

This lets you focus on just the subset of the EPN that the selected EPN assembly
file represents.

To see the union of all components in all EPN assembly files, select Full EPN from
the EPN Editor Filter pull-down menu.

For more information, see Section 6.2.2, "Filtering".
5. Create and connect nodes on the EPN.

See Section 6.4, "Using the EPN Editor".

4.4 Creating Component Configuration Files

You use a component configuration file to configure the components that make up
your Oracle CEP application.
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For an example of a component configuration file, see the "Foreign Exchange (FX)
Example" in the Oracle Complex Event Processing Getting Started.

4.4.1 How to Create a New Component Configuration File Using Oracle CEP IDE for
Eclipse

The most efficient and least error-prone way to create and edit a component
configuration file is using the New File Wizard in the Oracle CEP IDE for Eclipse.

For more information, see:
s Section 6.2, "EPN Editor Overview"

= Section 4.7, "Managing Libraries and Other Non-Class Files in Oracle CEP
Projects"

To create a new component configuration file using Oracle CEP IDE for Eclipse:
1. Create an Oracle CEP project.

See Section 4.2, "Creating Oracle CEP Projects".

By default, Oracle CEP IDE for Eclipse creates one component configuration file
for your project. Optionally, you may choose to configure Oracle CEP objects in
multiple component configuration files to improve management, concurrent
development, and re-use.

2. To optionally create component configuration files:
= Select File > New > Other.
The New dialog appears as Figure 4-8 shows.

Figure 4-8 New Dialog

Select a wizard

| B JavaScript Al
RS
=2 Oracle CEP
| Sl oracl CEP Application Configuration File
ﬂg Oracle CEP Application Project
Ei Oracle CEP Assembly File
¥ Oracle CEP Probe Kit
| B2 Plug-in Development
| B[ Remote System Explarer
| [ Server
| B[ 5L Development

| B> Tasks

([ User Assistance |
| B Web ~|
—

=  Expand Oracle CEP and select Oracle CEP Application Configuration File.
] Click Next.
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The New CEP Application Configuration File dialog appears as Figure 4-9
shows.

Figure 4-9 New CEP Application Configuration File Dialog

L New CEP Application Configuration File

New CEP Application Configuration File

Create a new CEP application configuration File.

Enter or select the parent folder:

JCEPFxMETA-INF fwlevs

= &2 CEPFx
(== .settings
= build

(2= spring

(= wlevs
B src

File name: | compaonent,smi|

lc?jl Nexk = [ Finish l [ Cancel ]

= Configure the New CEP Assembly File dialog as shown in Table 4—4.

Table 4-5 New CEP Configuration File Dialog

Attribute Description
Enter or select the parent Enter the fully qualified path to the folder in which Oracle CEP
folder IDE for Eclipse will create the component configuration file or

use the file system navigation controls to select the folder.

File name Enter the name of the new component configuration file.

»  Click Finish.
3. Open the EPN editor.

See Section 6.1, "Opening the EPN Editor".
4. Create and connect nodes on the EPN.

See Section 6.4, "Using the EPN Editor".

4.5 Exporting Oracle CEP Projects

Exporting an Oracle CEP project builds the project into an OSGi bundle that can be
deployed to a production Oracle CEP server.

4.5.1 How to Export an Oracle CEP Project

This section describes how to export an Oracle CEP project into an OSGi bundle.
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To export an Oracle CEP project:

1. Start the Oracle CEP IDE for Eclipse and open your Oracle CEP project.

2. The Oracle CEP IDE for Eclipse compiles and adds Java resources to the exported
JAR automatically. If your project contains other resources (such as a manifest file
or images), configure your project to export them:

a. Locate the build.properties file in the Project Explorer and double-click

this file to edit it.

The build.properties file opens as shown in Figure 4-10.

Figure 4-10 Oracle CEP Project build.properties File

@ EPM: Hellowvaorld @a *build. properties 3
& Build Configuration
[ custom Build

Runtime Information

Define the libraries, specify the order in which they shauld be built, and list the source Folders that should be compiled into each

selected library.

=

Binary Build
Select the Folders and files to include in the binary build,

+L| (= META-INF

£ [] = buid

] D@a build properties

1) build,xml
bundle . properties

[JE= dist

[=-[H] = images

\ ig‘§xam|:ule-resource.jpg

<

b Extra Classpath Entries

Build | build. properties

Source Build
Select the folders and files to include in the source build,

[7[%] .classpath ~
|:| X| .project
+-[] = settings
+-[] = META-INF
#-[] = buid
F 3} build properties
141 build, sl
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[ dist
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b. In the Binary Build area, check the resources you want exported with your

application.

3. Select File > Export.

The Export dialog appears as shown in Figure 4-11.
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Figure 4-11 Export Dialog
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== Cracle CEP

(= Plug-in Development
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= Web
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@

4. Expand the Oracle CEP option and select Oracle CEP Applications.

5. Click Next.
The Oracle CEP Applications Export: Select Project dialog appears as shown in
Figure 4-12.

Figure 4-12 Oracle CEP Applications Export: Select Project Dialog

& Oracle CEP Applications

Oracle CEP Applications

Select the projects ko export as Oracle CEP applications and the » E|
directory where they will be placed, 1

Available Projects:

Praject Cutput File Select Al
Hellovorld (1.0.0 ocep.example.helowarld_1.0.0jar
O ¢ ) 5 5 - g Deselect Al

Direcktory: | b | [ Erowse. .. ]

[ overwrite existing Files withaut warning

@
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6. Configure the Oracle CEP Applications Export: Select Project dialog as shown in
Table 4-6.

Table 4-6 Oracle CEP Application Content Dialog

Attribute Description

Available Projects The list of Oracle CEP projects available for export.
Check the project or projects you want to export.

Each project will be exported to a JAR file with the name given
in the Output File column. The name of the bundle that will be
exported conforms to the OSGi bundle naming conventions,
using the bundle ID and the bundle version in the JAR name.

Directory The directory in which Oracle CEP project JAR files are
exported.

Click Browse to choose this directory.

Overwrite existing files Check this option to overwrite existing JAR files with the same
without warning name in the selected directory.

7. Click Finish.

Your project, its Java resources, and any binary resources you selected are
exported to the project JAR file.

8. Deploy the JAR file to your Oracle CEP server.

a. If your JARis an application, see Section 5.3.6, "How to Deploy an Application
to an Oracle CEP Server".

b. If your JAR is an application library, see Section 24.1.3, "Application Libraries"
9. Deploy other dependent resources, if any, to your Oracle CEP server.

For example:

s Other OSGi bundles your application depends on.

Deploy these bundles on the Oracle CEP server using the Oracle CEP
Visualizer or command line deployment tools.

= Any entries in config.xml for datasources that are referenced from within
the application.

Add these entries to the target server's config.xml file.

4.6 Upgrading Projects

When upgrading Oracle CEP from one version to another, it may be necessary to make
changes to your existing Oracle CEP projects.

This section describes:
= Section 4.6.1, "How to Upgrade Projects from Oracle CEP 2.1 to 10.3"

= Section 4.6.2, "How to Upgrade Projects from Oracle CEP 10.3 to 11g Release 1
(11.1.1)"

For more information, see:
= Section 3.4, "Configuring Eclipse"
»  Oracle Complex Event Processing Getting Started
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4.6.1 How to Upgrade Projects from Oracle CEP 2.1 to 10.3

While project structure has stayed the same since 2.1, the data stored in Oracle CEP
Projects has changed significantly. It is therefore necessary to take steps to upgrade 2.1
projects manually before continuing their development in 10.3.

The following outlines the steps necessary to upgrade 2.1 projects to 10.3

To upgrade projects from Oracle CEP 2.1 to 10.3:
1. Open your Oracle CEP 2.1 project in Oracle CEP IDE for Eclipse.

2. Select File > Switch Workspace > Other.
The Workspace Launcher dialog appears as shown in Figure 4-13.

Figure 4-13 Workspace Launcher Dialog

& Workspace Launcher [‘S_<|
Select a workspace
Eclipse Platform stores your projects in a folder called a workspace,
Choose a workspace folder to use For this session,
wiorkspace: | Cleclipse-projs v

~ Lo a5
[ workbench Layout
[ warking Sets

.;:i;. (o4 ] [ Cancel

Note: Do not choose to copy settings from the current workspace.

3. Click Browse and select a new workspace directory.
Eclipse exits and restarts using the new workspace.
4. Select File > Import.
The Import Dialog appears as shown in Figure 4-14.
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Figure 4-14 Import Dialog

& Import
Select
N
Create new projects from an archive file or directory, I E - 5 I

Select an import source:
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[ archive File
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[, File System
EL Preferences
= s
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@

5. Expand the General option and select Existing Projects into Workspace.

6. Click Next.

The Import Projects dialog appears as shown in Figure 4-15.
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Figure 4-15 Import Projects Dialog

Import Projects e
Select a directory to search for existing Eclipse projects. ; ,""
-
() Select root directory: | | [ Browse. .. ]

O select archive file: | |

Projects:

Select all
Deselect Al

|:| Copy projects into workspace

®

7. Use the Import Projects dialog to import your 2.1 projects into the new workspace.
Optionally, choose to copy the project files into your new workspace.

8. For each project, change the project facet version as follows:
a. Right-click your project and select Properties.

The Project Properties dialog appears as shown in Figure 4-16.
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Figure 4-16 Project Properties Dialog: Project Facets
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b. Select the Project Facets option.

The Project Facet properties are displayed as Figure 4-16 shows.
c. Click Modify Project.

The Modify Faceted Project dialog appears shown in Figure 4-17.

Figure 4-17 Modify Faceted Project

= Modify Faceted Project

Project Facets

Select the Facets that should be enabled for khis project,

Configurations: |<cust0m> v|[ Save ][ Delete ]

Praoject Facet Version
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(=l Oracle CEP

<< Show Runtimes

@ < Back Plest [ Finish ][ Cancel ]
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d. For the Oracle CEP facet, select 10.3 from the Version pull-down menu.
e. Click Finish.
f. Click OK.
g. Repeat for the next project.
9. Create a new Oracle CEP server runtime:
a. Select Window > Preferences.

The Preferences dialog appears as shown in Figure 4-18.

Figure 4-18 Preferences Dialog

& Preferences

[Evpe Filer bext Installed Server Runtime Environments i

+! T . L
General Add, remove, or edit installed server runtime definitions.

Ank

Conneckivicy Installed server runtimes: /_\
Help Name p— T
Install{Update

Internet
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RunDebug
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Audio
Installed Runtimes
Launching
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Team
Walidation
Wb and XML
Web Services
WindowTester
wDoclet

@ [ oK ] [ Cancel

b. Expand the Server option and select Installed Runtimes.

c. Add anew 10.3 Oracle CEP server runtime as Section 5.2.3, "How to Create an
Oracle CEP Server Runtime" describes.

d. Click OK.
10. For each project, specify the new 10.3 Oracle CEP server runtime you created:
a. Right-click your project and select Properties.

The Project Properties dialog appears as shown in Figure 4-19.
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Figure 4-19 Project Properties Dialog: Targeted Runtimes
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b. Select the Targeted Runtimes option.

The Targeted Runtimes properties are displayed as Figure 4-19 shows.

c. Check the new Oracle CEP 10.3 targeted runtime you created.

d. Click OK.

e. Repeat for the next project.

11. For each project update the project builders:

a. Right-click the project and select Open EPN Editor.

b. If the EPN diagram opens without error, proceed to step 12.

c. If the EPN diagram opens with the error shown in Figure 4-20, click the
Configure Builder button.
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Figure 4-20 Builder Error

| hella.context. xml ) EPN: hella 23 =8

Filter: = Full EPM G| 100% ==

The EPN cannot be displaved because the Oracle CEP build is configured in an invalid order,
Click. the button below to reconfigure the builder in the correct order,

Configure Builder

Overview | Event Types

The EPN diagram is displayed.
d. Repeat for the next project.
12. Validate build inclusions:

If your application bundle is using bundle localization and has substitution
variables in its MANIFEST . MF file such as:

Bundle-Name: $project.name
Then your project root directory’s build.properties file element

bin.include must contain a reference to your bundle.properties file such
as:

bin.includes = META-INF/,\
bundle.properties, \

13. Perform source changes, if necessary.
For more information, see:

s "Upgrading a WebLogic Event Server 2.0 Application to Run on Oracle CEP
10.3" in the Oracle Complex Event Processing Getting Started

m  Oracle CEP Release Notes for 10.3
(http://download.oracle.com/docs/cd/E13157_
01/wlevs/docs30/notes/notes.html)

After performing these steps, you should do a clean build of your project.

4.6.2 How to Upgrade Projects from Oracle CEP 10.3 to 11g Release 1 (11.1.1)

While project structure has stayed the same since 10.3, the data stored in Oracle CEP
Projects has changed significantly. It is therefore necessary to take steps to upgrade
10.3 projects manually before continuing their development in 11g Release 1 (11.1.1).

The following outlines the steps necessary to upgrade 10.3 projects to 11g Release 1
(11.1.1)
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To upgrade projects from Oracle CEP 10.3 to 11g Release 1 (11.1.1)
1. Open your Oracle CEP 10.3 project in Oracle CEP IDE for Eclipse.

2. Select File > Switch Workspace > Other.
The Workspace Launcher dialog appears as shown in Figure 4-21.
Figure 4-21 Workspace Launcher Dialog

& Workspace Launcher,

X

Select a workspace

Eclipse Platform stores your projects in a folder called a workspace,
Choose a workspace folder to use For this session,

Workspace: | Ci\edipse-projs v| [ Browse...

[ warking Sets

(':’:' [ O ] [ Cancel ]

3. Click Browse and select a new workspace directory.

Note: Do not choose to copy settings from the current workspace.

Eclipse exits and restarts using the new workspace.

4. Select File > Import.
The Import Dialog appears as shown in Figure 4-14.
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Figure 4-22 Import Dialog

& Import
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5. Expand the General option and select Existing Projects into Workspace.
6. Click Next.

The Import Projects dialog appears as shown in Figure 4-15.
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Figure 4-23 Import Projects Dialog

Import Projects

Select a directory to search for existing Eclipse projects.

(®) Select root directory: |

O select archive file: | |

Projects:

Browse...

|:| Copy projects into workspace

Mext = Firish

Select all
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Caneel

Use the Import Projects dialog to import your 10.3 projects into the new

workspace. Optionally, choose to copy the project files into your new workspace.

a.

For each project, change the project facet version as follows:

Right-click your project and select Properties.

The Project Properties dialog appears as shown in Figure 4-16.
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Figure 4-24 Project Properties Dialog: Project Facets
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b. Select the Project Facets option.

The Project Facet properties are displayed as Figure 4-16 shows.
c. Click Modify Project.

The Modify Faceted Project dialog appears shown in Figure 4-17.

Figure 4-25 Modify Faceted Project

= Modify Faceted Project

Project Facets

Select the Facets that should be enabled for khis project,

Configurations: |<cust0m> v|[ Save H Delete ]
Praoject Facet Version
[Z14] Java 6.0 -
[¥leE ©racle CEP 2.0 v
11.1
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<< Show Runtimes

@ < Back Plest [ Finish ][ Cancel ]
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d. For the Java facet, select 6.0 from the Version pull-down menu.
e. For the Oracle CEP facet, select 11.1 from the Version pull-down menu.
f. Click Finish.
g. Click OK.
h. Repeat for the next project.
9. Create a new Oracle CEP server runtime:
a. Select Window > Preferences.

The Preferences dialog appears as shown in Figure 4-18.

Figure 4-26 Preferences Dialog
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b. Expand the Server option and select Installed Runtimes.

c. Add anew 11.0 Oracle CEP server runtime as Section 5.2.3, "How to Create an
Oracle CEP Server Runtime" describes.

d. Click OK.
10. For each project, specify the new 11.0 Oracle CEP server runtime you created:
a. Right-click your project and select Properties.

The Project Properties dialog appears as shown in Figure 4-19.
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Figure 4-27 Project Properties Dialog: Targeted Runtimes
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b. Select the Targeted Runtimes option.
The Targeted Runtimes properties are displayed as Figure 4-19 shows.
c. Check the new Oracle CEP 11.0 targeted runtime you created.
d. Click OK.
e. Repeat for the next project.
11. For each project update the project builders:
a. Right-click the project and select Open EPN Editor.
b. If the EPN diagram opens without error, proceed to step 12.

c. If the EPN diagram opens with the error shown in Figure 4-20, click the
Configure Builder button.
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Figure 4-28 Builder Error

| hella.context. xml ) EPN: hella 23 =8

Filter: = Full EPM G| 100% ==

The EPN cannot be displaved because the Oracle CEP build is configured in an invalid order,
Click. the button below to reconfigure the builder in the correct order,

Configure Builder

Overview | Event Types

The EPN diagram is displayed.
d. Repeat for the next project.
12. Select Window > Preferences.

The Preferences dialog appears as shown in Figure 4-29.
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Figure 4-29 Preferences Dialog
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13. Select the Validaion option.

14. Ensure that the following validation options are checked:
s CQL Validator
= EPN Validator
= XML Validator

15. Unselect all other options.

16. Click OK.

17. Validate build inclusions:

If your application bundle is using bundle localization and has substitution
variables in its MANIFEST . MF file such as:

Bundle-Name: $project.name

Then your project root directory’s build.properties file element
bin.include must contain a reference to your bundle.properties file such
as:

bin.includes = META-INF/,\
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bundle.properties, \

18. Perform source changes, if necessary.

For more information, see:

s "Upgrading an Oracle CEP 10.3 Application to Run on Oracle CEP Release
11gR1 (11.1.1)" in the Oracle Complex Event Processing Getting Started

s Oracle CEP Release Notes

4.7 Managing Libraries and Other Non-Class Files in Oracle CEP Projects

Many projects require the use of non-class files such as libraries or property files that
were obtained from a source other than the project itself, whether that be third party
libraries, internal libraries created in other projects, or otherwise.

You can add the following non-class files to an Oracle CEP project, each with its own
packaging and deployment characteristics:

Standard JAR Files: Adding a standard JAR file to a project makes for the easiest
management of the library. The library is packaged directly with the project by the
Oracle CEP IDE for Eclipse and you can check the library into a source code
control system as part of the project.

For more information, see:

»  Section 4.7.1, "How to Add a Standard JAR File to an Oracle CEP Project"

= Section 4.7.2, "How to Add an OSGi Bundle to an Oracle CEP Project"

= Section 4.7.3, "How to Add a Property File to an Oracle CEP Project"

= Section 4.7.4, "How to Export a Package"

= Section 4.7.5, "How to Import a Package"

= Section 24.2.2.2.2, "Accessing Third-Party JAR Files Using -Xbootclasspath"

OSGi Bundles: If your library is already packaged as an OSGi bundle and you
would like to deploy it to the server once (allowing multiple applications to
reference it), you can use the OSGi bundle library option. Note that this leaves
some parts of deployment to the user since the OSGi bundle is not automatically
packaged with the application. It can also make working in team environments a
little more difficult because each developer must have the bundle in the DOMATIN_
DIR/servername/modules directory of their machine, rather than have it
source controlled with the rest of the project.

The main advantage of the OSGi bundle library option is that you can use the
Oracle CEP server application library to manage OSGi bundle libraries to ensure
that they are deployed before any applications that depend on them.

For more information, see:
= Section 4.7.2, "How to Add an OSGi Bundle to an Oracle CEP Project"
= Section 24.1.3, "Application Libraries"

Property Files: Adding a Java property file to a project allows you to manage
properties efficiently. You can add a Java property file to an Oracle CEP project so
that the property file is deployed with your application and is available at
runtime.

For more information, see:
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= Section 4.7.3, "How to Add a Property File to an Oracle CEP Project”

»  Section 1.1.5.1, "Accessing Component and Server Configuration Using the
ConfigurationPropertyPlaceholderConfigurer Class"

4.7.1 How to Add a Standard JAR File to an Oracle CEP Project

If the library you need to use is a standard JAR file, you can add it to your Oracle CEP
project. Alternatively, you can add a library as an OSGi bundle (see Section 4.7.2, "How
to Add an OSGi Bundle to an Oracle CEP Project").

When you add a standard JAR file to an Oracle CEP project, you can optionally expose
some or all of its packages to other bundles that will depend on this bundle.

To add a standard JAR file to an Oracle CEP project:

1.

Create a folder in your Oracle CEP IDE for Eclipse project to put the JAR file in.
Oracle recommends that you create a folder to put them in such as 1ib.

To create a new folder, right-click your project folder and select New > Folder.
Outside of the Oracle CEP IDE for Eclipse, copy your JAR file into the 1ib folder.

Inside the Oracle CEP IDE for Eclipse, right-click the 1ib folder and select
Refresh.

The JAR file appears in the 1ib folder as Figure 4-30 shows.

Figure 4-30 Oracle CEP IDE for Eclipse lib Directory
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|m8 build, properties
E bundle. properties
startDataFeed. crd

Expand the META-INF directory and right-click the MANIFEST . MF file and select
Open With > Plug-in Manifest Editor.

The Manifest Editor opens as Figure 4-31 shows.
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Figure 4-31 Manifest Editor: Build Tab

J}{ﬂ*CEPSample &3 )
& Build Configuration ©)

[ custom Build

Runtime Information

Define the libraries, specify the order in which they shauld be built, and list the source Folders that should be compiled into each
selected library.

=
Binary Build Source Build
Select the folders and files to include in the binary build, Select the folders and files to include in the source build,
LR classpath [1 %] .classpath
[ 1% .praject [ % project
B[] settings #-[JE= settings
- [] (= META-INF #-[] = META-INF
&[] buid - [] = build
) [awb build properties | [awb build properties
bundle.properties [1 2 bundle.properties
[ dist [ dist
=-[E] = b #E-[J& lib
m javas. jws_2.0.jar R =
B[] sre [1=] startDataFesd.cnd

[ startDataFesd.cmd

» Extra Classpath Entries

Overview Dependencies | Runtime | Build | MANIFEST.MF | build, properties

5. Click the Build tab.

6. Add your JAR file to the binary build under the project root as follows:
s In the Binary Build area, expand the 1ib directory.
»  Check the box next to your library as Figure 4-31 shows.
»  Press hit CTRL-SHIFT-S to save all files.

This edits the build.properties file in your project, and tells the Oracle
CEP IDE for Eclipse to add the JAR file to your bundle when you build the
bundle JAR.

7. In the Manifest Editor, click the Runtime tab.

The Runtime tab appears as Figure 4-32 shows.
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Figure 4-32 Manifest Editor - Runtime Tab
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8. Add the JAR file to your project's classpath as follows:
s In the Manifest Editor, click the Add button.
The JAR Selection dialog appears as shown in Figure 4-33.

Figure 4-33 JAR Selection Dialog
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= Select the JAR you want to add to the bundle.

In this example, expand the lib directory and select the javax.jws_2.0.jar
file.

s Click OK.
This adds the selected JAR to the Classpath list as Figure 4-34 shows.

Figure 4-34 Manifest Editor Runtime tab After Adding a JAR to the Classpath
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»  Press hit CTRL-SHIFT-S to save all files.
This edits the MANIFEST . MF file, putting the JAR on your project classpath.

To confirm this, in the Manifest Editor, click the MANIFEST.MF tab and note
that the JAR is now listed under the Bundle-Classpath property as
Figure 4-35 shows.
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Figure 4-35 Manifest Editor MANIFEST.MF Tab
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Note also that the JAR now appears as a library at the root of the project as
Figure 4-36 shows.

Figure 4-36 Package Explorer
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9. Optionally, if your bundle needs to export packages from this JAR to other
bundles that will depend on this bundle, then you can export these packages as
Section 4.7.4, "How to Export a Package" describes.
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4.7.2 How to Add an OSGi Bundle to an Oracle CEP Project

If the library you need to use is an OSGi bundle, you can add it to your Oracle CEP
project. Alternatively, you can add a library as a standard JAR file (see Section 4.7.1,
"How to Add a Standard JAR File to an Oracle CEP Project").

To add an OSGi bundle to an Oracle CEP project, you add the bundle to that bundle's
dependencies definition.

Note: This process only makes the referenced bundle available to
your project at build time. It does not package the bundle directly
with your application when it is deployed or exported. Instead, this
bundle must be deployed to the Oracle CEP server manually. For
more information, see Section 24.1.3, "Application Libraries".

To add an OSGi bundle to an Oracle CEP project:

1. Place the OSGi bundle in the DOMAIN DIR/servername/modules directory,
where DOMAIN DIR refers to the domain directory such as /oracle_cep/user_
projects/domains/mydomain and servername refers to the server instance,
such as myserver. For example:

c:\oracle_cep\user_projects\domains\mydomain\myserver\modules

2. Start the Oracle CEP IDE for Eclipse.
3. Right-click the project and select Refresh Targeted Runtime.

4. Right-click the META-INF/MANIFEST .MF file and select Open With > Plug-in
Manifest Editor.

The Manifest Editor opens as Figure 4-37 shows.

Figure 4-37 Manifest Editor: Dependencies Tab
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5. Click the Dependencies tab.
6. In the Required Plug-ins area, click Add.
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The Plug-in Selection dialog appears as shown in Figure 4-38.

Figure 4-38 Plug-in Selection Dialog
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7. Select the bundle you added to the DOMAIN_DIR/servername/modules
directory of your Oracle CEP server installation directory in step 1 and click OK.

The selected bundle appears in the Require-Bundle section of the MANIFEST . MF
file.

4.7.3 How to Add a Property File to an Oracle CEP Project

You can add a Java property file to an Oracle CEP project so that the property file is
deployed with your application and is available at runtime.

To add a property file to an Oracle CEP project:

1. Create a folder in your Oracle CEP IDE for Eclipse project to put the property files
in.

Oracle recommends that you create a folder to put them in such as properties.
To create a new folder, tight-click your project folder and select New > Folder.

2. Outside of the Oracle CEP IDE for Eclipse, copy your property file into the
properties folder.

3. Inside the Oracle CEP IDE for Eclipse, right-click the properties folder and
select Refresh.

The property file appears in the properties folder as Figure 4-39 shows.
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Figure 4-39 Oracle CEP IDE for Eclipse properties Directory
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4. Expand the META-INF directory and right-click the MANIFEST . MF file and select
Open With > Plug-in Manifest Editor.

The Manifest Editor opens as Figure 4-40 shows.

Figure 4-40 Manifest Editor: Build Tab
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5. Click the Build tab.

6. Add your property file to the binary build under the project root as follows:

s In the Binary Build area, expand the properties directory.

»  Check the box next to your property file as Figure 4-40 shows.
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m Press hit CTRL-SHIFT-S to save all files.

This edits the build.properties file in your project, and tells the Oracle
CEP IDE for Eclipse to add the property file to your bundle when you build
the bundle JAR.

7. You can access the properties file in Java code as Example 4-1 shows:

Example 4-1 Accessing a Properties File

public void onInsertEvent (Object event) {
if (event instanceof HelloWorldEvent) {
HelloWorldEvent helloWorldEvent = (HelloWorldEvent) event;
InputStream resourceAsStream = getClass().getClassLoader () .getResourceAsStreamn (
"properties/test.properties"
)
Properties props = new Properties();
try {
props.load(resourceAsStream) ;
} catch (IOException e) {
e.printStackTrace() ;
}
System.out.println("Message: " + props.get("test-key"));

4.7.4 How to Export a Package

Optionally, if your bundle needs to export a package from a JAR to other bundles that
will depend on this bundle, then you can export this package. By doing so, you update
the Package-Export MANIFEST entry to create an OSGi exporter for the package.

To export a package:
1. Inside the Oracle CEP IDE for Eclipse, expand the META-INF directory as
Figure 441 shows.

Figure 4-41 Oracle CEP IDE for Eclipse lib Directory
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2. Right-click the MANIFEST . MF file and select Open With > Plug-in Manifest
Editor.

The Manifest Editor opens as Figure 4-42 shows.
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Figure 4-42 Manifest Editor: Runtime tab
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3. Click the Runtime tab.

The Runtime tab appears as Figure 4-42 shows.

4. In the Exported Packages area, click the Add button.

The Package Selection dialog appears as Figure 4-43 shows.

Figure 4-43 Package Selection Dialog
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5. Select the package you want to export.
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To find a package in the list by name, type the name into the text field.
In this example, select the javax. jws . soap package.

6. Click OK.

The selected package is added to the Exported Packages area as Figure 444
shows.

Figure 4-44 Manifest Editor Runtime tab After Exporting a Package
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7. Press CTRL-SHIFT-S to save all files.

4.7.5 How to Import a Package

Optionally, if your bundle needs to import a package from a JAR, then you can import
this package. By doing so, you update the Package-Import MANIFEST entry to
create an OSGi importer for the package.

To import a package:

1. Inside the Oracle CEP IDE for Eclipse, expand the META-INF directory as
Figure 4-45 shows.
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Figure 4-45 Oracle CEP IDE for Eclipse lib Directory
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2. Right-click the MANIFEST . MF file and select Open With > Plug-in Manifest
Editor.

The Manifest Editor opens as Figure 4-46 shows.

Figure 4-46 Manifest Editor: Dependencies tab
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Click the Dependencies tab.

The Dependencies tab appears as Figure 4-46 shows.

In the Imported Packages area, click the Add button.

The Package Selection dialog appears as Figure 4-47 shows.
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Figure 4-47 Package Selection Dialog
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5. Select the package you want to import.

To find a package in the list by name, type the name into the text field.

In this example, select the javax. jws . soap package.

6. Click OK.

The selected package is added to the Import Packages area as Figure 4-48 shows.

Figure 4-48 Manifest Editor Dependencies tab After Importing a Package
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7. Press CTRL-SHIFT-S to save all files.
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4.8 Configuring Oracle CEP IDE for Eclipse Preferences

You can configure various preferences to customize Oracle CEP IDE for Eclipse to suit
your needs, including:

= Section 4.8.1, "How to Configure Application Library Path Preferences"

= Section 4.8.2, "How to Configure Problem Severity Preferences"

4.8.1 How to Configure Application Library Path Preferences

You can define the path to an Oracle CEP server domain directory that contains
application libraries that extend the Oracle CEP runtime.

For more information, see Section 24.3.1, "How to Define the Application Library
Directory Using Oracle CEP IDE for Eclipse".

4.8.2 How to Configure Problem Severity Preferences

You can assign a severity to the various problems that Oracle CEP IDE for Eclipse can
detect in your Oracle CEP project and application.

You can configure these preferences for each project individually or you can configure

these preferences the same for all the projects in a given workspace.

To configure problem severity preferences:
1. Open the EPN Editor (see Section 6.1, "Opening the EPN Editor")

2. Select Window > Preferences.

The Preferences dialog appears as shown in Figure 4-49.
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Figure 4-49 Properties Dialog
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3. Select Oracle CEP Problem Severities.
4. Choose the configuration scope:

= To configure problem severities for all the projects in a workspace, click
Configure Workspace Settings.

The Oracle CEP Problem Severities dialog appears as Figure 4-50 shows.
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Figure 4-50 Oracle CEP Problem Severities Dialog: Workspace
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= To configure problem severities for the current project only, click Enable
project specific settings.

The Oracle CEP Problem Severities dialog appears as shown in Figure 4-51.
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Figure 4-51 Oracle CEP Problem Severities Dialog: Project
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5. Select a severity for each type of problem. You can select one of:
»s Error: treat the problem as an error.
= Warning: treat the problem as a warning.
= Ignore:ignore the problem.

Table 4-7 describes each of the problem areas you can configure.
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Table 4-7 Oracle CEP Problem Severities

Category

Problem

Description

Cache Configuration

Unresolved cache loaders or
resolved loaders with incorrect
interface declarations.

Ensure that the assembly file contains a bean element that identifies
the cache loader class for each wlevs: cache-loader element and
ensure that the cache loader class implements the appropriate
interfaces.

For more information, see:

= Section 12.2.3, "Configuring an Oracle CEP Local Cache
Loader"

= Section 12.3.4.1, "Configuring an Oracle Coherence Cache
Loader."

Unresolved cache stores or
resolved stores with incorrect
interface declarations.

Ensure that the assembly file contains a bean element that identifies
the cache store class for each wlevs: cache-store element and
ensure that the cache store class implements the appropriate
interfaces.

For more information, see:
N Section 12.2.4, "Configuring an Oracle CEP Local Cache Store"

= Section 12.3.4.2, "Configuring an Oracle Coherence Cache
Store."

Event Processing

Configuration objects without

EPN configuration elements are linked to assembly definitions by

Network a matching assembly definition | name and ID, respectively. Validate that a configuration element has
a name that exactly matches an assembly element by ID within the
same application.

Configuration objects with Configuration elements in Oracle CEP configuration files are

duplicate name declarations. identified by a name. Validate that no two configuration elements in
an application have the same name.

Unresolved event listeners or An event processing network is built by defining how elements in

resolved listeners with the network pull or push to events to other elements in the

incorrect interface declarations | application. Validate that the target of an event push, a listener
declaration on an EPN assembly element, implements the interfaces
required to receive pushed events.

Unresolved event sources or An event processing network is built by defining how elements in

resolved sources with incorrect | the network pull or push to events to other elements in the

interface declarations application. Validate that the source of an event pull, a source
declaration on an EPN assembly element, implements the interfaces
required to provide pulled events.

Unresolved query selectors Given a channel with an upstream Oracle CQL processor that

configured for channels. defines more than one rule, ensure that the channel component
configuration file selector element contains only rule names of
the rules defined in the upstream Oracle CQL processor.
For more information, see Section D.78, "selector".

References to foreign stages Ensure that references to foreign stages can be resolved.

(stag}es C.lefmed in external For more information, see Section 1.1.1.9, "Foreign Stages".

applications).

Channels not associated with Given a channel that does not have an upstream Oracle CQL

CQL processors missing processor, ensure that the assembly file wlevs : channel element is

"event-type" declaration. configured with an event-type attribute.
For more information, see Chapter 9, "Configuring Channels".

Deprecated EPN elements Oracle CEP provides backwards compatibility with applications
built for previous versions. Validate an application's use of
deprecated XML elements.

Event Type Repository | Event property type values that | Event types may be defined using dynamic Spring Beans through
are not predefined types or do | the properties element. The property values are limited to a
not resolve to a known class. fixed set of supported types. Validate that the property type is one

of these allowed types.
For more information, see Section 1.1.2, "Oracle CEP Event Types".

Query Validation Problems found validating Validate that the Oracle CQL statement in a processor configuration

CQL Statements

is correct given the current application. Verify property names, event
types, syntax, and other assembly-to-Oracle CQL references.
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Table 4-7 (Cont.) Oracle CEP Problem Severities

Category

Problem

Description

Problems preventing the
validation of CQL statements

Some fundamental application errors will keep a Oracle CQL
statement from being validated. For example, a processor
configuration must have a matching processor assembly definition
before any Oracle CQL requirements can be met. Verify that the
minimum requirements are met to validate a processor's Oracle CQL
statements.

CQL statements affected
directly or indirectly by
missing binding parameters.

Parameterized queries.

CQL statements in
disconnected processors (no

upstream channels in the EPN).

Ensure that all Oracle CQL processors are connected to an upstream
stage on the EPN. Without an upstream stage, the Oracle CQL
processor’s rules have no event stream to operate on.

Click Apply.
Click OK.
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Oracle CEP IDE for Eclipse and Oracle CEP

Servers

Using Oracle CEP IDE for Eclipse, you can manage and deploy to the Oracle CEP
server: the core of an Oracle CEP application. It provides the runtime in which your

Oracle CEP application executes.

This chapter describes:

s Section 5.1, "Oracle CEP Server Overview"

m  Section 5.2, "Creating Oracle CEP Servers"

m  Section 5.3, "Managing Oracle CEP Servers"

= Section 5.4, "Debugging an Oracle CEP Application Running on an Oracle CEP

Server"

5.1 Oracle CEP Server Overview

The Oracle CEP IDE for Eclipse provides features that allow you to set up and manage
Oracle CEP servers that are used during development. These tools help you to:

= Configure instances of Oracle CEP servers

m Attach to external Oracle CEP server instances

= Manage Oracle CEP server lifecycle with start, stop, and debug commands

= Associate applications with and deploy applications to Oracle CEP servers during
development

Table 5-1 maps Eclipse terminology used by the Oracle CEP IDE for Eclipse to Oracle
CEP server terminology.

Table 5-1

Eclipse and Oracle CEP Server Concepts

Eclipse IDE
Concept

Oracle CEP Server
Concept

Description

Runtime

Oracle CEP server
installation

The Oracle CEP IDE for Eclipse has the concept of a runtime.
The runtime defines the location where the Oracle CEP IDE for
Eclipse can find the installation of a particular Oracle CEP
server. This information is used to find JAR files and OSGi
bundles to add to the project classpath and to further define
Servers and Server Instances.

Note that a Runtime is not itself a runnable artifact.
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Table 5-1 (Cont.) Eclipse and Oracle CEP Server Concepts

Eclipse IDE Oracle CEP Server
Concept Concept Description

Server and Domain The Oracle CEP IDE for Eclipse uses the term Server to describe
Server Instance an actual runnable Oracle CEP server instance. You can think of
it as something that has start scripts, for example. In Oracle CEP
server terminology, this equates to a Domain. When you set up a
server, you specify the domain that this instance will run.

For more information on domains, see:

N For more information, see "Administrating Oracle CEP
Standalone-Server Domains" in the Oracle Complex Event
Processing Administrator’s Guide.

N For more information, see "Administrating Oracle CEP
Standalone-Server Domains" in the Oracle Complex Event
Processing Administrator’s Guide.

Publish Deploy The Oracle CEP IDE for Eclipse typically uses the term Publish
to describe physically deploying an application to a server.

Project Application or A project in the Oracle CEP IDE for Eclipse becomes a single
Deployment Oracle CEP application packaged as an OSGi bundle. It is
deployed to a server and shows in the Oracle CEP server’s
deployments . xml file.

Server definitions are the central concept in controlling an Oracle CEP server from the
Oracle CEP IDE for Eclipse. It is from the server definition that you start and stop the
server. After associating a project with the server, you can publish (deploy) the
application to and unpublish (undeploy) the application from the server, all without
having to leave the Oracle CEP IDE for Eclipse. For more information, see Section 5.2,
"Creating Oracle CEP Servers".

You can communicate with a running Oracle CEP server using Oracle CEP IDE for
Eclipse in the following ways:

»  Start a server from within Oracle CEP IDE for Eclipse.

In this case, the Oracle CEP server console is sent directly to the console view in
Oracle CEP IDE for Eclipse. All of the Oracle CEP server features (such as start,
stop, publish, unpublish, debug, and launching the Oracle CEP Visualizer) are
available. The Oracle CEP server process itself is managed from within Oracle CEP
IDE for Eclipse. In other words, stopping the Oracle CEP server from the Oracle
CEP IDE for Eclipse will terminate the actual Oracle CEP server process. Console
messages from the Oracle CEP server are sent to the Oracle CEP IDE for Eclipse
Console view.

For more information, see:

—  Section 5.3.1, "How to Start a Local Oracle CEP Server"

— Section 5.3.2, "How to Stop a Local Oracle CEP Server"
= Attach to a running Oracle CEP server.

In this case, the user starts the Oracle CEP server from the command line, then
clicks the Start button for that server in Oracle CEP IDE for Eclipse. A dialog is
shown asking whether or not to attach and, if the user clicks Yes, Oracle CEP IDE
for Eclipse enters attached mode. All of the Oracle CEP server features except
debug are available. However, the Oracle CEP server process is not managed by
the Oracle CEP IDE for Eclipse. Clicking the Stop button simply disconnects from
the attached Oracle CEP server; it does not terminate the actual Oracle CEP server
process. Console messages from the Oracle CEP server are sent to the Oracle CEP
server console (standard output to the terminal window in which it is running).
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Oracle CEP IDE for Eclipse only shows limited Oracle CEP IDE for Eclipse
operation messages in the console view.

For more information, see:
- Section 5.3.3, "How to Attach to an Existing Local Oracle CEP Server Instance"

- Section 5.3.5, "How to Detach From an Existing Oracle CEP Server Instance"

5.2 Creating Oracle CEP Servers

Creating a server allows you to start and stop the server instance from within the
Oracle CEP IDE for Eclipse, as well as automatically deploy your applications to that
server.

You can create a local or remote Oracle CEP server:

s Local server: a local Oracle CEP server is one in which both the server and server
runtime are on the same host

= Remote server: a remote Oracle CEP server is one in which the server and server
runtime are on different hosts. The server is on a remote host and the server
runtime is on the local host (the host on which you are executing the Oracle CEP
IDE for Eclipse).

This section describes:
m Section 5.2.1, "How to Create a Local Oracle CEP Server and Server Runtime"
s Section 5.2.2, "How to Create a Remote Oracle CEP Server and Server Runtime"

s Section 5.2.3, "How to Create an Oracle CEP Server Runtime"

5.2.1 How to Create a Local Oracle CEP Server and Server Runtime

This section describes how to create both a local server and server runtime. After
creating the initial server and server runtime, you can create additional server
runtimes.

A local Oracle CEP server is one in which both the server and server runtime are on
the same host.

Alternatively, you can create a remote server and server runtime.
For more information, see:
s Section 5.2.3, "How to Create an Oracle CEP Server Runtime"

s Section 5.2.2, "How to Create a Remote Oracle CEP Server and Server Runtime"

To create a local Oracle CEP server and server runtime:
1. Select Window > Show View > Servers.

The Servers view appears as shown in Figure 5-1.
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Figure 5-1 Oracle CEP IDE for Eclipse Server View

4 servers 53 e

Server State Status

N T

2. Right-click in the Servers view pane and select New > Server.
3. Consider whether or not server runtimes have been created:
a. If this is the first time you have created an Oracle CEP server, there will be no
installed server runtimes. Proceed to step 4.
b. If this is not the first time you have created an Oracle CEP server, there will be
one or more installed server runtimes. Proceed to step 5.
4. If this is the first time you have created an Oracle CEP server, there will be no

installed server runtimes:

In this case, the New Server: Define New Server dialog appears as Figure 5-2

shows.

Figure 5-2 New Server: Define New Server Dialog (No Installed Runtimes)

1 New Server

Define a New Server

Choose the type of server to create

Server's host name: | localhost |

Download additional server adapters
Select the server type:

bype filker texk |

(= Basic A

= 1BM

(= JBoss

= Objectweb

[ Oradle
el Cracle CEP vi1.1
E Oracle ©C4] Standalone Server 10,1.3
B Oracle OC4] Standalone Server 10.1.3.0

(- B B

Supports controlling Oracle CEP Servers. Allows starting)'stopping the server, and deploving
applications,

Server name: Oracle CEP v11.1 at localhosk
N

Configure the new server as follows:
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a. Configure the dialog as shown in Table 5-2.

Table 5-2 New Server: Define New Server Dialog (No Installed Runtimes) Attributes

Attribute Description
Server’s host name The host name of the computer on which you installed Oracle
CEP server.

For development, this will typically be localhost.

Select the server type The type of Oracle CEP server.

In this example, choose Oracle CEP v11l

Server name The name of this Oracle CEP server.
Default: Oracle CEP v11.1 at HOSTNAME

Where HOSTNAME is the value you entered in the Server’s host
name field.

b. Click Next.

The New Server: New Oracle CEP v11 Runtime dialog appears as shown in
Figure Figure 5-3.

Figure 5-3 New Server: New Oracle CEP v11.1 Runtime Dialog

12} New Server |:|@@

New Oracle CEP v11.1 Runtime —r
=
Define a new Oracle CEP w11.1 runtime \_§ﬂ|
Oracle Middleware Home Directory:
“iou can use [nstalled JRE preferences ko create a new JRE
JRE: Default JRE v
3

c. Configure the dialog as shown in Table 5-3.
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Table 5-3 New Server: New Oracle CEP v11 Runtime Dialog Attributes

Attribute Description

Oracle Middleware Home  The fully qualified path to the Oracle CEP server installation
Directory directory. This is the same as the "Middleware Home" that was
selected when installing the server.

When selecting this directory, select the directory that contains
the Oracle CEP installation rather than the Oracle CEP directory
itself. For example, choose:

C:\OracleCEP

But do not choose:
C:\OracleCEP\ocep_11.1

The runtime wizard will use the installation to find the
appropriate Oracle CEP installation directory.

For more information, see "Oracle Fusion Middleware Directory
Structure and Concepts" in the Oracle Complex Event Processing
Getting Started.

JRE The type of JRE to use.

Select the type of JRE to use from the pull-down menu or click
the Installed JRE preferences link to create a new JRE.

Be sure to choose a Java 6 JRE.

NOTE: The Oracle CEP server JRE is ultimately set by the
JAVA_HOME setting in setDomainEnv.cmd or
setDomainEnv. sh script in the server domain directory.

d. Proceed to step 6.

5. If this is not the first time you have created an Oracle CEP server, there will be one
or more installed server runtimes.

In this case, the New Server: Define New Server dialog appears as Figure 5-4
shows.

Figure 5-4 New Server: Define New Server (Installed Runtimes) Dialog

@ )

Define a New Server
Choose the kvpe of server ko create

Servet's host name: | localhost w |

Dowrnload additional server adapkers
Seleck the server bype:

|type filker bect |

= Objectweb A
== Oracle

&l oracle CEP w111

a Oracle OC4] Skandalone Server 1001.3 =

E Oracle 0C4] Skandalone Server 10.1.3.1 v
Supports controlling Oracle CEP Servers, Allows startingfskopping the server, and deploying
applications.
Server runtime: |Oracle CEP w11 » | [Installed Runtimes. ..
@ Mexk = ] [ Finish ] [ Cancel
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Configure the dialog as shown in Table 5-4.

Table 5-4 New Server: Define New Server (Installed Runtimes) Dialog Attributes

Attribute Description
Server’s host name The host name of the computer on which you installed Oracle
CEP server.

For development, this will typically be localhost.

Select the server type The type of Oracle CEP server.

In this example, choose Oracle CEP v11.

Server runtime Select the server runtime from the pull-down menu.

To create or edit server runtimes, click Installed Runtimes. For
more information, see Section 5.2.3, "How to Create an Oracle
CEP Server Runtime".

6. Click Next.

The New Server: New Oracle CEP v11.1 Server dialog appears as Figure 5-5
shows.

Figure 5-5 New Server: New Oracle CEP v11.1 Server

LF New Server |:|@@

New Oracle CEP v11.1 Server —
Define a new Oracle CEF v11.1 server \9

A local server execukes on this machine, In addition ko deploying and undeploying applications, you can also start, stop,
and debug the local server process,

A remote server executes on a machine on a network accessible by this machine, Instead of controlling the server
process, you can only attach ko an already running remote server, Java debugging is not available for remaote servers,

(%) Local Server
() Remaote Server

'@) . <Back | Mext» ][ Finish ][ Cancel

7. Select Local Server.
8. Click Next.
The New Server: New Oracle CEP v11 Server dialog appears as Figure 5-6 shows.
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Figure 5-6 New Server: New Oracle CEP v11 Server Dialog for a Local Server

& New Senver,

New Oracle CEP v11 Server

Define a new Oracle CEP w11 server

Domain Directory: | C:/OracleCEPfuser _projects/domains{ocep_domainf defaultserver | [Browse. .. |

Domain Configuration

Skark Scripk: | CiforacleCERfuser _projects/domainsfocep _domain/def aultserverfstartwlevs,cmd | [B_rowse... ]
Skop Scripk: | i fOracleCER fuser_projects/domains/ocep_domain/def aultserver/stopwleys.cmd | [B_rowse... ]
Debug Part: [ 8453 |

Server Configuration

Server Mame: | Oracle CEP w1l |
User Mane: | wlevs |
User Password: | wlevs |

Automatic Publishing: (%) Disabled
() Use workspace default

@ [ <Back | met= ][ Emsh |[ cancel |

9. Click Advanced and configure the dialog as shown in Table 5-5.

Table 5-5 New Server: New Oracle CEP v11 Server Dialog Attributes for a Local Server

Attribute Description

Domain Directory The fully qualified path to the directory that contains the domain for
this server.

Click Browse to choose the directory.

Default: ORACLE-CEP-HOME\user_projects\domains\ocep_
domain\defaultserver.

Start Script The script that Oracle CEP IDE for Eclipse uses to start the Oracle CEP
server.

Default on UNIX: ORACLE-CEP-HOME/user_
projects/domains/ocep_
domain/defaultserver/startwlevs.sh

Default on Windows: ORACLE-CEP-HOME\user_
projects\domains\ocep_
domain\defaultserver\startwlevs.cmd

Stop Script The script that Oracle CEP IDE for Eclipse uses to stop the Oracle CEP
server.

Default on UNIX: ORACLE-CEP-HOME/user_
projects/domains/ocep_
domain/defaultserver/stopwlevs.sh

Default on Windows: ORACLE-CEP-HOME\user_
projects\domains\ocep_
domain\defaultserver\stopwlevs.cmd
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Table 5-5 (Cont.) New Server: New Oracle CEP v11 Server Dialog Attributes for a Local

Attribute

Description

Debug Port

Server Name

User Name

User Password

Automatic Publishing

The Oracle CEP server port that Oracle CEP IDE for Eclipse connects
to when debugging the Oracle CEP server.

Default: 8453.

The name of the Oracle CEP server.
Default: Oracle CEP v11

The user name Oracle CEP IDE for Eclipse uses when logging into the
Oracle CEP server.

Default: wlevs.

The user password Oracle CEP IDE for Eclipse uses when logging into
the Oracle CEP server.

Default: wlevs.

By default, when you change an application, you must manually
publish the changes to the Oracle CEP server.

Select Use Workspace Default to configure Oracle CEP IDE for Eclipse
to automatically publish changes to the Oracle CEP server.

Default: Disabled.

10. Click Finish.

11. If you configured Automatic Publishing to Use Workspace Default, select
Windows > Preferences.

The Preferences dialog appears as Figure 5-7 shows.

Figure 5-7 Preferences - Server

|type Filter bext

General
Ant
Connectivity
Help
InstalljUpdate
Inkernet
Java

IPA
Mylyn
Plug-in Dreveloprment
Run/Debug

Audio
Installed Runtimes
Launching

S0L Development

Team

Yalidation

Web and XML

Web Services

#Doclek

@

Server L=l
Shaw Servers view when server state changes
[13ynchronize servers on workbench startup
Automatically publish to local servers
Publishing inkerval {in seconds):
Automatically publish to remote servers
Publishing interval {in seconds):
Prompt before making irreversible changes within an editor
Server timeout delay:
[Restore Defaults ] [ Apphy ]
[ OK ] [ Cancel ]

12. Select the Server option.
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13. Configure your automatic publishing options:

= Automatically publish to local servers: enable or disable this option, as
required.

Default: enabled.

— Publishing interval: configure the frequency at which the Oracle CEP IDE
for Eclipse publishes changes to the server (in seconds).

Default: 60 seconds.

= Automatically publish to remote servers: enable or disable this option, as
required.

Default: enabled.

— Publishing interval: configure the frequency at which the Oracle CEP IDE
for Eclipse publishes changes to the server (in seconds).

Default: 60 seconds.
14. Click OK.

5.2.2 How to Create a Remote Oracle CEP Server and Server Runtime

This section describes how to create both a remote server and server runtime. After
creating the initial server and server runtime, you can create additional server
runtimes.

A remote Oracle CEP server is one in which the server and server runtime are on
different hosts. The server is on a remote host and the server runtime is on the local
host (the host on which you are executing the Oracle CEP IDE for Eclipse).

Alternatively, you can create a local server and server runtime.
For more information, see:
s Section 5.2.3, "How to Create an Oracle CEP Server Runtime"

m  Section 5.2.1, "How to Create a Local Oracle CEP Server and Server Runtime"

To create a remote Oracle CEP server and server runtime:
1. Select Window > Show View > Servers.

The Servers view appears as shown in Figure 5-1.

Figure 5-8 Oracle CEP IDE for Eclipse Server View

b Servers £3 e o B |

Server State Status

R T

2. Right-click in the Servers view pane and select New > Server.
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3. Consider whether or not server runtimes have been created:

a. If this is the first time you have created an Oracle CEP server, there will be no
installed server runtimes. Proceed to step 4.

b. If this is not the first time you have created an Oracle CEP server, there will be
one or more installed server runtimes. Proceed to step 5.

4, If this is the first time you have created an Oracle CEP server, there will be no
installed server runtimes:

In this case, the New Server: Define New Server dialog appears as Figure 5-2
shows.

Figure 5-9 New Server: Define New Server Dialog (No Installed Runtimes)

LJ New Server, |z|@@

Define a New Server
Choose the type of server to create

Server's host name: | localhost

Download additional server adapters
Select the server type:

bype filker texk

+- (= Basic A

+-[= IBM

+-[== JBoss

+- (= ObjectWeb

= (= Oracle
el Cracle CEP vi1.1
E Oracle ©C4] Standalone Server 10,1.3
B Oracle OC4] Standalone Server 10.1.3.0

Supports controlling Oracle CEP Servers. Allows starting)'stopping the server, and deploving
applications,

Server name: Oracle CEP v11.1 at localhosk
v
@

Configure the new server as follows:

a. Configure the dialog as shown in Table 5-2.

Table 5-6 New Server: Define New Server Dialog (No Installed Runtimes) Attributes

Attribute Description
Server’s host name The host name of the computer on which you installed Oracle
CEP server.

For development, this will typically be localhost.

Select the server type The type of Oracle CEP server.

In this example, choose Oracle CEP v11l
Server name The name of this Oracle CEP server.

Default: Oracle CEP v11.1 at HOSTNAME

Where HOSTNAME is the value you entered in the Server’s host
name field.
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b. Click Next.

The New Server: New Oracle CEP v11 Runtime dialog appears as shown in

Figure Figure 5-3.

Figure 5-10 New Server: New Oracle CEP v11.1 Runtime Dialog

LF New Server |:|@@

New Dracle CEP v11.1 Runtime

Define a new Oracle CEF 11,1 runtime

Oracle Middleware Home Directory:

JRE:

@

‘ou can use [nstalled JRE preferences ko create a new JRE
Default JRE v

T

-

Erowse. ..

Cancel

c. Configure the dialog as shown in Table 5-3.

Table 5-7 New Server: New Oracle CEP v11 Runtime Dialog Attributes

Attribute

Description

Oracle Middleware Home
Directory

The fully qualified path to the Oracle CEP server installation
directory. This is the same as the "Middleware Home" that was
selected when installing the server.

When selecting this directory, select the directory that contains
the Oracle CEP installation rather than the Oracle CEP directory
itself. For example, choose:

C:\OracleCEP

But do not choose:
C:\OracleCEP\ocep_11.1

The runtime wizard will use the installation to find the
appropriate Oracle CEP installation directory.

For more information, see "Oracle Fusion Middleware Directory
Structure and Concepts" in the Oracle Complex Event Processing
Getting Started.
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Table 5-7 (Cont.) New Server: New Oracle CEP v11 Runtime Dialog Attributes

Attribute

Description

JRE

The type of JRE to use.

Select the type of JRE to use from the pull-down menu or click
the Installed JRE preferences link to create a new JRE.

Be sure to choose a Java 6 JRE.

NOTE: The Oracle CEP server JRE is ultimately set by the
JAVA_HOME setting in setDomainEnv.cmd or
setDomainEnv. sh script in the server domain directory.

d. Proceed to step 6.

5. If this is not the first time you have created an Oracle CEP server, there will be one
or more installed server runtimes.

In this case, the New Server: Define New Server dialog appears as Figure 5-4

shows.

Figure 5-11 New Server: Define New Server (Installed Runtimes) Dialog

f

Seleck the server bype:

type filter bext

+-[= Objectweb
== Cracle
&l oracle cEP w111

applications.

Server runtime: | Oracle CEP w11

: - [5]x]
Define a New Server =

Choose the kvpe of server ko create

Server's host name: | localhost w

[ Oracle 0C41Standalone Server 10,1.3
Oracle ©C4] Standalone Server 10.1.3.1 b
Supports controling Oracle CEP Servers, Allows startingfskopping the server, and deploving

Download additional server adapters

w | | Installed Runtimes. ..

[ Mexk = H Finish H Cancel

Configure the new server as follows:

Table 5-8 New Server: Define New Server (Installed Runtimes) Dialog Attributes

Attribute

Description

Server’s host name

Select the server type

The host name of the computer on which you installed Oracle
CEP server.

For development, this will typically be localhost.

The type of Oracle CEP server.

In this example, choose Oracle CEP v1l.
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Table 5-8 (Cont.) New Server: Define New Server (Installed Runtimes) Dialog Attributes

Attribute Description

Server runtime Select the server runtime from the pull-down menu.

To create or edit server runtimes, click Installed Runtimes. For
more information, see Section 5.2.3, "How to Create an Oracle
CEP Server Runtime".

6. Click Next.

The New Server: New Oracle CEP v11.1 Server dialog appears as Figure 5-5
shows.

Figure 5-12 New Server: New Oracle CEP v11.1 Server

¥ New Server |:|@@

New Oracle CEP v11.1 Server —
Define a new Oracle CEP v11.1 server \g

A local server executes on this machine. In addition to deploving and undeploving applications, vou can also start, stop,
and debug the local server process.

A remote server executes on a maching on a network accassible by this machine. Instead of controlling the server
process, vou can only attach bo an already running remote server, Java debugging is not available For remate servers.

(®) Local Server
O Remote Server

'/‘?' | <Back || Mext: ][ Finish ][ Cancel

7. Select Remote Server.
8. Click Next.

The New Server: New Oracle CEP v11 Server dialog appears dialog appears as
Figure 5-13 shows.
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Figure 5-13 New Server: New Oracle CEP v11 Server Dialog for a Remote Server

{5} New Server

New Oracle CEP v11.1 Server —

Define a new Oracle CEP v11.1 server X a i

1

..
Remate Server [P Address: | 141.144.201.166 |
Remate Server Pork: | 00z |
User Marme: | wlevs |
User Password: | wlevs |

3 : 7
@) [ <Back || mext» | [ Finish ] [ Cancel

9. Configure the dialog as shown in Table 5-9.

Table 5-9 New Server: New Oracle CEP v11 Server Dialog Attributes for a Local Server

Attribute Description

Remote Server IP Address The IP address of the remote Oracle CEP server.
Default: IP address of localhost.

Remote Server Port The port you specified in the remote Oracle CEP server
DOMAIN_DIR/config/config.xml file that describes your
Oracle CEP domain, where DOMAIN_DIR refers to your domain
directory.

The port number is the value of the Port child element of the
Netio element:

<Netio>
<Name>NetI0</Name>
<Port>9002</Port>
</Netio>

Default: 9002

User Name The user name that the Oracle CEP IDE for Eclipse uses to log
into the remote server.

Default: wlevs

User Password The password that the Oracle CEP IDE for Eclipse uses to log
into the remote server.

Default: wlevs

10. Click Finish.
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5.2.3 How to Create an Oracle CEP Server Runtime

Before you can create a server, you must configure the Oracle CEP IDE for Eclipse with
the location of your Oracle CEP server installation by creating a server runtime using
the runtime wizard. You can access the runtime wizard from several places including
the new server wizard, the new project wizard, and the workspace preferences dialog.

You only need to create a runtime explicitly if you have not yet created an Oracle CEP
server.

For more information, see:
m  Section 5.2.1, "How to Create a Local Oracle CEP Server and Server Runtime"

s Section 5.2.2, "How to Create a Remote Oracle CEP Server and Server Runtime"

To create an Oracle CEP server runtime:
1. Select Windows > Preferences.

The Preferences dialog appears as Figure 5-14 shows.

Figure 5-14 Preferences - Server - Installed Runtimes

1} Preferences

| | Server Runtime Environments

General
Ant
[rata Management Server runtime environments:
Help
InstaljUpdate
Java
JavaEE
Oracle CEP Problem Severities
Plug-in Developrment
Remaote Systems
Run/Debug
[=)- Server
Audio
Launching
Profilers
Runkime Environments
Tasks
Tearm
Terminal
Usage Data Colleckar
Walidation
Web
Web Services
“Doclet
HML

Add, remove, or edit server runtime environments,

Mame Type Add...

(‘?\' [ [o]4 H Cancel ]

2. Expand the Server option and select Runtime Environments.
3. Click Add.

The New Server Runtime Environment dialog appears as shown in Figure 5-15.
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Figure 5-15 New Server Runtime Environment Dialog

L} New Server, Runtime Environment |:|@@
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4. Configure the dialog as shown in Table 5-10.

Table 5-10 New Server Runtime Dialog Attributes

Attribute

Description

Select the type of runtime
environment

Create a new local server

The type of Oracle CEP server.

In this example, choose Oracle CEP v11.1.

Optionally, check this to create a new local server if you have not
yet created a server. For more information, see Section 5.2.1,
"How to Create a Local Oracle CEP Server and Server Runtime".

5. Click Next.

The New Server Runtime Environment dialog appears as shown in Figure 5-16.
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Figure 5-16 New Server Runtime Environment: New Oracle CEP v11.1 Runtime Dialog
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6. Configure the dialog as shown in Table 5-11.

Table 5-11

New Server Runtime Dialog Attributes

Attribute

Description

Oracle Middleware Home
Directory

JRE

The fully qualified path to the Oracle CEP server installation
directory. This is the same as the "Middleware Home" that was
selected when installing the server.

When selecting this directory, select the directory that contains
the Oracle CEP installation rather than the Oracle CEP directory
itself. For example, choose:

C:\OracleCEP

But do not choose:
C:\OracleCEP\ocep_11.1

The runtime wizard will use the installation to find the
appropriate Oracle CEP installation directory.

For more information, see "Oracle Fusion Middleware Directory
Structure and Concepts" in the Oracle Complex Event Processing
Getting Started.

The type of JRE to use.

Select the type of JRE to use from the pull-down menu or click
the Installed JRE preferences link to create a new JRE.

Be sure to choose either JRockit Real Time or the JRockit JDK
installed with your Oracle CEP installation.

7. Click Finish.

5-18 Oracle Complex Event Processing Developer's Guide



Managing Oracle CEP Servers

5.3 Managing Oracle CEP Servers

Using the Oracle CEP IDE for Eclipse and the Oracle CEP Visualizer accessible from
the Oracle CEP IDE for Eclipse, you can manage many aspects of your Oracle CEP
server during development.

This section describes the following Oracle CEP server management tasks you can
perform from the Oracle CEP IDE for Eclipse:

= Section 5.3.1, "How to Start a Local Oracle CEP Server"

= Section 5.3.2, "How to Stop a Local Oracle CEP Server"

= Section 5.3.3, "How to Attach to an Existing Local Oracle CEP Server Instance"

= Section 5.3.4, "How to Attach to an Existing Remote Oracle CEP Server Instance"
= Section 5.3.5, "How to Detach From an Existing Oracle CEP Server Instance"

= Section 5.3.6, "How to Deploy an Application to an Oracle CEP Server"

= Section 5.3.7, "How to Configure Connection and Control Settings for Oracle CEP
Server"

= Section 5.3.8, "How to Configure Domain (Runtime) Settings for Oracle CEP
Server"

m  Section 5.3.9, "How to Start the Oracle CEP Visualizer from Oracle CEP IDE for
Eclipse"

5.3.1 How to Start a Local Oracle CEP Server

After you create a local server, you can start the Oracle CEP server from the Oracle
CEP IDE for Eclipse.

You can also start the local Oracle CEP server in debug mode.

Alternatively, you can start the local Oracle CEP server from the command line and
attach to it using Oracle CEP IDE for Eclipse.

For more information, see:
m Section 5.2.1, "How to Create a Local Oracle CEP Server and Server Runtime"

= Section 5.4.1, "How to Debug an Oracle CEP Application Running on an Oracle
CEP Server"

= Section 5.3.3, "How to Attach to an Existing Local Oracle CEP Server Instance"

To start a local Oracle CEP server:
1. Select Window > Show Views > Servers.

The Servers view opens as shown in Figure 5-17.
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Figure 5-17 Starting an Oracle CEP Server

[LProbIems 4k Servers 3 B console #}3 () G ElE! =8
Server State Status
B Oracle CEP w11 = Stopped - s

Cpen

¥ Delete
Rename

5 Debug

h | D start

2. Start the server by choosing one of the following;:
a. Click the Start the Server icon in the Servers view tool bar.
b. Right-click a server in the Servers view and select Start.

After starting the server you will see log messages from the server in the Console
view.

5.3.2 How to Stop a Local Oracle CEP Server

After you start a local Oracle CEP server from the Oracle CEP IDE for Eclipse, you can
stop the Oracle CEP server from the Oracle CEP IDE for Eclipse.

For more information, see Section 5.3.1, "How to Start a Local Oracle CEP Server".

To stop a local Oracle CEP server:
1. Select Window > Show Views > Servers.

The Servers view opens as shown in Figure 5-18.

Figure 5-18 Stopping an Oracle CEP Server
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2. Stop the server by choosing one of the following:
a. Click the Stop the Server icon in the Servers view tool bar.

b. Right-click a server in the Servers view and select Stop.
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5.3.3 How to Attach to an Existing Local Oracle CEP Server Instance

After you create a local server, you can start the local Oracle CEP server from the
command line and attach Oracle CEP IDE for Eclipse to this existing, already running
local Oracle CEP server instance.

Alternatively, you can start the local Oracle CEP server directly from within Oracle
CEP IDE for Eclipse.

For more information, see:
s Section 5.2.1, "How to Create a Local Oracle CEP Server and Server Runtime"

m Section 5.3.1, "How to Start a Local Oracle CEP Server"

To attach to an existing local Oracle CEP server instance:
1. Start the Oracle CEP server from the command line.

For more information, see "Starting and Stopping Oracle CEP Servers" in the
Oracle Complex Event Processing Administrator’s Guide.

2. Select Window > Show Views > Servers.

The Servers view opens as shown in Figure 5-17.

Figure 5-19 Attaching to an Existing Local Oracle CEP Server Instance
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3. Attach to the already running local server by choosing one of the following:
a. Click the Start the Server icon in the Servers view tool bar.
b. Right-click a server in the Servers view and select Start.

The Attach to Running CEP Server dialog appears as Figure 5-20 shows.

Figure 5-20 Attach to Running CEP Server

& Attach to Running CEP Server?

9 4 Arunning Oracle CEP server was Found on port 9002, Do you wank to attach
o/ tothis server in run mode?

4. Click Yes.

After attaching to the server you will not see log messages from the server in the
Console view.

Oracle CEP IDE for Eclipse and Oracle CEP Servers 5-21



Managing Oracle CEP Servers

You can view the server console using the Oracle CEP Visualizer. For more
information, see "How to View Console Output" in the Oracle Complex Event
Processing Visualizer User’s Guide.

5.3.4 How to Attach to an Existing Remote Oracle CEP Server Instance

After you create a remote server, you can start the remote Oracle CEP server from the
command line and attach Oracle CEP IDE for Eclipse to this existing, already running
remote Oracle CEP server instance.

For more information, see Section 5.2.2, "How to Create a Remote Oracle CEP Server
and Server Runtime".

To attach to an existing remote Oracle CEP server instance:
1. Start the remote Oracle CEP server from the command line.

For more information, see "Starting and Stopping Oracle CEP Servers" in the
Oracle Complex Event Processing Administrator’s Guide.

2. Select Window > Show Views > Servers.

The Servers view opens as shown in Figure 5-17.

Figure 5-21 Attaching to an Existing Remote Oracle CEP Server Instance
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3. Attach to the already running remote server by choosing one of the following:
a. Click the Start the Server icon in the Servers view tool bar.
b. Right-click a server in the Servers view and select Start.

After attaching to the remote server, Oracle CEP IDE for Eclipse writes one status
message to the Console view, reading;:

[3/23/10 12:32 PM] Attached to remote CEP server at address 10.11.12.13 and
port 9002

You will not see log messages from the remote server in the Console view.

You can view the server console using the Oracle CEP Visualizer. For more
information, see "How to View Console Output” in the Oracle Complex Event
Processing Visualizer User’s Guide.

5.3.5 How to Detach From an Existing Oracle CEP Server Instance

After you attach to an existing, running Oracle CEP server instance, you can detach
from the Oracle CEP server and leave it running.

For more information, see:
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= Section 5.3.3, "How to Attach to an Existing Local Oracle CEP Server Instance”

= Section 5.3.4, "How to Attach to an Existing Remote Oracle CEP Server Instance"

To detach from an existing Oracle CEP server instance:
1. Select Window > Show Views > Servers.

The Servers view opens as shown in Figure 5-18.

Figure 5-22 Stopping an Oracle CEP Server
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2. Detach from the server by choosing one of the following:
a. Click the Stop the Server icon in the Servers view tool bar.
b. Right-click a server in the Servers view and select Stop.

Oracle CEP IDE for Eclipse detaches from the Oracle CEP server instance. The
Oracle CEP server instance continues to run.

If you detach from a remote Oracle CEP server, Oracle CEP IDE for Eclipse writes
a log message to the Console view reading:

[3/23/10 12:47 PM] Server communication stopped

5.3.6 How to Deploy an Application to an Oracle CEP Server

A project in the Oracle CEP IDE for Eclipse is built as an Oracle CEP application, then
deployed to the server. To deploy an application, a server must first be defined. To
then deploy an application, simply add it to the server. The application will be
deployed immediately if the server is already started, or when the server is next
started if the server is stopped.

For more information, see:
m Section 5.2.1, "How to Create a Local Oracle CEP Server and Server Runtime"

s Section 5.2.2, "How to Create a Remote Oracle CEP Server and Server Runtime"

To deploy an application to an Oracle CEP server:
1. Create an Oracle CEP project (see Section 4.2, "Creating Oracle CEP Projects").

2. Create a server (see Section 5.2.1, "How to Create a Local Oracle CEP Server and
Server Runtime").

3. Select Window > Show Views > Servers.

The Servers view opens as shown in Figure 5-23.
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Figure 5-23 Adding a Project to an Oracle CEP Server
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4. Right-click the server and select Add and Remove.
The Add and Remove dialog appears as shown in Figure 5-24.

Figure 5-24 Add and Remove Dialog
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5. Configure the dialog as Table 5-12 shows.

Table 5-12 Add and Remove Dialog Attributes

Attribute Description

Available Select one or more projects from this list and click Add or Add
All to move them into the Configured list.
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Table 5-12 (Cont.) Add and Remove Dialog Attributes

Attribute Description

Configured Select one or more projects from this list and click Remove or
Remove All to move them into the Available list.

If server is started, publish ~ Check this option to immediately publish projects that you
changes immediately. modify. Applicable only if the server is already running.

6. Click Finish.

Once an application is added, it will show as a child of the server in the Servers
view as shown in Figure 5-25.

Figure 5-25 Server View After Adding a Project
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7. To deploy (publish) the application to the Oracle CEP server, right-click the added
application and select Force Publish.

a. If the Oracle CEP server is part of a standalone-server, domain the application
is deployed.

b. If the Oracle CEP server is part of a multi-server domain, the Select Cluster
Deployment Group Name dialog appears as Figure 5-26 shows.

Figure 5-26 Select Cluster Deployment Group Name Dialog
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Select the cluster deployment group you want to deploy the application to and
click OK.

For more information on clustering, see "Introduction to Multi-Server
Domains" in the Oracle Complex Event Processing Administrator’s Guide.
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Once an application is deployed (published), it will show as a child of the server in

the Servers view as shown in Figure 5-27.

Figure 5-27 Server View After Deploying (Pub
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5.3.7 How to Configure Connection and Control Settings for Oracle CEP Server

After you create a server, you can use the Server Overview editor to configure all the
important server connection and control settings that Oracle CEP IDE for Eclipse uses

to communicate with the Oracle CEP server.

For more information, see:

s Section 5.2.1, "How to Create a Local Oracle CEP Server and Server Runtime"

= Section 5.3.8, "How to Configure Domain
Server"

(Runtime) Settings for Oracle CEP

To configure connection and control settings for Oracle CEP server:

1. Select Window > Show Views > Servers.

2. Double-click a server in the Servers view.

The Server Overview editor opens as shown in Figure 5-28.

Figure 5-28 Server Overview Editor
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3. Configure the Server Overview editor as s
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Table 5-13 Server Overview Editor Attributes

Attribute

Description

Server Name

Host Name

Runtime Enviroment

Domain Directory1

Start Script1

Stop Script!

Debug Port!

Remote Server IP Address®

The name of this server. Only used within the Oracle CEP IDE

for Eclipse as a useful identifier.

For more information, see Section 5.2.1, "How to Create a Local

Oracle CEP Server and Server Runtime".

The name of the host on which this server is installed.

For more information, see Section 5.2.1, "How to Create a Local

Oracle CEP Server and Server Runtime".

The current installed runtime selected for this server.

Select a new runtime from the pull down menu or click the Edit

link to modify the configuration of the selected runtime.

For more information, see Section 5.2.1, "How to Create a Local

Oracle CEP Server and Server Runtime".

The fully qualified path to the directory that contains the
domain for this server.

Click Browse to choose the directory.

Default: ORACLE-CEP-HOME\user_
projects\domains\ocep_domain\defaultserver.

The script that Oracle CEP IDE for Eclipse uses to start the
Oracle CEP server.

Click Browse to choose the start script.

Default on UNIX: ORACLE-CEP-HOME\user_
projects\domains\ocep_
domain\defaultserver\stopwlevs.sh

Default on Windows: ORACLE-CEP-HOME\user_
projects\domains\ocep_
domain\defaultserver\stopwlevs.cmd

The script that Oracle CEP IDE for Eclipse uses to stop the
Oracle CEP server.
Click Browse to choose the stop script.

Default on UNIX: ORACLE-CEP-HOME\user_
projects\domains\ocep_
domain\defaultserver\startwlevs.sh

Default on Windows: ORACLE-CEP-HOME\user_
projects\domains\ocep_
domain\defaultserver\startwlevs.cmd

The Oracle CEP server port that Oracle CEP IDE for Eclipse
connects to when debugging the Oracle CEP server.

Default: 8453.
The IP address of the remote Oracle CEP server.
Default: IP address of localhost.
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Table 5-13 (Cont.) Server Overview Editor Attributes

Attribute

Description

Remote Server Port?

User Name?

User Password?

Publishing

Timeouts

The port you specified in the remote Oracle CEP server
DOMAIN_DIR/config/config.xml file that describes your
Oracle CEP domain, where DOMAIN_DIR refers to your domain
directory.

The port number is the value of the Port child element of the
Netio element:

<Netio>
<Name>NetIO</Name>
<Port>9002</Port>
</Netio>

Default: 9002

The user name that the Oracle CEP IDE for Eclipse uses to log
into the remote server.

Default: wlevs

The password that the Oracle CEP IDE for Eclipse uses to log
into the remote server.

Default: wlevs

By default, when you change an application, you must manually
publish the changes to the Oracle CEP server.

Select Never publish automatically to disable automatic
publishing.

Select Override default settings to override the default
automatic publishing interval. Enter a new publishing interval
(in seconds).

Default: Never publish automatically.
Enter a positive, integer number of seconds in the Start (in

seconds) field to specify the time in which the Oracle CEP server
must start.

Default: 150 seconds.

Enter a positive, integer number of seconds in the Stop (in
seconds) field to specify the time in which the Oracle CEP server
must start.

Default: 60 seconds.

1 Click Local Server to modify. Applies to both a local server and the runtime of a remote server.
2 Click Remote Server to modify. Applies only to a remote server.

4. Select File > Save.

5. Close the Server Overview editor.

5.3.8 How to Configure Domain (Runtime) Settings for Oracle CEP Server

After you create a server, you can use the Oracle CEP IDE for Eclipse to configure
Oracle CEP server domain (runtime) settings in the Oracle CEP server config.xml

file.

Recall that a local Oracle CEP server is one in which both the server and server
runtime are on the same host and a remote Oracle CEP server is one in which the
server and server runtime are on different hosts: the server is on a remote host and the
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server runtime is on the local host (the host on which you are executing the Oracle
CEP IDE for Eclipse).

For both local and remote Oracle CEP servers, when you configure domain (runtime)
settings, you are modifying only the Oracle CEP server config.xml on the local host.

You can also use the Oracle CEP IDE for Eclipse to configure all the important server
connection and control settings that Oracle CEP IDE for Eclipse uses to communicate
with the Oracle CEP server.

Any changes you make to the Oracle CEP server config.xml file for a running
Oracle CEP server are not read by the Oracle CEP server until you restart it.

If you make changes to the Oracle CEP server config.xml file for a running Oracle
CEP server using the Oracle CEP Visualizer, the changes apply to the running Oracle
CEP server as soon as you save them. The Oracle CEP Visualizer updates the Oracle
CEP server config.xml file and overwrites the current filesystem version of that file
with the current, in-memory version.

If you make changes to the Oracle CEP server config.xml file by manually editing
this file, and you then make further changes using the Oracle CEP Visualizer, your
manual edits will be overwritten by the Oracle CEP Visualizer.

To avoid this, when you manually edit the Oracle CEP server config.xml file,
always stop and start the Oracle CEP server to read those changes into the runtime
configuration and then use the Oracle CEP Visualizer to make further changes.

For more information, see:
»  Section 5.2.1, "How to Create a Local Oracle CEP Server and Server Runtime"
s Section 5.2.2, "How to Create a Remote Oracle CEP Server and Server Runtime"

= Section 5.3.7, "How to Configure Connection and Control Settings for Oracle CEP
Server"

s Section 5.3.9, "How to Start the Oracle CEP Visualizer from Oracle CEP IDE for
Eclipse"

s "Understanding Oracle CEP Server Configuration" in the Oracle Complex Event
Processing Administrator’s Guide

To configure domain (runtime) settings for Oracle CEP server:
1. Select Window > Show Views > Servers.

2. Right-click a server in the Servers view and select Open Domain Configuration
File as shown in Figure 5-29.
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Figure 5-29 Editing the Domain Configuration File
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The Oracle CEP server domain configuration file config.xml opens as shown in
Figure 5-30.

Figure 5-30 Oracle CEP Domain Configuration File config.xml
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<netiox
<name>NetI0</ name>
<port>9002Z</port>
<fnetiox

<netiox
<name>ss 1Net Io</ name>
<szl-config-bean-name>sslConfig</ssl-config-hean-name>
<port>9003</ports

</netiox

<work-manager:>
<name>JettyWorkManager </ name >
<min-threads-constraint>5</min-threads-constraints> A
< >
Design | Source
3. Edit the domain configuration file as required.
4. Select File > Save.

5. Close the domain configuration file.

5.3.9 How to Start the Oracle CEP Visualizer from Oracle CEP IDE for Eclipse

After you create a server, you can start the Oracle CEP Visualizer from the Oracle CEP
IDE for Eclipse.
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The Oracle CEP Visualizer is the administration console for a running Oracle CEP
server. For more information, see the Oracle Complex Event Processing Visualizer
User's Guide.

For more information, see Section 5.2.1, "How to Create a Local Oracle CEP Server and
Server Runtime".

Note: If you use the Oracle CEP Visualizer to make changes to the
Oracle CEP server config.xml (for example, editing a data source),
you may overwrite config.xml file changes made manually. For more
information, see Section 5.3.8, "How to Configure Domain (Runtime)
Settings for Oracle CEP Server".

To start the Oracle CEP Visualizer from Oracle CEP IDE for Eclipse:
1. Start the server (see Section 5.3.1, "How to Start a Local Oracle CEP Server").

2. Right-click the running server in the Servers view and select Open CEP Visualizer
as shown in Figure 5-31.

Figure 5-31 Opening the Oracle CEP Visualizer
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The Oracle CEP Visualizer opens as shown in Figure 5-32.
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Figure 5-32 Oracle CEP Visualizer
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3. Use the Oracle CEP Visualizer as the Oracle Complex Event Processing Visualizer

User’s Guide describes.

5.4 Debugging an Oracle CEP Application Running on an Oracle CEP

Server

Because Oracle CEP applications are Java applications, standard Java debugging tools
including those provided in Eclipse can be used with these applications.

This section describes:

= Section 5.4.1, "How to Debug an Oracle CEP Application Running on an Oracle
CEP Server"

You can also use the load generator and csvgen adapter to simulate data feeds for
testing. For more information, see Chapter 25, "Testing Applications With the Load
Generator and csvgen Adapter".

5.4.1 How to Debug an Oracle CEP Application Running on an Oracle CEP Server

This section describes how to debug an Oracle CEP application running on an Oracle
CEP server.
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To debug an Oracle CEP application running on an Oracle CEP server:
1. Set a breakpoint in the Java code you wish to debug.

In this case, set the breakpoint by right-clicking in the gutter of the editor and
selecting Toggle Breakpoint as Figure 5-33 shows.

Figure 5-33 Setting a Breakpoint
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2. Select Window > Show Views > Servers.

3. Start the server in debug mode by choosing one of the following as shown in
Figure 5-34:

a. Click the Start the Server in debug mode icon in the Servers view tool bar.

b. Right-click a server in the Servers view and select Debug.

Figure 5-34 Starting the Oracle CEP Server in Debug Mode
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4. The server will start, and when it gets to your breakpoint the thread will stop.

If the Oracle CEP IDE for Eclipse does not automatically switch to the Debug
perspective, switch to that perspective by selecting Window > Open Perspective >
Other and selecting the Debug option from the list of perspective.

5. Debug your application using the Debug perspective.

Note: Insome cases you may get a dialog box warning that it could
not install a breakpoint because of missing line number information.
This dialog comes from the core Eclipse debugger and is normally a
harmless issue with Oracle CEP Service Engine applications. Simply
check the Don't Tell Me Again checkbox and continue debugging.
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6. When you are finished you can stop the server as usual (see Section 5.3.2, "How to
Stop a Local Oracle CEP Server").
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Oracle CEP IDE for Eclipse and the Event
Processing Network

The Oracle CEP Event Processing Network (EPN) is the central concept in an Oracle
CEP application. It is the primary point where application components are wired
together. Using Oracle CEP IDE for Eclipse, you can use an EPN Editor that provides a
graphical view of the EPN and offers visualization and navigation features to help you
build Oracle CEP applications.

This section describes how to use the editor and the information it displays, including:
= Section 6.1, "Opening the EPN Editor"

m  Section 6.2, "EPN Editor Overview"

= Section 6.3, "Navigating the EPN Editor"

= Section 6.4, "Using the EPN Editor"

6.1 Opening the EPN Editor

You can open the EPN Editor from either the project folder or a context or
configuration file of an Oracle CEP application.

6.1.1 How to Open the EPN Editor from a Project Folder

You can open the EPN Editor from the Eclipse project folder of an Oracle CEP
application. Alternatively, you can open the EPN Editor from a context or
configuration file (see Section 6.1.2, "How to Open the EPN Editor from a Context or
Configuration File").

To open the EPN Editor from a project:
1. Launch the Oracle CEP IDE for Eclipse.

2. Open your Oracle CEP project in the Project Explorer.
3. Right-click the project folder and select Open EPN Editor as Figure 6-1 shows.
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Figure 6—-1 Opening the EPN Editor from a
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The EPN Editor opens in a tab named

Project

8% 70

4

EPN: PROJECT-NAME, where

PROJECT-NAME is the name of your Oracle CEP project, as Figure 6-2 shows.

Figure 6—-2 EPN Editor
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6.1.2 How to Open the EPN Editor from a Context or Configuration File

You can open the EPN Editor from a Spring context file or an Oracle CEP server
configuration file in an Oracle CEP application. Alternatively, you can open the EPN
Editor from a context or configuration file (see Section 6.1.1, "How to Open the EPN
Editor from a Project Folder")

To open the EPN Editor from a context or configuration file:
1. Launch the Oracle CEP IDE for Eclipse.

2. Open your Oracle CEP project in the Project Explorer.

3. Right-click a context or configuration file and select Open in EPN Editor as
Figure 6-3 shows.

Figure 6-3 Opening the EPN Editor from a Context or Configuration File
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The EPN Editor opens in a tab named EPN: PROJECT-NAME, where
PROJECT-NAME is the name of your Oracle CEP project, as Figure 6—4 shows.
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Figure 6—4 EPN Editor
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6.2 EPN Editor Overview

This section describes the main controls you use to manage the EPN view and how the
EPN Editor displays Oracle CEP application information, including:

ms  Section 6.2.1, "Flow Representation"

= Section 6.2.2, "Filtering"

= Section 6.2.3, "Zooming"

= Section 6.2.4, "Layout”

= Section 6.2.5, "Showing and Hiding Unconnected Beans"
= Section 6.2.6, "Printing and Exporting to an Image"

= Section 6.2.7, "Configuration Badging"

= Section 6.2.8, "Link Specification Location Indicator"

= Section 6.2.9, "Nested Stages"

= Section 6.2.10, "Event Type Repository Editor"

6.2.1 Flow Representation

The primary display in the editor is of the flow inside the application as Figure 6-5

shows.
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Figure 6-5 EPN Flow Representation
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The EPN is composed of nodes connected by links and streams. Nodes are of various
types including adapter, processor, database table, bean, and cache. For more
information on the graphic notation the EPN Editor uses on nodes, links, and streams,
see:

= Section 6.2.7, "Configuration Badging"

= Section 6.2.8, "Link Specification Location Indicator"

6.2.2 Filtering

Although you often specify your EPN in a single assembly file, you may specify an
EPN across multiple assembly files.

By default the EPN Editor shows the EPN for a single Oracle CEP application bundle
with the information combined from all files.

To see the network for a single assembly file simply select that file from the Filter

pull-down menu as Figure 6-6 shows.

Figure 6—6 Filtering the EPN by Assembly File

[5h EPM: signal_generation 53 =0

Filter: = Full EPM &t a7 [1o0% S
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algo_trading, contesxt, xml &
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cachel
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When editing an EPN, the assembly file shown in the EPN Editor filter is the assembly
file to which new nodes will be added. If the EPN Editor filter is set to Full EPN then
the first assembly file in the filter list will be the file to which new nodes will be added.
Existing nodes will be edited in or deleted from the assembly file in which they are
defined.

If the assembly file the EPN Editor edits is open in an Eclipse source editor, then the
edits will be made to the editor for that open file. In this case, you will need to save
changes to the open editor before the changes appear in the file on disk.
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If the assembly file the EPN Editor edits is not open in an Eclipse source editor, then
the edits are immediately applied to the file on disk.

For more information, see Section 4.3, "Creating EPN Assembly Files".

6.2.3 Zooming

You can change the zoom level of the EPN Editor by entering a percent value into the
zoom field or selecting a value from the zoom field pull-down menu as Figure 6-7
shows. To fit the EPN into the current EPN Editor window, select Fit to Window.

Figure 6—-7 Zoom Level
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6.2.4 Layout

You can optimize and simplify the EPN layout by clicking Layout EPN as Figure 6-8
shows.

Figure 6—-8 Optimize Layout
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6.2.5 Showing and Hiding Unconnected Beans

You can also filter out <bean> elements with no references in the EPN. Clicking
Show/Hide Unconnected Beans will toggle the visibility of such beans as Figure 6-9
shows. For more information, see Section 6.4.3, "Laying Out Nodes".
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Figure 6-9 Show/Hide Unconnected Beans
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6.2.6 Printing and Exporting to an Image

You can export the EPN Editor view to an image file by clicking Export to Image as
Figure 6-10 shows. You can export the image asa .bmp, .gif, . jpg, or .png file.

Figure 6—10 Exporting the EPN as an Image File
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You can print the EPN Editor view by clicking Print as Figure 6-11 shows.

Figure 6—11 Printing the EPN
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6.2.7 Configuration Badging

Nodes that have configuration information in one of the configuration files in the
META-INF/wlevs directories are badged with an indicator on the bottom right as
Figure 6-12 shows.
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Figure 6-12 Configuration Badging

outStream
algoTradingProcessor

Nodes with this badge will also have the Go To Configuration Source context menu
item.

6.2.8 Link Specification Location Indicator

When working with streams, you can specify a link in the assembly file as a:

= source element in the downstream node.

= listener element in the upstream node

A circle on the line indicates where a particular link is specified in the assembly file.

Figure 6-13 shows an example in which the link is specified as a source element on the
downstream node outStream so the circle is next to the out Stream node.
Figure 6-14 shows the corresponding assembly file.

Figure 6-13 Link Source

= filkered3traam
filkerFanoutProcessor

Figure 6—14 Link Source Assembly File

<wlevs:processor 1d="hsRRA3 S R-bTaRbied s ol
</wlevs:processor>

<wleva:channel id="filtereditream”
event-type="FilteredPriceEvent ">
<wlewvs:listener ref="bhaProcessor™ /&
<wleva:listener ref="analyticsProcessor™ />
<wlevs:source ref="filterFanoutProcessor™ />
</wlevs:channels
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Figure 6-15 shows an example in which the link is specified as a listener element in the
upstream node algoTradingProcessor so the circle is next to the
algoTradingProcessor node. Figure 6-16 shows the corresponding assembly file.

Figure 6-15 Link Listener

o
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P —
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= CrossRateStream
FindCrossRates
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Figure 6—16 Link Listener Assembly File

<wlewvs:processor id=")3ks
<wlevs:listener ref

provider="cogl™:
CrossRateStresam"/ >
</wlevs:processor>

<wlewvs:channel id="CrossBEateStream” event-type="SpreaderCuputEvent” advertise="true:
<wlevs:listensr ref="swmwarizeResults™/ >
<wlevsz:listeners
<hean class="cow.oracle.cep.sample.fx.0utputBean” autowvire="bylame™/ >
<fwlevs: listeners
</wlevs:channels>

6.2.9 Nested Stages

When you define a child node within a parent node, the child node is said to be
nested. Only the parent node can specify the child node as a listener. You can drag
references from a nested element, but not to them. For more information, see
Section 6.4.2, "Connecting Nodes".

Consider the EPN that Figure 6-17 shows. Example 61 shows the EPN assembly
source for this EPN. Note that the HelloWorldBean is nested within the
helloworldOutputChannel. As a result, it appears within a box in the EPN
diagram. Only the parent helloworldOutputChannel may specify the nested bean
as a listener.

Figure 6—-17 EPN With Nested Bean

hellowerldInputChannel 6= helloworldOutputChannel
helloworldadapter hellowarldProcessor HelloWorldBean

Example 6-1 Assembly Source for EPN With Nested Bean

<wlevs:adapter id="helloworldAdapter"
class="com.bea.wlevs.adapter.example.helloworld.HelloWorldAdapter" >

<wlevs:instance-property name="message" value="HelloWorld - the current time is:"/>
</wlevs:adapter>

<wlevs:channel id="helloworldInputChannel" event-type="HelloWorldEvent" >
<wlevs:listener ref="helloworldProcessor"/>
<wlevs:source ref="helloworldAdapter"/>

</wlevs:channel>

<wlevs:processor id="helloworldProcessor" />

<wlevs:channel id="helloworldOutputChannel" event-type="HelloWorldEvent" advertise="true">
<wlevs:listener>
<bean class="com.bea.wlevs.example.helloworld.HelloWorldBean" />
</wlevs:listener>
<wlevs:source ref="helloworldProcessor"/>
</wlevs:channel>

Alternatively, you can define this EPN so that all nodes are nested as Figure 6-18
shows. Example 6-2 shows the EPN assembly source for this EPN. Note that all the
nodes are nested and as a result, all nodes appear within a box in the EPN diagram.
The helloworldAdapter is the outermost parent node and does not appear within a
box in the EPN diagram.
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Figure 6—-18 EPN With all Nodes Nested
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Example 6-2 Assembly Source for EPN With all Nodes Nested

<wlevs:adapter id="helloworldAdapter" class="com.bea.wlevs.adapter.example.helloworld.HelloWorldAdapter" >
<wlevs:instance-property name="message" value="HelloWorld - the current time is:"/>
<wlevs:listener>
<wlevs:channel id="helloworldInputChannel" event-type="HelloWorldEvent" >
<wlevs:listener>
<wlevs:processor id="helloworldProcessor">
<wlevs:listener>
<wlevs:channel id="helloworldOutputChannel" event-type="HelloWorldEvent">
<wlevs:listener>
<bean class="com.bea.wlevs.example.helloworld.HelloWorldBean" />
</wlevs:listener>
</wlevs:channel>
</wlevs:listener>
</wlevs:processor>
</wlevs:listener>
</wlevs:channel>
</wlevs:listener>
</wlevs:adapter>

6.2.10 Event Type Repository Editor

You can create and edit JavaBean and tuple event types using the event type repository
editor.

To open the event type repository editor, click on the Event Types tab in the EPN
editor as Figure 6-19 shows.

Figure 6—19 Event Type Repository Editor
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Crverview Event Types

For more information, see:
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»  Section 2.2.1, "How to Create an Oracle CEP Event Type as a JavaBean Using the
Event Type Repository Editor"

s Section 2.3.1, "How to Create an Oracle CEP Event Type as a Tuple Using the
Event Type Repository Editor"

For information on the other types of events you can create, see Section 1.1.2, "Oracle
CEP Event Types".

6.3 Navigating the EPN Editor

Because the EPN Editor has a view of the whole project it is a natural place from which
to navigate to the various artifacts that make up an Oracle CEP application. Oracle
CEP IDE for Eclipse offers the following features to help navigate the EPN Editor:

= Section 6.3.1, "Moving the Canvas"

= Section 6.3.2, "Shortcuts to Component Configuration and EPN Assembly Files"
= Section 6.3.3, "Hyperlinking"

s Section 6.3.4, "Context Menus"

= Section 6.3.5, "Browsing Oracle CEP Types"

6.3.1 Moving the Canvas

To move the EPN canvas without using the horizontal and vertical scroll bars, you can
use any of the following options:

= Position the cursor on the canvas, hold down the middle mouse button, and drag.
=  Hold down the space bar and click and drag the canvas.

s In the Overview view, click in the highlight box and drag.

6.3.2 Shortcuts to Component Configuration and EPN Assembly Files

If a node has a configuration object associated with it, then double-clicking that node
will open the component configuration file where that node's behavior is defined.

Otherwise, double-clicking that node will open the EPN assembly file (the Spring
context file) where that node is defined.

A configuration badge will be shown on nodes with associated configuration objects
as shown in Figure 6-20.

Figure 6—-20 Node with Configuration Badge

an
exampleProcessamithConfig

For more information, see:
= Section 6.2.7, "Configuration Badging"
= Section 6.3.3, "Hyperlinking"
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6.3.3 Hyperlinking

When editing a component configuration file, EPN assembly file, or Oracle CQL
statement, hold down the Ctrl key to turn on hyperlinking. Using hyperlinking, you
can easily move between assembly and configuration files and follow reference IDs to
jump to bean implementation classes.

This section describes:

= Section 6.3.3.1, "Hyperlinking in Component Configuration and EPN Assembly
Files"

= Section 6.3.3.2, "Hyperlinking in Oracle CQL Statements"

6.3.3.1 Hyperlinking in Component Configuration and EPN Assembly Files

Figure 6-21 shows a component configuration file with the cursor over the value of a
processor element name child element while holding down the Ctrl key. The name
value has an underline to indicate it is a hyperlink. Click this link to jump to the
corresponding element in the EPN assembly file as Figure 6-22 shows.

Figure 6-21 Component Configuration File: Hyperlinking to EPN Assembly File
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7 <rulesx i

=) <guery id="Yr3iZector™:><![CDATL]

9 select cusip, bid, srcld, bidQty, ask, askQty, seq from priceltream whe
10 11><fquerys

11 </ruless>

12 </processors>
13
l4<processors

15 <name>bbaProcessor</ name:

16 “rules:

17 <wiew id="laatEvents" schema="cusip bid sreld bidoty ask askQty seqts

18 select cusip, bid, srcld, bidQty, ask, askOty, seq

19 from filtered3tream[ srcld, cusip 1]

z0 11=<fviews

z1 <wiew id="hidask" schema="cusip bhid ask"><![CDATL[

22 zelect cusip, max(bid), min{ask)

Z3 from lastEvents

24 group by cusip v
< ¥

Design | Source

This figure shows a component configuration file with a processor element. The mouse
is hovering over the filterFanoutProcessor value of the name element. The name value
is underlined to indicate that it is a hyperlink.

B e R R R S R

Similarly, hovering over the wlevs: processor element id child element value
filterFanoutProcessor while holding down the Ctrl key allows you to hyperlink
back to the component configuration file.
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Figure 622 EPN Assembly File: Hyperlinking to Component Configuration File

Fﬁq’g EPM: CQLTesk |X| citipoc.context.ml £2 |X| com.oracle.cep.sample.fx. context, xml |X| citipoc,xml = m
a1 </wlevs:adapters> »
gz
83 <wlevs:channel id="priceStream” event-type="PriceEvent™:
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</wlevs:channel>
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<wlevs:processor id="filcerFanoutProcessor™ >
I
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<wlevs:channel id="filtered3tream™
event-type="FilteredPriceEwventc":
<wlevs:listener ref="bbaProcessor" />
<wlevs:listener ref="analyticsProcessor™ />
<wlevarsource ref="filterFanoutProcessor™ />
</wlevs:channel>

<!-— Explicitly specify provider CQOL -->
101 “wlevs:processor id="hhaProcessor™ provider="ocgl™:
10z <wleva:listener ref="bidliskBEAStream" />
103 </wlevs:processors
104 v

Design | Source

6.3.3.2 Hyperlinking in Oracle CQL Statements

Figure 6-23 shows a component configuration file with the cursor over an event
attribute while holding down the Ctrl key. The fromRate attribute has an underline
to indicate it is a hyperlink. Click this link to jump to the corresponding event
definition in the EPN assembly file as Figure 6-24 shows.

Note: Hyperlinking in Oracle SQL statements is designed for simple
use cases and may not work as expected in more complex
implementations.

Figure 6-23 Oracle CQL Statement: Event Schema

I3k EPM; CEPFx |X| spreader.xml 3 i m|
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<rulesx
<guery id="FindfrossREatesEule"s<!|[CDATL[
select [(a.price * b.price) + 0.05) as internalPrice,

a.fromPate as crossRatel,
b.tDRag jas crossRatez

from FxQuoteltream [ 1] a= a, FxQuoteltream [ 1] a= b
where

HOT (a.price IS HULL)
and

HOT (b.price IS HULL)

1] =</ querys

<frules>

</processors>
</nliconfigs

< >
Design | Source
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Figure 6-24 Corresponding Event Definition in EPN Assembly File
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<wlevs:property name="symbol" type=Tchar" /> ~
</wlevs:properties>
</wlevs:event—type:
wwlevs:event-type type-name="CrossRateEvent™s
“wlewvs:propertises:
<wlevs:property name="price™ type="Tdouble"™ />
<WleVS:property nsme=" [4=" type="char™ />
<wlevs:property name="toRate" type=Tchkar" />
</wlevs:propertiess
</wlevs:event—types
“wlewvs:event-type type-name="SpreaderluputEvent ™

<wleva:properties type="iuple™
<wlevs:property name="internglPrice™ type="double™ /»
<WlEVS:property name="crosskatel™ type="char"™ />
<wlevs:property name="crossEatelf" type="ckar" />
</wlevs:propertiess
</wlevsievent—types
<wlewvs:event-type type-name="CrossrateSummarvEvent s
<wlevs:properties>
<wlevs:property name="arveragelnternalPrice”™ type="doukle™ />
<wlevs:property name="crossRatePair™ type="char" />
<wlevs:property name="totelCount" type="Tint" />

Design | Source

Similarly, you can Ctrl-click the FxQuoteStream channel in the Oracle CQL
statement that Figure 6-23 shows to jump to the channel’s definition. This is applicable
wherever references to external objects are present in a Oracle CQL statement.

6.3.4 Context Menus

Each node on the EPN Editor has a group of context menu items that provide
convenient access to various node-specific functions. Right-click the node to display its
context menu.

Depending on the node type, you can use the EPN Editor context menu to select from
the following options:

= Go to Configuration Source: opens the corresponding component configuration
file and positions the cursor in the appropriate element. You can use hyperlinking
to quickly move from this file to the corresponding EPN assembly file. For more
information, see Section 6.3.3, "Hyperlinking".

= Go to Assembly Source: opens the corresponding EPN assembly file and
positions the cursor in the appropriate element. You can use hyperlinking to
quickly move from this file to the corresponding component configuration file. For
more information, see Section 6.3.3, "Hyperlinking"

= Go to Java Source: opens the corresponding Java source file for this component.

s Delete: deletes the component from both the EPN assembly file and component
configuration file (if applicable).

= Rename: allows you to change the name of the component. The name is updated
in both the EPN assembly file and component configuration file (if applicable).

= Help: displays context sensitive help for the component.

Note that these navigation options will become disabled when a corresponding source
artifact cannot be found. For example, if an adapter does not have a corresponding
entry in a configuration XML file, its Go to Configuration Source menu item will be
greyed out.
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6.3.5 Browsing Oracle CEP Types

A typical Oracle CEP project contains many instances of Oracle CEP types such as

adapters, channels, processors, event beans. In a large, complex Oracle CEP project, it

can be a challenge to locate a particluar instance. The Oracle CEP IDE for Eclipse

provides an Oracle CEP type browser that you can use to quickly locate instances of

any Oracle CEP type.

6.3.5.1 How to Browse Oracle CEP Types
You can open the Oracle CEP type browser using the keyboard short cut Ctrl-Alt-T.

To browse Oracle CEP types:
1. Open an Oracle CEP project.

In the following procedure, consider the Oracle CEP project that Figure 6-25
shows. This is based on the Oracle CEP foreign exchange example. For more

information on this example, see "Foreign Exchange (FX) Example" in the Oracle

Complex Event Processing Getting Started.

Figure 6-25 Example Oracle CEP

EPN

1} Java EE - CEPFx - Eclipse
File Edit Mavigate Search Project Run  Window Help

i Wi %0 Q-
: <::| -
L5 Project Explorer &2 = <«===(>

(=83 com.oracke.cep,sample.
+ m MarketEvent. java
£ m OutputBean.java
[#-m8, JRE System Lbrary [JavasE-1.6]
[#-m, OCEP Classpath
build
META-INF
=z spring
|X| com.oracle.cep.sample.Fx.context, xml
=2 wlevs
|X] PubSubadapterConfiguration.ml
|| spreader.xml

X SummarizeResults, xml
4 MANIFEST MF
lavd build, properties
@ bundle.properties
startDataFeed, cnd

B G- @O

o ¥ = O G epn: cePRx £

Filter: = Bu...| ¥ &b a1 [100%
Filker&merStream

FxMarketamer
Filterasiastream

FxMarketisia

EilkavF1 weSheazrn

>

Overview | Event Types

[l markers | =] Properties | 47 Servers 23

E‘@ Oracle CEP w11.1 at lacalhost [Stopped]

&
= E m ))1 = E
= | H = e
cevTeskData A e S :
v
2
wData Source Explorer | [ Snippets 8
% 0 ¢ -

2. Type the keyboard short cut Ctrl-Alt-T.

The Oracle CEP type browser appears as Figure 6-26 shows.
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Figure 6-26 Oracle CEP Type Browser

5] Open CEP Type

Select an item o open (7 = any character, * = any string): -

| Filter* |

Makching items:

“hFilterfmer
O FilterAmerStream

O FilberEuroStream

‘::, Filterfsia - C:/edipse-galilea-projects/ CEPFx/META-INF /spring) com. oracle. cep. sample. Fx. context. xml

@j [ O H Cancel ]

3. Configure the Oracle CEP Type dialog as shown in Table 6-1.

Table 6—-1 Oracle CEP Type Dialog

Attribute Description

Select an item to open Specify a filter to match the names of the items you wan to find.

Use the ? wildcard for any single character and the * wildcard
for any string of two or more characters.

Matching items The list of Oracle CEP type instances whose name matches the
filter you specified.

By default, the status line below the Matching items list shows the fully qualified
path to the selected item in the Select an item to open list. To toggle status line
display, click on the pull-down menu in the right hand corner and select Show
Status Line.

4. Select a type in the Matching Items list and click OK.

The type is opened in the source file in which it is defined. For example, selecting
FilterAsia from the Matching Items list and clicking OK opens the
com.oracle.cep.sample. fx.content.xml EPN assembly file in which this
processor is defined as Figure 6-27 shows.
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Figure 6-27 Opening the FilterAsia EPN Assembly File

4F Java EE - CEPEX/META-INF/spring/com.oracle.cep.sample. fx.context.xml - Eclipse
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= b‘JCEPFx in a real application —-> R e [ i
B sre <wlevs:channel id="Fil ter}ls?_lastre?m 5 -[€] beans w &
=3 com.oracle.cep.sample.fx <wlevs:listener ref="Filterdsia"/ > [&] wiev
m MarketEvent.java </wlevs:channels> 0. #eoor
[1] outputBean.java <wlevs:processor id="lg ;" prowvic |°E| wlev
B IRE System Library [JavasE-1.6] <wlevs:listener ref="FxQuoteStream' U eor
Y -
B0, OCEP Classpath </ Wlevs:iprocessors [&] wlew
(= build [&] wilew
5= META-INF <wlevs:adapter id="faMarketEuro™ provic [E] wlev
(== spring <wlevs:instance-property name="port 0 #eor
. L
|| com,oracle,cep,sample.fx,context.xml <wlevs:listenser ref="FilterFuroStre [&] wlev
= Eb\:\;tlevs b : . | </wlevs:adaprers [E] wiev
K] PubSubAdapterConfiguration. xml [B] wlew
%] spreader.xml < !-— This processor is siwply here to £ U weor
X i . i i ic. B -
@ 1X] SummarizeResults, xml to make it appear more reslistic. It wo [€] wiev
g MANIFEST MF < > - Ta] e
@: build. properties Design | Source < >

bundle.properties

startDataFeed.cmd & Markers | £ Properties 4l Sepvers B3 m Data Sourc | F=1 Snippets @ Progress |

t5 0 o B

E‘g iOracle CEP v11,1 at localhost [Stopped] §

iy Ditems selected

To navigate to the corresponding component configuration file as Figure 6-28
shows, Ctrl-click the FilterAsia id attribute value.

Figure 6-28 Opening the FilterAsia Component Configuration File

% Java EE - CEPFX/META-INFhwlevs/spreader.xml - Eclipse

File Edit Source Mavigate Search Project Run Window Help

i-HE i %-0-Q- (B - 6 8o - @i R HN B | ¢9 JvaE |
SRR R R
[[\:,Project Explorer &3 g:p @ i |X| com.oracle,cep.sampl \X| spreader.xml &3 il T 21
= bd CEPF:x <guery id="AmerFilterCrossRates -
= src </rules> 27 ;<m|
=3 com.oracle.cep.sample. </processor> =-[&] nicarfig xr
m MarketEvent.java <processors [&] process:
[3] outputBean.java @&
. process
B, JRE System Library [JavasE-1.6] <rules:> [&] nam
B, OCEP Classpath <view id="EurTolpy" schema="1zs & rule:
(= build select lastPrice, svmbol from F [&] process
== META-INF 11=</views [ process
== spring <view id="EurTofpyPre" schema="'
|| com,oracle,cep,sample.fx,context.xml select avg(lastPrice)] as price,
== wlevs from EurTodpy
%] PubSubadapterConfiguration.xml where lastPrice < 200.0 and las
%] spreader.xml 11 »</views
] SummarizeResults, xml <guery id="AsiagFilterCrossRates™
I MANIFEST MF 3 >
@ build. properties Design | Source < >

bundle.properties

startDataFeed.cmd [2_‘ Markers | =1 Properties 4L Servers 52 m Data Sourc | = Snippets @J Progress e

£ L
F‘g Cracle CEP vw11.1 at localhaost [Stopped]

:¢ nl:configiprocessoriname/#text ‘Writable Smart Insert 15: 25

For more information on hyperlinking, see Section 6.3.3, "Hyperlinking".
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6.4 Using the EPN Editor

The EPN Editor allows you to create and edit an application's EPN using actions on
the editor surface. Most actions in the EPN Editor result in edits to an assembly file in
that application. You can use a single EPN assembly file or multiple EPN assembly
files (for more information, see Section 6.2.2, "Filtering").

The following sections describe EPN Editor editing tasks, including;:
= Section 6.4.1, "Creating Nodes"

= Section 6.4.2, "Connecting Nodes"

= Section 6.4.3, "Laying Out Nodes"

= Section 6.4.4, "Renaming Nodes"

= Section 6.4.5, "Deleting Nodes"

For more information, see:

= Section 4.1, "Oracle CEP Project Overview"
m  Section 6.2, "EPN Editor Overview"

= Section 6.1, "Opening the EPN Editor"

= Section 6.3, "Navigating the EPN Editor"

6.4.1 Creating Nodes

When adding new nodes to an EPN using the EPN editor, a new node will appear at
the location of the mouse click that was used to show the EPN Editor context menu.
You can create any of the nodes that Table 6-2 lists.

Table 6-2 EPN Editor Icons

Node Description

Yo Adapter: a node that interfaces an event data source with the EPN or interfaces
“ the EPN with an event data sink.

For more information, see:

»  Section 6.4.1.2, "How to Create an Adapter Node"

»  Chapter 7, "Configuring J]MS Adapters"

= Chapter 8, "Configuring HTTP Publish-Subscribe Server Adapters"
»  Chapter 14, "Configuring Custom Adapters"

»  Chapter 25, "Testing Applications With the Load Generator and csvgen
Adapter"

GRS Channel: a node that conveys events between an event data source and an event
data sink.

For more information, see:
s Section 6.4.1.1, "How to Create a Basic Node"

s Chapter 9, "Configuring Channels"

7o Processor: a node that executes Oracle CQL or EPL rules on the event data
- offered to it by one or more channels.

-

For more information, see:

s Section 6.4.1.3, "How to Create a Processor Node"
s Chapter 10, "Configuring Oracle CQL Processors"
= Chapter 11, "Configuring EPL Processors"
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Table 6-2 (Cont.) EPN Editor Icons

Node Description
'S Event Bean: a node similar to a standard Spring bean except that it can be
@ managed by the Oracle CEP management framework and can actively use the

capabilities of the Oracle CEP server container.
For more information, see:
s Section 6.4.1.1, "How to Create a Basic Node"

s Chapter 15, "Configuring Custom Event Beans"

. Spring Bean: a Plain Old Java Object (POJO) node that consumes events. A
& Spring bean is managed by the Spring framework.

For more information, see:
s Section 6.4.1.1, "How to Create a Basic Node"

s Chapter 16, "Configuring Custom Spring Beans"

Cache: a node that provides a temporary storage area for events, created
exclusively to improve the overall performance of your Oracle CEP application.

For more information, see:
s Section 6.4.1.1, "How to Create a Basic Node"
s Chapter 12, "Configuring Caching"

Table: a node that connects a relational database table to the EPN as an event

L)
T a data source.

For more information, see:

s Section 6.4.1.1, "How to Create a Basic Node"

-

= Section 10.3, "Configuring an Oracle CQL Processor Table Source”

The user may not reposition the nodes on the EPN Editor. To refresh the layout of the
nodes on the EPN Editor, click the Layout EPN button on the EPN Editor toolbar. For
more information, see Section 6.4.3, "Laying Out Nodes".

When a child node is nested within a parent node, its icon appears within a box. For
more information, see Section 6.2.9, "Nested Stages".

6.4.1.1 How to Create a Basic Node
Basic nodes include beans, caches, channels, event beans, and tables.

For information on how to create other nodes, see Section 6.4.1, "Creating Nodes".

To create a basic node:
1. Open the EPN Editor (see Section 6.1, "Opening the EPN Editor").

2. Right-click on an empty portion of the EPN Editor surface and select New from
the context menu as Figure 629 shows.
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Figure 6-29 Creating a Basic Node

@QEPN: SimpleProject &3 =0
Fiter: = Full EPM a% &1 100% = |.*.;1 =
adapterl BeanClass
Bean...
Help

Cache...

Event Bean... E!

Processar...
Table. ..

Crverview | Event Types

3. Select the type of node you want to create.

The EPN Editor edits the source file indicated in the EPN Editor filter and the EPN
Editor displays the new EPN node. For most nodes, a default ID is chosen and the
new node is immediately opened for rename as Figure 6-30 shows.

Figure 6-30 New Basic Node

@gEPN: SimpleProject &3 =8
Filker: v[}gullEPN &b AT 100% b |;';;J =
adapterl BeanClass

Crverview | Event Types

To rename the node, see Section 6.4.4, "Renaming Nodes".

To reposition the node and update the EPN Editor layout, see Section 6.4.3,
"Laying Out Nodes".

4. Optionally, configure additional node options.
See:
»  Chapter 9, "Configuring Channels"
= Section 10.3, "Configuring an Oracle CQL Processor Table Source"
s Chapter 12, "Configuring Caching"
»  Chapter 14, "Configuring Custom Adapters"
s Chapter 15, "Configuring Custom Event Beans"
»  Chapter 16, "Configuring Custom Spring Beans"

s Chapter 25, "Testing Applications With the Load Generator and csvgen
Adapter"
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6.4.1.2 How to Create an Adapter Node

This section describes how to create an adapter using the EPN Editor, including:
= JMS adapters (in-bound or out-bound)
»  HTTP publish-subscribe server adapters (publishing or subscribing)

For information on how to create other nodes, see Section 6.4.1, "Creating Nodes".

To create an adapter node:
1. Open the EPN Editor (see Section 6.1, "Opening the EPN Editor").

2. Right-click on an empty portion of the EPN Editor surface and select New from
the context menu as Figure 6-31 shows.

Figure 6-31 Creating an Adapter Node

@ EPM: SimpleProject &3 =8
Filter: = Full EPM AT AL | 100% = | ==
adapterl BeanClass

B T
Bean...

elp Cache...
Channel...
Event Bean...
Processar, ..
Table...

Crverview | Event Types

3. Select node type Adapter.
The New Adapter wizard appears as shown in Figure 6-32.

Figure 6-32 New Adapter Wizard

12 New Adapter EI@

Basic Adapter Information
Specify an ID, provider, and configuration lacation for the new adaptar, %

Adapter ID: | adapker |

Type:

(&) Provider:

Configuration location:

() Create a new File:

| adapter.xml |

(%) Use an existing configuration File:

|c0nfig.xml - |

@
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4. Configure the New Adapter Wizard - Page 1 as shown in Table 6-3.

Table 6-3 New Adapter Wizard - Page 1

Attribute Description

Adapter ID Specifies the ID of the adapter EPN element and the name
of the associated adapter configuration element.

Provider Select the adapter provider type from the pull-down menu
for an adapter already defined in the Oracle CEP
component configuration schema.

Select one of:

= jms-inbound: JMS in-bound adapter.

= jms-outbound: JMS out-bound adapter.

= httppub: HTTP publish-suscribe adapter for
publishing.

= httpsub: HTTP publish-suscribe adapter for
subscribing.

Class Specify the fully qualified Java class name of a custom

Create a new file

Use an existing configuration file

adapter.

NOTE: If you are using a custom adapter factory, you must
add the wlevs: factory element manually. For more
information, see Chapter 14, "Configuring Custom
Adapters".

Creates the adapter component configuration in a new file.

The new file is created in the application's
META-INF/wlevs directory with the same name as the
adapter ID.

Creates the adapter component configuration in an existing
configuration file.

The new adapter configuration element is appended to the
configurations in the selected file.

5. Proceed depending on how you configured the adapter implementation:

a. If you selected Class, Proceed to step 8.

b. If you selected Provider, proceed to step 6.

6. Click Next.

The provider-specific New Adapter Wizard page appears.

7. Configure the provider-specific New Adapter Wizard page as the following

figures show:

»  Figure 6-33, "New Adapter Wizard - jms-inbound"

See Section 7.6.1, "JMS Inbound Adapter Component Configuration".

»  Figure 6-34, "New Adapter Wizard - jms-outbound"

See Section 7.6.2, "JMS Outbound Adapter Component Configuration”.

»  Figure 6-35, "New Adapter Wizard - httppub”
See Section 8.5.1, "HTTP Pub-Sub Adapter for Publising Component

Configuration".

»  Figure 6-36, "New Adapter Wizard - httpsub"
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See Section 8.5.2, "HTTP Pub-Sub Adapter for Subscribing Component
Configuration”.

Figure 6-33 New Adapter Wizard - jms-inbound

T New A dapter @
Adapter Configuration "
Enter configuration values For this adapter,
Properties: Property Description:
Zonneckion Event Type
Event Type: |

Event type whose property
names match inbound JM3 Map
Message property names.

JNDI Provider URL:* |

JNDI Factory: | weblogic.jndi, WLInitialContextFactary Specify this property only if
wou want Oracle CEP ta
Connection JNDI Marne: | weblogic.jms. ConnectionFactary automatically perform the

conversion between JM35
messages and events, If you
have created your own custom
converter bean, then do not
specify this property,

() Destination JNDI Mame:* |

() Destination Mame:™* |

Security
User:

() Passwaord:

() Encrypted Password:

Connection User:

O Connection Password:

() Connection Encrypted Password:

Advanced

‘Wark Manager:

Concurrent Consumers:

Message Selectar: |

Session Acknowledgrnent Mode: | AUTO_ACKNOWLEDGE v

Session Transacted: O

* Required property

@
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Figure 6-34 New Adapter Wizard - jms-outbound

LF New A dapter @

Adapter Configuration

Enter configuration values For this adapter.

Propetties: Property Descripkion:
Conneckion Event Type
Event Type: |

| Event type whose property

| names match inbound JMS Map
Message property names,

| Specify this property only if

| wou wank Oracle CEP to

|

|

INDI Pravider URL:* |

JHDI Factory! | weblogic. jndi, WLInitislConkextFactory

Connection JMDI Mame: aukomatically perform the
corversion betwesn JM3
messages and events, If you
have created your own custom
converter bean, then do not
specify this property,

| weblogic. jms. ConnectionFactory

() Destination JNDI Mame:* |

() Destination Marme:* |

Security

User;

() Password:

() Encrypted Password:

Conneckion User;

O Connection Password:

() Connection Encrypted Password:

Advanced
Session Transacted: [ |

Delivery Mode: | persistent

* Required property

@

Mext = Finish

Figure 6-35 New Adapter Wizard - httppub

L New A dapter E
Adapter Configuration \%

Enter configuration values For this adapter,

Properties: Property Description:

Zonneckion

() Server URL:*

Channel:*

Event Type:

Security
User: | |

() Password: | |

() Encrypred Password: | |

* Required property

®
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Figure 6-36 New Adapter Wizard - httpsub

LF New A dapter

Adapter Configuration

Enter configuration values For this adapter.

Propetties:

Propetty Description:

Conneckion

Server URL

Server URL:* | |

| The Server URL is used when

Channel:* |

| publishing or subscribing to a remote
channel, i.e. a channel hosted by &

Event Type: |

| remate Pub-Sub server, The Server
URL identifies the remote Pub-Sub

Security

server, For example, a value such
as 'htp:ffmyhost, com: 2002 pubsub’

User: |

| could be used to idenkify the

Pub-5ub server running on hosk

() Passward: |

| ravhost.com at pork 9002,

() Encrypred Passwoard: |

@

* Required property

Cancel

8. Click Finish.

9. Use the new adapter node on the EPN.

The EPN Editor creates the adapter configuration in the file you specified in the
New Adapter wizard, edits the source file indicated in the EPN Editor filter, and
displays the new EPN node as Figure 6-37 shows.

Figure 6-37 New Adapter Node

[El EpM: SimpleProject 52

Filter: = Bundle: SimplePraject

o

hellowarldadapter

{ .

—_

helloworldInputChannel

adapter

<
Crverview | Event Types

=0
|? i -*-:I-*-;l =
- -

i hellowarldOutputChannel
helloworldProcessor

To rename the node, see Section 6.4.4, "Renaming Nodes".

To reposition the node and update the EPN Editor layout, see Section 6.4.3,

"Laying Out Nodes".
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10. Optionally, configure additional node options.
For more information, see:
s Chapter 7, "Configuring JMS Adapters"
s Chapter 8, "Configuring HTTP Publish-Subscribe Server Adapters"

6.4.1.3 How to Create a Processor Node

This section describes how to create a processor node using the EPN Editor. For
information on creating other node types, see Section 6.4.1.1, "How to Create a Basic
Node".

When deploying an Oracle CEP application with a wlevs:processor node, other
nodes in an EPN may reference that processor only if a processor configuration exists
for that processor. Processor configurations are defined in Oracle CEP application
configuration files. See Section 1.1.5, "Component Configuration Files" for more
information about CEP configuration files.

To create a processor node:
1. Open the EPN Editor (see Section 6.1, "Opening the EPN Editor").

2. Right-click on an empty portion of the EPN Editor surface and select New from
the context menu as Figure 6-38 shows.

Figure 6-38 Creating a Processor Node

5l EpM: SimpleProject 52 =0
Filter: = Full EPN a0 A% 100% 3| A =
8 '
%
adapteri Beanlass
Bean...
Help

Cache...
Channel...
Event Bean...

Table... k

Crverview | Event Types

3. Select node type Processor.

The New Processor dialog appears as shown in Figure 6-39.
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Figure 6-39 New Processor Dialog

& New Processor, fgl

¥
Specify an ID and configuration location for the new processor, '

Processor ID:
Configuration location:
() Create a new file:

processor,xml

() Use an existing configuration file:

@ [ Ok H Caneel ]

4. Configure the New Processor dialog as shown in Table 6—4.

Table 6—4 New Processor Dialog

Attribute Description

Processor ID Specifies the ID of the processor EPN element and the name
of the associated processor configuration element

Create a new file Creates the processor configuration in a new file.

The new file is created in the application's
META-INF/wlevs directory with the same name as the
processor ID.

Use an existing configuration file Creates the processor configuration in an existing
configuration file.

The new processor configuration element is appended to
the configurations in the selected file.

5. Click OK.

The EPN Editor creates the processor configuration in the file you specified in the
New Processor dialog, edits the source file indicated in the EPN Editor filter, and
displays the new EPN node as Figure 6—40 shows.

Figure 640 New Processor Node

[l Epn: SimpleProject 57 =0
Filter: V%ull EFN 2% a7 oo = H G
adapterl Beantlass

i

0

=

processar

Crverview | Event Types

To rename the node, see Section 6.4.4, "Renaming Nodes".

Oracle CEP IDE for Eclipse and the Event Processing Network 6-27



Using the EPN Editor

To reposition the node and update the EPN Editor layout, see Section 6.4.3,
"Laying Out Nodes".

Note: In Oracle CEP, you must use a channel to connect a push event
source to an Oracle CQL processor and to connect an Oracle CQL
processor to an event sink. For more information, see Section 9.1.2,
"Channels Representing Streams and Relations".

6. Optionally, configure additional processor options.
See:
s Chapter 10, "Configuring Oracle CQL Processors"
s Chapter 11, "Configuring EPL Processors"

6.4.2 Connecting Nodes

The nodes in the EPN represent the flow of events through an Event Processing
Network of an Oracle CEP application. When a node may forward events to another
node in the EPN, the EPN Editor allows you to connect that node visually by dragging
a line from the source node to the destination node.

6.4.2.1 How to Connect Nodes
This section describes how to connect nodes in the EPN Editor.

To connect nodes:
1. Open the EPN Editor (see Section 6.1, "Opening the EPN Editor").

2. Select the source of events and drag to the target of the event flow.
= If a connection is allowed, a plug icon is shown at the target end as

Figure 641 shows.

Figure 641 Connecting Nodes: Connection Allowed

Fq‘lg EPM: SimpleProject &3 =8

Fiter: ¥ Secondfssembly.context.xml A0 41| 100% = | &= =

Edapter

»  If the connection is not allowed, a forbidden icon is shown at the target end as
Figure 642 shows.

Crverview | Event Types
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Figure 6—42 Connecting Nodes: Connection Forbidden

@gEPN: SimpleProject &3 ¥| Secondassembly. contesxt, xml =08

Filter:

y

¥ SecondAssembly, context.xml &b AT 100% - = oE

o B

adapter

| %@O
Flimming 12

Crverview | Event Types

Not all nodes may be a target of event flow. For example, connection is
forbidden if:

— A node does not define a valid identifier.

- A node is nested (for more information, see Section 6.2.9, "Nested Stages").

3. Release the mouse button to complete the connection.

When the connection is made, the EPN Editor updates the EPN assembly file. For
example:

When you connect an adapter to a channel or a channel to a processor or event
bean, the EPN Editor adds a wlevs:1listener element to the source node
with a reference to the target node by ID.

When you connect a table to a processor, the EPN Editor adds a
wlevs:table-source element to the target processor node that references
the source table.

For example, suppose you connect the adapter to the channel, and the channel to
the processor shown in Figure 6-43.

Figure 6—43 Valid Connections

Fe

adapter

Processor

channel

Figure 6-44 shows the EPN assembly file before connection.

Figure 6-44 EPN Assembly File: Before Connection

<wlevs:adapter id="adapter" provider="httppuh™:
</ wlevs:adapters>

<wlevz:channel id="channel™:

</wlevs:channel>

<wlewvs:processor id="processor™:
</wlevs:processor:

Figure 6-45 shows the EPN assembly file after connection.
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Figure 645 EPN Assembly File: After Connection

<wlevs:adapter id="adapter" provider="httppuk™:
<wlevs:listener ref="channel"™ />
</ wlevs:adapters

<wlevs:channel id="channel™:
<wlevs:listener ref="processor" />
</ wlevs:channels

<wlevs:processor id="processor™:
</wWlEvs:processor>

6.4.3 Laying Out Nodes

Certain EPN Editor actions will use the location of the action as the location of the
rendered result. For example, when adding new nodes to an EPN using the EPN
editor, a new node will appear at the location of the mouse click that was used to show
the EPN Editor context menu. The user may not reposition the nodes on the EPN
Editor. To refresh the layout of the nodes on the EPN Editor, click the Layout EPN
button on the EPN Editor toolbar as Figure 6-46 shows.

Figure 6—46 Laying Out Nodes
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Crverview | Event Types

For more information, see Section 6.2.4, "Layout".

6.4.4 Renaming Nodes

Most node types support a rename operation that will change all references to the
node across both assembly and configuration XML files. You can select Rename from
the node’s context menu as Figure 6-47 shows.

Figure 6—47 Renaming Nodes

P Goto Assembly Source ‘

6.4.5 Deleting Nodes

You may delete most nodes and connections visible on the EPN Editor using the
node’s context menu or the Delete key:
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= Using the keyboard, select the object you want to delete and then click the Delete
key.

= Using the context menu, right-click on the object to show the context menu, then
select Delete as Figure 648 shows.

Figure 6—48 Deleting Nodes
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When deleting a node, the incoming and outgoing connections are also deleted. For
example, Figure 6-49 shows the EPN and Figure 6-51 shows the assembly file before
deleting the channel node named stream.

Figure 6-49 EPN Before Deleting a Channel Node
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Figure 6-50 Assembly File Before Deleting a Channel Node

<wlevs:adapter id="adapter"” provider="httppub™:>
<wlevs:listener ref="channel"™ />
</wlevs:adapters>

<wlevs:channel id="channel':
<wlewvs:listener ref="processor"™ />

</wlevs:channels

<wlevs:processor id="processor™:
</wlevs:processors>

Figure 6-51 shows the EPN and Figure 6-52 shows the assembly file after deleting this
channel node.
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Figure 6-51 EPN After Deleting a Channel Node
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Figure 6-52 Assembly File After Deleting a Channel Node

<wlewvs:adapter id="adapter”™ provider="httppub™:

</wlevs:iadapters

<wlews:processor id="processor™:
</ wWlevs:processors

Note: If a bean or other anonymous element is deleted, then the
object containing that object is deleted too. For example, given a
bean within a wlevs: listener element, then deleting the bean
will delete the 1istener element too.
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7

Configuring JMS Adapters

This section contains information on the following subjects:
= Section 7.1, "Overview of JMS Adapter Configuration"
»  Section 7.2, "Configuring a JMS Adapter for a JMS Service Provider"

= Section 7.3, "Creating a Custom Converter Between JMS Messages and Event
Types"

= Section 7.4, "Encrypting Passwords in the J]MS Adapter Component Configuration
File"

»  Section 7.5, "Configuring the JMS Adapter EPN Assembly File"
= Section 7.6, "Configuring the JMS Adapter Component Configuration File"

7.1 Overview of JMS Adapter Configuration

The Oracle CEP JMS adapters support any Java EE compliant JMS service provider
that provides a Java client. For more information, see Section 7.1.1, "JMS Service
Providers".

Oracle CEP provides the following Java Message Service (JMS) adapters that you can
use in your event applications to send and receive messages to and from a JMS
destination, respectively, without writing any Java code:

= Section 7.1.2, "Inbound JMS Adapter"
= Section 7.1.3, "Outbound JMS Adapter"

For general information about JMS, see Java Message Service on the Sun Developer
Network athttp://java.sun.com/products/jms/.

7.1.1 JMS Service Providers

The Oracle CEP JMS adapters support any Java EE compliant JMS service provider
that provides a Java client.

This chapter describes how to configure the Oracle CEP JMS inbound and outbound
adapters for use with the following JMS service providers:

= Section 7.2.3, "How to Configure a JMS Adapter for Oracle WebLogic Server JMS
Manually"

= Section 7.2.4, "How to Configure a JMS Adapter for Tibco EMS JMS Manually"

If your JMS service provider is not in this list, you can still configure Oracle CEP JMS
adapters for use with your JMS service provider. Review the procedure in
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Section 7.2.4, "How to Configure a JMS Adapter for Tibco EMS JMS Manually" as a
configuration model, consult your JMS service provider documentation, and adapt
this procedure to suit your JMS service provider.

For more information, see Section 7.2, "Configuring a JMS Adapter for a JMS Service
Provider".

7.1.2 Inbound JMS Adapter

The inbound JMS adapter receives messages from a JMS destination and converts
them into events.

You specify an inbound JMS adapter in the EPN assembly file as follows:

<wlevs:adapter id="myJdmsInbound" provider="jms-inbound">

</wlevs:adapter>

You configure an inbound JMS adapter in its component configuration file as follows:

<jms-adapter>
<name>myJms Inbound</name>
<jndi-provider-url>t3://localhost:7001</jndi-provider-url>
<destination-jndi-name>Queuel</destination-jndi-name>
<user>weblogic</user>
<password>weblogic</password>
<work-manager>JettyWorkManager</work-manager>
<concurrent-consumers>1</concurrent-consumers>
<session-transacted>false</session-transacted>
</jms-adapter>

This section describes:

s Section 7.1.2.1, "Conversion Between JMS Messages and Event Types"

= Section 7.1.2.2, "Single and Multi-threaded Inbound JMS Adapters"

For more information, see:

= Section 7.5.1, "IMS Inbound Adapter EPN Assembly File Configuration"
= Section 7.6.1, "JMS Inbound Adapter Component Configuration”

7.1.2.1 Conversion Between JMS Messages and Event Types

By default, the inbound JMS adapter can automatically converts J]MS messages into
events by matching property names with a specified event type if the following is true:

= You must specify an event type using the jms-adapter element event-type
child element in the JMS adapter component configuration file.

The JMS adapter converts incoming JMS messages into the Oracle CEP event type
this element specifies.

= JMS messages must be of type MapMessage.

For each incoming message, an event of the specified event type is created. For
each map element in the incoming message, the adapter looks for a property on
the event type and if found, sets the corresponding value.

Optionally, you may customize JMS message to event type conversion by writing your
own Java class to specify exactly how you want the incoming JMS messages to be
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converted into one or more event types. In this case, you do not specify an event type
using the jms-adapter element event-type child element in the JMS adapter
component configuration file.

For more information, see Section 7.3, "Creating a Custom Converter Between JMS
Messages and Event Types".

7.1.2.2 Single and Multi-threaded Inbound JMS Adapters

By default, an inbound JMS adapter is single-threaded. That is, the inbound JMS
adapter uses a single thread to read messages from the JMS destination.

When the inbound JMS adapter is single-threaded, event order is guaranteed.

To improve scalability, you can configure an inbound JMS adapter to use multiple
threads to read messages from the JMS destination. The simplest way to do this is to
configure the adapter with a work manager. You can specify a dedicated work
manager used only by the adapter or you can share a work manager amongst several
components such as other adapters and Jetty.

When the inbound JMS adapter is multi-threaded, event order is not guaranteed.
For more information, see:

s work-manager and concurrent-consumers in Table 7-1, " jms-adapter
Inbound Child Elements"

s Section 22.2.1, "EventPartitioner"

7.1.3 Outbound JMS Adapter

The outbound JMS adapter sends events to a JMS destination, automatically
converting the event into a JMS map message by matching property names with the
event type.

Typically, you also customize this conversion by writing your own Java class to specify
exactly how you want the event types to be converted into outgoing JMS messages.

If you do not provide your own converter class, and instead let Oracle CEP take care
of the conversion between messages and event types, the following is true:

= You must specify an event type using the jms-adapter element event-type
child element in the JMS adapter component configuration file.

The JMS adapter converts incoming JMS messages into the Oracle CEP event type
this element specifies.

s By default, the outbound JMS adapter default converter creates JMS messages of
type MapMessage. For each property of the event, a corresponding element is
created in the output MapMessage.

You specify an outbound JMS adapter in the EPN assembly file as follows:

<wlevs:adapter id="myJmsOutbound" provider="jms-outbound">

</wlevs:adapter>

You configure an outbound JMS adapter in its component configuration file as follows:

<jms-adapter>
<name>myJmsOutbound</name>
<event-type>JMSEvent</event-type>
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<jndi-provider-url>t3://localhost:7001</jndi-provider-url>

<destination-jndi-name>Topicl</destination-jndi-name>

<delivery-mode>nonpersistent</delivery-mode>
</jms-adapter>

For more information, see:
= Section 7.5.2, "IMS Outbound Adapter EPN Assembly File Configuration"
= Section 7.6.2, "IMS Outbound Adapter Component Configuration"

= Section 7.3, "Creating a Custom Converter Between JMS Messages and Event
Types."

7.2 Configuring a JMS Adapter for a JMS Service Provider

This section describes how to configure the Oracle CEP JMS inbound and outbound

adapters:
= Section 7.2.1, "How to Configure a JMS Adapter Using the Oracle CEP IDE for
Eclipse"

= Section 7.2.2, "How to Configure a JMS Adapter Manually"
This section provides examples specific to the following JMS service providers:

= Section 7.2.3, "How to Configure a JMS Adapter for Oracle WebLogic Server JMS
Manually"

= Section 7.2.4, "How to Configure a JMS Adapter for Tibco EMS JMS Manually"

If your JMS service provider is not in this list, and your JMS service provider offers a
Java client, then you can still configure Oracle CEP JMS adapters for use with your
JMS service provider. Review the procedure in Section 7.2.4, "How to Configure a JMS
Adapter for Tibco EMS JMS Manually" as a configuration model, consult your JMS
service provider documentation, and adapt this procedure to suit your JMS service
provider.

For more information, see Section 7.1.1, "JMS Service Providers".

Note: In the following sections, it is assumed that you have already
created an Oracle CEP application along with its EPN assembly file
and component configuration files, and that you want to update the
application to use an inbound or outbound JMS adapter. If you have
not, refer to Chapter 1, "Overview of Creating Oracle CEP
Applications" for details.

7.2.1 How to Configure a JMS Adapter Using the Oracle CEP IDE for Eclipse

The simplest way to create and configure a JMS adapter is using the Oracle CEP IDE
for Eclipse adapter wizard.

For more information, see Section 6.4.1.2, "How to Create an Adapter Node".

After using the adapter wizard to create and specify the basic J]MS adapter
configuration, review Section 7.2.2, "How to Configure a J]MS Adapter Manually" to
complete the configuration.
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7.2.2 How to Configure a JMS Adapter Manually

This section describes how to create and configure a JMS adapter manually. It
describes the detailed steps that you may require depending on your JMS adapter
application and service provider.

The simplest way to create and configure a JMS adapter is using the Oracle CEP IDE
for Eclipse adapter wizard as Section 7.2.1, "How to Configure a JMS Adapter Using
the Oracle CEP IDE for Eclipse" describes. After using the adapter wizard to create and
specify the basic JMS adapter configuration, review this procedure to complete the
configuration.

To configure a JMS adapter manually:

1. In the EPN assembly file of the application, add a wlevs :adapter element for
each inbound and outbound JMS adapter you want to use in your application.

Example 7-1 shows the wlevs:adapter element for a JMS inbound adapter.

Example 7-1 wlevs:adapter Element for Inbound Adapter

<wlevs:adapter id="inboundJmsAdapterl" provider="jms-inbound">
</wlevs:adapter>

See:
= Section 7.5.1, "JMS Inbound Adapter EPN Assembly File Configuration"
= Section 7.5.2, "JMS Outbound Adapter EPN Assembly File Configuration"

2. In the component configuration file of the application, add a jms-adapter
element for each inbound and outbound JMS adapter you want to use in your
application.

Example 7-2 shows the jms-adapter element for the JMS inbound adapter in
Example 7-1.

Example 7-2 jms-adapter Element for Inbound Adapter

<jms-adapter>
<name>inboundImsAdapterl</name>

</ims-adapter>
For each jms-adapter element, the name child element must be set to the
corresponding wlevs:adapter element id child element.
See:
= Section 7.6.1, "JMS Inbound Adapter Component Configuration”
= Section 7.6.2, "JMS Outbound Adapter Component Configuration”

3. Decide how you want to convert between JMS messages and Oracle CEP event
types:

a. If you want the JMS adapters to perform automatic conversion, specify an
event type using the jms-adapter element event-type child element in
the JMS adapter component configuration file.

See:
- Section 7.6.1, "JMS Inbound Adapter Component Configuration”
- Section 7.6.2, "JMS Outbound Adapter Component Configuration”
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b. If you want the JMS adapters to perform custom conversion, create a custom
converter Java class and register it in the EPN assembly file.

See Section 7.3, "Creating a Custom Converter Between JMS Messages and
Event Types".

4. Configure the jms-adapter elements for your JMS provider as Example 7-3
shows:

Example 7-3 jms-adapter Element With Tibco EMS JMS Configuration

<jms-adapter>
<name>inboundJmsAdapterl</name>

<jndi-provider-url> ... </jndi-provider-url>
<jndi-factory> ... </jndi-factory>
<connection-jndi-name> ... </connection-jndi-name>
<destination-jndi-name> ... </destination-jndi-name>

</jms-adapter>

For all options that the Oracle CEP JMS adapters support, see:

- Section 7.6.1, "JMS Inbound Adapter Component Configuration”
- Section 7.6.2, "JMS Outbound Adapter Component Configuration”
For specific JMS provider examples, see:

= Section 7.2.3, "How to Configure a JMS Adapter for Oracle WebLogic Server
JMS Manually"

= Section 7.2.4, "How to Configure a JMS Adapter for Tibco EMS JMS Manually"
For more information, see your JMS service provider documentation.

5. If you specify JMS provider client passwords in the component configuration file,
consider encrypting them.

See Section 7.4, "Encrypting Passwords in the JMS Adapter Component
Configuration File".

6. Create a JMS client application library that contains the following:
s The JMS client JAR files your JMS service provider documentation specifies.

= If you are using Java Object messages, the Java classes used for messaging
need to be packaged in a library bundle.

You may include these Java classes in this JMS client JAR application library.

Note: This JMS client JAR application library must:

=  Export all provider-specific packages.

= Export the Java classes used for messaging, if applicable.
s Import javax.jms and javax.naming.

The application bundle does not need to export the provider-specific
packages.

The application bundle must import Java classes used for messaging,
if applicable.

1

For more information, see Section 24.1.3.3, "Creating Application Libraries".
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For a specific JMS provider example, see Section 7.2.4, "How to Configure a JMS
Adapter for Tibco EMS JMS Manually".

7. Copy the JMS client JAR application library to the appropriate Oracle CEP server
application library directory:

a. If your bundle is a driver, you must put it in the library extensions directory.
See Section 24.1.3.2, "Library Extensions Directory".

b. If your bundle is not a driver, you may put it in the library directory.
See Section 24.1.3.1, "Library Directory"

For more information, see Section 24.3.4, "How to Update an Application Library
Using Oracle CEP IDE for Eclipse".

8. If you created a custom converter class in step 3, update the MANIFEST . MF file of
your application to add the following packages to the Import-Package header:

Import-Package: javax.jms,javax.naming, ...

See Section 4.7.5, "How to Import a Package".

7.2.3 How to Configure a JMS Adapter for Oracle WebLogic Server JMS Manually
Oracle CEP includes a WebLogic JMS client.

When connecting to Oracle WebLogic server, Oracle CEP uses the T3 client by default.

You can use the IIOP WebLogic client by starting Oracle WebLogic Server with the
-useIIOP command-line argument. This is a server-wide setting that is independent
of the JMS code being used (whether it is one of the provided adapters or custom JMS
code).

It is not possible to mix T3 and IIOP usage within a running Oracle CEP server.

For more information, see Section 7.2, "Configuring a JMS Adapter for a JMS Service
Provider".

You can manually configure the built-in JMS inbound and outbound adapter to use the
Oracle WebLogic Server JMS provider.

The simplest way to create and configure a JMS adapter is using the Oracle CEP IDE
for Eclipse adapter wizard as Section 7.2.1, "How to Configure a J]MS Adapter Using
the Oracle CEP IDE for Eclipse" describes. After using the adapter wizard to create and
specify the basic JMS adapter configuration, review this procedure to complete the
configuration.

To configure JMS adpaters for Oracle WebLogic Server JMS manually:

1. Update the EPN assembly file of the application by adding a wlevs:adapter
element for each inbound and outbound JMS adapter you want to use in your
application.

Example 7-4 shows the wlevs:adapter element for a JMS inbound adapter.

Example 7-4 wlevs:adapter Element for Inbound Adapter
<wlevs:adapter id="inboundJmsAdapterl" provider="jms-inbound">

</wlevs:adapter>

See:
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= Section 7.5.1, "IMS Inbound Adapter EPN Assembly File Configuration"
= Section 7.5.2, "IMS Outbound Adapter EPN Assembly File Configuration"

2. Update the component configuration file of the application by adding a
jms-adapter element for each inbound and outbound JMS adapter you want to
use in your application.

Example 7-5 shows the jms-adapter element for the JMS inbound adapter in
Example 7-4.

Example 7-5 jms-adapter Element for Inbound Adapter

<jms-adapter>
<name>inboundJmsAdapterl</name>

</jms-adapter>

For each jms-adapter element, the name child element must be set to the
corresponding wlevs:adapter element id child element.

See:
= Section 7.6.1, "JMS Inbound Adapter Component Configuration”
= Section 7.6.2, "JMS Outbound Adapter Component Configuration”

3. Decide how you want to convert between JMS messages and Oracle CEP event
types:

a. If you want the JMS adapters to perform automatic conversion, specify an
event type using the jms-adapter element event-type child element in
the JMS adapter component configuration file.

See:
- Section 7.6.1, "JMS Inbound Adapter Component Configuration”
- Section 7.6.2, "JMS Outbound Adapter Component Configuration"

b. If you want the JMS adapters to perform custom conversion, create a custom
converter Java class and register it in the EPN assembly file.

See Section 7.3, "Creating a Custom Converter Between JMS Messages and
Event Types".

4. Configure the jms-adapter elements for your Oracle WebLogic Server J]MS
provider.

Example 7-6 shows the jms-adapter elements for a JMS inbound and JMS
outbound adapter.

Example 7-6 jms-adapter Elements for an Oracle WebLogic Server JMS Provider

<jms-adapter>
<name>JmsInbound</name>
<event-type>SimpleMapEvent</event-type>
<jndi-provider-url>t3://localhost:7001</jndi-provider-url>
<destination-jndi-name>Queueln</destination-jndi-name>
<user>weblogic</user>
<password>welcomel</password>
<work-manager>JettyWorkManager</work-manager>
<concurrent-consumers>1</concurrent-consumers>
<session-transacted>false</session-transacted>
<delivery-mode>nonpersistent</delivery-mode>
</Jjms-adapter>
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<jms-adapter>
<name>JmsOutbound</name>
<event-type>SimpleMapEvent</event-type>
<jndi-provider-url>t3://localhost:7001</jndi-provider-url>
<destination-jndi-name>Queueln</destination-jndi-name>
<user>weblogic</user>
<password>welcomel</password>
<message-selector></message-selector>
<session-transacted>false</session-transacted>
<delivery-mode>nonpersistent</delivery-mode>
</Jjms-adapter>

See:
- Section 7.6.1, "JMS Inbound Adapter Component Configuration”
- Section 7.6.2, "JMS Outbound Adapter Component Configuration”

If you specify JMS provider client passwords in the component configuration file,
consider encrypting them.

See Section 7.4, "Encrypting Passwords in the JMS Adapter Component
Configuration File".

If you are using Java Object messages, you must create a JMS client application
library that contains the Java classes used for messaging need to be packaged in a
library bundle.

For more information, see Section 24.1.3.3, "Creating Application Libraries".

Note: This JMS client JAR application library must:
»  Export the Java classes used for messaging.
u hnpoﬁjavax.jmsandjavax.naming

The application bundle does not need to export provider-specific
packages.

The application bundle must import Java classes used for messaging,
if applicable.

If you are using Java Object messages, copy the Java classes for messaging
application library to the appropriate Oracle CEP server application library
directory:

a. If your bundle is a driver, you must put it in the library extensions directory.
See Section 24.1.3.2, "Library Extensions Directory".

b. If your bundle is not a driver, you may put it in the library directory.
See Section 24.1.3.1, "Library Directory"

For more information, see Section 24.3.4, "How to Update an Application Library
Using Oracle CEP IDE for Eclipse".

If you created a custom converter class in step 3, update the MANIFEST . MF file of
your application to add the following packages to the Import-Package header:

Import-Package: javax.jms,javax.naming,
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See Section 4.7.5, "How to Import a Package".

7.2.4 How to Configure a JMS Adapter for Tibco EMS JMS Manually
Oracle CEP supports TIBCO Enterprise Message Service (EMS) version 4.2.0 or higher.

To use the Tibco EMS JMS provider, you must add the following Tibco EMS client JAR
files to the Oracle CEP server library directory:

s tibjms.jar

For more information, see:

= Section 7.2, "Configuring a J]MS Adapter for a JMS Service Provider"
= Section 24.1.3.1, "Library Directory"

You can manually configure the built-in JMS inbound and outbound adapter to use the
Tibco EMS JMS provider.

The simplest way to create and configure a JMS adapter is using the Oracle CEP IDE
for Eclipse adapter wizard as Section 7.2.1, "How to Configure a JMS Adapter Using
the Oracle CEP IDE for Eclipse" describes. After using the adapter wizard to create and
specify the basic JMS adapter configuration, review this procedure to complete the
configuration.

To configure a JMS adpater for Tibco EMS JMS manually:

1. In the EPN assembly file of the application, add a wlevs :adapter element for
each inbound and outbound JMS adapter you want to use in your application.

Example 7-7 shows the wlevs:adapter element for a JMS inbound adapter.

Example 7-7 wlevs:adapter Element for Inbound Adapter

<wlevs:adapter id="inboundJmsAdapterl" provider="jms-inbound">
</wlevs:adapter>

See:
= Section7.5.1, "JMS Inbound Adapter EPN Assembly File Configuration"
= Section 7.5.2, "JMS Outbound Adapter EPN Assembly File Configuration"

2. In the component configuration file of the application, add a jms-adapter
element for each inbound and outbound JMS adapter you want to use in your
application.

Example 7-8 shows the jms-adapter element for the JMS inbound adapter in
Example 7-7.

Example 7-8 jms-adapter Element for Inbound Adapter

<jms-adapter>
<name>inboundImsAdapterl</name>

</jms-adapter>

For each jms-adapter element, the name child element must be set to the
corresponding wlevs :adapter element id child element.

See:

s Section 7.6.1, "IMS Inbound Adapter Component Configuration”
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= Section 7.6.2, "IMS Outbound Adapter Component Configuration"

3. Decide how you want to convert between JMS messages and Oracle CEP event
types:

a. If you want the JMS adapters to perform automatic conversion, specify an
event type using the jms-adapter element event-type child element in
the JMS adapter component configuration file.

See:
- Section 7.6.1, "JMS Inbound Adapter Component Configuration"
- Section 7.6.2, "JMS Outbound Adapter Component Configuration"

b. If you want the JMS adapters to perform custom conversion, create a custom
converter Java class and register it in the EPN assembly file.

See Section 7.3, "Creating a Custom Converter Between JMS Messages and
Event Types".

4. Configure the jms-adapter elements for your Tibco EMS JMS provider as
Example 7-9 shows:

Example 7-9 jms-adapter Element With Tibco EMS JMS Configuration

<jms-adapter>
<name>inboundJmsAdapterl</name>

<jndi-provider-url>tcp://TIBCOHOST: PORT</jndi-provider-url>
<jndi-factory>com.tibco.tibjms.naming.TibjmsInitialContextFactory</jndi-factory>
<connection-jndi-name>CONNECTION_NAME</connection-jndi-name>
<destination-jndi-name>DESTINATION NAME</destination-jndi-name>

</jms-adapter>

Where:
»  TIBCOHOST: the hostname of the Tibco EMS JMS provider host.
»  PORT: the Tibco EMS JMS provider port.

» DESTINATION_NAME: the destination JNDI name of the Tibco EMS JMS
destination, such as TibcoRequestQueuel.

s CONNECTION_NAME: the connection JNDI name of the Tibco EMS JMS
connection factory you defined in the Tibco EMS JMS server, such as
TibcoQueueConnectionFactory.

See:
- Section 7.6.1, "JMS Inbound Adapter Component Configuration"
- Section 7.6.2, "JMS Outbound Adapter Component Configuration"

5. If you specify JMS provider client passwords in the component configuration file,
consider encrypting them.

See Section 7.4, "Encrypting Passwords in the JMS Adapter Component
Configuration File".

6. Create a JMS client application library that contains the following:
s tibjms.jar

= If you are using Java Object messages, the Java classes used for messaging
need to be packaged in a library bundle.
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You may include these Java classes in this JMS client application library.

Note: The JMS client application library must:

= Export all provider-specific packages.

= Export the Java classes used for messaging, if applicable.
s Import javax.jms and javax.naming.

The application bundle does not need to export the provider-specific
packages.

The application bundle must import Java classes used for messaging,
if applicable.

For more information, see Section 24.1.3.3, "Creating Application Libraries".

For a specific JMS provider example, see Section 7.2.4, "How to Configure a J]MS
Adapter for Tibco EMS JMS Manually".

Copy the application library to the appropriate Oracle CEP server application
library directory:

a. If your bundle is a driver, you must put it in the library extensions directory.
See Section 24.1.3.2, "Library Extensions Directory".

b. If your bundle is not a driver, you may put it in the library directory.
See Section 24.1.3.1, "Library Directory"

For more information, see Section 24.3.4, "How to Update an Application Library
Using Oracle CEP IDE for Eclipse".

If you created a custom converter class in step 3, update the MANIFEST . MF file of
your application to add the following packages to the Import-Package header:

Import-Package: javax.jms,javax.naming, ...

See Section 4.7.5, "How to Import a Package".

7.3 Creating a Custom Converter Between JMS Messages and Event

Types

If you want to customize the conversion between JMS messages and event types you
must create your own converter bean.

This section describes:

Section 7.3.1, "How to Create a Custom Converter for the Inbound JMS Adapter"”
Section 7.3.2, "How to Create a Custom Converter for the Outbound JMS Adapter"

7.3.1 How to Create a Custom Converter for the Inbound JMS Adapter

The custom converter bean for an inbound JMS must implement the
com.bea.wlevs.adapters.jms.api.InboundMessageConverter interface.
This interface has a single method:

public List convert (Message message) throws MessageConverterException, JMSException;
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The message parameter corresponds to the incoming JMS message and the return
value is a List of events that will be passed on to the next stage of the event
processing network.

See the Oracle Fusion Middleware Java API Reference for Oracle Complex Event Processing
for a full description of these APIs.

To create a custom converter for the inbound JMS adapter:

1. Using the Oracle CEP IDE for Eclipse (or your preferred IDE), add a Java class to
your application project.

2. Implement the
com.bea.wlevs.adapters.jms.api.InboundMessageConverter
interface.

Example 7-10 shows a possible implementation.

Example 7-10 Custom Converter for an Inbound JMS Adapter

package com.customer;
import com.bea.wlevs.adapters.jms.api.InboundMessageConverter;
import com.bea.wlevs.adapters.jms.api.MessageConverterException;
import com.bea.wlevs.adapters.jms.api.OutboundMessageConverter;
import javax.jms.JMSException;
import javax.jms.Message;
import javax.jms.Session;
import javax.jms.TextMessage;
import java.util.ArrayList;
import java.util.List;
public class MessageConverter implements InboundMessageConverter,
OutboundMessageConverter {
public List convert(Message message) throws MessageConverterException, JMSException {
TestEvent event = new TestEvent();
TextMessage textMessage = (TextMessage) message;
event.setString_ 1 (textMessage.getText());
List events = new ArrayList(1l);
events.add (event) ;
return events;
}
public List<Message> convert (Session session, Object inputEvent)
throws MessageConverterException, JMSException {
TestEvent event = (TestEvent) inputEvent;
TextMessage message = session.createTextMessage (
"Text message: " + event.getString_1()
)
List<Message> messages = new ArrayList<Message>();
messages.add (message) ;
return messages;

3. Specify the converter in your application EPN assembly file as Example 7-11
shows:

= Register the convert class using a bean element.

= Associate the converter class with the JMS adapter by adding a
wlevs:instance-property with name set to converterBean and ref
set to the id of bean.

Example 7-11 Specifying a Converter Class for an Inbound JMS Adapter in the EPN
Assembly File
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<bean id="myConverter" class="com.customer.MessageConverter"/>

<wlevs:adapter id="jmsInbound" provider="jms-inbound">
<wlevs:instance-property name="converterBean" ref="myConverter"/>
<wlevs:listener ref="mySink"/>

</wlevs:adapter>

4. Package the Java class with your application.

For more information, see Chapter 24, "Assembling and Deploying Oracle CEP
Applications".

7.3.2 How to Create a Custom Converter for the Outbound JMS Adapter

The custom converter bean for an outbound JMS must implement the
com.bea.wlevs.adapters.jms.api.OutboundMessageConverter interface.
This interface has a single method:

public List<Message> convert (Session session, Object event)
throws MessageConverterException, JMSException;

The parameters correspond to an event received by the outbound JMS adapter from
the source node in the EPN and the return value is a List of J]MS messages.

See the Oracle Fusion Middleware Java API Reference for Oracle Complex Event Processing
for a full description of these APIs.

To create a custom converter for the outbound JMS adapter:

1. Using the Oracle CEP IDE for Eclipse (or your preferred IDE), add a Java class to
your application project.

2. Implement the
com.bea.wlevs.adapters.jms.api.OutboundMessageConverter
interface.

Example 7-10 shows a possible implementation.

Example 7-12 Custom Converter for an Outbound JMS Adapter

package com.customer;
import com.bea.wlevs.adapters.jms.api.InboundMessageConverter;
import com.bea.wlevs.adapters.jms.api.MessageConverterException;
import com.bea.wlevs.adapters.jms.api.OutboundMessageConverter;
import javax.jms.JMSException;
import javax.jms.Message;
import javax.jms.Session;
import javax.jms.TextMessage;
import java.util.ArrayList;
import java.util.List;
public class MessageConverter implements InboundMessageConverter,
OutboundMessageConverter {
public List convert (Message message) throws MessageConverterException, JMSException {
TestEvent event = new TestEvent();
TextMessage textMessage = (TextMessage) message;
event.setString_1 (textMessage.getText());
List events = new ArrayList(l);
events.add (event) ;
return events;
}
public List<Message> convert(Session session, Object inputEvent)
throws MessageConverterException, JMSException {

TestEvent event = (TestEvent) inputEvent;
TextMessage message = session.createTextMessage (
"Text message: " + event.getString_1()
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}

3.

)i

List<Message> messages = new ArrayList<Message>();
messages.add (message) ;

return messages;

Specify the converter in your application EPN assembly file as Example 7-11
shows:

= Register the convert class using a bean element.

= Associate the converter class with the JMS adapter by adding a
wlevs:instance-property with name set to converterBean and ref
set to the id of bean.

Example 7-13 Specifying a Converter Class for an Outbound JMS Adapter in the EPN
Assembly File

<bean id="myConverter" class="com.customer.MessageConverter"/>
<wlevs:adapter id="jmsOutbound" provider="jms-outbound">

<wlevs:instance-property name="converterBean" ref="myConverter"/>
</wlevs:adapter>

Package the Java class with your application.

For more information, see Chapter 24, "Assembling and Deploying Oracle CEP
Applications".

7.4 Encrypting Passwords in the JMS Adapter Component Configuration

File

You can encrypt the password in the JMS adapter configuration file.

Note: The procedure assumes that you are currently using the
password element in the configuration file, along with a cleartext
password value, but want to start using the encrypted-password
element to encrypt the password.

7.4.1 How to Encrypt Passwords in the JMS Adapter Component Configuration File

You can encrypt the password in the JMS adapter configuration file.

To encrypt passwords in the JMS adapter component configuration file:

1.

Open a command window and set your environment as described in "Setting Your
Development Environment" in the Oracle Complex Event Processing Getting Started.

Change to the directory that contains the configuration file for your JMS adapter.

Execute the following encryptMSAConfig command to encrypt the value of the
<password> element in the configuration file:

prompt> ORACLE_CEP_HOME/ocep_11.1/bin/encryptMSAConfig . config file
msainternal.dat_file

where ORACLE_CEP_HOME refers to the main BEA directory into which you
installed Oracle CEP, such as d: \oracle_cep. The second argument refers to the
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directory that contains the JMS adapter configuration file; because this procedure
directs you to actually change to the directory, the example shows " . ". The
config file parameter refers to the name of your JMS adapter configuration
file. Finally, the msainternal.dat_file parameter refers to the location of the
.msainternal.dat file associated with your domain; by default this file is
located in the DOMAIN DIR/servername directory, where DOMAIN_DIR refers to
the domain directory such as /oracle_cep/user_
projects/domains/mydomain and servername refers to the server instance.

The encryptMSAConfig command comes in two flavors:
encryptMSAConfig.cmd (Windows) and encryptMSAConfig. sh (UNIX).

After you run the command, the value of the <password> element will be
encrypted, as shown in bold in the following example:

<jms-adapter>
<name>jmsInbound</name>
<jndi-provider-url>t3://localhost:7001</jndi-provider-url>
<destination-jndi-name>Queuel</destination-jndi-name>
<user>weblogic</user>
<password>{Salted-3DES}B7L6nehu7dgPtJJTnTIWRA==</password>
<work-manager>JettyWorkManager</work-manager>
<concurrent-consumers>1</concurrent-consumers>
<session-transacted>false</session-transacted>

</jms-adapter>

4. Using your favorite XML editor, edit the JMS adapter configuration file. Change
the <password> element (whose value is now encrypted) to
<encrypted-password>, as shown in bold in the following example:

<jms-adapter>
<name>jmsInbound</name>
<jndi-provider-url>t3://localhost:7001</jndi-provider-url>
<destination-jndi-name>Queuel</destination-jndi-name>
<user>weblogic</user>
<encrypted-password> {Salted-3DES}B7L6nehu7dgPtJJTnTIJWRA==</encrypted-password

<work-manager>JettyWorkManager</work-manager>

<concurrent-consumers>1</concurrent-consumers>

<session-transacted>false</session-transacted>
</jms-adapter>

7.5 Configuring the JMS Adapter EPN Assembly File

For each JMS adapter in your event processing network, you must add a
corresponding wlevs:adapter element to the EPN assembly file of your application;
use the provider attribute to specify whether the JMS adapter is inbound or
outbound.

As with any other stage in the EPN, add listeners to the wlevs:adapter element to
integrate the JMS adapter into the event processing network. Typically, an inbound
JMS adapter is the first stage in an EPN (because it receives messages) and an
outbound JMS adapter would be in a later stage (because it sends messages). However,
the requirements of your own Oracle CEP application define where in the network the
JMS adapters fit in.

For both JMS inbound and outbound adapters, if you have created a custom converter
bean to customize the conversion between the JMS messages and event types, first use
the standard bean Spring element to declare it in the EPN assembly file. Then pass a
reference of the bean to the JMS adapter by specifying its id using the
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wlevs:instance-property element, with the name attribute set to
converterBean, as shown:

<bean id="myConverter"
class="com.customer.MessageConverter" />

<wlevs:adapter id="jmsOutbound" provider="jms-outbound">
<wlevs:instance-property name="converterBean" ref="myConverter"/>
</wlevs:adapter>

In this case, be sure you do not specify an event type in the component configuration
file because it is assumed that the custom converter bean takes care of specifying the
event type.

This section describes:

= Section 7.5.1, "JMS Inbound Adapter EPN Assembly File Configuration"

= Section 7.5.2, "JMS Outbound Adapter EPN Assembly File Configuration"”
For more information, see:

= Section 1.1.5, "Component Configuration Files."

= Section B.2, "Component Configuration Schema wlevs_application_config.xsd"

7.5.1 JMS Inbound Adapter EPN Assembly File Configuration

If you are specifying an inbound JMS adapter, set the provider attribute to
jms-inbound, as shown:

<wlevs:adapter id="jmsInbound" provider="jms-inbound"/>

The value of the id attribute, in this case jms Inbound, must match the name
specified for this JMS adapter in its configuration file. The configuration file configures
the JMS destination from which this inbound JMS adapter gets its messages.

Because no converter bean is specified, Oracle CEP automatically converts the
inbound message to the event type specified in the component configuration file by
mapping property names.

The following sample EPN assembly file shows how to configure an inbound JMS
adapter. The network is simple: the inbound JMS adapter called jmsInbound receives
messages from the JMS destination configured in its component configuration file. The
Spring bean myConverter converts the incoming JMS messages into event types, and
then these events flow to the mySink event bean.

<?xml version="1.0" encoding="UTF-8"?>
<beans xmlns="http://www.springframework.org/schema/beans"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmlns:osgi="http://www.springframework.org/schema/osgi"
xmlns:wlevs="http://www.bea.com/ns/wlevs/spring"
xsi:schemaLocation="
http://www.springframework.org/schema/beans
http://www.springframework.org/schema/beans/spring-beans.xsd
http://www.springframework.org/schema/osgi
http://www.springframework.org/schema/osgi/spring-osgi.xsd
http://www.bea.com/ns/wlevs/spring
http://www.bea.com/ns/wlevs/spring/spring-wlevs-vll_1_1_3.xsd">
<wlevs:event-type-repository>
<wlevs:event-type type-name="JMSEvent">
<wlevs:class>com.customer.JMSEvent</wlevs:class>
</wlevs:event-type>
</wlevs:event-type-repository>
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<!-- Event bean that is an event sink -->
<wlevs:event-bean id="mySink"
class="com.customer.MySink" />
<!-- Inbound JMS adapter with custom converter class; adapter sends events to mySink
event bean-->
<bean id="myConverter" class="com.customer.MessageConverter"/>
<wlevs:adapter id="jmsInbound" provider="jms-inbound">
<wlevs:instance-property name="converterBean" ref="myConverter"/>
<wlevs:listener ref="mySink"/>
</wlevs:adapter>
</beans>

7.5.2 JMS Outbound Adapter EPN Assembly File Configuration

If you are specifying an outbound JMS adapter, set the provider attribute to
jms-outbound, as shown:

<wlevs:adapter id="jmsOutbound" provider="jms-outbound"/>

The value of the id attribute, in this case jmsOutbound, must match the name
specified for this JMS adapter in its configuration file. The configuration file configures
the JMS destination to which this outbound JMS adapter sends messages.

Because no converter bean is specified, Oracle CEP automatically converts the
incoming event types to outgoing JMS messages by mapping the property names.

The following sample EPN assembly file shows how to configure an outbound JMS
adapter. The network is simple: a custom adapter called getData receives data from
some feed, converts it into an event type and passes it to myProcessor, which in turn
sends the events to the jmsOutbound JMS adapter via the st reamOne channel.
Oracle CEP automatically converts these events to JMS messages and sends the
messages to the JMS destination configured in the component configuration file
associated with the jmsOutbound adapter.

<?xml version="1.0" encoding="UTF-8"?>
<beans xmlns="http://www.springframework.org/schema/beans"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmlns:osgi="http://www.springframework.org/schema/osgi"
xmlns:wlevs="http://www.bea.com/ns/wlevs/spring"
xsi:schemaLocation="
http://www.springframework.org/schema/beans
http://www.springframework.org/schema/beans/spring-beans.xsd
http://www.springframework.org/schema/osgi
http://www.springframework.org/schema/osgi/spring-osgi.xsd
http://www.bea.com/ns/wlevs/spring
http://www.bea.com/ns/wlevs/spring/spring-wlevs-vll_1_1_3.xsd">
<wlevs:event-type-repository>
<wlevs:event-type type-name="JMSEvent">
<wlevs:class>com.customer.JMSEvent</wlevs:class>
</wlevs:event-type>
</wlevs:event-type-repository>
<!-- Custom adapter that gets data from somewhere and sends it to myProcessor -->
<wlevs:adapter id="getData"
class="com.customer.GetData">
<wlevs:listener ref="myProcessor"/>
</wlevs:adapter>
<wlevs:processor id="myProcessor" />
<wlevs:adapter id="jmsOutbound" provider="jms-outbound"/>
<!-- Channel for events flowing from myProcessor to outbound JMS adapter -->
<wlevs:channel id="streamOne">
<wlevs:listener ref="jmsOutbound"/>
<wlevs:source ref="myProcessor"/>
</wlevs:channel>
</beans>
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7.6 Configuring the JMS Adapter Component Configuration File

You configure the JMS adapters in their respective configuration files, similar to how
you configure other components in the event processing network, such as processors
or streams.

The root element for configuring a JMS adapter is jms-adapter. The name child
element for a particular adapter must match the 1d attribute of the corresponding
wlevs:adapter element in the EPN assembly file that declares this adapter.

This section describes:

= Section 7.6.1, "JMS Inbound Adapter Component Configuration”

= Section 7.6.2, "JMS Outbound Adapter Component Configuration"
For more information, see:

= Section 1.1.5, "Component Configuration Files."

= Section B.2, "Component Configuration Schema wlevs_application_config.xsd"

7.6.1 JMS Inbound Adapter Component Configuration

Table 7-1 lists the jms-adapter element child elments applicable to the JMS inbound
adapter.

Table 7-1 jms-adapter Inbound Child Elements

Child Element Description

bindings Bindings are used to configure horizontal scale-out and are an
advanced feature. Using the
com.oracle.cep.cluster.hagroups.ActiveActiveGro
upBean, you can partition an incoming JMS stream in Oracle
CEP applications by utilizing the notification groups that the
ActiveActiveGroupBean creates. Use this element to
associate a notification group with a particular
message-selector value.

For more information, see Section 22.2.2,
"ActiveActiveGroupBean"

concurrent-consumers Number of consumers to create. Default value is 1.
If you set this value to a number greater than 1:
= Consider the work-manager configuration.

= Besure that your converter bean is thread-safe because the
converter bean will be shared among the consumers. For
more information, see Section 7.3, "Creating a Custom
Converter Between JMS Messages and Event Types".

connection-jndi-name Optional. The JNDI name of the JMS connection factory. Default
value is weblogic. jms.ConnectionFactory, for Oracle
CEP server JMS.

connection-password Optional. Either the password, or encrypted password, for

. connection-user.
connection-encrypted-password

Note: Specify either connection-password or
connection-encrypted-password, but not both.

See Section 7.4, "Encrypting Passwords in the JMS Adapter
Component Configuration File" for details on encrypting the
password.

Configuring JMS Adapters 7-19



Configuring the JMS Adapter Component Configuration File

Table 7-1 (Cont.) jms-adapter Inbound Child Elements

Child Element

Description

connection-user

Optional. When Oracle CEP calls the createConnection
method on the javax. jms.ConnectionFactory to create a
connection to the JMS destination (JMS queue or topic), it uses
the connection-user and connection-password (or
connection-encrypted-password) settings, if configured.
Otherwise, Oracle CEP uses the user and password (or
encrypted-password) settings.

You can use the connection-user and
connection-password (or
connection-encrypted-password) settings in applications
where one security provider is used for JNDI access and a
separate security provider is used for JMS access.

destination-jndi-name

Required. The JNDI name of the JMS destination.

Note: Specify either destination-jndi-name or
destination-name, but not both.

destination-name

Required. The actual name of the JMS destination.

Note: Specify either destination-jndi-name or
destination-name, but not both.

event-type

Event type whose property names match inbound JMS Map
Message property names. Specify this property only if you want
Oracle CEP to automatically perform the conversion between
JMS messages and events. If you have created your own custom
converter bean, then do not specify this property

For more information, see Section 7.3, "Creating a Custom
Converter Between JMS Messages and Event Types".

jndi-factory

Optional. The JNDI factory name. Default value is
weblogic.jndi.WLInitialContextFactory, for Oracle
CEP server JMS.

jndi-provider-url

Required. The URL of the JNDI provider.

message-selector

JMS message selector to use to filter messages. Only messages
that match the selector will produce events.

Default: there is no selector; all messages will produce events.

password

encrypted-password

Required. Either the password, or encrypted password, for
user.

Note: Specify either password or encrypted-password, but
not both.

See Section 7.4, "Encrypting Passwords in the JMS Adapter
Component Configuration File" for details on encrypting the
password.

session-ack-mode-name

Determines how messages are acknowledged. Once a message
is successfully acknowledged it will never be resent following a
failure.

Valid values from javax.jms.Session are:

= AUTO_ACKNOWLEDGE: With this acknowledgment mode,
the session automatically acknowledges a client's receipt of
a message either when the session has successfully
returned from a call to receive or when the message
listener the session has called to process the message
successfully returns.

" CLIENT_ACKNOWLEDG: With this acknowledgment mode,
the client acknowledges a consumed message by calling
the message's acknowledge method.

. DUPS_OK_ACKNOWLEDGE: This acknowledgment mode
instructs the session to lazily acknowledge the delivery of
messages.

Default: AUTO_ACKNOWLEDGE.
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Table 7-1 (Cont.) jms-adapter Inbound Child Elements

Child Element

Description

session-transacted

Boolean value that specifies whether or not the session is
transactional.

If the session is transacted then do not specify
session-ack-mode-name.

Default: False.

user

Required. When Oracle CEP acquires the JNDI
InitialContext, it uses the user and password (or
encrypted-password) settings.

work-manager

Name of a work manager, configured in the Oracle CEP server
config.xml file. This name corresponds to the value of the
name child element of the work-manager element in
config.xml.

If concurrent-consumers is greater than 1 and you want all
the consumers to be run concurrently, then consider the
configuration of the work-manager you associate with this JMS
inbound adapter:

= If the work-manager is shared with other components
(such as other adapters and Jetty) then set the
work-manager attribute max-threads-constraint
greater than or equal to the concurrent-consumers
setting.

. If the work-manager is not shared (that is, it is dedicated
to this inbound JMS adapter only) then set the
work-manager attribute max-threads-constraint
equal to the concurrent-consumers setting.

The default value is the work manager configured for the
application itself.

For more information, see Section F.44, "work-manager".

The following configuration file shows a complete example of configuring an inbound

JMS adapter.

<?xml version="1.0" encoding="UTF-8"?>

<nl:config

xsi:schemalocation="http://www.bea.com/ns/wlevs/config/application wlevs_application_

config.xsd"

xmlns:nl="http://www.bea.com/ns/wlevs/config/application"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">

<jms-adapter>

<name>jmsInbound</name>
<jndi-provider-url>t3://localhost:7001</jndi-provider-url>
<destination-jndi-name>Queuel</destination-jndi-name>
<user>weblogic</user>

<password>weblogic</password>
<work-manager>MyWorkManager</work-manager>
<concurrent-consumers>1</concurrent-consumers>
<session-transacted>false</session-transacted>

</jms-adapter>
<jms-adapter>

<name>jmsOutbound</name>

<event-type>JMSEvent</event-type>
<jndi-provider-url>t3://localhost:7001</jndi-provider-url>
<destination-jndi-name>Topicl</destination-jndi-name>
<delivery-mode>nonpersistent</delivery-mode>

</jms-adapter>
</nl:config>
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7.6.2 JMS Outbound Adapter Component Configuration

Table 7-2 lists the jms-adapter element child elments applicable to the JMS

outbound adapter.

Table 7-2 jms-adapter Outbound Component Configuration Child Elements

Child Element

Description

connection-jndi-name

Optional. The JNDI name of the JMS connection factory. Default
value is weblogic. jms.ConnectionFactory, for Oracle
CEP server JMS.

connection-password

connection-encrypted-password

Optional. Either the password, or encrypted password, for
connection-user.

Note: Specify either connection-password or
connection-encrypted-password, but not both.

See Section 7.4, "Encrypting Passwords in the JMS Adapter
Component Configuration File" for details on encrypting the
password.

connection-user

Optional. When Oracle CEP calls the createConnection
method on the javax. jms.ConnectionFactory to create a
connection to the JMS destination (JMS queue or topic), it uses
the connection-user and connection-password (or
connection-encrypted-password) settings, if configured.
Otherwise, Oracle CEP uses the user and password (or
encrypted-password) settings.

You can use the connection-user and
connection-password (or
connection-encrypted-password) settings in applications
where one security provider is used for JNDI access and a
separate security provider is used for JMS access.

delivery-mode

Specifies the delivery mode: persistent (default value) or
nonpersistent.

destination-jndi-name

Required. The JNDI name of the JMS destination.

Note: Specify either destination-jndi-name or
destination-name, but not both.

destination-name

Required. The actual name of the JMS destination.

Note: Specify either destination-jndi-name or
destination-name, but not both.

event-type

Event type whose property names match inbound JMS Map
Message property names. Specify this property only if you want
Oracle CEP to automatically perform the conversion between
JMS messages and events. If you have created your own custom
converter bean, then do not specify this property

For more information, see Section 7.3, "Creating a Custom
Converter Between JMS Messages and Event Types".

jndi-factory

Optional. The JNDI factory name. Default value is
weblogic.jndi.WLInitialContextFactory, for Oracle
CEP server JMS.

jndi-provider-url

Required. The URL of the JNDI provider.

password

encrypted-password

Required. Either the password, or encrypted password, for
user.

Note: Specify either password or encrypted-password, but
not both.

See Section 7.4, "Encrypting Passwords in the JMS Adapter
Component Configuration File" for details on encrypting the
password.

session-transacted

Boolean value that specifies whether or not the session is
transactional.

If the session is transacted then do not specify
session-ack-mode-name.

Default: False.
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Table 7-2 (Cont.) jms-adapter Outbound Component Configuration Child Elements

Child Element

Description

user

Required. When Oracle CEP acquires the JNDI
InitialContext, it uses the user and password (or
encrypted-password) settings.

The following configuration file shows a complete example of configuring an

outbound JMS adapter.

<?xml version="1.0" encoding="UTF-8"?>

<nl:config

xsi:schemalocation="http://www.bea.com/ns/wlevs/config/application wlevs_application_

config.xsd"

xmlns:nl="http://www.bea.com/ns/wlevs/config/application"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">

<jms-adapter>

<name>jmsInbound</name>
<jndi-provider-url>t3://localhost:7001</jndi-provider-url>
<destination-jndi-name>Queuel</destination-jndi-name>
<user>weblogic</user>

<password>weblogic</password>
<work-manager>JettyWorkManager</work-manager>
<concurrent-consumers>1</concurrent-consumers>
<session-transacted>false</session-transacted>

</jms-adapter>
<jms-adapter>

<name>jmsOutbound</name>

<event-type>JMSEvent</event-type>
<jndi-provider-url>t3://localhost:7001</jndi-provider-url>
<destination-jndi-name>Topicl</destination-jndi-name>
<delivery-mode>nonpersistent</delivery-mode>

</jms-adapter>
</nl:config>
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8

Configuring HTTP Publish-Subscribe Server
Adapters

This section contains information on the following subjects:

= Section 8.1, "Overview of HTTP Publish-Subscribe Server Adapter Configuration”
= Section 8.2, "Configuring an HTTP Pub-Sub Adapter"

= Section 8.4, "Configuring the HTTP Pub-Sub Adapter EPN Assembly File"

= Section 8.5, "Configuring the HTTP Pub-Sub Adapter Component Configuration
File"

8.1 Overview of HTTP Publish-Subscribe Server Adapter Configuration

An HTTP Publish-Subscribe server (pub-sub server) is a mechanism whereby Web
clients, such as browser-based clients, subscribe to channels, receive messages as they
become available, and publish messages to these channels, all using asynchronous
messages over HTTP. A channel is similar to a JMS topic.

Every instance of Oracle CEP includes a pub-sub server that programmers can use to
implement HTTP publish-subscribe functionality in their applications. The pub-sub
server is configured in the config.xml file along with other server services such as
Jetty and JDBC datasources. The pub-sub server is based on the Bayeux protocol (see
http://svn.xantus.org/shortbus/trunk/bayeux/bayeux.html) proposed
by the cometd project (see http://cometd. com/). The Bayeux protocol defines a
contract between the client and the server for communicating with asynchronous
messages over HTTP.

In Oracle CEP, programmers access HTTP publish-subscribe functionality by using the
following built-in HTTP publish-subscribe adapters (pub-sub adapters):

= Publishing to a channel: see Section 8.1.1, "Overview of the Built-In Pub-Sub
Adapter for Publishing"

— Local publishing to a channel: see Section 8.1.1.1, "Local Publishing".
- Remote publishing to a channel: see Section 8.1.1.2, "Remote Publishing".

= Subscribing to a channel: see Section 8.1.2, "Overview of the Built-In Pub-Sub
Adapter for Subscribing".

Oracle CEP also provides a pub-sub API for programmers to create their own custom
pub-sub adapters for publishing and subscribing to a channel, if the built-in pub-sub
adapters are not adequate. For example, programmers might want to filter incoming
messages from a subscribed channel, dynamically create or destroy local channels, and
so on. The built-in pub-sub adapters do not provide this functionality, which is why
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programmers must implement their own custom pub-sub adapters in this case. For
details, see Chapter 14, "Configuring Custom Adapters."

By default, Oracle CEP performs automatic conversion to and from Oracle CEP event
types. Alternatively, you can create a custom converter. See Section 8.3, "Creating a
Custom Converter Between the HTTP Pub-Sub Messages and Event Types".

Oracle CEP can also automatically convert between JSON messages and Oracle CEP
event types. See Section 8.1.3, "Converting Between JSON Messages and Event Types".

The built-in pub-sub adapters work like any other adapter: they are stages in the event
processing network, they are defined in the EPN assembly file, and they are
configured with the standard component configuration files. Typical configuration
options include specifying channels, specifying the local or remote pub-sub server, and
user authentication.

The pub-sub server can communicate with any client that can understand the Bayeux
protocol. Programmers developer their Web clients using one of the following
frameworks:

= Dojo JavaScript library (see http://dojotoolkit.org/) that supports the
Bayeux protocol. Oracle CEP does not provide this library.

s WebLogic Workshop Flex plug-in that enables development of a Flex client that
uses the Bayeux protocol to communicate with a pub-sub server.

For information on securing an HTTP pub-sub server channel, see "Configuring HTTP
Publish-Subscribe Server Channel Security" in the Oracle Complex Event Processing
Administrator’s Guide.

8.1.1 Overview of the Built-In Pub-Sub Adapter for Publishing

You can use the built-in pub-sub adapter for publishing events to a channel. The
built-in pub-sub adapter supports the following publishing modes:

= Section 8.1.1.1, "Local Publishing"
= Section 8.1.1.2, "Remote Publishing"

For more information, see Section 8.1, "Overview of HTTP Publish-Subscribe Server
Adapter Configuration".

8.1.1.1 Local Publishing

Figure 8-1 shows how the built-in pub-sub adapter for local publishing fits into a
simple event processing network. The arbitrary adapter and processor are not
required, they are just an example of possible components in your application in
addition to the pub-sub adapter.
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Figure 8—1 Built-In Pub-Sub Adapter For Local Publishing
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Note the following in Figure 8-1:

= Events flow from some source into an adapter of an application running in Oracle
CEP. This adapter is not required, it is shown only as an example.

»  The events flow from the adapter to an arbitrary processor; again, this processor is
not required.

= The processor sends the events to the built-in pub-sub adapter for local
publishing. The adapter in turn sends the events to the local HTTP pub-sub server
configured for the Oracle CEP instance on which the application is deployed. The
pub-sub adapter sends the messages to the channel for which it has been
configured.

s The local HTTP pub-sub server configured for Oracle CEP then sends the event as
a message to all subscribers of the local channel.

8.1.1.2 Remote Publishing

Figure 8-2 shows how the built-in pub-sub adapter for remote publishing fits into a
simple event processing network.

Figure 8-2 Built-In Pub-Sub Adapter For Remote Publishing

Oracle CEP
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Note the following in Figure 8-2:
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Events flow from some source into an adapter of an application running in Oracle
CEP. The arbitrary adapter is not required, it is shown only as an example.

The events flow from the adapter to an arbitrary processor; again, this processor is
not required.

The processor sends the events to the built-in pub-sub adapter for remote
publishing. The adapter in turn sends the events as messages to the remote HTTP
pub-sub server for which the adapter is configured; this HTTP pub-sub server
could be on another Oracle CEP instance, a WebLogic Server instance, or any other
third-party implementation. The pub-sub adapter sends the messages to the
channel for which it has been configured.

The remote HTTP pub-sub server then sends the message to all subscribers of the
channel.

8.1.2 Overview of the Built-In Pub-Sub Adapter for Subscribing

Figure 8-3 shows how the built-in pub-sub adapter for subscribing fits into a simple
event processing network. The arbitrary processor and business POJO are not
required, they are just an example of possible components in your application in
addition to the pub-sub adapter.

Figure 8-3 Built-In Pub-Sub Adapter For Subscribing

Oracle CEP, WebLogic Server,
or Other HTTP Pub-Sub Server

Web-based client
publisher, such as . HTTP Pub-Sub
a browsar Server
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HTTP
Oracle CEP
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Built-In Pub-Sub Arbitrary
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Subscribing

. Business PCUO

Note the following in Figure 8-3:

Messages are published to a remote HTTP pub-sub server, which could be another
instance of Oracle CEP, WebLogic Server, or a third-party implementation. The
messages are typically published by Web based clients (shown in graphic), by the
HTTP pub-sub server itself, or another server application.

The built-in pub-sub adapter running in an Oracle CEP application subscribes to
the HTTP pub-sub server and receives messages from the specified channel. The
adapter converts the messages into the event type configured for the adapter.

The pub-sub adapter sends the events to a processor. This processor is not
required, it is shown only as an example of a typical Oracle CEP application.

The processor sends the events to a business POJO. Again, this business POJO is
not required.

For more information, see Section 8.1, "Overview of HTTP Publish-Subscribe Server
Adapter Configuration".
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8.1.3 Converting Between JSON Messages and Event Types

Oracle CEP can automatically convert incoming JavaScript Object Notation (JSON)
messages to event types, and vice versa in the outbound case. However, if you want to
customize the way a JSON message (either inbound via a HTTP pub-sub adapter for
subscribing or outbound via an HTTP pub-sub adapter for publishing) is converted to
an event type, or vice versa, you must create your own converter bean. See Section 8.3,
"Creating a Custom Converter Between the HITP Pub-Sub Messages and Event
Types" for details.

If you do not provide your own converter class, and instead let Oracle CEP take care of
the conversion between messages and event types, the following is true:

= You must specify an event type that Oracle CEP uses in its conversion. See
Section 8.2.2, "How to Configure an HTTP Pub-Sub Adapter Manually" for details.

s The default converter used in the HT'TP adapter for subscribing creates a new
event of the specified type for each incoming message. For each property of the
specified event type, it looks for a corresponding property name in the JSON
object that constitutes the message, and if found, sets the corresponding value.

s The default converter used in the HI'TP adapter for publishing creates a JSON
message for each event. For each property of the specified event type, a
corresponding element is created in the output JSON message.

For more information, see http://www. json.org/.

8.2 Configuring an HTTP Pub-Sub Adapter

This section describes how to configure Oracle CEP HTTP pub-sub adapter for both
publishing and subscribing;:

= Section 8.2.1, "How to Configure an HTTP Pub-Sub Adapter Using the Oracle CEP
IDE for Eclipse"

= Section 8.2.2, "How to Configure an HTTP Pub-Sub Adapter Manually"

Note: This section assumes that you have already created an Oracle
CEP application, along with its EPN assembly file and component
configuration files, and that you want to update the application to use
the built-in pub-sub adapters. If this is not true, refer to Chapter 1,
"Overview of Creating Oracle CEP Applications" for general
information about creating an Oracle CEP application.

8.2.1 How to Configure an HTTP Pub-Sub Adapter Using the Oracle CEP IDE for

Eclipse

The simplest way to create and configure an HTTP pub-sub adapter is using the
Oracle CEP IDE for Eclipse adapter wizard.

For more information, see Section 6.4.1.2, "How to Create an Adapter Node".

After using the adapter wizard to create and specify the basic HI'TP pub-sub adapter
configuration, review Section 8.2.2, "How to Configure an HTTP Pub-Sub Adapter
Manually" to complete the configuration.
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8.2.2 How to Configure an HTTP Pub-Sub Adapter Manually

This section describes how to create and configure an HTTP pub-sub adapter
manually. It describes the detailed steps that you may require depending on your
application.

The simplest way to create and configure an HTTP pub-sub adapter is using the
Oracle CEP IDE for Eclipse adapter wizard as Section 8.2.1, "How to Configure an
HTTP Pub-Sub Adapter Using the Oracle CEP IDE for Eclipse" describes. After using
the adapter wizard to create and specify the basic HTTP pub-sub adapter
configuration, review this procedure to complete the configuration.

You configure the built-in pub-sub adapters in their respective configuration files,
similar to how you configure other components in the event processing network, such
as processors or streams. For general information about these configuration files, see
Section 1.1.5, "Component Configuration Files."

The following procedure describes the main steps to configure the built-in pub-sub
adapters for your application. For simplicity, it is assumed in the procedure that you
are going to configure all components of an application in a single configuration XML
file and that you have already created this file for your application.

See Section B.2, "Component Configuration Schema wlevs_application_config.xsd" for
the complete XSD Schema that describes the configuration of the built-in pub-sub
adapters.

To configure an HTTP pub-sub adapter manually:
1. Open the configuration XML file using your favorite XML editor.

2. For each built-in pub-sub adapter you want to configure, add a
http-pub-sub-adapter child element of the config root element; use the
<name> child element to uniquely identify it. This name value will be used later as
the id attribute of the wlevs:adapter element in the EPN assembly file that
defines the event processing network of your application. This is how Oracle CEP
knows to which particular adapter in the EPN assembly file this adapter
configuration applies.

For example, assume your configuration file already contains a processor (contents
removed for simplicity) and you want to configure instances of each of the three
built-in pub-sub adapters; then the updated file might look like the following;
details of the adapter configuration will be added in later steps:

<?xml version="1.0" encoding="UTF-8"?>
<nl:config
xsi:schemalocation="http://www.bea.com/ns/wlevs/config/application wlevs_
application_config.xsd"
xmlns:nl="http://www.bea.com/ns/wlevs/config/application"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">

<processor>

</processor>
<http-pub-sub-adapter>
<name>remotePublisher</name>

</http-pub-sub-adapter>
<http-pub-sub-adapter>

<name>remoteSubscriber</name>

</http-pub-sub-adapter>
<http-pub-sub-adapter>
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<name>localPublisher</name>

</http-pub-sub-adapter>
</nl:config>

For each remote pub-sub adapter (for both publishing and subscribing), add a
server-url child element of ht tp-pub-sub-adapter to specify the URL of
the remote HTTP pub-sub server to which the Oracle CEP application will publish
or subscribe, respectively. The remote pub-sub server could be another instance of
Oracle CEP, or a WebLogic Server instance, or it could be any third-party HTTP
pub-sub server. For example:

<http-pub-sub-adapter>
<name>remotePublisher</name>
<server-url>http://myhost.com:9102/pubsub</server-url>

</http-pub-sub-adapter>

In the example, the URL of the remote HTTP pub-sub server to which the
remotePublisher adapter will publish events is
http://myhost.com:9102/pubsub.

For each local pub-sub adapter for publishing, add a server-context-path
element to specify the path of the local HTTP pub-sub server associated with the
Oracle CEP instance hosting the current Oracle CEP application.

By default, each Oracle CEP server is configured with an HTTP pub-sub server
with path /pubsub; if, however, you have created a new local HTTP pub-sub
server, or changed the default configuration, then specify the value of the path
child element of the ht tp-pubsub element in the server's config.xml file. For
example:

<http-pub-sub-adapter>
<name>localPublisher</name>
<server-context-path>/pubsub</server-context-path>

</http-pub-sub-adapter>

For all the pub-sub adapters, whether they are local or remote or for publishing or
subscribing, add a channel child element to specify the channel that the pub-sub
adapter publishes or subscribes to, whichever is appropriate. For example:

<http-pub-sub-adapter>
<name>localPublisher</name>
<server-context-path>/pubsub</server-context-path>
<channel>/channel2</channel>
</http-pub-sub-adapter>

In the example, the 1ocalPublisher pub-sub adapter publishes to a local
channel with pattern /channel?2.

For all pub-sub adapters for subscribing, add an event -type element that
specifies the JavaBean to which incoming messages are mapped. You are required
to specify this for all subscribing adapters. At runtime, Oracle CEP uses the
incoming key-value pairs in the message to map the message data to the specified
event type.

You can also optionally use the event -type element in a pub-sub adapter for
publishing if you want to limit the types of events that are published to just those
specified by the event-type elements. Otherwise, all events sent to the pub-sub
adapter are published. For example:
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<http-pub-sub-adapter>
<name>remoteSubscriber</name>
<server-url>http://myhost.com:9102/pubsub</server-url>
<channel>/channel3</channel>
<event-type>com.mycompany . httppubsub.PubsubEvent</event-type>
</http-pub-sub-adapter>

Be sure this event type has been registered in the EPN assembly file by specifying
it as a child element of the wlevs:event-type-repository element.

7. Finally, if the HTTP pub-sub server to which the Oracle CEP application is
publishing requires user authentication, add user and password (or
encrypted-password) elements to specify the username and password or
encrypted password. For example:

<http-pub-sub-adapter>
<name>remotePublisher</name>
<server-url>http://myhost.com:9102/pubsub</server-url>
<channel>/channell</channel>
<event-type>com.mycompany.httppubsub. PubsubEvent</event-type>
<user>wlevs</user>
<password>wlevs</password>
</http-pub-sub-adapter>
8. Optionally create a converter Java class if you want to customize the way the
inbound or outbound messages are converted into event types. This step is
optional because you can let Oracle CEP make the conversion based on mapping
property names between the messages and a specified event type.

See Section 8.3, "Creating a Custom Converter Between the HTTP Pub-Sub
Messages and Event Types."

9. If you are going to use the local HTTP pub-sub server associated with the Oracle
CEP instance for local publishing, use Visualizer, the Oracle CEP Administration
Tool, to add new channels with the channel pattern required by your application.

For details, see "How to Configure Security for an HTTP Publish-Subscribe
Channel" in the Oracle Complex Event Processing Visualizer User’s Guide.

10. Update the EPN assembly file, adding declarations for each built-in pub-sub
adapter you are adding to your application.

See Section 8.4, "Configuring the HTTP Pub-Sub Adapter EPN Assembly File."

11. Update the MANIFEST . MF file of your application, adding the package
com.bea.core.encryption to the Import-Package header. For example:

Import-Package:
com.bea.core.encryption
com.bea.wlevs.adapter.defaultprovider;version="11.1.1.4_0",

See Section 24.2.2.1, "Creating the MANIFEST.MF File" for additional information
on the manifest file.

8.3 Creating a Custom Converter Between the HTTP Pub-Sub Messages
and Event Types

If you want to customize the way a message (either inbound via a HTTP pub-sub
adapter for subscribing or outbound via an HTTP pub-sub adapter for publishing) is
converted to an event type, or vice versa, you must create your own converter bean.
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The custom converter bean for an inbound HTTP pub-sub message must implement
the com.bea.wlevs.adapters.httppubsub.api.InboundMessageConverter
interface. This interface has a single method:

public List convert (JSONObject message) throws Exception;

The message parameter corresponds to the incoming HTTP pub-sub message and the
return value is a List of events that will be passed on to the next stage of the event
processing network. The incoming message is assumed to be the JSON format.

The custom converter bean for an outbound HTTP pub-sub message must implement
the
com.bea.wlevs.adapters.httppubsub.api.OutboundMessageConverter
interface. This interface has a single method:

public List<JSONObject> convert (Object event) throws Exception;

The parameters correspond to an event received by the outbound HTTP pub-sub
adapter from the source node in the EPN and the return value is a List of JSON
messages.

See the Oracle Fusion Middleware Java API Reference for Oracle Complex Event Processing
for a full description of these APIs.

The following example shows the Java source of a custom converter bean that
implements both InboundMessageConverter and OutboundMessageConvert;
this bean can be used for both inbound and outbound HTTP pub-sub adapters:

package com.sample.httppubsub;
import com.bea.wlevs.adapters.httppubsub.api.InboundMessageConverter;
import com.bea.wlevs.adapters.httppubsub.api.OutboundMessageConverter;
import com.bea.httppubsub.json.JSONObject;
import java.util.List;
import java.util.ArrayList;
import java.util.HashMap;
import java.util.Map;
public class TestConverter implements InboundMessageConverter, OutboundMessageConverter {
public List convert (JSONObject message) throws Exception {
List eventCollection = new ArrayList();
PubsubTestEvent event = new PubsubTestEvent();
event.setMessage ("From TestConverter: " + message);
eventCollection.add(event) ;
return eventCollection;
}
public List<JSONObject> convert (Object event) throws Exception {
List<JSONObject> list = new ArrayList<JSONObject>(1);
Map map = new HashMap () ;
map.put ("message", ((PubsubTestEvent) event).getMessage());
list.add(new JSONObject (map)) ;
return list;

You can use the GSON Java library to help you convert Java objects to JSON format.
For more information, see:
m http://www.json.org/

m http://code.google.com/p/google-gson
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8.4 Configuring the HTTP Pub-Sub Adapter EPN Assembly File

For each HTTP pub-sub adapter in your event processing network, you must add a
corresponding wlevs: adapter element to the EPN assembly file of your application;
use the provider attribute to specify whether the HTTP pub-sub adapter is
publishing or subscribing.

As with any other stage in the EPN, add listeners to the wlevs:adapter element to
integrate the HTTP pub-sub adapter into the event processing network. The
requirements of your own Oracle CEP application define where in the EPN the HTTP
pub-sub adapters fit in.

This section describes:

= Section 8.4.1, "HTTP Pub-Sub Adapter for Publising EPN Assembly File
Configuration”

= Section 8.4.2, "HTTP Pub-Sub Adapter for Subscribing EPN Assembly File
Configuration”

For more information, see:
= Section 1.1.5, "Component Configuration Files."

= Section B.2, "Component Configuration Schema wlevs_application_config.xsd"

8.41 HTTP Pub-Sub Adapter for Publising EPN Assembly File Configuration

If you are using a built-in pub-sub adapter for publishing (either locally or remotely),
set the provider attribute to ht tppub, as shown:

<wlevs:adapter id="remotePublisher" provider="httppub"/>

The value of the id attribute, in this case remotePublisher, must match the name
specified for this built-in pub-sub adapter in its configuration file. Note that the
declaration of the built-in adapter for publishing in the EPN assembly file does not
specify whether this adapter is local or remote; you specify this in the adapter
configuration file.

As with any other stage in the EPN, add listeners to the wlevs:adapter element to
integrate the pub-sub adapter into the event processing network. Typically, a pub-sub
adapter for subscribing is the first stage in an EPN (because it receives messages) and a
pub-sub adapter for publishing would be in a later stage (because it sends messages).
However, the requirements of your own Oracle CEP application define where in the
network the pub-sub adapters fit in.

Also be sure that the event types used by the pub-sub adapters have been registered in
the event type repository using the wlevs:event-type-repository element.

The following sample EPN file shows an event processing network with two built-in
pub-sub adapters for publishing both local and remote publishing); see the text after
the example for an explanation:

<?xml version="1.0" encoding="UTF-8"?>
<beans xmlns="http://www.springframework.org/schema/beans"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmlns:osgi="http://www.springframework.org/schema/osgi"
xmlns:wlevs="http://www.bea.com/ns/wlevs/spring"
xsi:schemalocation="
http://www.springframework.org/schema/beans
http://www.springframework.org/schema/beans/spring-beans.xsd
http://www.springframework.org/schema/osgi
http://www.springframework.org/schema/osgi/spring-osgi.xsd
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http://www.bea.com/ns/wlevs/spring

http://www.bea.com/ns/wlevs/spring/spring-wlevs.xsd">
<wlevs:event-type-repository>
<wlevs:event-type type-name="com.mycompany.httppubsub.PubsubEvent">

<wlevs:class>com.mycompany.httppubsub.PubsubEvent</wlevs:class>

</wlevs:event-type>

</wlevs:event-type-repository>
<wlevs:adapter id="receiveFromFeed"

class="com.mycompany.httppubsub.ReceiveFromFeed">

</wlevs:adapter>

<wlevs:processor id="pubsubProcessor" />

<wlevs:adapter id="remotePublisher" provider="httppub"/>
<wlevs:adapter id="localPublisher" provider="httppub"/>
<wlevs:channel id="feed2processor">

<wlevs:source ref="receiveFromFeed"/>
<wlevs:listener ref="pubsubProcessor"/>
</wlevs:channel>

<wlevs:channel id="pubsubStream">

<wlevs:listener ref="remotePublisher"/>

<wlevs:listener ref="localPublisher"/>

<wlevs:source ref="pubsubProcessor"/>
</wlevs:channel>

</beans>

In the preceding example:

s The receiveFromFeed adapter is a custom adapter that receives data from some
data feed; the details of this adapter are not pertinent to this topic. The
receiveFromFeed adapter then sends its events to the pubsubProcessor via
the feed2processor channel.

s The pubsubProcessor processes the events from the receiveFromFeed
adapter and then sends them to the pubsubStream channel, which in turn sends
them to the two built-in pub-sub adapters: remotePublisher and
localPublisher.

= Based on the configuration of these two pub-sub adapters (see examples in
Section 8.2.2, "How to Configure an HTTP Pub-Sub Adapter Manually"),
remotePublisher publishes events only of type
com.mycompany . ht tppubsub. PubsubEvent and publishes them to the a
channel called /channell on the HTTP pub-sub server hosted remotely at
http://myhost.com:9102/pubsub.

The localPublisher pub-sub adapter publishes all events it receives to the local
HTTP pub-sub server, in other words, the one associated with the Oracle CEP
server on which the application is running. The local pub-sub server's path is
/pubsub and the channel to which the adapter publishes is called /channel?2.

The following sample EPN file shows an event processing network with one built-in
pub-sub adapter for subscribing; see the text after the example for an explanation:

<?xml version="1.0" encoding="UTF-8"?>
xmlns="http://www.springframework.org/schema/beans"

<beans

http

xmlns
xmlns
xmlns

:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
:0sgi="http://www.springframework.org/schema/osgi"
:wlevs="http://www.bea.com/ns/wlevs/spring"

xsi:schemaLocation="

/[ www
http:
http:
http:
http:
http:

/ [ www
/ [waw
/ [ ww
/ [ www
/ [ww

.springframework.org/schema/beans
.springframework.org/schema/beans/spring-beans.xsd
.springframework.org/schema/osgi
.springframework.org/schema/osgi/spring-osgi.xsd
.bea.com/ns/wlevs/spring
.bea.com/ns/wlevs/spring/spring-wlevs.xsd">

<wlevs:event-type-repository>
<wlevs:event-type type-name="com.mycompany.httppubsub.PubsubEvent">
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<wlevs:class>com.mycompany.httppubsub.PubsubEvent</wlevs:class>
</wlevs:event-type>
</wlevs:event-type-repository>
<wlevs:adapter id="remoteSubscriber" provider="httpsub">
<wlevs:listener ref="myEventBean"/>
</wlevs:adapter>
<bean id="myEventBean"
class="com.mycompany .httppubsub.MyEventBean">
</bean>
<wlevs:channel id="pubsubStream" advertise="true">
<wlevs:listener>
<bean id="mySink"
class="com.mycompany . httppubsub.MySink" />
</wlevs:listener>
<wlevs:source ref="myEventBean"/>
</wlevs:channel>
</beans>

In the preceding example:
s The remoteSubscriber adapter is a built-in pub-sub adapter for subscribing.

Based on the configuration of this adapter (see examples in Section 8.2.2, "How to
Configure an HTTP Pub-Sub Adapter Manually"), remoteSubscriber
subscribes to a channel called /channel3 configured for the remote HTTP
pub-sub server hosted at http: //myhost.com: 9102 /pubsub. Oracle CEP
converts each messages it receives from this channel to an instance of
com.mycompany . httppubsub. PubsubEvent and then sends it a Spring bean
called myEventBean.

s The myEventBean processes the event as described by the
com.mycompany . ht tppubsub. MyEventBean class, and then passes it the
mySink event source via the pubsubStream channel. This section does not
discuss the details of these components because they are not pertinent to the HTTP
pub-sub adapter topic.

8.4.2 HTTP Pub-Sub Adapter for Subscribing EPN Assembly File Configuration

If you are using a built-in pub-sub adapter for subscribing, set the provider attribute to
httpsub, as shown:

<wlevs:adapter id="remoteSubscriber" provider="httpsub"/>

The value of the id attribute, in this case remoteSubscriber, must match the name
specified for this built-in pub-sub adapter in its configuration file.

The value of the id attribute, in this case remoteSubscriber, must match the name
specified for this HTTP pub-sub adapter in its configuration file. The configuration file
configures the HTTP pub-sub server destination to which this adapter subscribes.

The following sample EPN file shows an event processing network with one built-in
pub-sub adapter for subscribing:

<?xml version="1.0" encoding="UTF-8"?>
<beans xmlns="http://www.springframework.org/schema/beans"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmlns:osgi="http://www.springframework.org/schema/osgi"
xmlns:wlevs="http://www.bea.com/ns/wlevs/spring"
xsi:schemalocation="
http://www.springframework.org/schema/beans
http://www.springframework.org/schema/beans/spring-beans.xsd
http://www.springframework.org/schema/osgi
http://www.springframework.org/schema/osgi/spring-osgi.xsd
http://www.bea.com/ns/wlevs/spring
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http://www.bea.com/ns/wlevs/spring/spring-wlevs.xsd">
<wlevs:event-type-repository>
<wlevs:event-type type-name="com.mycompany.httppubsub.PubsubEvent">
<wlevs:class>com.mycompany.httppubsub.PubsubEvent</wlevs:class>
</wlevs:event-type>
</wlevs:event-type-repository>
<wlevs:adapter id="remoteSubscriber" provider="httpsub">
<wlevs:listener ref="myEventBean"/>
</wlevs:adapter>
<bean id="myEventBean"
class="com.mycompany .httppubsub.MyEventBean">
</bean>
<wlevs:channel id="pubsubStream" advertise="true">
<wlevs:listener>
<bean id="mySink"
class="com.mycompany . httppubsub.MySink" />
</wlevs:listener>
<wlevs:source ref="myEventBean"/>
</wlevs:channel>
</beans>

8.5 Configuring the HTTP Pub-Sub Adapter Component Configuration
File
You configure the HTTP pub-sub adapters in their respective configuration files,

similar to how you configure other components in the event processing network, such
as processors or streams.

The root element for configuring an HTTP pub-sub adapter is
http-pub-sub-adapter. The name child element for a particular adapter must
match the id attribute of the corresponding wlevs:adapter element in the EPN
assembly file that declares this adapter.

This section describes:

= Section 8.5.1, "HTTP Pub-Sub Adapter for Publising Component Configuration"

= Section 8.5.2, "HTTP Pub-Sub Adapter for Subscribing Component Configuration"
For more information, see:

= Section 1.1.5, "Component Configuration Files."

= Section B.2, "Component Configuration Schema wlevs_application_config.xsd"

8.5.1 HTTP Pub-Sub Adapter for Publising Component Configuration

Table 8-1 lists the ht tp-pub-sub-adapter element child elments applicable to an
HTTP pub-sub adapter for publishing.

Table 8-1 http-pub-sub-adapter for Publishing Component Configuration Child
Elements

Child Element Description

server-context-path | Required. For each local HTTP pub-sub adapter for publishing, specify the
value of the Oracle CEP server config.xml file element ht tp-pubsub child
element path of the local HTTP pub-sub server associated with the Oracle
CEP instance hosting the current Oracle CEP application.

Default: /pubsub.

If you have created a new local HTTP pub-sub server, or changed the default
configuration, then specify the appropriate path child element value.

NOTE: Do not specify this option for a remote HTTP pub-sub adapter.
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Table 8-1 (Cont.) http-pub-sub-adapter for Publishing Component Configuration Child
Elements

Child Element Description

server-url Required. For each remote HTTP pub-sub adapter for publishing, specify the
URL of the remote HTTP pub-sub server to which the Oracle CEP application
will publish. The remote HTTP pub-sub server could be another instance of
Oracle CEP, or a WebLogic Server instance, or it could be any third-party
HTTP pub-sub server. For example:

http://myhost.com:9102/pubsub

NOTE: Do not specify this option for a local HTTP pub-sub adapter.

channel Required. For both local and remote HTTP pub-sub adapters for publishing,
specify the channel that the HTPP pub-sub adapter publishes to.

event-type Optional. For both local and remote HTTP pub-sub adapters for publishing,
specify the fully qualified class name of the JavaBean event to limit the
types of events that are published. Otherwise, all events sent to the HTTP
pub-sub adapter are published.

You must register this class in the EPN assembly file as a
wlevs:event-type-repository element wlevs:class child element.
For more information, see Section 2.2, "Creating an Oracle CEP Event Type as
a JavaBean".

user Optional. For both local and remote HTTP pub-sub adapters for publishing, if
the HTTP pub-sub server to which the Oracle CEP application is publishing
requires user authentication, specify a user name.

password Optional. For both local and remote HTTP pub-sub adapters for publishing, if
the HTTP pub-sub server to which the Oracle CEP application is publishing
requires user authentication, specify a password.

Choose either password or encrypted-password but not both.

encrypted-password | Optional. For both local and remote HTTP pub-sub adapters for publishing, if
the HTTP pub-sub server to which the Oracle CEP application is publishing
requires user authentication and requires password encryption, specify an
encrypted password.

Choose either password or encrypted-password but not both.

The following configuration file shows a complete example of configuring an HTTP
pub-sub adapter for publishing: both a remote and local publisher is shown.

<?xml version="1.0" encoding="UTF-8"?>
<nl:config
xsi:schemalocation="http://www.bea.com/ns/wlevs/config/application wlevs_application_
config.xsd"
xmlns:nl="http://www.bea.com/ns/wlevs/config/application"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<http-pub-sub-adapter>
<name>remotePublisher</name>
<server-url>http://myhost.com:9102/pubsub</server-url>
<channel>/channell</channel>
<event-type>com.mycompany . httppubsub. PubsubEvent</event-type>
<user>wlevs</user>
<password>wlevs</password>
</http-pub-sub-adapter>
<http-pub-sub-adapter>
<name>localPublisher</name>
<server-context-path>/pubsub</server-context-path>
<channel>/channel2</channel>
</http-pub-sub-adapter>
<http-pub-sub-adapter>
<name>remoteSubscriber</name>
<server-url>http://myhost.com:9102/pubsub</server-url>
<channel>/channel3</channel>
<event-type>com.mycompany . httppubsub. PubsubEvent</event-type>
</http-pub-sub-adapter>
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</nl:config>

8.5.2 HTTP Pub-Sub Adapter for Subscribing Component Configuration

Table 8-2 lists the ht tp-pub-sub-adapter element child elments applicable to an
HTTP pub-sub adapter for subscribing.

Table 8-2 http-pub-sub-adapter for Subscribing Component Configuration Child

Elements

Child Element

Description

server-url

Required. For each remote HTTP pub-sub adapter for subscribing, specify the
URL of the remote HTTP pub-sub server to which the Oracle CEP application
will publish. The remote HTTP pub-sub server could be another instance of
Oracle CEP, or a WebLogic Server instance, or it could be any third-party
HTTP pub-sub server

NOTE: do not specify this option for a local HTTP pub-sub adapter.

channel

Required. For both local and remote HTTP pub-sub adapters for subscribing,
specify the channel that the HTPP pub-sub adapter subscribes to.

event-type

Required. For both local and remote HTTP pub-sub adapters for subscribing,
specify the fully qualified class name of the JavaBean to which incoming
messages are mapped. At runtime, Oracle CEP uses the incoming key-value
pairs in the message to map the message data to the specified event type.

You must register this class in the EPN assembly file as a
wlevs:event-type-repository element wlevs:class child element.
For more information, see Section 2.2, "Creating an Oracle CEP Event Type as
a JavaBean".

user Optional. For both local and remote HTTP pub-sub adapters for subscribing,
if the HTTP pub-sub server to which the Oracle CEP application is publishing
requires user authentication, specify a user name.

password Optional. For both local and remote HTTP pub-sub adapters for subscribing,

if the HTTP pub-sub server to which the Oracle CEP application is publishing
requires user authentication, specify a password.

Choose either password or encrypted-password but not both.

encrypted-password

Optional. For both local and remote HTTP pub-sub adapters for subscribing,
if the HTTP pub-sub server to which the Oracle CEP application is publishing
requires user authentication and requires password encryption, specify an
encrypted password.

Choose either password or encrypted-password but not both.

The following configuration file shows a complete example of configuring an HTTP
pub-sub adapter for subscribing.

<?xml version="1.0" encoding="UTF-8"?>

<nl:config

xsi:schemaLocation="http://www.bea.com/ns/wlevs/config/application wlevs_application_

config.xsd"

xmlns:nl="http://www.bea.com/ns/wlevs/config/application"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<http-pub-sub-adapter>
<name>remotePublisher</name>
<server-url>http://myhost.com:9102/pubsub</server-url>
<channel>/channell</channel>

<event-type>com.mycompany.httppubsub.PubsubEvent</event-type>

<user>wlevs</user>

<password>wlevs</password>
</http-pub-sub-adapter>
<http-pub-sub-adapter>

<name>localPublisher</name>

<server-context-path>/pubsub</server-context-path>
<channel>/channel2</channel>
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</http-pub-sub-adapter>

<http-pub-sub-adapter>
<name>remoteSubscriber</name>
<server-url>http://myhost.com:9102/pubsub</server-url>
<channel>/channel3</channel>
<event-type>com.mycompany . httppubsub. PubsubEvent</event-type>

</http-pub-sub-adapter>

</nl:config>
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Configuring Channels

This section contains information on the following subjects:
= Section 9.1, "Overview of Channel Configuration"
= Section 9.2, "Configuring a Channel"

= Section 9.3, "Example Channel Configuration Files"

9.1 Overview of Channel Configuration

An Oracle CEP application contains one or more channel components. A channel
represents the physical conduit through which events flow between other types of
components, such as between adapters and processors, and between processors and
event beans (business logic POJOs).

You may use a channel with both streams and relations. For more information, see
Section 9.1.2, "Channels Representing Streams and Relations".

When you create a channel in your Event Processing Network (EPN), it has a default
configuration. For complete details, see Section C.10, "wlevs:channel".

The default channel configuration is typically adequate for most applications.

However, if you want to change this configuration, you must create a channel
element in a component configuration file. In this channel element, you can specify
channel configuration that overrides the defaults.

The component configuration file channel element’s name element must match the
EPN assembly file channel element’s id attribute. For example, given the EPN
assembly file channel element shown in Example 9-1, the corresponding component
configuration file channel element is shown in Example 9-2.

Example 9—-1 EPN Assembly File Channel Id: priceStream

<wlevs:channel id="priceStream" event-type="PriceEvent">
<wlevs:listener ref="filterFanoutProcessor" />
<wlevs:source ref="PriceAdapter" />

</wlevs:channel>

Example 9-2 Component Configuration File Channel Name: priceStream

<channel>
<name>priceStream</name>
<max-size>10000</max-size>
<max-threads>4</max-threads>
</channel>
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You can create a channel element in any of the following component configuration
files:

s The default Oracle CEP application configuration file (by default,
META-INF/wlevs/config.xml).

= A separate configuration file.

If your application has more than one channel, you can create a channel element for
each of them in the default config.xml file, you can create separate XML files in
META-INF/wlevs for each, or create a single XML file in META-INF/wlevs that
contains the configuration for all channels, or even all components of your application
(adapters, processors, and channels). Choose the method that best suits your
development environment.

By default, Oracle CEP IDE for Eclipse creates one component configuration file and
one EPN assembly file.

Component configuration files are deployed as part of the Oracle CEP application
bundle. You can later update this configuration at runtime using Oracle CEP
Visualizer, the wlevs . Admin utility, or manipulating the appropriate JMX Mbeans
directly.

This section describes:

m  Section 9.1.1, "When to Use a Channel"

= Section 9.1.2, "Channels Representing Streams and Relations"
= Section 9.1.3, "System-Timestamped Channels"

= Section 9.1.4, "Application-Timestamped Channels"

= Section 9.1.5, "Controlling Which Queries Output to a Downstream Channel:
selector”

= Section 9.1.6, "Batch Processing Channels"

m  Section 9.1.7, "EventPartitioner Channels"

For more information, see:

s Section 1.1.5, "Component Configuration Files"

= Section 4.3, "Creating EPN Assembly Files"

»  Oracle Complex Event Processing Visualizer User's Guide

s "wlevs.Admin Command-Line Reference" in the Oracle Complex Event Processing
Administrator’s Guide

s "Configuring JMX for Oracle CEP" in the Oracle Complex Event Processing
Administrator’s Guide

9.1.1 When to Use a Channel

When constructing your EPN, consider the following rules:

= A channel is mandator when connecting an Oracle CQL processor to a
down-stream stage.

= A channel is mandatory when connecting a push source stream or relation to a
processor.
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A channel is mandatory for a push source because in that case, the Oracle CQL
processor does need to be aware of its shape (that is, DDL is required) and so does
need the channel to act as intermediary.

= A channel is optional when connecting an external relation, or pull source, such as
a cache or table source, to a processor.

A channel is not needed between a pull source, such as a cache or table, and a
processor because the pull source represent an external relation. For an external
relation, the only valid operation is a join between a stream and a NOW window
operator and hence it is considered a pull source. In other words, the join actually
happens outside of the Oracle CQL processor. Because it is a pull, the Oracle CQL
processor does not need to be aware of its shape (that is, no DDL is required) and
so does not need the channel to act as intermediary.

In general, use a channel between components when:

= Buffering is needed between the emitting component and the receiver.
= Queuing or concurrency is needed for the receiving component.

= If a custom adapter is used and thread control is necessary.

It is a good design practice to include channels in your EPN to provide the flexibility
of performance tuning (using buffering, queuing, and concurrency options) later in the
design lifecycle. Setting the channel attribute max-threads to 0 puts a channel in
pass-through mode and incurs no performance penalty.

For more information, see:
s Section 9.1.7, "EventPartitioner Channels"

s Table C-9, " Attributes of the wlevs:channel Application Assembly Element"

9.1.2 Channels Representing Streams and Relations

A channel can represent either a stream or a relation.
For more information, see:
s Section 1.1.3.2, "Stream and Relation Sources"

= Section 9.1, "Overview of Channel Configuration"

9.1.2.1 Channels as Streams

A stream supports appends only. You specify a channel as a stream by setting EPN
assembly element wlevs:channel attribute is-relation to false (the default).

9.1.2.2 Channels as Relations
A relation supports inserts, deletes, and updates. You specify a channel as a relation by
setting EPN assembly element wlevs: channel attribute is-relation to true.

When a channel is a relation, you must specify one or more event properties that
define event identity using the wlevs:channel attribute primary-key as
Example 9-3 shows.

Example 9-3 Channel as Relation: primary-key Attribute

<wlevs:channel id="priceStream" event-type="PriceEvent" primary-key="stock,broker">
<wlevs:listener ref="filterFanoutProcessor" />
<wlevs:source ref="PriceAdapter" />
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</wlevs:channel>

Example 9-4 PriceEvent

<wlevs:event-type-repository>
<wlevs:event-type type-name="PriceEvent">
<wlevs:property>
<entry key="stock" value="java.lang.String"/>
<entry key="broker" value="java.lang.String"/>
<entry key="high" value="float"/>
<entry key="low" value="float"/>
</wlevs:property>
</wlevs:event-type>
</wlevs:event-type-repository>

For more information, see primary-key in Table C-9, " Attributes of the
wlevs:channel Application Assembly Element".

9.1.3 System-Timestamped Channels

By default, channels are system-timestamped. In this case, Oracle CEP will assign a
new time from the CPU clock under two conditions: when a new event arrives, and
when the configurable heartbeat timeout expires.

For more information, see:

= Section 9.2.1, "How to Configure a System-Timestamped Channel Using Oracle
CEP IDE for Eclipse"

s Section D.46, "heartbeat"

9.1.4 Application-Timestamped Channels

Optionally, you can configure a channel to be application-timestamped. In this case,
the time-stamp of an event is determined by the configurable wlevs:expression
element. A common example of an expression is a reference to a property on the event.
If no expression is specified, then the time-stamp may be propagated from a prior
event. For example, this is the case when you have a system-timestamped channel
from one Oracle CQL processor feeding events into an application-timestamped
channel of another downstream Oracle CQL processor.

In addition, an application can use the StreamSender . sendHeartbeat method to
send an event of type heart-beat downstream to StreamSink listeners in the EPN.

For more information, see:

= Section 9.2.2, "How to Configure an Application-Timestamped Channel Using
Oracle CEP IDE for Eclipse"

= Section C.3, "wlevs:application-timestamped"

= Section C.14, "wlevs:expression"

9.1.5 Controlling Which Queries Output to a Downstream Channel: selector

If you configure an Oracle CQL processor with more than one query, by default, all
queries output their results to the downstream channel.

You can control which queries may output their results to a downstream channel using
the channel selector child element.
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Figure 9-1 shows an EPN with channel £ilteredStream connected to up-stream
Oracle CQL processor filteredFanoutProcessor.

Figure 9-1 EPN With Oracle CQL Processor and Down-Stream Channel

pricestream filkeredStream
PriceAdapter filkerFanoutProcessor

Example 9-5 shows the queries configured for the Oracle CQL processor.

Example 9-5 filterFanoutProcessor Oracle CQL Queries

<processor>
<name>filterFanoutProcessor</name>
<rules>
<query id="Yr3Sector"><! [CDATA[
select cusip, bid, srcId, bidQty, ask, askQty, seq
from priceStream where sector="3_YEAR"
11></query>
<query id="Yr2Sector"><![CDATA[
select cusip, bid, srcId, bidQty, ask, askQty, seq
from priceStream where sector="2_YEAR"
11></query>
<query id="YrlSector"><![CDATA[
select cusip, bid, srcId, bidQty, ask, askQty, seq
from priceStream where sector="1_YEAR"
11></query>
</rules>
</processor>

If you specify more than one query for an Oracle CQL processor as Example 9-5
shows, then, by default, all query results are output to the processor’s out-bound
channel (filteredstreamin Figure 9-1). Optionally, in the component configuration
source, you can use the channel element selector child element to specify a
space-delimited list of one or more Oracle CQL query names that may output their
results to the channel as Example 9-6 shows. In this example, query results for query
Yr3Sector and Yr2Sector are output to filteredStream but not query results
for query YrlSector.

Example 9-6 Using selector to Control Which Query Results are Output

<channel>
<name>filteredStream</name>
<selector>Yr3Sector Yr2Sector</selector>
</channel>

You may configure a channel element with a selector before creating the queries
in the upstream processor. In this case, you must specify query names that match the
names in the selector.

Note: The selector child element is only applicable if the
up-stream node is an Oracle CQL processor. For more information, see
Chapter 10, "Configuring Oracle CQL Processors".

For more information, see Appendix D.78, "selector".
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9.1.6 Batch Processing Channels

By default, a channel processes events as they arrive. Alternatively, you can configure
a channel to batch events together that have the same timestamp and were output
from the same query by setting the wlevs: channel attribute batching to true as
Example 9-7 shows.

Example 9-7 Batch Processing Channel

<wlevs:channel id="priceStream" event-type="PriceEvent" batching="true">
<wlevs:listener ref="filterFanoutProcessor" />
<wlevs:source ref="PriceAdapter" />

</wlevs:channel>

For more information, see:
s Section 1.1.3.2, "Stream and Relation Sources"
s Section 1.1.3.3, "Stream and Relation Sinks"

s batching in Table C-9, " Attributes of the wlevs:channel Application Assembly
Element"

9.1.7 EventPartitioner Channels

By default, a channel broadcasts each event to every listener.

When you configure a channel to use an EventPartitioner, each time an incoming
event arrives, the channel selects a listener and dispatches the event to that listener
instead of broadcasting each event to every listener.

You can use an EventPartitioner on a channel to improve scalability.

For more information, see Section 22.2.1, "EventPartitioner".

9.2 Configuring a Channel
You can configure a channel manually or by using the Oracle CEP IDE for Eclipse.

See Section B.2, "Component Configuration Schema wlevs_application_config.xsd" for
the complete XSD Schema that describes the channel component configuration file.

See Section 9.3, "Example Channel Configuration Files" for a complete example of a
channel configuration file.

This section describes the following topics:

= Section 9.2.1, "How to Configure a System-Timestamped Channel Using Oracle
CEP IDE for Eclipse"

= Section 9.2.2, "How to Configure an Application-Timestamped Channel Using
Oracle CEP IDE for Eclipse"

= Section 9.2.3, "How to Create a Channel Component Configuration File Manually"

9.2.1 How to Configure a System-Timestamped Channel Using Oracle CEP IDE for
Eclipse

This section describes how to create a system-timestamped channel.
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The most efficient and least error-prone way to create and edit a channel configuration
in the default component configuration file is to use the Oracle CEP IDE for Eclipse.
Optionally, you can create a channel configuration file manually (see Section 9.2.3,
"How to Create a Channel Component Configuration File Manually").

For more information, see:

Section 9.1.3, "System-Timestamped Channels"
Chapter 6, "Oracle CEP IDE for Eclipse and the Event Processing Network"

To configure a channel using Oracle CEP IDE for Eclipse:
Use Oracle CEP IDE for Eclipse to create a channel.

1.

See Section 6.4.1.1, "How to Create a Basic Node".

Optionally, override the default channel assembly file configuration by adding
additional wlevs: channel attributes and child elements:

b.

Right-click the channel node and select Go To Assembly Source.
Add the appropriate wlevs: channel attributes.

Required attributes include:

- id

- event-type

In particular, specify whether this channel is a stream or relation by
configuring attribute is-relation:

- To specify this channel as stream , set is-relation to false (default).
- To specify this channel as a relation, set is-relation to true.

If you specify this channel as a relation, you must also configure the chan-
nel attribute primary-key.

See Table C-9, " Attributes of the wlevs:channel Application Assembly
Element".

Add the appropriate wlevs: channel child elements.
- Appendix C.17, "wlevs:instance-property"

- Appendix C.18, "wlevs:listener"

- Appendix C.21, "wlevs:property"

- Appendix C.22, "wlevs:source"

In the Project Explorer, expand your META-INF/wlevs directory.

Choose the component configuration file you want to use:

To use the default component configuration file, right-click the
META-INF/wlevs/config.xml file and select Open With > XML Editor.

The file opens in an XML Editor.

To create a new component configuration file:

- Right-click the wlevs directory and select New > File.
The New File dialog appears.

— Enter a file name.
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You can name the file anything you want but the name of the file must
end in .xml.

— Click Finish.

Oracle CEP IDE for Eclipse adds the component configuration file to the
wlevs directory.

5. Right-click the component configuration file you chose to use and select Open
With > XML Editor.

The file opens in an XML Editor.

6. If you created a new component configuration file, add the header and config
element shown in Example 9-8. Otherwise, proceed to step 7.

Example 9-8 Component Configuration File Header and config Element

<?xml version="1.0" encoding="UTF-8"?>

<nl:config xsi:schemalLocation="http://www.bea.com/ns/wlevs/config/application
wlevs_application_config.xsd"
xmlns:nl="http://www.bea.com/ns/wlevs/config/application"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">

</config>

7. Add a channel element for the channel as Example 9-9 shows.

Example 9-9 Component Configuration File Channel Element
<?xml version="1.0" encoding="UTF-8"?>
<nl:config xsi:schemalocation="http://www.bea.com/ns/wlevs/config/application
wlevs_application_config.xsd"
xmlns:nl="http://www.bea.com/ns/wlevs/config/application"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">

<processor>

</processor>

<channel>

</channel>
</config>

8. Add a name child element to the channel element.

The name element value must match the corresponding EPN assembly file
channel element’s id attribute.

For example, given the EPN assembly file channel element shown in
Example 9-10, the corresponding configuration file channel element is shown in
Example 9-11.

Example 9-10 EPN Assembly File Channel Id: priceStream

<wlevs:channel id="priceStream" event-type="PriceEvent">
<wlevs:listener ref="filterFanoutProcessor" />
<wlevs:source ref="PriceAdapter" />

</wlevs:channel>

Example 9-11 Component Configuration File Channel Name: priceStream

<channel>
<name>priceStream</name>
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</channel>

Caution: Identifiers and names in XML files are case sensitive. Be
sure to specify the same case when referencing the component's
identifier in the EPN assembly file.

9. Optionally, override the default channel configuration by adding additional
channel child elements:

Add a max-threads child element to specify the maximum number of
threads that Oracle CEP server uses to process events for this channel.

Setting this value has no effect when max-size is 0. The default value is 0.

<channel>
<name>priceStream</name>
<max-threads>2</size>
</channel>

When set to 0, the channel acts as a pass-through. When max-threads > 0,
the channel acts as classic blocking queue, where upstream components are
producers of events and the downstream components are the consumers of
events. The queue size is defined by the configuration max-size. There will
be up to max-threads number of threads consuming events from the queue.

Add a max-size child element to specify the maximum size of the channel.
Zero-size channels synchronously pass-through events.

Non-zero size channels process events asynchronously, buffering events by the
requested size. The default value is 0.

<channel>
<name>priceStream</name>
<max-size>10000</size>
</channel>

Add a heartbeat child element to specify the number of nanoseconds a
channel can be idle before Oracle CEP generates a heartbeat event to advance
time.

The heartbeat child element applies to system-timestamped relations or
streams only when no events arrive in the event channels that are feeding the
processors and the processor has been configured with a statement that
includes some temporal operator, such as a time-based window or a pattern
matching with duration.

<channel>
<name>MatchOutputChannel</name>
<heartbeat>10000</heartbeat>
</channel>

Add a selector child element to specify which up-stream Oracle CQL
processor queries are permitted to output their results to the channel.

You may configure a channel element with a selector before creating the
queries in the upstream processor. In this case, you must specify query names
that match the names in the selector.

For more information, Section 9.1.5, "Controlling Which Queries Output to a
Downstream Channel: selector".
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Note: The selector attribute is only applicable if the up-stream
node is an Oracle CQL processor. For more information, see
Chapter 10, "Configuring Oracle CQL Processors".

10. Select File > Save.

The EPN Editor adds a configuration badge to the channel as Figure 9-2 shows.
For more information, see Section 6.2.7, "Configuration Badging".

Figure 9-2 Channel With Configuration Badge

CR—

priceSkream
Pricefdapter filkerFanautPracessar

9.2.2 How to Configure an Application-Timestamped Channel Using Oracle CEP IDE for

Eclipse

This section describes how to create an application-timestamped channel.

The most efficient and least error-prone way to create and edit a channel configuration
in the default component configuration file is to use the Oracle CEP IDE for Eclipse.
Optionally, you can create a channel configuration file manually (see Section 9.2.3,
"How to Create a Channel Component Configuration File Manually").

For more information, see:
= Section 9.1.4, "Application-Timestamped Channels"
»  Chapter 6, "Oracle CEP IDE for Eclipse and the Event Processing Network"

To configure a channel using Oracle CEP IDE for Eclipse:
1. Use Oracle CEP IDE for Eclipse to create a channel.

See Section 6.4.1.1, "How to Create a Basic Node".

2. Optionally, override the default channel assembly file configuration by adding
additional wlevs: channel attributes and child elements:

a. Right-click the channel node and select Go To Assembly Source.
b. Add the appropriate wlevs: channel attributes.

In particular, specify whether this channel is a stream or relation by
configuring attribute is-relation:

- To specify this channel as stream , set is-relation to false (default).
- To specify this channel as a relation, set is-relation to true.

See Table C-9, " Attributes of the wlevs:channel Application Assembly
Element".

c. Addawlevs:application-timestamped child element.

Use this element to specify a wlevs : expression child element that Oracle
CEP uses to generate timestamp values.

Optionally, configure the wlevs:application-timestamped attributes:
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- is-total-order: specifies if the application time published is always
strictly greater than the last value used.

Valid values are true or false. Default: false.

For more information, see Appendix C.3, "wlevs:application-timestamped".
d. Add other appropriate wlevs:channel child elements.

- Appendix C.17, "wlevs:instance-property"

- Appendix C.18, "wlevs:listener"

- Appendix C.21, "wlevs:property"

- Appendix C.22, "wlevs:source"
In the Project Explorer, expand your META-INF/wlevs directory.
Choose the component configuration file you want to use:

a. To use the default component configuration file, right-click the
META-INF/wlevs/config.xml file and select Open With > XML Editor.

The file opens in an XML Editor.
b. To create a new component configuration file:
- Right-click the wlevs directory and select New > File.
The New File dialog appears.
- Enter a file name.

You can name the file anything you want but the name of the file must
end in .xml.

— Click Finish.

Oracle CEP IDE for Eclipse adds the component configuration file to the
wlevs directory.

Right-click the component configuration file you chose to use and select Open
With > XML Editor.

The file opens in an XML Editor.

If you created a new component configuration file, add the header and config
element shown in Example 9-8. Otherwise, proceed to step 7.

Example 9-12 Component Configuration File Header and config Element

<?xml version="1.0" encoding="UTF-8"?>

<nl:config xsi:schemalocation="http://www.bea.com/ns/wlevs/config/application
wlevs_application_config.xsd"
xmlns:nl="http://www.bea.com/ns/wlevs/config/application"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">

</config>

Add a channel element for the channel as Example 9-9 shows.

Example 9—-13 Component Configuration File Channel Element

<?xml version="1.0" encoding="UTF-8"?>

<nl:config xsi:schemalLocation="http://www.bea.com/ns/wlevs/config/application
wlevs_application_config.xsd"
xmlns:nl="http://www.bea.com/ns/wlevs/config/application"
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xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<processor>

</processor>

<channel>

</channel>
</config>

8. Add a name child element to the channel element.

The name element value must match the corresponding EPN assembly file
channel element’s id attribute.

For example, given the EPN assembly file channel element shown in
Example 9-10, the corresponding configuration file channel element is shown in
Example 9-11.

Example 9-14 EPN Assembly File Channel Id: priceStream

<wlevs:channel id="priceStream" event-type="PriceEvent">
<wlevs:listener ref="filterFanoutProcessor" />
<wlevs:source ref="PriceAdapter" />

</wlevs:channel>

Example 9-15 Component Configuration File Channel Name: priceStream

<channel>
<name>priceStream</name>
</channel>

Caution: Identifiers and names in XML files are case sensitive. Be
sure to specify the same case when referencing the component's
identifier in the EPN assembly file.

9. Optionally, override the default channel configuration by adding additional
channel child elements:

= Add amax-threads child element to specify the maximum number of
threads that Oracle CEP server uses to process events for this channel.

Setting this value has no effect when max-size is 0. The default value is 0.

<channel>
<name>priceStream</name>
<max-threads>2</size>
</channel>

When set to 0, the channel acts as a pass-through. When max-threads > 0,
the channel acts as classic blocking queue, where upstream components are
producers of events and the downstream components are the consumers of
events. The queue size is defined by the configuration max-size. There will
be up to max-threads number of threads consuming events from the queue.

= Add amax-size child element to specify the maximum size of the channel.
Zero-size channels synchronously pass-through events.

Non-zero size channels process events asynchronously, buffering events by the
requested size. The default value is 0.
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<channel>
<name>priceStream</name>
<max-size>10000</size>
</channel>

Add a selector child element to specify which up-stream Oracle CQL
processor queries are permitted to output their results to the channel.

You may configure a channel element with a selector before creating the
queries in the upstream processor. In this case, you must specify query names
that match the names in the selector.

For more information, Section 9.1.5, "Controlling Which Queries Output to a
Downstream Channel: selector".

Note: The selector attribute is only applicable if the up-stream
node is an Oracle CQL processor. For more information, see
Chapter 10, "Configuring Oracle CQL Processors".

For more information, Section D.78, "selector".

10. Select File > Save.

The EPN Editor adds a configuration badge to the channel as Figure 9-2 shows.
For more information, see Section 6.2.7, "Configuration Badging".

Figure 9-3 Channel With Configuration Badge
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9.2.3 How to Create a Channel Component Configuration File Manually

Although the Oracle CEP IDE for Eclipse is the most efficient and least error-prone
way to create and a channel configuration file (see Section 9.2.1, "How to Configure a
System-Timestamped Channel Using Oracle CEP IDE for Eclipse"), alternatively, you
can also create and maintain a channel configuration file manually.

For simplicity, the following procedure assumes that you are going to configure all
components of an application in a single XML file.

To create a channel component configuration file manually:

1.

Create an EPN assembly file and add a wlevs:channel element for each channel in

your application.

Uniquely identify each wlevs:channel with the 14 attribute.

See Section 4.3, "Creating EPN Assembly Files" for details.

Optionally, override the default channel assembly file configuration by adding

additional wlevs:channel attributes and child elements:

a.

Add the appropriate wlevs : channel attributes.

See Table C-9, " Attributes of the wlevs:channel Application Assembly
Element".

Add the appropriate wlevs: channel child elements.

Configuring Channels 9-13



Configuring a Channel

- Appendix C.3, "wlevs:application-timestamped"
- Appendix C.17, "wlevs:instance-property"
- Appendix C.18, "wlevs:listener"
- Appendix C.21, "wlevs:property"
- Appendix C.22, "wlevs:source"
3. Create an XML file using your favorite XML editor.

You can name this XML file anything you want, provided it ends with the .xm1
extension.

The root element of the configuration file is config, with namespace definitions
shown in the next step.

4. For each channel in your application, add a channel child element of config.

Uniquely identify each channel with the name child element. This name must be
the same as the value of the id attribute in the channel element of the EPN
assembly file that defines the event processing network of your application. This is
how Oracle CEP knows to which particular channel component in the EPN
assembly file this channel configuration applies. See Section 4.3, "Creating EPN
Assembly Files" for details.

For example, if your application has two streams, the configuration file might
initially look like:

<?xml version="1.0" encoding="UTF-8"?>
<nl:config xmlns:nl="http://www.bea.com/ns/wlevs/config/application"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<helloworld:config
xmlns:helloworld="http://www.bea.com/xml/ns/wlevs/example/helloworld">
<processor>

</processor>

<channel>
<name>firstStream</name>

</channel>

<channel>
<name>secondStream</name>

</channel>
</helloworld:config>

In the example, the configuration file includes two channels called firstStream
and secondStream. This means that the EPN assembly file must include at least
two channel registrations with the same identifiers:

<wlevs:channel id="firstStream" ...>

</wlevs:channel>
<wlevs:channel id="secondStream" ...>

</wlevs:channel>
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Caution: Identifiers and names in XML files are case sensitive, so be
sure you specify the same case when referencing the component's
identifier in the EPN assembly file.

5. Optionally, override the default channel configuration by adding additional
channel child elements:

Add a max-threads child element to specify the maximum number of
threads that Oracle CEP server uses to process events for this channel.

Setting this value has no effect when max-size is 0. The default value is 0.

<channel>
<name>priceStream</name>
<max-threads>2</size>
</channel>

When set to 0, the channel acts as a pass-through. When max-threads > 0,
the channel acts as classic blocking queue, where upstream components are
producers of events and the downstream components are the consumers of
events. The queue size is defined by the configuration max-size. There will
be up to max-threads number of threads consuming events from the queue.

Add a max-size child element to specify the maximum size of the channel.
Zero-size channels synchronously pass-through events.

Non-zero size channels process events asynchronously, buffering events by the
requested size. The default value is 0.

<channel>
<name>priceStream</name>
<max-size>10000</size>
</channel>

Add a heartbeat child element to specify the number of nanoseconds a
channel can be idle before Oracle CEP generates a heartbeat event to advance
time.

The heartbeat child element applies to system-timestamped relations or
streams only when no events arrive in the event channels that are feeding the
processors and the processor has been configured with a statement that
includes some temporal operator, such as a time-based window or a pattern
matching with duration.

<channel>
<name>MatchOutputChannel</name>
<heartbeat>10000</heartbeat>
</channel>

Add a selector child element to specify which up-stream Oracle CQL
processor queries are permitted to output their results to the channel.

You may configure a channel element with a selector before creating the
queries in the upstream processor. In this case, you must specify query names
that match the names in the selector.

For more information, Section 9.1.5, "Controlling Which Queries Output to a
Downstream Channel: selector".
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Note: The selector attribute is only applicable if the up-stream
node is an Oracle CQL processor. For more information, see
Chapter 10, "Configuring Oracle CQL Processors".

For more information, Section D.78, "selector".

6. Save and close the configuration file.

9.3 Example Channel Configuration Files

Figure 9—4 shows part of an EPN that contains two channels: priceStream and
filteredStream. The priceStream channel is an in-bound channel that connects
the PriceAdapter event source and its PriceEvent events to an Oracle CQL
processor filterFanoutProcessor. The filteredStream channel is an
out-bound channel that connects the Oracle CQL processor’s query results
(FilteredPriceEvent events) to down-stream components (not shown in

Figure 9-4).

Figure 9-4 EPN with Two Channels
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This section provides example channel configuration files, including:
= Section 9.3.1, "Channel Component Configuration File"

= Section 9.3.2, "Channel EPN Assembly File"

9.3.1 Channel Component Configuration File

Example 9-16 shows a sample component configuration file that configures the two
channels shown in Figure 9-4.

Example 9-16 Sample Channel Component Configuration File

<?xml version="1.0" encoding="UTF-8"?>
<nl:config xmlns:nl="http://www.bea.com/ns/wlevs/config/application"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<processor>
<name>filterFanoutProcessor</name>
<rules>
<query id="Yr3Sector"><! [CDATA|
select cusip, bid, srcId, bidQty, ask, askQty, seq
from priceStream where sector="3_YEAR"
11></query>
</rules>
</processor>
<channel>
<name>priceStream</name>
<max-size>10000</max-size>
<max-threads>4</max-threads>
</channel>
<channel>
<name>filteredStream</name>
<max-size>5000</max-size>
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<max-threads>2</max-threads>
</channel>
</nl:config>

9.3.2 Channel EPN Assembly File

Example 9-17 shows a EPN assembly file that configures the two channels shown in
Figure 9-4.

Example 9-17 Channel EPN Assembly File

<?xml version="1.0" encoding="UTF-8"?>
<beans xmlns="http://www.springframework.org/schema/beans"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmlns:osgi="http://www.springframework.org/schema/osgi"
xmlns:wlevs="http://www.bea.com/ns/wlevs/spring"
xmlns:cqglx="http://www.oracle.com/schema/cglx"
xsi:schemalocation="
http://www.springframework.org/schema/beans
http://www.springframework.org/schema/beans/spring-beans.xsd
http://www.springframework.org/schema/osgi
http://www.springframework.org/schema/osgi/spring-osgi.xsd
http://www.bea.com/ns/wlevs/spring
http://www.bea.com/ns/wlevs/spring/spring-wlevs-vll_1_1_3.xsd">

<wlevs:event-type-repository>
<wlevs:event-type type-name="PriceEvent">
<wlevs:properties>
<wlevs:property name="cusip" type="java.lang.String" />
<wlevs:property name="bid" type="java.lang.Double" />
<wlevs:property name="srcId" type="java.lang.String" />
<wlevs:property name="bidQty" type="java.lang.Integer" />
<wlevs:property name="ask" type="java.lang.Double" />
<wlevs:property name="askQty" type="java.lang.Integer" />
<wlevs:property name="seq" type="java.lang.Long" />
<wlevs:property name="sector" type="java.lang.String" />
</wlevs:properties>
</wlevs:event-type>
<wlevs:event-type type-name="FilteredPriceEvent">
<wlevs:properties>
<wlevs:property name="cusip" type="java.lang.String" />
<wlevs:property name="bid" type="java.lang.Double" />
<wlevs:property name="srcId" type="java.lang.String" />
<wlevs:property name="bidQty" type="java.lang.Integer" />
<wlevs:property name="ask" type="java.lang.Double" />
<wlevs:property name="askQty" type="java.lang.Integer" />
<wlevs:property name="seq" type="java.lang.Long" />
</wlevs:properties>
</wlevs:event-type>
<wlevs:event-type type-name="BidAskEvent">
<wlevs:properties>
<wlevs:property name="cusip" type="java.lang.String" />
<wlevs:property name="bidseq" type="java.lang.Long" />
<wlevs:property name="bidSrcId" type="java.lang.String" />
<wlevs:property name="bid" type="java.lang.Double" />
<wlevs:property name="askseq" type="java.lang.Long" />
<wlevs:property name="askSrcId" type="java.lang.String" />
<wlevs:property name="ask" type="java.lang.Double" />
<wlevs:property name="bidQty" type="java.lang.Integer" />
<wlevs:property name="askQty" type="java.lang.Integer" />
<wlevs:property name="intermediateStrategy" type="java.lang.String" />
<wlevs:property name="correlationId" type="java.lang.Long" />
<wlevs:property name="priority" type="java.lang.Integer" />
</wlevs:properties>
</wlevs:event-type>
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<wlevs:event-type type-name="FinalOrderEvent">
<wlevs:properties>
<wlevs:property name="cusip" type="java.lang.String" />
<wlevs:property name="bidseq" type="java.lang.Long" />
<wlevs:property name="bidSrcId" type="java.lang.String" />
<wlevs:property name="bid" type="java.lang.Double" />
<wlevs:property name="bidQty" type="java.lang.Integer" />
<wlevs:property name="bidSourceStrategy" type="java.lang.String"
<wlevs:property name="askseqg" type="java.lang.Long" />
<wlevs:property name="askSrcId" type="java.lang.String" />
<wlevs:property name="ask" type="java.lang.Double" />
<wlevs:property name="askQty" type="java.lang.Integer" />
<wlevs:property name="askSourceStrategy" type="java.lang.String"
<wlevs:property name="correlationId" type="java.lang.Long" />
</wlevs:properties>
</wlevs:event-type>
</wlevs:event-type-repository>

<!-- Assemble EPN (event processing network) -->
<wlevs:adapter advertise="true" id="PriceAdapter"
provider="csvgen">
<wlevs:instance-property name="port" value="9008" />
<wlevs:instance-property name="eventTypeName"
value="PriceEvent" />
<wlevs:instance-property name="eventPropertyNames"
value="srcId, sector,cusip,bid, ask,bidQty, askQty, seq" />
</wlevs:adapter>

<wlevs:channel id="priceStream" event-type="PriceEvent">
<wlevs:listener ref="filterFanoutProcessor" />
<wlevs:source ref="PriceAdapter" />

</wlevs:channel>

<!-- By default, CQL is used for OCEP 11.0 -->
<wlevs:processor id="filterFanoutProcessor" >
</wlevs:processor>

<wlevs:channel id="filteredStream"
event-type="FilteredPriceEvent">
<wlevs:listener ref="bbaProcessor" />
<wlevs:listener ref="analyticsProcessor" />
<wlevs:source ref="filterFanoutProcessor" />
</wlevs:channel>

<!-- Explicitly specify provider CQL -->
<wlevs:processor id="bbaProcessor" provider="cqgl">

<wlevs:listener ref="bidAskBBAStream" />
</wlevs:processor>

<wlevs:processor id="analyticsProcessor">
<wlevs:listener ref="bidAskAnalyticsStream" />
</wlevs:processor>

<wlevs:channel id="bidAskBBAStream" event-type="BidAskEvent">
<wlevs:listener ref="selectorProcessor" />
</wlevs:channel>

<wlevs:channel id="bidAskAnalyticsStream" event-type="BidAskEvent">
<wlevs:listener ref="selectorProcessor" />

</wlevs:channel>

<wlevs:processor id="selectorProcessor">
<wlevs:listener ref="citipocOut" />

</wlevs:processor>

<wlevs:channel id="citipocOut" event-type="FinalOrderEvent" advertise="true">
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<wlevs:listener>
<!-- Create business object -->
<bean id="outputBean"
class="com.bea.wlevs.POC.citi.OutputBean"
autowire="byName" />
</wlevs:listener>
</wlevs:channel>
</beans>
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Configuring Oracle CQL Processors

This section contains information on the following subjects:

= Section 10.1, "Overview of Oracle CQL Processor Configuration"

= Section 10.2, "Configuring an Oracle CQL Processor"

= Section 10.3, "Configuring an Oracle CQL Processor Table Source"
= Section 10.4, "Configuring an Oracle CQL Processor Cache Source"

= Section 10.5, "Example Oracle CQL Processor Configuration Files"

Note: Oracle CQL replaces Event Processing Language (EPL) in
Oracle CEP 11g Release 1 (11.1.1). Oracle CEP supports EPL for
backwards compatibility. For more information, see Chapter 11,
"Configuring EPL Processors".

10.1 Overview of Oracle CQL Processor Configuration

An Oracle CEP application contains one or more complex event processors, or
processors for short. Each processor takes as input events from one or more adapters;
these adapters in turn listen to data feeds that send a continuous stream of data from a
source. The source could be anything, from a financial data feed to the Oracle CEP
load generator.

The main feature of an Oracle CQL processor is its associated Oracle Continuous
Query Language (Oracle CQL) rules that select a subset of the incoming events to then
pass on to the component that is listening to the processor. The listening component
could be another processor, or the business object POJO that typically defines the end
of the event processing network, and thus does something with the events, such as
publish them to a client application. For more information on Oracle CQL, see the
Oracle Complex Event Processing CQL Language Reference.

For each Oracle CQL processor in your application, you must create a processor
element in a component configuration file. In this processor element you specify the
initial set of Oracle CQL rules of the processor and any optional processor
configuration.

You can configure additional optional Oracle CQL processor features in the Oracle
CQL processor EPN assembly file.

The component configuration file processor element’s name element must match
the EPN assembly file processor element’s id attribute. For example, given the EPN
assembly file processor element shown in Example 10-1, the corresponding
component configuration file processor element is shown in Example 10-2.
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Example 10-1 EPN Assembly File Oracle CQL Processor Id: proc

<wlevs:processor id="proc">
<wlevs:table-source ref="Stock" />
</wlevs:processor>

Example 10-2 Component Configuration File Oracle CQL Processor Name: proc

<processor>
<name>proc</name>
<rules>
<query id="gl"><![CDATA[
SELECT ExchangeStream.symbol, ExchangeStream.price, Stock.exchange
FROM ExchangeStream [Now], Stock
WHERE ExchangeStream.symbol = Stock.symbol
11></query>
</rules>
</procesor>

You can create a processor element in any of the following component configuration
files:

s The default Oracle CEP application configuration file (by default,
META-INF/wlevs/config.xml).

= A separate configuration file.

If your application has more than one processor, you can create a processor element
for each of them in the default config.xml file, you can create separate XML files in
META-INF/wlevs for each, or create a single XML file in META-INF/wlevs that
contains the configuration for all processors, or even all components of your
application (adapters, processors, and channels). Choose the method that best suits
your development environment.

By default, Oracle CEP IDE for Eclipse creates one component configuration file and
one EPN assembly file. When you create an Oracle CQL processor using Oracle CEP
IDE for Eclipse, by default, the processor element is added to the default component
configuration file META-INF/wlevs/config.xml file. Using Oracle CEP IDE for
Eclipse, you can choose to create a new configuration file or use an existing
configuration file at the time you create the Oracle CQL processor.

Component configuration files are deployed as part of the Oracle CEP application
bundle. You can later update this configuration at runtime using Oracle CEP
Visualizer, the wlevs . Admin utility, or manipulating the appropriate JMX Mbeans
directly.

For more information, see:

= Section 1.1.5, "Component Configuration Files"

= Section 1.1.4, "EPN Assembly File"

= Section 4.3, "Creating EPN Assembly Files"

»  Oracle Complex Event Processing Visualizer User’s Guide

= "wlevs.Admin Command-Line Reference" in the Oracle Complex Event Processing
Administrator’s Guide

s "Configuring JMX for Oracle CEP" in the Oracle Complex Event Processing
Administrator’s Guide

For more information on Oracle CQL processor configuration, see:

= Section 10.1.1, "Controlling Which Queries Output to a Downstream Channel"
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= Section 10.2, "Configuring an Oracle CQL Processor"
s Section 10.3, "Configuring an Oracle CQL Processor Table Source"
= Section 10.4, "Configuring an Oracle CQL Processor Cache Source"

= Section 10.5, "Example Oracle CQL Processor Configuration Files"

10.1.1 Controlling Which Queries Output to a Downstream Channel

If you configure an Oracle CQL processor with more than one query, by default, all
queries output their results to the downstream channel.

You can control which queries may output their results to a downstream channel using
the channel selector element to specify a space delimited list of query names that
may output their results on this channel.

You may configure a channel element with a selector before creating the queries
in the upstream processor. In this case, you must specify query names that match the
names in the selector.

For more information, see Section 9.1.5, "Controlling Which Queries Output to a
Downstream Channel: selector".

10.2 Configuring an Oracle CQL Processor
You can configure a processor manually or by using the Oracle CEP IDE for Eclipse.

See Section B.2, "Component Configuration Schema wlevs_application_config.xsd" for
the complete XSD Schema that describes the processor component configuration file.

See Section 10.5, "Example Oracle CQL Processor Configuration Files" for a complete
example of an Oracle CQL processor component configuration file and assembly file.

This section describes the following topics:

= Section 10.2.1, "How to Configure an Oracle CQL Processor Using Oracle CEP IDE
for Eclipse"

= Section 10.2.2, "How to Create an Oracle CQL Processor Component Configuration
File Manually"

10.2.1 How to Configure an Oracle CQL Processor Using Oracle CEP IDE for Eclipse

The most efficient and least error-prone way to create and edit a processor is to use the
Oracle CEP IDE for Eclipse. Optionally, you can create and edit a processor manually
(see Section 10.2.2, "How to Create an Oracle CQL Processor Component
Configuration File Manually").

To configure an Oracle CQL processor using Oracle CEP IDE for Eclipse:
1. Use Oracle CEP IDE for Eclipse to create a processor.

See Section 6.4.1.3, "How to Create a Processor Node".

When you use the EPN editor to create an Oracle CQL processor, Oracle CEP IDE
for Eclipse prompts you to choose either the default component configuration file
or a new component configuration file. For more information, see Chapter 6,
"Oracle CEP IDE for Eclipse and the Event Processing Network".

2. Right-click the processor node and select Go to Configuration Source.
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Oracle CEP IDE for Eclipse opens the appropriate component configuration file.
The default processor component configuration is shown in Example 10-3.

The default processor component configuration includes a name element and
rules element.

Use the rules element to group the child elements you create to contain the
Oracle CQL statements this processor executes, including:

= rule: contains Oracle CQL statements that register or create user-defined
windows. The rule element id attribute must match the name of the
window.

s view: contains Oracle CQL view statements (the Oracle CQL equivalent of
subqueries). The view element id attribute defines the name of the view.

s query: contains Oracle CQL select statements. The query element id
attribute defines the name of the query.

The default processor component configuration includes a dummy query element
with id Query.

Example 10-3 Default Processor Component Configuration

<processor>
<name>proc</name>
<rules>
<query id="Query"><!-- <![CDATA[ select * from MyChannel [now] ]]> -->
</query>
</rules>
</processor>

3. Replace the dummy query element with the rule, view, and query elements
you create to contain the Oracle CQL statements this processor executes.

For more information, see "Introduction to Oracle CQL Queries, Views, and Joins"
in the Oracle Complex Event Processing CQL Language Reference.

4. Select File > Save.

5. Optionally, configure additional Oracle CQL processor features in the assembly
file:
s Section 10.1.1, "Controlling Which Queries Output to a Downstream Channel"

s Section 10.3, "Configuring an Oracle CQL Processor Table Source"

= Section 10.4, "Configuring an Oracle CQL Processor Cache Source"

10.2.2 How to Create an Oracle CQL Processor Component Configuration File Manually

Although the most efficient and least error-prone way to create and edit a processor
configuration is to use the Oracle CEP IDE for Eclipse (see Section 10.2.1, "How to
Configure an Oracle CQL Processor Using Oracle CEP IDE for Eclipse"), alternatively,
you can also create and maintain a processor configuration file manually.

This section describes the main steps to create the processor configuration file
manually. For simplicity, it is assumed in the procedure that you are going to configure
all processors in a single XML file, although you can also create separate files for each
processor.
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To create an Oracle CQL processor component configuration file manually:

1.

Design the set of Oracle CQL rules that the processor executes. These rules can be
as simple as selecting all incoming events to restricting the set based on time,
property values, and so on, as shown in the following;:

SELECT *
FROM TradeStream [Now]
WHERE price > 10000

Oracle CQL is similar in many ways to Structure Query Language (SQL), the
language used to query relational database tables, although the syntax between
the two differs in many ways. The other big difference is that Oracle CQL queries
take another dimension into account (time), and the processor executes the Oracle
CQL continually, rather than SQL queries that are static.

For more information, see "Introduction to Oracle CQL Queries, Views, and Joins"
in the Oracle Complex Event Processing CQL Language Reference.

Create the processor configuration XML file that will contain the Oracle CQL rules
you designed in the preceding step, as well as other optional features, for each
processor in your application.

You can name this XML file anything you want, provided it ends with the .xml
extension.

The root element of the processor configuration file is config, with namespace
definitions shown in the next step.

For each processor in your application, add a processor child element of
config.

Uniquely identify each processor with the name child element. This name must be
the same as the value of the id attribute in the wlevs : processor element of the
EPN assembly file that defines the event processing network of your application.
This is how Oracle CEP knows to which particular processor component in the
EPN assembly file this processor configuration applies. See Section 4.3, "Creating
EPN Assembly Files" for details.

For example, if your application has two processors, the configuration file might
initially look like:

<?xml version="1.0" encoding="UTF-8"?>
<nl:config xmlns:nl="http://www.bea.com/ns/wlevs/config/application">
<processor>
<name>firstProcessor</name>

</processor>
<processor>
<name>secondProcessor</name>

</processor>
</nl:config>

In the example, the configuration file includes two processors called
firstProcessor and secondProcessor. This means that the EPN assembly
file must include at least two processor registrations with the same identifiers:

<wlevs:processor id="firstProcessor" ...>

</wlevs:processor>
<wlevs:processor id="secondProcessor" ...>
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</wlevs:processor>

Caution: Identifiers and names in XML files are case sensitive, so be
sure you specify the same case when referencing the component's
identifier in the EPN assembly file.

Add a rules child element to each processor element.

Use the rules element to group the child elements you create to contain the
Oracle CQL statements this processor executes, including:

= rule: contains Oracle CQL statements that register or create user-defined
windows. The rule element id attribute must match the name of the
window.

= view: contains Oracle CQL view statements (the Oracle CQL equivalent of
subqueries). The view element id attribute defines the name of the view.

s query: contains Oracle CQL select statements. The query element id
attribute defines the name of the query.

Use the required id attribute of the view and query elements to uniquely
identify each rule. Use the XML CDATA type to input the actual Oracle CQL rule.
For example:

<?xml version="1.0" encoding="UTF-8"?>
<nl:config
xsi:schemalocation="http://www.bea.com/ns/wlevs/config/application wlevs_
application_config.xsd"
xmlns:nl="http://www.bea.com/ns/wlevs/config/application"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<processor>
<name>proc</name>
<rules>
<view id="lastEvents" schema="cusip bid srcId bidQty"><! [CDATA[
select mod(price)
from filteredStream[partition by srcId, cusip rows 1]
11></view>
<query id="qgl"><![CDATA[
SELECT *
FROM lastEvents [Now]
WHERE price > 10000
]11></query>
</rules>
</processor>
</nl:config>]]></query>

Save and close the file.

Optionally, configure additional Oracle CQL processor features in the assembly
file:

= Section 10.1.1, "Controlling Which Queries Output to a Downstream Channel"
= Section 10.3, "Configuring an Oracle CQL Processor Table Source"

= Section 10.4, "Configuring an Oracle CQL Processor Cache Source"
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10.3 Configuring an Oracle CQL Processor Table Source

You can configure an Oracle CQL processor to access a table in a relational database as
an event stream in which each row in the table is represented as a tuple.

In this section, assume that you create the table you want to access using the SQL
statement that Example 10—4 shows.

Example 10-4 Table Create SQL Statement

create table Stock (symbol varchar(16), exchange varchar(16));

After configuration, you can define Oracle CQL queries that access the Stock table as
if it was just another event stream. In the following example, the query joins one event
stream ExchangeStream with the Stock table:

Example 10-5 Oracle CQL Query on Relational Database Table Stock

SELECT ExchangeStream.symbol, ExchangeStream.price, Stock.exchange
FROM ExchangeStream [Now], Stock
WHERE ExchangeStream.symbol = Stock.symbol

Note: Because changes in the table source are not coordinated in
time with stream data, you may only join the table source to an event
stream using a Now window and you may only join to a single
database table.

To integrate arbitrarily complex SQL queries and multiple tables with
your Oracle CQL queries, consider using the Oracle JDBC data
cartridge instead.

For more information, see "Understanding the Oracle JDBC Data
Cartridge" in the Oracle Complex Event Processing CQL Language
Reference.

10.3.1 How to Configure an Oracle CQL Processor Table Source Using Oracle CEP IDE

for Eclipse

The most efficient and least error-prone way to configure an Oracle CQL processor to
access a relational database table is to use the Oracle CEP IDE for Eclipse.

To configure an Oracle CQL processor table source using Oracle CEP IDE for
Eclipse:

1. Create a data source for the database that contains the table you want to use.

Example 10-6 shows an example Oracle CEP server config.xml file with data
source StockDS.

Example 10-6 Oracle CEP Server config.xml File With Data Source StockDS

<?xml version="1.0" encoding="UTF-8"?>
<nl:config xsi:schemalocation="http://www.bea.com/ns/wlevs/config/server wlevs_server_
config.xsd"
xmlns:nl="http://www.bea.com/ns/wlevs/config/server"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<domain>
<name>ocep_domain</name>
</domain>
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<data-source>
<name>StockDs</name>
<connection-pool-params>
<initial-capacity>l</initial-capacity>
<max-capacity>10</max-capacity>
</connection-pool-params>
<driver-params>
<url>jdbc:derby:</url>
<driver-name>org.apache.derby.jdbc.EmbeddedDriver</driver-name>
<properties>
<element>
<name>databaseName</name>
<value>db</value>
</element>
<element>
<name>create</name>
<value>true</value>
</element>
</properties>
</driver-params>
<data-source-params>
<jndi-names>
<element>StockDs</element>
</jndi-names>
<global-transactions-protocol>None</global-transactions-protocol>
</data-source-params>
</data-source>

</nl:config>

For more information, see "Configuring Access to a Relational Database" in the
Oracle Complex Event Processing Administrator’s Guide.

2. Use Oracle CEP IDE for Eclipse to create a table node.
See Section 6.4.1.1, "How to Create a Basic Node".

3. Use Oracle CEP IDE for Eclipse to create an Oracle CQL processor.
See Section 6.4.1.3, "How to Create a Processor Node".

4. Connect the table node to the Oracle CQL processor node.
See Section 6.4.2.1, "How to Connect Nodes".

The EPN Editor adds a wlevs: table-source element to the target processor
node that references the source table.

5. Right-click the table node in your EPN and select Go to Assembly Source.
Oracle CEP IDE for Eclipse opens the EPN assembly file for this table node.

6. Edit the table element as Example 10-7 shows and configure the table element
attributes as shown in Table 10-1.

Example 10-7 EPN Assembly File table Element

<wlevs:table id="Stock" event-type="StockEvent" data-source="StockDs" />
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Table 10-1 EPN Assembly File table Element Attributes

Attribute Description
id The name of the table source. Subsequent references to this table source use this name.
event-type The type-name you specify for the table event-type you create in step 9.

data-source | The data-source name you specified in the Oracle CEP server config.xml file in
step 1.

7. Right-click the Oracle CQL processor node connected to the table in your EPN and
select Go to Assembly Source.

Oracle CEP IDE for Eclipse opens the EPN assembly file for this Oracle CQL
processor.

8. Edit the Oracle CQL processor element’s table-source child element as
Example 10-8 shows.

Set the ref attribute to the 1d of the table element you specified in step 6.

Example 10-8 EPN Assembly File table-source Element

<wlevs:processor id="proc">
<wlevs:table-source ref="Stock" />
</wlevs:processor>

9. Edit the EPN assembly file to update the event-type-repository element
with a new event-type child element for the table as Example 10-9shows.

Create a property child element for each column of the table you want to access
and configure the property attributes as shown in Table 10-2.

Example 10-9 EPN Assembly File event-type element for a Table

<wlevs:event-type-repository>

<wlevs:event-type type-name="StockEvent">
<wlevs:properties>
<wlevs:property name="symbol" type="char[]" length="16" />
<wlevs:property name="exchange" type="char[]" length="16" />
</wlevs:properties>
</wlevs:event-type>

</wlevs:event-type-repository>

Table 10-2 EPN Assembly File event-type Element Property Attributes

Attribute | Description

name The name of the table column you want to access as specified in the SQL create table
statement. You do not need to specify all columns.

type The Oracle CEP Java type from Table 10-3 that corresponds to the column’s SQL data type.
In Example 104, the type value for column symbol is char[].

length The column size as specified in the SQL create table statement.

In Example 10—4, the 1ength of column symbol is 16.
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Table 10-3 SQL Column Types and Oracle CEP Type Equivalents

SQL Type Oracle CEP Java Type com.bea.wlevs.ede.api.Type | Description

ARRAY [Ljava.lang.Object Array, of depth 1, of java.lang.Object.

BIGINT java.math.BigInteger | bigint An instance of java.math.BigInteger.

BINARY bytel] Array, of depth 1, of byte.

BIT java.lang.Boolean boolean An instance of java.lang.Boolean.

BLOB bytel] Array, of depth 1, of byte.

BOOLEAN java.lang.Boolean boolean An instance of java.lang.Boolean.

CHAR java.lang.Character char An instance of java.lang.Character.

CLOB bytel] Array, of depth 1, of byte.

DATE java.sqgl.Date timestamp An instance of java.sqgl .Date.

DECIMAL java.math.BigDecimal An instance of java.math.BigDecimal.

BINARY DOUBLE' | java.lang.Double double An instance of java.lang.Double

or DOUBLE?

BINARY FLOAT! java.lang.Double float An instance of java.lang.Double

or FLOAT?

INTEGER java.lang.Integer int An instance of java.lang.Integer.

JAVA_OBJECT java.lang.Object object An instance of java.lang.Object.

LONGNVARCHAR char[] char Array, of depth 1, of char.

LONGVARBINARY | byte[] Array, of depth 1, of byte.

LONGVARCHAR char[] char Array, of depth 1, of char.

NCHAR char[] char Array, of depth 1, of char.

NCLOB bytel] Array, of depth 1, of byte.

NUMERIC java.math.BigDecimal An instance of java.math.BigDecimal.

NVARCHAR char|[] char Array, of depth 1, of char.

OTHER java.lang.Object object An instance of java.lang.Object.

REAL java.lang.Float float An instance of java.lang.Float

SMALLINT java.lang.Integer int An instance of java.lang.Integer.

SQLXML xmltype xmltype For more information on processing
XMLTYPE data in Oracle CQL, see
"SQL/XML (SQLX)" in the Oracle Complex
Event Processing CQL Language Reference.

TIME java.sql.Time An instance of java.sqgl.Time.

TIMESTAMP java.sqgl.Timestamp timestamp An instance of java.sgl.Timestamp.

TINYINT java.lang.Integer int An instance of java.lang.Integer.

VARBINARY bytel] Array, of depth 1, of byte.

VARCHAR char|[] char Array, of depth 1, of char.

1 Oracle SQL.

2 Non-Oracle SQL.

For more information on creating event types, see:

s Chapter 2.1.4, "Creating Oracle CEP Event Types"

= Section 2.1.3, "Event Type Data Types"

10. Right-click the Oracle CQL processor node connected to the table in your EPN and
select Go to Configuration Source.
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Oracle CEP IDE for Eclipse opens the component configuration file for this Oracle
CQL processor.

11. Edit the component configuration file to add Oracle CQL queries that use the
table’s event-type as shown in Example 10-10.

Example 10-10 Oracle CQL Query Using Table Event Type StockEvent

<processor>
<name>proc</name>
<rules>
<query id="gl"><![CDATA[
SELECT ExchangeStream.symbol, ExchangeStream.price, Stock.exchange
FROM ExchangeStream [Now], Stock
WHERE ExchangeStream. symbol = Stock.symbol
11></query>
</rules>
</processor>

Note: Because changes in the table source are not coordinated in
time with stream data, you may only use a Now window. For more
information, see "S[Now]" in the Oracle Complex Event Processing CQL
Language Reference.

10.4 Configuring an Oracle CQL Processor Cache Source
You can configure an Oracle CQL processor to access the Oracle CEP cache.
For more information, see:
= Section 12.1, "Overview of Oracle CEP Cache Configuration"
»  Section 12.9, "Accessing a Cache From an Oracle CQL User-Defined Function"

»  Section 12.5, "Accessing a Cache From an Oracle CQL Statement"

10.5 Example Oracle CQL Processor Configuration Files
This section provides example Oracle CQL processor configuration files, including:
= Section 10.5.1, "Oracle CQL Processor Component Configuration File"

= Section 10.5.2, "Oracle CQL Processor EPN Assembly File"

10.5.1 Oracle CQL Processor Component Configuration File

The following example shows a component configuration file for an Oracle CQL
processor.

<?xml version="1.0" encoding="UTF-8"?>
<nl:config
xsi:schemalocation="http://www.bea.com/ns/wlevs/config/application wlevs_application_
config.xsd"
xmlns:nl="http://www.bea.com/ns/wlevs/config/application"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<processor>
<name>proc</name>
<rules>
<view id="lastEvents" schema="cusip bid srcId bidQty ask askQty seq"><![CDATA[
select mod(price)
from filteredStream[partition by srcId, cusip rows 1]
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11></view>
<query id="qgl"><![CDATA[
SELECT *
FROM  lastEvents [Now]
WHERE price > 10000
11></query>
</rules>
</processor>
</nl:config>

In the example, the name element specifies that the processor for which the Oracle
CQL rules are being configured is called proc. This in turn implies that the EPN
assembly file that defines your application must include a corresponding
wlevs:processor element with an id attribute value of proc to link these Oracle
CQL rules with an actual proc processor instance (see Section 10.5.2, "Oracle CQL
Processor EPN Assembly File").

This Oracle CQL processor component configuration file also defines a view element
to specify an Oracle CQL view statement (the Oracle CQL equivalent of a subquery).
The results of the view’s select are not output to a down-stream channel.

Finally, this Oracle CQL processor component configuration file defines a query
element to specify an Oracle CQL query statement. The query statement selects from
the view. By default, the results of a query are output to a down-stream channel. You
can control this behavior in the channel configuration using a selector element. For
more information, see:

= Section 9.2.1, "How to Configure a System-Timestamped Channel Using Oracle
CEP IDE for Eclipse"

= Section 9.2.2, "How to Configure an Application-Timestamped Channel Using
Oracle CEP IDE for Eclipse"

10.5.2 Oracle CQL Processor EPN Assembly File
The following example shows an EPN assembly file for an Oracle CQL processor.

<?xml version="1.0" encoding="UTF-8"?>
<beans xmlns="http://www.springframework.org/schema/beans"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmlns:osgi="http://www.springframework.org/schema/osgi"
xmlns:wlevs="http://www.bea.com/ns/wlevs/spring"
xsi:schemalocation="
http://www.springframework.org/schema/beans
http://www.springframework.org/schema/beans/spring-beans.xsd
http://www.springframework.org/schema/osgi
http://www.springframework.org/schema/osgi/spring-osgi.xsd
http://www.bea.com/ns/wlevs/spring
http://www.bea.com/ns/wlevs/spring/spring-wlevs-v11l_1_1_3.xsd">

<wlevs:event-type-repository>
<wlevs:event-type type-name="ExchangeEvent">
<wlevs:properties>
<wlevs:property name="symbol" type="[C" length="16" />
<wlevs:property name="price" type="java.lang.Double" />
</wlevs:properties>
</wlevs:event-type>
<wlevs:event-type type-name="StockExchangeEvent">
<wlevs:properties>
<wlevs:property name="symbol" type="[C" length="16" />
<wlevs:property name="price" type="java.lang.Double" />
<wlevs:property name="exchange" type="[C" length="16" />
</wlevs:properties>
</wlevs:event-type>
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<wlevs:event-type type-name="StockEvent">
<wlevs:properties>
<wlevs:property name="symbol" type="[C" length="16" />
<wlevs:property name="exchange" type="[C" length="16" />
</wlevs:properties>
</wlevs:event-type>
</wlevs:event-type-repository>

<!-- Assemble EPN (event processing network) -->

<wlevs:adapter id="adapter" class="com.bea.wlevs.example.db.ExchangeAdapter" >
<wlevs:listener ref="ExchangeStream"/>

</wlevs:adapter>

<wlevs:channel id="ExchangeStream" event-type="ExchangeEvent" >
<wlevs:listener ref="proc"/>
</wlevs:channel>

<wlevs:table id="Stock" event-type="StockEvent" data-source="StockDs" />

<wlevs:processor id="proc" advertise="true" >
<wlevs:table-source ref="Stock" />
</wlevs:processor>

<wlevs:channel id="OutputStream" advertise="true" event-type="StockExchangeEvent" >
<wlevs:listener ref="bean"/>
<wlevs:source ref="proc"/>

</wlevs:channel>

<osgi:reference id="ds" interface="com.bea.core.datasource.DataSourceService"
cardinality="0..1" />

<!-- Create business object -->
<bean id="bean" class="com.bea.wlevs.example.db.OutputBean">
<property name="dataSourceService" ref="ds"/>

</bean>

</beans>
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Configuring EPL Processors

This section contains information on the following subjects:

= Section 11.1, "Overview of EPL Processor Component Configuration"
»  Section 11.2, "Configuring an EPL Processor"

= Section 11.3, "Configuring an EPL Processor Cache Source"

»  Section 11.4, "Example EPL Processor Configuration Files"

Note: Oracle CQL replaces Event Processing Language (EPL) in
Oracle CEP 11g Release 1 (11.1.1). Oracle CEP supports EPL for
backwards compatibility. For more information, see Chapter 10,
"Configuring Oracle CQL Processors".

11.1 Overview of EPL Processor Component Configuration

An Oracle CEP application contains one or more complex event processors, or
processors for short. Each processor takes as input events from one or more adapters;
these adapters in turn listen to data feeds that send a continuous stream of data from a
source. The source could be anything, from a financial data feed to the Oracle CEP
load generator.

The main feature of an EPL processor is its associated Event Processing Language
(EPL) rules that select a subset of the incoming events to then pass on to the
component that is listening to the processor. The listening component could be another
processor, or the business object POJO that typically defines the end of the event
processing network, and thus does something with the events, such as publish them to
a client application. For more information about EPL, see the Oracle Complex Event
Processing EPL Language Reference.

For each EPL processor in your application, you must create a processor element in
a component configuration file. In this processor element you specify the initial set
of EPL rules of the processor and any optional processor configuration such as:

= JDBC datasource reference if your Oracle CEP application requires a connection to
a relational database.

= Enable monitoring of the processor.

You can configure additional optional EPL processor features in the EPL processor
EPN assembly file.

The component configuration file processor element’s name element must match
the EPN assembly file processor element’s id attribute. For example, given the EPN
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assembly file processor element shown in Example 11-1, the corresponding
component configuration file processor element is shown in Example 11-2.

Example 11-1 EPN Assembly File EPL Processor Id: proc

<wlevs:processor id="proc" provider="epl" >
<wlevs:table-source ref="Stock" />
</wlevs:processor>

Example 11-2 Component Configuration File EPL Processor Name: proc

<processor>
<name>proc</name>
<rules>
<rule id="myRule"><![CDATA[
SELECT symbol, AVG(price)
FROM (SELECT * FROM MarketTrade WHERE blockSize > 10)
RETAIN 100 EVENTS PARTITION BY symbol WITH LARGEST price
GROUP BY symbol
HAVING AVG(price) >= 100
ORDER BY symbol
11></rule>
</rules>
</procesor>

Note: Because Oracle CQL replaces Event Processing Language
(EPL) in Oracle CEP 11g Release 1 (11.1.1), the default processor
provider is cgl. To specify an EPL processor, in the EPN assembly file,
you must set the wlevs:processor element provider attribute to
epl as Example 11-1 shows. Oracle CEP supports EPL for backwards
compatibility. For more information, see Chapter 10, "Configuring
Oracle CQL Processors".

You can create a processor element in any of the following component configuration
files:

»  The default Oracle CEP application configuration file (by default,
META-INF/wlevs/config.xml).

= A separate configuration file.

If your application has more than one processor, you can create a processor element
for each of them in the default config.xml file, you can create separate XML files in
META-INF/wlevs for each, or create a single XML file in META-INF/wlevs that
contains the configuration for all processors, or even all components of your
application (adapters, processors, and channels). Choose the method that best suits
your development environment.

By default, Oracle CEP IDE for Eclipse creates one component configuration file and
one EPN assembly file. When you create an EPL processor using Oracle CEP IDE for
Eclipse, by default, the processor element is added to the default component
configuration file META-INF/wlevs/config.xml file.

Component configuration files are deployed as part of the Oracle CEP application
bundle. You can later update this configuration at runtime using Oracle CEP
Visualizer, the wlevs . Admin utility, or manipulating the appropriate JMX Mbeans
directly.

For more information, see:
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Section 1.1.5, "Component Configuration Files"
Section 1.1.4, "EPN Assembly File"

Section 4.3, "Creating EPN Assembly Files"

Oracle Complex Event Processing Visualizer User’s Guide

"wlevs.Admin Command-Line Reference" in the Oracle Complex Event Processing
Administrator’s Guide

"Configuring JMX for Oracle CEP" in the Oracle Complex Event Processing
Administrator’s Guide

For more information on EPL processor configuration, see:

Section 11.2, "Configuring an EPL Processor"
Section 11.3, "Configuring an EPL Processor Cache Source"

Section 11.4, "Example EPL Processor Configuration Files"

11.2 Configuring an EPL Processor

This section describes the main steps to create the processor configuration file. For
simplicity, it is assumed in the procedure that you are going to configure all processors
in a single XML file, although you can also create separate files for each processor.

See Section B.2, "Component Configuration Schema wlevs_application_config.xsd" for
the complete XSD Schema that describes the processor configuration file.

See Section 11.4, "Example EPL Processor Configuration Files" for a complete example
of a processor configuration file.

11.2.1 How to Configure an EPL Processor Manually

You can configure an EPL processor manually using your preferred text editor.

To configure an EPL processor:

1.

Design the set of EPL rules that the processor executes. These rules can be as
simple as selecting all incoming events to restricting the set based on time,
property values, and so on, as shown in the following two examples:

SELECT * from Withdrawal RETAIN ALL

SELECT symbol, AVG(price)

FROM (SELECT * FROM MarketTrade WHERE blockSize > 10)
RETAIN 100 EVENTS PARTITION BY symbol WITH LARGEST price
GROUP BY symbol

HAVING AVG(price) >= 100

ORDER BY symbol

EPL is similar in many ways to Structure Query Language (SQL), the language
used to query relational database tables, although the syntax between the two
differs in many ways. The other big difference is that EPL queries take another
dimension into account (time), and the processor executes the EPL continually,
rather than SQL queries that are static.

For additional conceptual information about EPL, and examples and reference
information to help you design and write your own EPL rules, see Oracle Complex
Event Processing EPL Language Reference.
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2. Create the processor configuration XML file that will contain the EPL rules you
designed in the preceding step, as well as other optional features, for each
processor in your application.

You can name this XML file anything you want, provided it ends with the .xm1
extension.

The root element of the processor configuration file is config, with namespace
definitions shown in the next step.

3. For each processor in your application, add a processor child element of
config.

Uniquely identify each processor with the name child element. This name must be
the same as the value of the id attribute in the wlevs :processor element of the
EPN assembly file that defines the event processing network of your application.
This is how Oracle CEP knows to which particular processor component in the
EPN assembly file this processor configuration applies. See Section 4.3, "Creating
EPN Assembly Files" for details.

For example, if your application has two processors, the configuration file might
initially look like:

<?xml version="1.0" encoding="UTF-8"?>
<nl:config xmlns:nl="http://www.bea.com/ns/wlevs/config/application">
<processor>
<name>firstProcessor</name>

</processor>
<processor>
<name>secondProcessor</name>

</processor>
</nl:config>

In the example, the configuration file includes two processors called
firstProcessor and secondProcessor. This means that the EPN assembly
file must include at least two processor registrations with the same identifiers:

<wlevs:processor id="firstProcessor" provider="epl"...>

</wlevs:processor>
<wlevs:processor id="secondProcessor" provider="epl"...>

</wlevs:processor>

Note: Because Oracle CQL replaces Event Processing Language
(EPL) in Oracle CEP 11g Release 1 (11.1.1), the default processor
provider is cql. To specify an EPL processor, in the EPN assembly file,
you must set the wlevs:processor element provider attribute to
epl. Oracle CEP supports EPL for backwards compatibility. For more
information, see Chapter 10, "Configuring Oracle CQL Processors".

Caution: Identifiers and names in XML files are case sensitive, so be
sure you specify the same case when referencing the component's
identifier in the EPN assembly file.
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4. Addarules child element to each processor to group together one or more
rule elements that correspond to the set of EPL rules you have designed for this
processor.

Use the required id attribute of the rule element to uniquely identify each rule.
Use the XML CDATA type to input the actual EPL rule. For example:

<processor>
<name>firstProcessor</name>
<rules>
<rule id="myFirstRule"><![CDATA[
SELECT * from Withdrawal RETAIN ALL
]1></rule>
<rule id="mySecondRule"><! [CDATA[
SELECT * from Checking RETAIN ALL
11></rule>
</rules>
</processor>

5. Optionally, override the default processor configuration by adding additional
processor child elements:

s Optionally add a database child element of the processor element to
define a JDBC data source for your application. This is required if your EPL
rules join a stream of events with an actual relational database table.

Use the name child element of database to uniquely identify the datasource.

Use the data-source-name child element of database to specify the actual
name of the data source; this name corresponds to the name child element of
the data-source configuration object in the config. xml file of your
domain.

For more information, see "Configuring Access to a Relational Database" in the
Oracle Complex Event Processing Administrator’s Guide.

For example:

<processor>
<name>firstProcessor</name>
<rules>

</rules>

<database>
<name>myDataSource</name>
<data-source-name>rdbmsDataSource</data-source-name>

</database>
</processor>

6. Save and close the file.
7. Optionally, configure additional EPL processor features in the assembly file:

= Section 11.3, "Configuring an EPL Processor Cache Source"

11.3 Configuring an EPL Processor Cache Source
You can configure an EPL processor to access the Oracle CEP cache.
For more information, see:

= Section 12.1, "Overview of Oracle CEP Cache Configuration"

Configuring EPL Processors 11-5



Example EPL Processor Configuration Files

»  Section 12.10, "Accessing a Cache From an EPL User-Defined Function"

»  Section 12.6, "Accessing a Cache From an EPL Statement"

11.4 Example EPL Processor Configuration Files

This section provides example Oracle CQL processor configuration files, including:

= Section 11.4.1, "EPL Processor Component Configuration File"

»  Section 11.4.2, "EPL Processor EPN Assembly File"

11.4.1 EPL Processor Component Configuration File

The following example shows how to configure one of the sample EPL queries shown
in Section 11.2, "Configuring an EPL Processor" for the myProcessor EPL processor:

<?xml version="1.0" encoding="UTF-8"?>
<nl:config xmlns:nl="http://www.bea.com/ns/wlevs/config/application"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<processor>
<name>myProcessor</name>
<rules>
<rule id="myRule"><! [CDATA[
SELECT symbol, AVG(price)

</nl:config>

FROM

(SELECT * FROM MarketTrade WHERE blockSize > 10)

RETAIN 100 EVENTS PARTITION BY symbol WITH LARGEST price
GROUP BY symbol
HAVING AVG(price) >= 100
ORDER BY symbol
]1></rule>
</rules>
</processor>

In the example, the name element specifies that the processor for which the single EPL
rule is being configured is called myProcessor. This in turn implies that the EPN
assembly file that defines your application must include a corresponding

<wlevs:processor id="myProcessor" provider="epl"

these EPL rules with an actual myProcessor EPL processor instance (see
Section 11.4.2, "EPL Processor EPN Assembly File").

11.4.2 EPL Processor EPN Assembly File

The following example shows an EPN assembly file for an EPL processor.

<?xml version="1.0" encoding="UTF-8"?>

<beans xmlns="http://www.springframework.org/schema/beans"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmlns:osgi="http://www.springframework.org/schema/osgi"

xmlns:wlevs="http://www.bea.com/ns/wlevs/spring"
xsi:schemaLocation="

http
http
http
http
http
http

o/ [ www .
2/ [ www .
2/ /www .
o/ [ www .
AL
2/ /www .

springframework.org/schema/beans
springframework.org/schema/beans/spring-beans.xsd
springframework.org/schema/osgi
springframework.org/schema/osgi/spring-osgi.xsd
bea.com/ns/wlevs/spring
bea.com/ns/wlevs/spring/spring-wlevs-v11_1_1_3.xsd">

<wlevs:event-type-repository>
<wlevs:event-type type-name="HelloWorldEvent">
<wlevs:class>com.bea.wlevs.event.example.helloworld.HelloWorldEvent</wlevs
</wlevs:event-type>
</wlevs:event-type-repository>
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<wlevs:adapter
id="helloworldAdapter"
class="com.bea.wlevs.adapter.example.helloworld.HelloWorldAdapter">
<wlevs:instance-property name="message" value="HelloWorld - the current time is:"/>

</wlevs:adapter>

<wlevs:channel id="helloworldInputChannel" event-type="HelloWorldEvent">
<wlevs:listener ref="helloworldProcessor"/>
<wlevs:source ref="helloworldAdapter"/>

</wlevs:channel>

<wlevs:processor id="helloworldProcessor" provider="epl" />

<wlevs:channel
id="helloworldOutputChannel" event-type="HelloWorldEvent" advertise="true">
<wlevs:listener>

<bean class="com.bea.wlevs.example.helloworld.HelloWorldBean"/>

</wlevs:listener>
<wlevs:source ref="helloworldProcessor"/>

</wlevs:channel>

</beans>
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Configuring Caching

This section contains information on the following subjects:

= Section 12.1, "Overview of Oracle CEP Cache Configuration"

= Section 12.2, "Configuring an Oracle CEP Local Caching System and Cache"
= Section 12.3, "Configuring an Oracle Coherence Caching System and Cache"
»  Section 12.4, "Configuring a Third-Party Caching System and Cache"

m  Section 12.5, "Accessing a Cache From an Oracle CQL Statement"

»  Section 12.6, "Accessing a Cache From an EPL Statement"

»  Section 12.7, "Accessing a Cache From an Adapter"

»  Section 12.8, "Accessing a Cache From a Business POJO"

»  Section 12.9, "Accessing a Cache From an Oracle CQL User-Defined Function"
= Section 12.10, "Accessing a Cache From an EPL User-Defined Function"

= Section 12.11, "Accessing a Cache Using JMX"

12.1 Overview of Oracle CEP Cache Configuration

A cache is a temporary storage area for events, created exclusively to improve the
overall performance of your Oracle CEP application; it is not necessary for the
application to function correctly. Oracle CEP applications can optionally publish or
consume events to and from a cache to increase the availability of the events and
increase the performance of their applications.

A caching system refers to a configured instance of a caching implementation. A
caching system defines a named set of configured caches as well as the configuration
for remote communication if any of the caches are distributed across multiple
machines.

Oracle CEP supports the following caching systems:
s Oracle CEP local cache: a local, in-memory single-JVM cache.

s Oracle Coherence: a JCache-compliant in-memory distributed data grid solution
for clustered applications and application servers. It coordinates updates to the
data using cluster-wide concurrency control, replicates data modifications across
the cluster using the highest performing clustered protocol available, and delivers
notifications of data modifications to any servers that request them. You take
advantage of Oracle Coherence features using the standard Java collections API to
access and modify data, and use the standard JavaBean event model to receive
data change notifications.
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Note: Before you can use Oracle CEP with Oracle Coherence, you
must obtain a valid Oracle Coherence license such as a license for
Coherence Enterprise Edition, Coherence Grid Edition, or Oracle
WebLogic Application Grid. For more information on Oracle
Coherence, see
http://www.oracle.com/technology/products/coherence/
index.html.

s Third-party caches: you can create a plug-in to allow Oracle CEP to work with
other, third-party cache implementations.

A cache can be considered a stage in the event processing network in which an
external element (the cache) consumes or produces events; this is similar to an adapter
that uses a JMS destination. A cache, however, does not have to be an actual stage in
the network; another component or Spring bean can access a cache programmatically
using the caching APlIs.

A caching system is always configured at the application level. Other Oracle CEP
applications in separate bundles can also use the caching system.

For each caching system in your application, you must create a caching-system
element in a component configuration file. In this caching-system element you
specify the caching system name and one or more cache elements. In the cache
elements, you define optional cache configuration such as:

= Maximum cache size

= Eviction policy

»  Time-to-live

s Idle time

= Write policy (write-none, write-through, or write-behind)
= Work manager

The component configuration file caching-system element’s name element must
match the EPN assembly file caching-system element’s id attribute. For example,
given the EPN assembly file caching-system element shown in Example 12-1, the
corresponding component configuration file caching-system element is shown in
Example 12-2.

Example 12-1 EPN Assembly File Caching System Id: cacheSystem

<wlevs:caching-system id="cacheSystem">
</wlevs:caching-system>

<wlevs:cache id="cachel">
<wlevs:caching-system ref="cacheSystem"/>
</wlevs:cache>

Example 12-2 Component Configuration File Caching System Name: cacheSystem

<caching-system>
<name>cacheSystem</name>
<cache>
<name>cachel</name>

</cache>
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</caching-system>

Similarly, the component configuration file cache element’s name element must
match the EPN assembly file cache element’s id attribute. For example, given the
EPN assembly file cache element shown in Example 12-1, the corresponding
component configuration file cache element is shown in Example 12-2.

Example 12-3 EPN Assembly File Caching Id: cache1

<wlevs:caching-system id="cacheSystem">
</wlevs:caching-system>

<wlevs:cache id="cachel">
<wlevs:caching-system ref="cacheSystem"/>
</wlevs:cache>

Example 12-4 Component Configuration File Caching Name: cache1
<caching-system>
<name>cacheSystem</name>
<cache>
<name>cachel</name>
</cache>
</caching-system>

You can create a caching-system element in any of the following component
configuration files:

s The default Oracle CEP application configuration file (by default,
META-INF/wlevs/config.xml).

= A separate configuration file.

If your application has more than one caching system, you can create a
caching-system element for each of them in the default config.xml file, you can
create separate XML files in META-INF/wlevs for each, or create a single XML file in
META-INF/wlevs that contains the configuration for all caching systems, or even all
components of your application (adapters, processors, and channels). Choose the
method that best suits your development environment.

By default, Oracle CEP IDE for Eclipse creates one component configuration file and
one EPN assembly file. When you add a cache to the EPN using Oracle CEP IDE for
Eclipse, it adds a cache element to the EPN assembly file. You must manually add
caching-system elements to the EPN assembly file and component configuration
file.

Component configuration files are deployed as part of the Oracle CEP application
bundle. You can later update this configuration at runtime using Oracle CEP
Visualizer, the wlevs . Admin utility, or manipulating the appropriate JMX Mbeans
directly.

For more information, see:

= Section 1.1.5, "Component Configuration Files"
= Section 1.1.4, "EPN Assembly File"

= Section 4.3, "Creating EPN Assembly Files"

»  Oracle Complex Event Processing Visualizer User’s Guide
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= "wlevs.Admin Command-Line Reference" in the Oracle Complex Event Processing
Administrator’s Guide

s "Configuring JMX for Oracle CEP" in the Oracle Complex Event Processing
Administrator’s Guide

For more information on configuring caching, see:
s Section 12.1.1, "Caching Use Cases"

= Section 12.1.2, "Additional Caching Features"
s Section 12.1.3, "Caching APIs"

12.1.1 Caching Use Cases

The following sections describe the principal Oracle CEP caching use cases.

12.1.1.1 Use Case: Publishing Events to a Cache

An example of this use case is a financial application that publishes events to a cache
while the financial market is open and then processes data in the cache after the
market closes.

Publishing events to a cache makes them highly available or available to other Oracle
CEP applications running in the server. Publishing events to a cache also allows for
asynchronous writes to a secondary storage by the cache implementation. You can
configure any stage in an Oracle CEP application that generates events (input adapter,
channel, business POJO, or processor) to publish its events to the cache.

12.1.1.2 Use Case: Consuming Data From a Cache

Oracle CEP applications may sometimes need to access non-streaming data in order to
do its work; caching this data can increase the performance of the application.

The standard components of an Oracle CEP application that are allowed direct
programming access to a cache are input- and output-adapters and business POJOs.

Additionally, applications can access a cache from Oracle CQL or EPL, either by a
user-defined function or directly from an Oracle CQL or EPL statement.

In the case of a user-defined function, programmers use Spring to inject the cache
resource into the implementation of the function. For more information, see
Section 1.4, "Configuring Oracle CEP Resource Access".

Applications can also query a cache directly from anOracle CQL or EPL statement that
runs in a processor. In this case, the cache essentially functions as another type of
stream data source to a processor so that querying a cache is very similar to querying a
channel except that data is pulled from a cache.

An example of using Oracle CQL to query a cache is from a financial application that
publishes orders and the trades used to execute the orders to a cache. At the end of the
day when the markets are closed, the application queries the cache in order to find all
the trades related to a particular order.

12.1.1.3 Use Case: Updating and Deleting Data in a Cache

An Oracle CEP application can both update and delete data in a cache when required.
For example, a financial application may need to update an order in the cache each
time individual trades that fulfill the order are executed, or an order may need to be

deleted if it has been cancelled. The components of an application that are allowed to
consume data from a cache are also allowed to update it.
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12.1.1.4 Use Case: Using a Cache in a Multi-Server Domain

If you build an Oracle CEP application that uses a cache, and you plan to deploy that
application in a multi-server domain, then you must use a caching-system that
supports a distributed cache.

In this case, you must use either Oracle Coherence or a third-party caching system that
supports a distributed cache.

For more information, see:

= "Administrating Multi-Server Domains With Oracle CEP Native Clustering" in the
Oracle Complex Event Processing Administrator’s Guide

= Section 12.3, "Configuring an Oracle Coherence Caching System and Cache"

= Section 12.4, "Configuring a Third-Party Caching System and Cache"

12.1.2 Additional Caching Features

In addition to the major caching features described in the preceding sections, Oracle
CEP caching includes the following features:

= Pre-load a cache with data before an application is deployed.

»  Periodically refresh, invalidate, and flush the data in a cache. All these tasks
happen incrementally and without halting the application or causing latency
spikes.

= Dynamically update a cache's configuration.

12.1.3 Caching APIs

Oracle CEP provides a number of caching APIs that you can use in your application to
perform certain tasks. The APIs are in two packages:

m com.bea.cache.jcache—Includes the APIs used to access a cache and create
cache loader, listeners, and stores.

= com.bea.wlevs.cache.spi—Includes the API used to access a caching
system.

The creation, configuration, and wiring of the caching systems and caches is all done
using the EPN assembly file and component configuration files. This means that you
typically never explicitly use the Cache and CachingSystem interfaces in your
application; the only reason to use them is if you have additional requirements than
the standard configuration. For example: if you want to provide integration with a
third-party cache provider, then you must use the CachingSystem interface; if you
want to perform operations on a cache that are not part of the java.util.Map
interface, then you can use the Cache interface.

If you create cache listeners, loaders, or stores for an Oracle CEP local cache, then the
Spring beans you write must implement the CacheListener, CacheLoader, or
CacheStore interfaces.

If you create cache listeners, loaders, or stores for an Oracle Coherence cache, then the
Spring beans you write must implement the appropriate Oracle Coherence interfaces.

If you create cache listeners, loaders, or stores for a third-party cache, then the Spring
beans you write must implement the appropriate third-party cache interfaces.

For more information, see:

= Section 12.2, "Configuring an Oracle CEP Local Caching System and Cache"
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= Section 12.3, "Configuring an Oracle Coherence Caching System and Cache"
= Section 12.4, "Configuring a Third-Party Caching System and Cache"

»  Oracle Fusion Middleware Java API Reference for Oracle Complex Event Processing.

12.2 Configuring an Oracle CEP Local Caching System and Cache

You can configure your application to use the Oracle CEP local caching system and
cache. The Oracle CEP local caching system is appropriate if you do not plan to deploy
your application to a multi-server domain. If you plan to deploy your application to a
multi-server domain, consider using an Oracle Coherence cache (see Section 12.3,
"Configuring an Oracle Coherence Caching System and Cache").

Note: It is assumed in this section that you have already created an
Oracle CEP application along with its EPN assembly file and that you
want to update the application to use caching. If you have not, refer to
Chapter 1, "Overview of Creating Oracle CEP Applications" for
details.

To configure an Oracle CEP local caching system and cache:
1. Declare the caching system in the EPN assembly file.

To declare a caching system that uses the Oracle CEP implementation
declaratively in the EPN assembly file, use the wlevs:caching-system element
without any additional attributes, as shown in the following example:

<wlevs:caching-system id="caching-system-id"/>
The value of the id attribute must match the name specified for the caching
system in the external configuration metadata.

To allow other applications to use the caching system, specify that the caching
system be advertised using the advertise attribute (by default set to false):

<wlevs:caching-system id="caching-system-id" advertise="true"/>

2. Declare one or more caches for this caching system in the EPN assembly file.

After you have declared a caching system for an application, you configure one or
more caches using the wlevs: cache element:

<wlevs:caching-system id="caching-system-id"/>

<wlevs:cache id="cache-id" name="alternative-cache-name">
<wlevs:caching-system ref="caching-system-id"/>
</wlevs:cache>

The name attribute is optional; specify it only if the name of the cache in the
caching system is different from its ID. The wlevs:caching-system child
element references the already-declared caching system that contains the cache.
You must specify this child element only if the caching system is ambiguous: there
is more than one caching system declared (either implicitly or explicitly) or if the
caching system is in a different application or bundle.

You can export both the caching system and the cache as an OSGI service using the
advertise attribute.

<wlevs:caching-system id="caching-system-id" advertise="true"/>
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<wlevs:cache id="cache-id" name="alternative-cache-name" advertise="true" >
<wlevs:caching-system ref="caching-system-id"/>
</wlevs:cache>

If the cache is advertised, then a component in the EPN of an application in a
separate bundle can then reference it. The following example shows how a
processor in one bundle can use as a cache source the cache with ID cache-id
located in a separate bundle (called cacheprovider):

<wlevs:processor id="myProcessor2">
<wlevs:cache-source ref="cacheprovider:cache-id"/>
</wlevs:processor>

The caching system is responsible for creating the cache associated with a
particular name and returning a reference to the cache. The resulting cache bean
implements the java.util.Map interface.

Open your application’s component configuration XML file using your favorite
XML editor.

Update the config root element to add a caching-system child element; use
the name child element to uniquely identify it.

This name must match the wlevs:caching-systemelement id attribute you
specified in the EPN assembly file in step 1. This is how Oracle CEP knows to
which particular caching system in the EPN assembly file this caching
configuration applies.

For example, assume your configuration file already contains a processor and an
adapter (contents removed for simplicity); then the updated file might look like
the following

<?xml version="1.0" encoding="UTF-8"?>
<nl:config xmlns:nl="http://www.bea.com/ns/wlevs/config/application"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<processor>

</processor>

<adapter>

</adapter

<caching-system>
<name>caching-system-id</name>

</caching-system>
</nl:config>

For each cache you want to create, update the caching-systemelement to add a
cache child element; use the name child element to uniquely identify it.

This name must match the wlevs: cache element id attribute you specified in
the EPN assembly file in step 2. This is how Oracle CEP knows to which particular
cache in the EPN assembly file this configuration applies.

The following example shows two caches in the caching system:

<caching-system>
<name>caching-system-id</name>
<cache>
<name>cache-id</name>

</cache>
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<cache>
<name>second-cache-id</name>
</cache>
</caching-system>

6. For each cache, optionally add the following elements that take simple data types
to configure the cache:

» max-size:The number of cache elements in memory after which
eviction/paging occurs. The maximum cache size is 2%'-1 entries; default is 64.

s eviction-policy: The eviction policy to use when max-size is reached.
Supported values are: FIFO, LRU, LFU, and NRU; default value is LFU.

s time-to-live: The maximum amount of time, in milliseconds, that an entry
is cached. Default value is infinite.

s idle-time: Amount of time, in milliseconds, after which cached entries are
actively removed from the cache. Default value is infinite.

= work-manager-name : The work manager to be used for all asynchronous
operations. The value of this element corresponds to the name child element of
the work-manager element in the server's config.xml configuration file.

For more information, see Section F.44, "work-manager".
For example:

<caching-system>
<name>caching-system-id</name>
<cache>
<name>cache-id</name>
<max-size>100000</max-size>
<eviction-policy>LRU</eviction-policy
<time-to-live>3600</time-to-live>
</cache>
</caching-system>

7. Optionally add either write-through or write-behind as a child element of
cache to specify synchronous or asynchronous writes to the cache store,
respectively. By default, writes to the store are synchronous (<rite-through)
which means that as soon as an entry is created or updated the write occurs.

If you specify the write-behind element, then the cache store is invoked from a
separate thread after a create or update of a cache entry. Use the following optional
child elements to further configure the asynchronous writes to the store:

» work-manager-name : The work manager that handles asynchronous writes
to the cache store. If a work manager is specified for the cache itself, this value
overrides it for store operations only. The value of this element corresponds to
the name child element of the work-manager element in the server's
config.xml configuration file.

For more information, see Section F.44, "work-manager".

s batch-size: The number of updates that are picked up from the store buffer
to write back to the backing store. Default value is 1.

s  buffer-size: The size of the internal store buffer that temporarily holds the
asynchronous updates that need to be written to the store. Default value is
100.
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s buffer-write-attempts: The number of attempts that the user thread
makes to write to the store buffer. The user thread is the thread that creates or
updates a cache entry. If all attempts by the user thread to write to the store
buffer fail, it will invoke the store synchronously. Default value is 1.

s buffer-write-timeout : The time in milliseconds that the user thread
waits before aborting an attempt to write to the store buffer. The attempt to
write to the store buffer fails only in case the buffer is full. After the timeout,
further attempts may be made to write to the buffer based on the value of
buffer-write-attempts. Default value is 100.

For example:

<caching-system>
<name>caching-system-id</name>
<cache>
<name>cache-id</name>
<max-size>100000</max-size>
<eviction-policy>LRU</eviction-policy
<time-to-live>3600</time-to-live>
<write-behind>
<buffer-size>200</buffer-size>
<buffer-write-attempts>2</buffer-write-attempts>
<buffer-write-timeout>200</buffer-write-timeout>
</write-behind>
</cache>
</caching-system>

Optionally add a cache element 1isteners child element to configure the
behavior of components that listen to the cache.

Use the asynchronous Boolean attribute to specify whether listeners should be
invoked:

= asynchronously: true.

= synchronously: false, which means listeners are invoked synchronously
(Default).

The listeners element has a single child element, work-manager-name, that
specifies the work manager to be used for asynchronously invoking listeners. This
value is ignored if synchronous invocations are enabled. If a work manager is
specified for the cache itself, this value overrides it for invoking listeners only. The
value of this element corresponds to the work-manager element name child
element in the Oracle CEP server config.xml configuration file.

For example:

<caching-system>
<name>caching-system-id</name>
<cache>
<name>cache-id</name>
<max-size>100000</max-size>
<eviction-policy>LRU</eviction-policy
<time-to-1live>3600</time-to-live>
<write-behind>
<buffer-size>200</buffer-size>
<buffer-write-attempts>2</buffer-write-attempts>
<buffer-write-timeout>200</buffer-write-timeout>
</write-behind>
<listeners asynchronous="true">
<work-manager-name>cachingWM</work-manager-name>
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</listeners>
</cache>
</caching-system>

For more information, see Section F.44, "work-manager"

9. Optionally, override the default cache configuration by updating the EPN
assembly file with one or more additional cache element child elements.

»  Specify that a cache is an event sink by configuring it as a listener to another
component in the event processing network.

See Section 12.2.1, "Configuring an Oracle CEP Local Cache as an Event
Listener."

»  Specify that a cache is an event source to which another component in the
event processing network listens.

See Section 12.2.2, "Configuring an Oracle CEP Local Cache as an Event
Source."

= Configure a cache loader for a cache.
See Section 12.2.3, "Configuring an Oracle CEP Local Cache Loader."
= Configure a cache store for a cache.
See Section 12.2.4, "Configuring an Oracle CEP Local Cache Store."
10. Access the Oracle CEP local cache:
- Optionally reference the Oracle CEP local cache in a query statement.

See:

*  Section 12.5, "Accessing a Cache From an Oracle CQL Statement"

*  Section 12.6, "Accessing a Cache From an EPL Statement”

— Optionally configure and program a custom adapter, business POJO, or Oracle
CQL or EPL user-defined function to access the Oracle CEP local cache.

The configuration is done in the EPN assembly file and the programming is
done in the Java file that implements the adapter, POJO, or user-defined
function.

See:

*  Section 12.7, "Accessing a Cache From an Adapter”

*

Section 12.8, "Accessing a Cache From a Business POJO"

*  Section 12.9, "Accessing a Cache From an Oracle CQL User-Defined
Function"

*  Section 12.10, "Accessing a Cache From an EPL User-Defined Function"
- Optionally, access the Oracle CEP local cache using J]MX.
See Section 12.11, "Accessing a Cache Using JMX".

11. When you assemble your application, verify that the META-INF/MANIFEST . MF
file includes the following import as Figure 12-1 shows:

com.bea.wlevs.cache.spi; version ="11.1.0.0"

If the MANIFEST . MF files does not include this import, update the MANIFEST . MF
file to add this import before deploying your application.
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Figure 12-1 Editing the MANIFEST.MF File
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12.2.1 Configuring an Oracle CEP Local Cache as an Event Listener

An Oracle CEP local cache can be configured as an explicit listener in the event
processing network in order to receive events.

For example, to specify that a cache listens to a channel, specify the wlevs:listener
element with a reference to the cache as a child of the wlevs:channel element as
shown below:

<wlevs:caching-system id="caching-system-id"/>

<wlevs:cache id="cache-id" name="alternative-cache-name">
<wlevs:caching-system ref="caching-system-id"/>
</wlevs:cache>

<wlevs:channel id="tradeStream">
<wlevs:listener ref="cache-id"/>
</wlevs:channel>

As the channel sends new events to the cache, they are inserted into the cache. If a
remove event (an old event that exits the output window) is sent by the channel, then
the event is removed from the cache.

12.2.1.1 Specifying the Key Used to Index an Oracle CEP Local Cache

When you configure an Oracle CEP local cache to be a listener, events are inserted into
the cache. This section describes the variety of options available to you to specify the
key used to index a cache in this instance.
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If you do not explicitly specify a key, the event object itself serves as both the key and
value when the event is inserted into the cache. In this case, the event class must
include a valid implementation of the equals and hashcode methods that take into
account the values of the key properties.

See the following for ways to explicitly specify a key:

= Section 12.3.2.1.1, "Specifying a Key Property in EPN Assembly File"
= Section 12.3.2.1.2, "Using a Metadata Annotation to Specify a Key"

= Section 12.3.2.1.3, "Specifying a Composite Key"

12.2.1.1.1  Specifying a Key Property in EPN Assembly File The first option is to specify a
property name for the key property when a cache is declared in the EPN assembly file
using the key-properties attribute, as shown in the following example:

<wlevs:cache id="cache-id" key-properties="key-property-name">
<wlevs:caching-system ref="caching-system-id"/>
</wlevs:cache>

In this case, all events that are inserted into the cache are required to have a property
of this name at runtime, otherwise Oracle CEP throws an exception.

For example, assume the event type being inserted into the cache looks something like
the following; note the key property (only relevant Java source shown):

public class MyEvent {

private String key;

public MyEvent() {

}

public MyEvent (String key) {
this.key = key;

}

public String getKey() {
return key;

}

public void setKey(String key) {
this.key = key;

}

}

The corresponding declaration in the EPN assembly file would look like the following;:

<wlevs:cache id="cache-id" key-properties="key">
<wlevs:caching-system ref="caching-system-id"/>
</wlevs:cache>

12.2.1.1.2 Using a Metadata Annotation to Specify a Key The second option is to use the
metadata annotation com.bea.wlevs.ede.api.Key to annotate the event property
in the Java class that implements the event type. This annotation does not have any
attributes.

To use a metadata annotation to specify a key:
1. Import the com.bea.wlevs.ede.api.Key package.

For more information, see Section 4.7.5, "How to Import a Package".
2. Apply the @Key annotation to a method.

The following example shows how to specify that the key property of the
MyEvent event type is the key; only relevant code is shown:

import com.bea.wlevs.ede.api.Key;
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public class MyEvent {

private String key;

public MyEvent () {

}

public MyEvent (String key) {
this.key = key;

}

public String getKey() {
return key;

}

@Key

public void setKey(String key) {
this.key = key;

}

}

12.2.1.1.3 Specifying a Composite Key The final option is to use the key-class
attribute of the wlevs : cache element to specify a composite key in which multiple
properties form the key. The value of the key-class attribute must be a JavaBean
whose public fields match the fields of the event class. The matching is done according
to the field name. For example:

<wlevs:cache id="cache-id" key-class="key-class-name">
<wlevs:caching-system ref="caching-system-id"/>
</wlevs:cache>

12.2.2 Configuring an Oracle CEP Local Cache as an Event Source

An Oracle CEP local cache can be configured as a source of events to which another
component in the event processing network listens. The listening component can be an
adapter or a standard Spring bean. Any component that listens to a cache must
implement the com.bea. cache. jcache.CacheListener interface. The following
example shows how to configure a cache to be an event source for a Spring bean:

<wlevs:caching-system id="caching-system-id"/>

<wlevs:cache id="cache-id" name="alternative-cache-name">
<wlevs:caching-system ref="caching-system-id"/>
<wlevs:cache-listener ref="cache-listener-id" />
</wlevs:cache>

<bean id="cache-listener-id" class="wlevs.example.MyCacheListener"/>

In the example, the cache-1istener-id Spring bean listens to events coming from
the cache; the class that implements this component,
wlevs.example.MyCacheListener, must implement the
com.bea.jcache.CacheListener interface. You must program the
wlevs.example.MyCacheListener class yourself.

12.2.3 Configuring an Oracle CEP Local Cache Loader

An Oracle CEP local cache loader is an object that loads objects into an Oracle CEP
local cache. You configure a cache loader by using the wlevs: cache-loader child
element of the wlevs: cache element to specify the bean that does the loading work,
as shown in the following example:

<wlevs:caching-system id="caching-system-id"/>

<wlevs:cache id="cache-id" name="alternative-cache-name">
<wlevs:caching-system ref="caching-system-id"/>
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<wlevs:cache-loader ref="cache-loader-id" />
</wlevs:cache>

<bean id="cache-loader-id" class="wlevs.example.MyCacheLoader"/>

In the example, the cache-loader-1id Spring bean does the cache loading work; it is
referenced by the cache using the ref attribute of the wlevs: cache-loader child
element.

You must program the wlevs . example .MyCacheLoader class yourself, and it must
implement the com.bea.cache. jcache.CacheLoader interface. This interface
includes the 1oad method to customize the loading of a single object into the cache;
Oracle CEP calls this method when the requested object is not in the cache. The
interface also includes 1oadAll methods that you implement to customize the
loading of the entire cache.

12.2.4 Configuring an Oracle CEP Local Cache Store

You can configure an Oracle CEP local cache with a custom store that is responsible for
writing data from the cache to a backing store, such as a table in a database. You
configure a cache store by using the wlevs:cache-store child element of the
wlevs:cache element to specify the bean that does the actual storing work, as shown
in the following example:

<wlevs:caching-system id="caching-system-id"/>

<wlevs:cache id="cache-id" name="alternative-cache-name">
<wlevs:caching-system ref="caching-system-id"/>
<wlevs:cache-store ref="cache-store-id" />
</wlevs:cache>

<bean id="cache-store-id" class="wlevs.example.MyCacheStore"/>

In the example, the cache-store-id Spring bean does the work of writing the data
from the cache to the backing store; it is referenced by the cache using the ref
attribute of the wlevs:cache-store child element.

You must program the wlevs . example.MyCacheStore class yourself, and it must
implement the com.bea.cache. jcache.CacheStore interface. This interface
includes the store method that stores the data in the backing store using the passed
key; Oracle CEP calls this method when it inserts data into the cache. The interface
also includes the storeAll method for storing a batch of data to a backing store in
the case that you have configured asynchronous writes for a cache with the
write-behind configuration element.

12.3 Configuring an Oracle Coherence Caching System and Cache

You can configure your application to use the Oracle Coherence caching system and
cache. Use this caching system if you plan to deploy your application to a multi-server
domain.

Using Oracle Coherence, only the first caching-system can be configured in a server.
Oracle CEP will ignore any other caching systems you might configure.
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Note: Before you can legally use Oracle CEP with Oracle Coherence,
you must obtain a valid Coherence license such as a license for
Coherence Enterprise Edition, Coherence Grid Edition, or Oracle
WebLogic Application Grid. For more information on Oracle
Coherence, see
http://www.oracle.com/technology/products/coherence/
index.html.

Note: Itis assumed in this section that you have already created an
Oracle CEP application along with its EPN assembly file and that you
want to update the application to use caching. If you have not, refer to
Chapter 1, "Overview of Creating Oracle CEP Applications" for
details.

To configure an Oracle Coherence caching system and cache:

1.

Decide whether or not your Oracle Coherence cache will be used exclusively by
this application or shared amongst two or more applications.

For more information, see Section 12.3.5, "Configuring a Shared Oracle Coherence
Cache".

Declare the Oracle Coherence caching system in the EPN assembly file.

To declare a caching system that uses the Oracle Coherence implementation
declaratively in the EPN assembly file, use the wlevs:caching-system element
as shown in the following example:

<wlevs:caching-system id="caching-system-id" provider="coherence"
advertise="false"/>

The value of the id attribute must match the name you specify for the caching
system in the application’s component configuration file (see step 4).

Declare one or more caches for this caching system in the EPN assembly file.

After you have declared a caching system for an application, you configure one or
more caches using the wlevs: cache element:

<wlevs:caching-system id="caching-system-id" provider="coherence"
advertise="false"/>

<wlevs:cache id="myCache" advertise="false">
<wlevs:caching-system ref="caching-system-id"/>
</wlevs:cache>

The wlevs:cache element id attribute is mandatory. This attribute maps to the
name of a cache in the Oracle Coherence configuration files (see step 4).

The name attribute is optional; specify it only if the name of the cache in the
caching system is different from its ID. The wlevs: caching-system child
element references the already-declared caching system that contains the cache.
You must specify this child element only if the caching system is ambiguous: there
is more than one caching system declared (either implicitly or explicitly) or if the
caching system is in a different application or bundle.
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The caching system is responsible for creating the cache associated with a
particular name and returning a reference to the cache. The resulting cache bean
implements the java.util.Map interface.

For more information, see Section 12.3.5, "Configuring a Shared Oracle Coherence
Cache".

4. Configure the caching system and its caches by updating the caching
configuration file for the application.

See Section 12.3.1, "Configuring the Oracle Coherence Caching System and
Caches."

5. Optionally, override the default cache configuration by updating the EPN
assembly file with one or more additional cache element child elements.

= Specify that a cache is an event sink by configuring it as a listener to another
component in the event processing network.

See Section 12.3.1, "Configuring the Oracle Coherence Caching System and
Caches."

»  Specify that a cache is an event source to which another component in the
event processing network listens.

See Section 12.3.2, "Configuring an Oracle Coherence Cache as an Event
Listener."

s Configure either a <wlevs:cache-loader> ora<wlevs:cache-store>
child element of the <wlevs:cache> element in the EPN assembly file, but
not both.

This is because Oracle Coherence combines the loader and store into a single
component. You specify a cache loader when the backing store is read-only
and a cache store when the backing store is read-write

See Section 12.3.4, "Configuring an Oracle Coherence Cache Loader or Store."
6. Access the Oracle Coherence cache:
- Optionally reference the Oracle Coherence cache in a query statement.
See:
*  Section 12.5, "Accessing a Cache From an Oracle CQL Statement"
*  Section 12.6, "Accessing a Cache From an EPL Statement”

- Optionally configure and program a custom adapter, business POJO, or Oracle
CQL or EPL user-defined function to access the Oracle Coherence cache.

The configuration is done in the EPN assembly file and the programming is
done in the Java file that implements the adapter, POJO, or user-defined
function.

See:
*  Section 12.7, "Accessing a Cache From an Adapter"
*  Section 12.8, "Accessing a Cache From a Business POJO"

*  Section 12.9, "Accessing a Cache From an Oracle CQL User-Defined
Function"

*  Section 12.10, "Accessing a Cache From an EPL User-Defined Function”

- Optionally, access the Oracle Coherence cache using JMX.
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See Section 12.11, "Accessing a Cache Using JMX".
7. Edit your MANIFEST . MF to import package com.bea.wlevs.cache.spi.
For more information, see Section 4.7.5, "How to Import a Package".
8. Assemble and deploy your application.

For more information, see Chapter 24, "Assembling and Deploying Oracle CEP
Applications".

12.3.1 Configuring the Oracle Coherence Caching System and Caches

Oracle CEP leverages the native configuration provided by Oracle Coherence. You do
this by packaging the following two Oracle Coherence configuration files, with the
indicated names, in the application bundle that uses the Oracle Coherence cache:

s coherence-cache-config.xml—Oracle Coherence cache configuration
information. Individual caches are identified with the cache-name element; the
value of this element maps to the 1d attribute of the wlevs: cache element in the
EPN assembly file. See Section 12.3.1.1, "The coherence-cache-config.xml File" for
information about this file as well as an example of the mapping.

m tangosol-coherence-override.xml—Oracle Coherence cluster
configuration. See Section 12.3.1.2, "The tangosol-coherence-override.xml File" for
information about this file as well as an example.

When assembling your application, consider the following;:

s coherence-cache-config.xml is a per-application configuration file; put this
file in the META-INF/wlevs/coherence directory of the bundle JAR. Note that
this directory is different from the directory that stores the component
configuration file for the local in-memory Oracle CEP caching provider
(META-INF/wlevs).

s tangosol-coherence-override.xml is a global per-server file (referred to as
"operational configuration” in the Oracle Coherence documentation); put this file
in the Oracle CEP server config directory.

Update your application configuration file as Example 12-5 shows:

Example 12-5 Application Configuration File: Coherence Cache

<coherence-caching-system>
<name>caching-system-id</name>
<coherence-cache-config>
../wlevs/coherence/coherence-cache-config.xml
</coherence-cache-config>
</coherence-caching-system>

When you declare that a caching system uses the Oracle Coherence provider, be sure
that all of the caches of this caching system also map to an Oracle Coherence
configuration and not an Oracle CEP local configuration, or Oracle CEP throws an
exception.

12.3.1.1 The coherence-cache-config.xml File

The coherence-cache-config.xml file is the basic Oracle Coherence
configuration file and must conform to the Oracle Coherence DTDs, as is true for any
Oracle Coherence application.
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The following sample shows a simple configuration. See the explanation after the
sample for information about the sections in bold.

<?xml version="1.0"?>
<!DOCTYPE cache-config SYSTEM "cache-config.dtd">
<cache-config>
<caching-scheme-mapping>
<cache-mapping>
<cache-name>myCoherenceCache</cache-name>
<scheme-name>new-replicated</scheme-name>
</cache-mapping>
<cache-mapping>
<cache-name>myLoaderCache</cache-name>
<scheme-name>test-loader-scheme</scheme-name>
</cache-mapping>
<cache-mapping>
<cache-name>myStoreCache</cache-name>
<scheme-name>test-store-scheme</scheme-name>
</cache-mapping>
</caching-scheme-mapping>
<caching-schemes>
<replicated-scheme>
<scheme-name>new-replicated</scheme-name>
<service-name>ReplicatedCache</service-name>
<backing-map-scheme>
<local-scheme>
<scheme-ref>my-local-scheme</scheme-ref>
</local-scheme>
</backing-map-scheme>
</replicated-scheme>
<local-scheme>
<scheme-name>my-local-scheme</scheme-name>
<eviction-policy>LRU</eviction-policy>
<high-units>100</high-units>
<low-units>50</low-units>
</local-scheme>
<local-scheme>
<scheme-name>test-loader-scheme</scheme-name>
<eviction-policy>LRU</eviction-policy>
<high-units>100</high-units>
<low-units>50</low-units>
<cachestore-scheme>
<class-scheme>
<class-factory-name>
com.bea.wlevs.cache.coherence.configuration.SpringFactory
</class-factory-name>
<method-name>getLoader</method-name>
<init-params>
<init-param>
<param-type>java.lang.String</param-type>
<param-value> {cache-name}</param-value>
</init-param>
</init-params>
</class-scheme>
</cachestore-scheme>
</local-scheme>
<local-scheme>
<scheme-name>test-store-scheme</scheme-name>
<eviction-policy>LRU</eviction-policy>
<high-units>100</high-units>
<low-units>50</low-units>
<cachestore-scheme>
<class-scheme>
<class-factory-name>
com.bea.wlevs.cache.coherence.configuration.SpringFactory
</class-factory-name>
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<method-name>getStore</method-name>
<init-params>
<init-param>
<param-type>java.lang.String</param-type>
<param-value>{cache-name}</param-value>
</init-param>
</init-params>
</class-scheme>
</cachestore-scheme>
</local-scheme>
</caching-schemes>
</cache-config>

In the Oracle Coherence configuration file, the cache-name element that is a child
element of cache-mapping identifies the name of the Oracle Coherence cache. The
value of this element must exactly match the value of the id attribute of the
wlevs:cache element in the EPN assembly file. For example, the following EPN
assembly file snippet refers to the myCoherenceCache cache in the Oracle Coherence
configuration file:

<wlevs:cache id="myCoherenceCache" advertise="false">
<wlevs:caching-system ref="coherence-cache"/>
<wlevs:cache-loader ref="locallLoader"/>
<wlevs:cache-listener ref="localListener"/>
</wlevs:cache>

The Oracle Coherence configuration file illustrates another requirement when using
Oracle Coherence with Oracle CEP: an Oracle Coherence factory must be declared
when using Spring to configure a loader or store for a cache. You do this using the
cachestore-scheme element in the Oracle Coherence configuration file to specify a
factory class that allows Oracle Coherence to call into Oracle CEP and retrieve a
reference to the loader or store that is configured for the cache. The only difference
between configuring a loader or store is that the method-name element has a value of
getLoader when a loader is used and getStore when a store is being used. You
pass the cache name to the factory as an input parameter.

Refer to your Oracle Coherence documentation (see
http://www.oracle.com/technology/products/coherence/index.html)
for detailed information about the coherence-cache-config.xml file.

12.3.1.2 The tangosol-coherence-override.xml File

The tangosol-coherence-override.xml file configures Oracle Coherence
caching. You may includes this file if you are using Oracle Coherence for caching only.
Do not include this file if you are using Oracle Coherence for clustering.

The following sample shows a simple configuration. See the explanation after the
sample for information about the sections in bold.

<?xml version='1.0'?>
<coherence xml-override="/tangosol-coherence-override.xml">
<cluster-config>
<member-identity>
<cluster-name>com.bea.wlevs.example.provider</cluster-name>
</member-identity>

</coherence>

This configuration file is fairly standard. The main thing to note is that you should
specify a cluster-name element to prevent Oracle Coherence from attempting to
join existing Oracle Coherence clusters when Oracle CEP starts up; this can cause
problems and sometimes even prevent Oracle CEP from starting.
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Refer to your Oracle Coherence documentation (see
http://www.oracle.com/technology/products/coherence/index.html)
for detailed information about the tangosol-coherence-override.xml file.

For more information on Oracle CEP clusters, see "Administrating Multi-Server
Domains With Oracle CEP Native Clustering" in the Oracle Complex Event Processing
Administrator’s Guide.

12.3.2 Configuring an Oracle Coherence Cache as an Event Listener

An Oracle Coherence cache can be configured as an explicit listener in the event
processing network in order to receive events.

For example, to specify that a cache listens to a channel, specify the wlevs:listener
element with a reference to the cache as a child of the wlevs:channel element as
shown below:

<wlevs:coherence-caching-system id="caching-system-id"/>

<wlevs:cache id="cache-id" name="alternative-cache-name">
<wlevs:caching-system ref="caching-system-id"/>
</wlevs:cache>

<wlevs:channel id="tradeStream">
<wlevs:listener ref="cache-id"/>
</wlevs:channel>

As the channel sends new events to the cache, they are inserted into the cache. If a
remove event (an old event that exits the output window) is sent by the channel, then
the event is removed from the cache.

12.3.2.1 Specifying the Key Used to Index an Oracle Coherence Cache

When you configure an Oracle Coherence cache to be a listener, events are inserted
into the cache. This section describes the variety of options available to you to specify
the key used to index a cache in this instance.

If you do not explicitly specify a key, the event object itself serves as both the key and
value when the event is inserted into the cache. In this case, the event class must
include a valid implementation of the equals and hashcode methods that take into
account the values of the key properties.

See the following for ways to explicitly specify a key:

= Section 12.3.2.1.1, "Specifying a Key Property in EPN Assembly File"

= Section 12.3.2.1.2, "Using a Metadata Annotation to Specify a Key"

= Section 12.3.2.1.3, "Specifying a Composite Key"

12.3.2.1.1 Specifying a Key Property in EPN Assembly File The first option is to specify a

property name for the key property when a cache is declared in the EPN assembly file
using the key-properties attribute, as shown in the following example:

<wlevs:cache id="myCache" key-properties="key-property-name">
<wlevs:caching-system ref="caching-system-id"/>
</wlevs:cache>

In this case, all events that are inserted into the cache are required to have a property
of this name at runtime, otherwise Oracle CEP throws an exception.

For example, assume the event type being inserted into the cache looks something like
the following; note the key property (only relevant Java source shown):
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public class MyEvent {

private String key;

public MyEvent () {

}

public MyEvent (String key) {
this.key = key;

}

public String getKey() {
return key;

}

public void setKey(String key) {
this.key = key;

}

}

The corresponding declaration in the EPN assembly file would look like the following:

<wlevs:cache id="myCache" key-properties="key">
<wlevs:caching-system ref="caching-system-id"/>
</wlevs:cache>

12.3.2.1.2 Using a Metadata Annotation to Specify a Key The second option is to use the
metadata annotation com.bea.wlevs.ede.api .Key to annotate the event property
in the Java class that implements the event type. This annotation does not have any
attributes.

To use a metadata annotation to specify a key:
1. Import the com.bea.wlevs.ede.api.Key package.

For more information, see Section 4.7.5, "How to Import a Package".
2. Apply the @Key annotation to a method.

The following example shows how to specify that the key property of the
MyEvent event type is the key; only relevant code is shown:

import com.bea.wlevs.ede.api.Key;
public class MyEvent ({
private String key;
public MyEvent () {
}
public MyEvent (String key) {
this.key = key;
}
public String getKey() {
return key;
}
@Key
public void setKey(String key) {
this.key = key;
}

}

12.3.2.1.3 Specifying a Composite Key The final option is to use the key-class
attribute of the wlevs : cache element to specify a composite key in which multiple
properties form the key. The value of the key-class attribute must be a JavaBean
whose public fields match the fields of the event class. The matching is done according
to the field name. For example:

<wlevs:cache id="myCache" key-class="key-class-name">
<wlevs:caching-system ref="caching-system-id"/>
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</wlevs:cache>

12.3.3 Configuring an Oracle Coherence Cache as an Event Source

You can configure an Oracle Coherence cache as a source of events to which another
component in the event processing network listens. The listening component can be an
adapter or a standard Spring bean. Any component that listens to a cache must
implement the com. tangosol.util.MapListener interface. The following
example shows how to configure an Oracle Coherence cache to be an event source for
a Spring bean:

<wlevs:coherence-caching-system id="caching-system-id"/>

<wlevs:cache id="myCache" advertise="false">
<wlevs:caching-system ref="caching-system-id"/>
<wlevs:cache-loader ref="localLoader"/>
<wlevs:cache-listener ref="localListener"/>
</wlevs:cache>
<bean id="localListener"
class="com.bea.wlevs.example.provider.coherence.LocalListener"/>

In the example, the cache-1istener-id Spring bean listens to events coming from
the cache; the class that implements this component,
com.bea.wlevs.example.provider.coherence.LocalListener, must
implement the appropriate Oracle Coherence-specific Java interfaces such as

com. tangosol.util.MapListener. You must program this LocalListener
class yourself as Example 12—6 shows.

Example 12-6 Oracle Coherence Cache LocalListener Implementation

package com.bea.wlevs.example.provider.coherence;

import com.tangosol.util.MapEvent;
import com.tangosol.util.MapListener;

public class Locallistener implements MapListener {
public static int deleted = 0;
public static int inserted = 0;
public static int updated = 0;

public void entryDeleted(MapEvent event) {
deleted++;

}

public void entryInserted(MapEvent event) {
inserted++;

}

public void entryUpdated(MapEvent event) {
updated++;

12.3.4 Configuring an Oracle Coherence Cache Loader or Store

Using an Oracle Coherence cache, you may configure either a wlevs:cache-loader
orawlevs:cache-store child element of the wlevs : cache element in the EPN
assembly file, but not both. This is because Oracle Coherence combines the loader and
store into a single component:

= Specify a cache loader when the backing store is read-only.
See Section 12.3.4.1, "Configuring an Oracle Coherence Cache Loader."

= Specify a cache store when the backing store is read-write.
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See Section 12.3.4.2, "Configuring an Oracle Coherence Cache Store."

12.3.4.1 Configuring an Oracle Coherence Cache Loader

In Example 12-7, the localLoader Spring bean loads events into the oracle
Coherence cache when the backing store is read-only. If the backing store is read-write,
use a cache store (see Section 12.3.4.2, "Configuring an Oracle Coherence Cache Store").

The class that implements this component,
com.bea.wlevs.example.provider.coherence.LocalLoader, must
implement the appropriate Oracle Coherence-specific Java interfaces such as

com. tangosol.net.cache.CacheLoader. You must program this LocalLoader
class yourself as Example 12-8 shows.

Example 12-7 Oracle Coherence Cache EPN Assembly File for a Cache Loader

<wlevs:coherence-caching-system id="caching-system-id"/>
<wlevs:cache id="myCache" advertise="false">
<wlevs:caching-system ref="caching-system-id"/>
<wlevs:cache-loader ref="localLoader"/>
</wlevs:cache>
<bean id="localLoader"
class="com.bea.wlevs.example.provider.coherence.LocalLoader" />

Example 12-8 Oracle Coherence Cache LocalLoader Implementation

package com.bea.wlevs.example.provider.coherence;

import java.util.Collection;
import java.util.HashMap;
import java.util.HashSet;
import java.util.Map;

import java.util.Set;

import com.bea.wlevs.example.provider.event.ProviderData;
import com.tangosol.net.cache.CachelLoader;

public class LocalLoader implements CacheLoader {
public static int loadCount = 0;
public static Set keys = new HashSet();

public LocalLoader () {
}
public Object load(Object key) {
loadCount++;
keys.add (key) ;
return new ProviderData((String) key);
}
public Map loadAll(Collection keys) {
Map result = new HashMap() ;

for (Object key : keys) {
result.put (key, load(key));
}

return result;
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12.3.4.2 Configuring an Oracle Coherence Cache Store

In Example 12-9, the localStore Spring bean loads events into the cache when the
backing store is read-write. If the backing store is read-only, use a cache loader (see
Section 12.3.4.1, "Configuring an Oracle Coherence Cache Loader").

The class that implements this component,
com.bea.wlevs.example.provider.coherence.LocalStore, must implement
the appropriate Oracle Coherence-specific Java interfaces such as

com. tangosol.net.cache.CacheStore. You must program this LocalStore
class yourself as Example 12-10 shows.

Example 12-9 Oracle Coherence Cache EPN Assembly File for a Cache Store

<wlevs:coherence-caching-system id="caching-system-id"/>
<wlevs:cache id="myCache" advertise="false">
<wlevs:caching-system ref="caching-system-id"/>
<wlevs:cache-store ref="localStore"/>
</wlevs:cache>
<bean id="localStore"
class="com.bea.wlevs.example.provider.coherence.LocalStore" />

Example 12-10 Oracle Coherence Cache LocalStore Implementation

package com.bea.wlevs.example.provider.coherence;

import java.util.Collection;
import java.util.HashMap;
import java.util.Map;

import java.util.Set;

import com.bea.wlevs.example.provider.event.ProviderData;
import com.tangosol.net.cache.CacheStore;

public class LocalStore implements CacheStore {
public static int eraseCount = 0;
public static int storeCount = 0;
public static int loadCount = 0;

public void erase(Object key) {
eraseCount++;
}
public void eraseAll (Collection keys) {
for (Object key : keys) {
erase (key) ;

}
public void store(Object key, Object value) {
//
// Do the store operation here.
//
}
public void storeAll (Map entries) {
for (Map.Entry entry : (Set <Map.Entry>)entries.entrySet()) {
store(entry.getKey (), entry.getValue());

}
public Object load(Object key) {
loadCount++;
return new ProviderData((String) key);
}
public Map loadAll(Collection keys) {
Map result = new HashMap();
for (Object key : keys) {
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result.put (key, load(key));
}

return result;

12.3.5 Configuring a Shared Oracle Coherence Cache

When declaring Oracle Coherence caches in the EPN assembly files of one or more
applications deployed to the same Oracle CEP server, you should never configure
multiple instances of the same cache with a loader or store. You might inadvertently
do this by employing multiple applications that each configure the same Oracle
Coherence cache with a loader or store in their respective EPN assembly file. If you do
this, Oracle CEP throws an exception.

If multiple application bundles need to share Oracle Coherence caches, then you
should put the EPN assembly file that contains the appropriate wlevs: cache and
wlevs:caching-systemin a separate bundle and set their advertise attributes to
true.

To export both the caching system and the cache as an OSGi service, set the
advertise attribute to true.

<wlevs:caching-system id="caching-system-id" provider="coherence" advertise="true"/>

<wlevs:cache id="cache-id" name="alternative-cache-name" advertise="true" >
<wlevs:caching-system ref="caching-system-id"/>
</wlevs:cache>

If the cache is advertised, then a component in the EPN of an application in a separate
bundle can then reference it. The following example shows how a processor in one
bundle can use as a cache source the cache with ID cache-id located in a separate
bundle called cacheprovider:

<wlevs:processor id="myProcessor2">
<wlevs:cache-source ref="cacheprovider:cache-id"/>
</wlevs:processor>

12.4 Configuring a Third-Party Caching System and Cache

You can configure your application to use a third-party caching system and cache.

Note: Itis assumed in this section that you have already created an
Oracle CEP application along with its EPN assembly file and that you
want to update the application to use caching. If you have not, refer to
Chapter 1, "Overview of Creating Oracle CEP Applications" for
details.

To configure a third-party caching system and cache:

1. Create a plug-in to define the third-party caching system as an Oracle CEP caching
system provider.

This involves:
= Implementing the com.bea.wlevs.cache.spi.CachingSystem interface
=  Creating a factory that creates caching systems of this type.

= Registering the factory with an attribute that identifies its provider type.
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2. Declare the caching system in the EPN assembly file.

Use the wlevs:caching-system element to declare a third-party
implementation; use the class or provider attributes to specify additional
information.

For simplicity, you can include the third-party implementation code inside the
Oracle CEP application bundle itself to avoid having to import or export packages
and managing the lifecycle of a separate bundle that contains the third-party
implementation. In this case the wlevs: caching-systemelement appears in the
EPN assembly file as shown in the following example:

<wlevs:caching-system id="caching-system-id"
class="third-party-implementation-class"/>

The class attribute specifies a Java class that must implement the
com.bea.wlevs.cache.spi.CachingSystem interface. For details about this
interface, see the Oracle Fusion Middleware Java API Reference for Oracle Complex
Event Processing.

Sometimes, however, you might not be able, or want, to include the third-party
caching implementation in the same bundle as the Oracle CEP application that is
using it. In this case, you must create a separate bundle whose Spring application
context includes the wlevs: caching-system element, with the advertise
attribute mandatory:

<wlevs:caching-system id ="caching-system-id"
class="third-party-implementation-class"
advertise="true"/>

Alternatively, if you want to decouple the implementation bundle from the bundle
that references it, or you are plugging in a caching implementation that supports
multiple caching systems per Java process, you can specify a factory as a provider:

<wlevs:caching-system id ="caching-system-id" provider="caching-provider"/>

<factory id="factory-id" provider-name="caching-provider">
<class>the.factory.class.name</class>

</factory>

The factory class (the. factory.class.name in the example) must implement
the com.bea.wlevs.cache.spi.CachingSystemFactory interface. This
interface has a single method, create, that returns a
com.bea.wlevs.cache.spi.CachingSystem instance.

You must deploy this bundle alongside the application bundle so that the latter
can start using it.

3. Declare one or more caches for this caching system in the EPN assembly file.

After you have declared a caching system for an application, you configure one or
more caches using the wlevs: cache element:

<wlevs:caching-system id ="caching-system-id" provider="caching-provider"/>

<wlevs:cache id="cache-id" name="alternative-cache-name">
<wlevs:caching-system ref="caching-system-id"/>
</wlevs:cache>

The name attribute is optional; specify it only if the name of the cache in the
caching system is different from its ID. The wlevs:caching-system child
element references the already-declared caching system that contains the cache.
You must specify this child element only if the caching system is ambiguous: there
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is more than one caching system declared (either implicitly or explicitly) or if the
caching system is in a different application or bundle.

You can export both the caching system and the cache as an OSGI service using the
advertise attribute.

<wlevs:caching-system id="caching-system-id" advertise="true"/>
<wlevs:cache id="cache-id" name="alternative-cache-name" advertise="true" >

<wlevs:caching-system ref="caching-system-id"/>
</wlevs:cache>

If the cache is advertised, then a component in the EPN of an application in a
separate bundle can then reference it. The following example shows how a
processor in one bundle can use as a cache source the cache with ID cache-id
located in a separate bundle (called cacheprovider):

<wlevs:processor id="myProcessor2">
<wlevs:cache-source ref="cacheprovider:cache-id"/>
</wlevs:processor>

The caching system is responsible for creating the cache associated with a
particular name and returning a reference to the cache. The resulting cache bean
implements the java.util.Map interface.

Configure the third-party caching system and its caches by updating the
third-party caching configuration file or files for the application.

Refer to your third-party cache documentation.

Optionally, override the default third-party cache configuration by updating the
appropriate configuration file with one or more additional cache element child
elements.

= Specify that a cache is an event sink by configuring it as a listener to another
component in the event processing network.

Refer to your third-party cache documentation.

= Specify that a cache is an event source to which another component in the
event processing network listens.

Refer to your third-party cache documentation.

= Configure a cache loader or store.
Refer to your third-party cache documentation.

Access the third-party cache:

- Optionally reference the third-party cache in a query statement.
See:

*

Section 12.5, "Accessing a Cache From an Oracle CQL Statement"
*  Section 12.6, "Accessing a Cache From an EPL Statement"

- Optionally configure and program a custom adapter, business POJO, or Oracle
CQL or EPL user-defined function to access the third-party cache.

The configuration is done in the EPN assembly file and the programming is
done in the Java file that implements the adapter, POJO, or user-defined
function.

See:
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*  Section 12.7, "Accessing a Cache From an Adapter"
*  Section 12.8, "Accessing a Cache From a Business POJO"

*  Section 12.9, "Accessing a Cache From an Oracle CQL User-Defined
Function"

*  Section 12.10, "Accessing a Cache From an EPL User-Defined Function”
- Optionally, access the third-party cache using JMX.
See Section 12.11, "Accessing a Cache Using JMX".

7. When you assemble your application, verify that the META-INF/MANIFEST . MF
file includes the following import as Figure 12-1 shows:

com.bea.wlevs.cache.spi; version ="11.1.0.0"

If the MANIFEST . MF files does not include this import, update the MANIFEST . MF
file to add this import before deploying your application.

Figure 12-2 Editing the MANIFEST.MF File
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12.5 Accessing a Cache From an Oracle CQL Statement

You can reference a cache from an Oracle CQL statement in much the same way you
reference a channel; this feature enables you to enrich standard streaming data with
data from a separate source. Example 12-11 shows a valid Oracle CQL query that joins
trade events from a standard channel named S1 with stock symbol data from a cache
named stockCache:
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Example 12-11 Valid Oracle CQL Query Against a Cache
SELECT Sl.symbol, Sl.lastPrice, stockCache.description

FROM S1 [Now], stockCache
WHERE  S1.symbol = stockCache.symbol

You must abide by these restrictions when using a cache in an Oracle CQL query:
= Whenever you query a cache, you must join against the [Now] window.

This guarantees that the query will execute against a snapshot of the cache. If you
join against any other window type, then if the cache changes before the window
expires, the query will be incorrect.

The following example shows an invalid Oracle CQL query that joins a Range
window against a cache. If the cache changes before this window expires, the
query will be incorrect. Consequently, this query will raise Oracle CEP server error
"external relation must be joined with s[now]".

SELECT trade.symbol, trade.price, trade.numberOfShares, company.name
FROM TradeStream [Range 8 hours] as trade, CompanyCache as company
WHERE trade.symbol = company.id

When you use data from a cache in an Oracle CQL query, Oracle CEP pulls the
data rather than it being pushed, as is the case with a channel. This means that,
continuing with Example 12-11, the query executes only when a channel pushes a
trade event to the query; the stock symbol data in the cache never causes a query
to execute, it is only pulled by the query when needed.

= You must specify all of the key properties needed to do a lookup based on the
cache key.

Consider two streams S and C with schemas (id, group, value) where the cache
key is (1d, group).

The following query is invalid because although the WHERE clause specifies both
key properties (id and group), the query does not supply a value for one of the
key properties (id):

select count(*) as n from S [now], C
where S.group = C.group and S.id is not null

A valid query is:

select count(*) as n from S [now], C
where S.group = C.group and S.id = C.id

For instructions on specifying the cache key, see:

- Section 12.2.1.1, "Specifying the Key Used to Index an Oracle CEP Local
Cache"

- Section 12.3.2.1, "Specifying the Key Used to Index an Oracle Coherence
Cache"

= Joins must be executed only by referencing the cache key.
= You cannot use a cache in a view. Instead, use a join.

= Only a single channel source may occur in the FROM clause of an Oracle CQL
statement that joins cache data source(s).

»  If the cache is a processor source, you connect the cache directly to the processor
on the EPN as Figure 12-3 shows.
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If the cache is a processor sink, you connect the processor to the cache using a
channel as Figure 124 shows.

12.5.1 How to Access a Cache From an Oracle CQL Statement

This section describes how to reference a cache in an Oracle CQL query statement.

This procedure assumes that you have already configured the caching system and
caches. For more information, see:

Section 12.2, "Configuring an Oracle CEP Local Caching System and Cache"
Section 12.3, "Configuring an Oracle Coherence Caching System and Cache"

Section 12.4, "Configuring a Third-Party Caching System and Cache"

To access a cache from an Oracle CQL statement:

1.

If you have not already done so, create the event type that corresponds to the
cache data and register it in the event repository.

See Chapter 2.1.4, "Creating Oracle CEP Event Types".
Specify the key properties for the data in the cache.
For instructions on specifying the cache key, see:

- Section 12.2.1.1, "Specifying the Key Used to Index an Oracle CEP Local
Cache"

- Section 12.3.2.1, "Specifying the Key Used to Index an Oracle Coherence
Cache"

In the EPN assembly file, update the configuration of the cache to declare the
event type of its values; use the value-type attribute of the wlevs:cache
element. For example:

<wlevs:caching-system id="caching-system-id"/>

<wlevs:cache id="cache-id"
name="alternative-cache-name"
value-type="CompanyEvent">
<wlevs:caching-system ref="caching-system-id"/>
</wlevs:cache>

The value-type attribute specifies the type for the values contained in the cache.
This must be a valid type name in the event type repository.

This attribute is required only if the cache is referenced in an Oracle CQL query.
This is because the query processor needs to know the type of events in the cache.

In the EPN assembly file, update the configuration of the processor that executes
the Oracle CQL query that references a cache:

a. If the cache is a processor source: you connect the cache directly to the
processor on the EPN as Figure 12-3 shows.
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Figure 12-3 Cache as Processor Source
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Update the wlevs :processor element a wlevs:cache-source child
element that references the cache. For example:

<wlevs:channel id="S1"/>

<wlevs:processor id="cacheProcessor">
<wlevs:source ref="S1">
<wlevs:cache-source ref="cache-id">
</wlevs:processor>

In the example, the processor will have data pushed to it from the S1 channel
as usual; however, the Oracle CQL queries that execute in the processor can
also pull data from the cache-id cache. When the query processor matches
an event type in the FROM clause to an event type supplied by a cache, such as
CompanyEvent, the processor pulls instances of that event type from the
cache.

b. If the cache is a processor sink: you must connect the processor to the cache
using a channel on the EPN (that is, there must be a channel between the
processor and the cache sink) as Figure 12—4 shows.

Figure 12-4 Cache as Processor Sink
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In this case, the application assembly file looks like this:

<wlevs:channel id="channell" event-type="StockTick">
<wlevs:listener ref="processor" />
</wlevs:channel>
<wlevs:processor id="processor">
<wlevs:listener ref="channel2" />
</wlevs:processor>
<wlevs:channel id="channel2" event-type="StockTick">
<wlevs:listener ref="cache-id" />
</wlevs:channel>

12.6 Accessing a Cache From an EPL Statement

You can reference a cache from an EPL statement in much the same way you reference
a channel; this feature enables you to enrich standard streaming data with data from a
separate source. For example, the following EPL query joins trade events from a
standard channel with company data from a cache:

INSERT INTO EnrichedTradeEvent

SELECT trade.symbol, trade.price, trade.numberOfShares, company.name
FROM TradeEvent trade RETAIN 8 hours, Company company

WHERE trade.symbol = company.id
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In the example, both TradeEvent and Company are event types registered in the
repository, but they have been configured in such a way that TradeEvents come
from a standard stream of events but Company maps to a cache in the event processing
network. This configuration happens outside of the EPL query, which means that the
source of the data is transparent in the query itself.

When you use data from a cache in an EPL query, Oracle CEP pulls the data rather
than it being pushed, as is the case with a channel. This means that, continuing with the
preceding sample, the query executes only when a channel pushes a trade event to the
query; the company data in the cache never causes a query to execute, it is only pulled
by the query when needed.

You must abide by these restrictions when using a cache in an EPL query:
= You must specify the key properties for data in the cache.
For instructions on specifying the cache key, see:

- Section 12.2.1.1, "Specifying the Key Used to Index an Oracle CEP Local
Cache"

- Section 12.3.2.1, "Specifying the Key Used to Index an Oracle Coherence
Cache"

= Joins must be executed only by referencing the cache key.

= You cannot specify a RETAIN clause for data pulled from a cache. If an event type
that gets its data from a cache is included in a RETAIN clause, Oracle CEP ignores
it.

= You cannot use a cache in a correlated sub-query. Instead, use a join.

= Only a single channel source may occur in the FROM clause of an EPL statement
that joins cache data source(s). Using multiple cache sources and parameterized
SQL queries is supported.

12.6.1 How To Access a Cache From an EPL Statement

This section describes how to reference a cache in an EPL query statement.

This procedure assumes that you have already configured the caching system and
caches. For more information, see:

= Section 12.2, "Configuring an Oracle CEP Local Caching System and Cache"
= Section 12.3, "Configuring an Oracle Coherence Caching System and Cache"

= Section 12.4, "Configuring a Third-Party Caching System and Cache"

To access a cache from an EPL statement:

1. If you have not already done so, create the event type that corresponds to the
cache data, such as Company in the preceding example, and registered it in the
event repository. See Chapter 2.1.4, "Creating Oracle CEP Event Types".

2. Specify the key properties for the data in the cache. There are a variety of ways to
do this; see

- Section 12.2.1.1, "Specifying the Key Used to Index an Oracle CEP Local
Cache"

- Section 12.3.2.1, "Specifying the Key Used to Index an Oracle Coherence
Cache"
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3. Inthe EPN assembly file, update the configuration of the cache in the EPN
assembly file to declare the event type of its values; use the value-type attribute
of the wlevs: cache element. For example:

<wlevs:caching-system id="caching-system-id"/>

<wlevs:cache id="cache-id"
name="alternative-cache-name"
value-type="Company">
<wlevs:caching-system ref="caching-system-id"/>
</wlevs:cache>

The value-type attribute specifies the type for the values contained in the cache.
This must be a valid type name in the event type repository.

This attribute is required only if the cache is referenced in an EPL query. This is
because the query processor needs to know the type of events in the cache.

4. In the EPN assembly file, update the configuration of the processor that executes
the EPL query that references a cache, adding a wlevs: cache-source child
element that references the cache. For example:

<wlevs:channel id="stream-id"/>
<wlevs:processor id="processor-id">
<wlevs:cache-source ref="cache-id">
<wlevs:source ref="stream-id">
</wlevs:processor>

In the example, the processor will have data pushed to it from the stream-id
channel as usual; however, the EPL queries that execute in the processor can also
pull data from the cache-1d cache. When the query processor matches an event
type in the FROM clause to an event type supplied by a cache, such as Company,
the processor pulls instances of that event type from the cache.

12.7 Accessing a Cache From an Adapter

An adapter can also be injected with a cache using the standard Spring mechanism for
referencing another bean. A cache bean implements the java.util.Map interface
which is what the adapter uses to access the injected cache.

First, the configuration of the adapter in the EPN assembly file must be updated with a
wlevs:instance-property child element, as shown in the following example:

<wlevs:caching-system id="caching-system-id"/>

<wlevs:cache id="cache-id" name="alternative-cache-name">
<wlevs:caching-system ref="caching-system-id"/>
</wlevs:cache>

<wlevs:adapter id="myAdapter" provider="myProvider">
<wlevs:instance-property name="map" ref="cache-id"/>
</wlevs:adapter>

In the example, the ref attribute of wlevs:instance-property references the id
value of the wlevs: cache element. Oracle CEP automatically injects the cache,
implemented as a java.util.Map, into the adapter.

In the adapter Java source, add a setMap (Map) method with the code that
implements whatever you want the adapter to do with the cache:

package com.bea.wlevs.example;
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import java.util.Map;
public class MyAdapter implements Runnable, Adapter, EventSource, SuspendableBean {

public void setMap (Map map) {...}

12.8 Accessing a Cache From a Business POJO

A business POJO, configured as a standard Spring bean in the EPN assembly file, can
be injected with a cache using the standard Spring mechanism for referencing another
bean. In this way the POJO can view and manipulate the cache. A cache bean
implements the java.util.Map interface which is what the business POJO uses to
access the injected cache. A cache bean can also implement a vendor-specific
sub-interface of java.util.Map, but for portability it is recommended that you
implement Map.

First, the configuration of the business POJO in the EPN assembly file must be
updated with a property child element, as shown in the following example based on
the Output bean of the FX example (see "HelloWorld Example" in the Oracle Complex
Event Processing Getting Started):

<wlevs:caching-system id="caching-system-id"/>

<wlevs:cache id="cache-id" name="alternative-cache-name">
<wlevs:caching-system ref="caching-system-id"/>
</wlevs:cache>

<bean class="com.bea.wlevs.example.helloworld.HelloWorldBean">
<property name="map" ref="cache-id"/>
</bean>

In the example, the ref attribute of the property element references the id value of
the wlevs: cache element. Oracle CEP automatically injects the cache, implemented
asa java.util.Map, into the business POJO bean.

In the business POJO bean Java source, add a setMap (Map) method with the code
that implements whatever you want the POJO to do with the cache:

package com.bea.wlevs.example.helloworld;

import java.util.Map;
public class HelloWorldBean implements EventSink {

public void setMap (Map map) {...}

12.9 Accessing a Cache From an Oracle CQL User-Defined Function

In addition to standard event streams, Oracle CQL rules can also invoke the member
methods of a user-defined function.

These user-defined functions are implemented as standard Java classes and are
declared in the component configuration file of the Oracle CQL processor, as shown in
the following example:

<bean id="orderFunction" class="orderFunction-impl-class"/>

The processor in which the relevant Oracle CQL rule runs must then be injected with
the user-defined function using the wlevs: function child element, referencing the
Spring bean with the ref attribute:

<wlevs:processor id= "tradeProcessor">
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<wlevs:function ref="orderFunction"/>
</wlevs:processor>

Alternatively, you can specify the bean class in the wlevs: function element:

<wlevs:processor id="testProcessor">
<wlevs:listener ref="providerCache"/>
<wlevs:listener ref="outputCache"/>
<wlevs:cache-source ref="testCache"/>
<wlevs:function function-name="mymod" exec-method="execute” />
<bean class="com.bea.wlevs.example.function.MyMod"/>
</wlevs:function>
</wlevs:processor>

The following Oracle CQL rule, assumed to be configured for the tradeProcessor
processor, shows how to invoke the existsOrder method of the orderFunction
user-defined function:

INSERT INTO InstitutionalOrder

SELECT er.orderKey AS key, er.symbol AS symbol, er.shares as cumulativeShares

FROM ExecutionRequest er [Range 8 hours]
WHERE NOT orderFunction.existsOrder (er.orderKey)

You can also configure the user-defined function to access a cache by injecting the
function with a cache using the standard Spring mechanism for referencing another
bean. A cache bean implements the java.util.Map interface which is what the
user-defined function uses to access the injected cache.

First, the configuration of the user-defined function in the EPN assembly file must be
updated with a wlevs : property child element, as shown in the following example:

<wlevs:caching-system id="caching-system-id"/>

<wlevs:cache id="cache-id" name="alternative-cache-name">
<wlevs:caching-system ref="caching-system-id"/>
</wlevs:cache>

<bean id="orderFunction" class="orderFunction-impl-class">
<wlevs:property name="cache" ref="cache-id"/>
</bean>

In the example, the ref attribute of the wlevs: property element references the id
value of the wlevs: cache element. Oracle CEP automatically injects the cache,
implemented as a java.util.Map, into the user-defined function.

In the user-defined function's Java source, add a setMap (Map) method with the code
that implements whatever you want the function to do with the cache:

package com.bea.wlevs.example;

import java.util.Map;
public class OrderFunction {

public void setMap (Map map) {...}

For more information on user-defined functions, see "Functions: User-Defined" in the
Oracle Complex Event Processing CQL Language Reference.

12.10 Accessing a Cache From an EPL User-Defined Function

In addition to standard event streams, EPL rules can also invoke the member methods
of a user-defined function.
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These user-defined functions are implemented as standard Java classes and are
declared in the EPN assembly file using the standard Spring bean tags, as shown in the
following example:

<bean id="orderFunction" class="orderFunction-impl-class"/>

The processor in which the relevant EPL rule runs must then be injected with the
user-defined function using the wlevs : function child element, referencing the
Spring with the ref attribute:

<wlevs:processor id= "tradeProcessor">
<wlevs:function ref="orderFunction"/>
</wlevs:processor>

The following EPL rule, assumed to be configured for the t radeProcessor
processor, shows how to invoke the existsOrder method of the orderFunction
user-defined function:

INSERT INTO InstitutionalOrder

SELECT er.orderKey AS key, er.symbol AS symbol, er.shares as cumulativeShares
FROM ExecutionRequest er RETAIN 8 HOURS WITH UNIQUE KEY

WHERE NOT orderFunction.existsOrder (er.orderKey)

You can also configure the user-defined function to access a cache by injecting the
function with a cache using the standard Spring mechanism for referencing another
bean. A cache bean implements the java.util.Map interface which is what the
user-defined function uses to access the injected cache.

First, the configuration of the user-defined function in the EPN assembly file must be
updated with a wlevs:property child element, as shown in the following example:

<wlevs:caching-system id="caching-system-id"/>

<wlevs:cache id="cache-id" name="alternative-cache-name">
<wlevs:caching-system ref="caching-system-id"/>
</wlevs:cache>

<bean id="orderFunction" class="orderFunction-impl-class">
<wlevs:property name="cache" ref="cache-id"/>
</bean>

In the example, the ref attribute of the wlevs: property element references the id
value of the wlevs: cache element. Oracle CEP automatically injects the cache,
implemented as a java.util.Map, into the user-defined function.

In the user-defined function's Java source, add a setMap (Map) method with the code
that implements whatever you want the function to do with the cache:

package com.bea.wlevs.example;

imp